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Функциональные Возможности
Создания Рисунков
Используя режим Рисунка в Pro/ENGINEER, можно создавать рисунки для всех моделей
Pro/ENGINEER или файлов, импортированных из других систем. Все виды модели в
рисунке ассоциативны: если изменяется значение размера в одном виде, система
соответственно изменяет другие виды рисунка. Кроме того, Pro/ENGINEER связывает
рисунки с их родительскими моделями. Модель автоматически отражает любые
изменения, проведенные в размерах рисунка. Дополнительно, соответствующие рисунки
также отображают любые изменения, сделанные в модели (типа добавления или удаления
элементов и изменения размеров) в режиме Детали, Sheetmetal, Сборки или Обработки.

Pro/ENGINEER предлагает функциональные возможности для работы с техническими
рисунками в двух отдельных компонентах: режиме рисунка (Drawing) и Pro/DETAIL.

Режим Рисунка

Режим Рисунка, доступный в основном модуле Pro/ENGINEER, содержит основные
функциональные возможности для документирования твердотельной или поверхностной
модели в рисунках, которые используют двухстороннюю ассоциативность с моделью. При
проведении изменений в модели в режиме Детали или Сборки, система автоматически
изменяет рисунок и отображает все изменения. Аналогично, любые изменения, сделанные
в модели в режиме Рисунка, немедленно отобразятся на модели в других режимах.
Pro/ENGINEER можно использовать для создания видов рисунка и образмеривания одной
или более моделей в нескольких стандартных видах. Также в рисунок можно вставлять
аннотации, управлять размерами и использовать слои для управления отображением
различных элементов.

Pro/DETAIL

Pro/DETAIL, необязательный дополнительный модуль, поставляемый для Pro/ENGINEER и
расширяющий возможности режима Рисунка. Его можно использовать с основным
модулем Pro/ENGINEER или как самостоятельный модуль для создания, просмотра и
аннотирования моделей и рисунков.

Pro/DETAIL поддерживает дополнительные типы видов и листы, содержит многочисленные
команды для управления элементами рисунка, и дает возможность добавлять и изменять
различные виды текстовой и символьной информации. Кроме того, его можно
использовать для оформления технических рисунков эскизной геометрией, создания
пользовательских форматов рисунка и проведения различных изменений в рисунках
косметического характера.

При наличии лицензии Pro/DETAIL, можно также использовать всплывающие меню для
изменения любого объекта рисунка в любом месте дерева меню. В любое время, когда
окно рисунка активно, можно прерывать текущий процесс и активизировать объект рисунка
для изменений.
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Интерфейсы Рисунка

При наличии лицензии для Pro/INTERFACE или Pro/DETAIL, можно вызывать различные
команды для экспорта файлов рисунков в другие системы и импорта файлов в режим
Рисунка. Используйте меню File в меню Pro/ENGINEER.

Экспорт Модели из Режима Рисунка
Выбирая Export и Model, можно экспортировать следующие модели из режима Рисунка в
файлы данных: IGES, DXF, DWG, SET, STEP.

Экспорт Изображения из Режима Рисунка
Выбирая Export и Image, можно экспортировать следующие изображения из режима
Рисунка в файл данных: CGM, TIFF, JPEG, тонированный, EPS, Snapshot.

Импорт Данных в Режим Рисунка
Выбирая Import и Create New Model, можно импортировать следующие данные в новую
модель в режиме Рисунка: IGES, SET, VDA, Neutral, CADAM, STEP, CATIA, PDGS, CGM,
ECAD.

Добавление Данных
Выбирая Import и Append to Model, к активному объекту можно добавлять следующие
данные: IGES, SET, DXF, STEP, CGM, TIFF, DWG.

Создание Группы Объектов с
Сохранением Ассоциативности их Групп
Для создания группы объектов, которые сохраняют собственную ассоциативность группы
при экспорте IGES, выберите IGES Groups из меню DADV DWG OPTS.
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Настройка Рисунка

Опции Файла Установок Рисунка
Pro/ENGINEER сохраняет опции файла установок рисунка отдельно для каждого рисунка и
формата рисунка. Эти опции файла установок определяют такие характеристики как
высоту текста размера и примечания, ориентацию текста, стандарт допуска на размер,
свойства шрифта, стандарты чертежа и длины стрелки.

Система присваивает этим опциям файла установок значения по умолчанию, но значения
можно изменять для настройки рисунка и их сохранения и использовать в других рисунках.
Система сохраняет (и вызывает) значения в файле установок рисунка, называемом
filename.dtl.

Файл, который определен в опции drawing_setup_file файла конфигурации, устанавливает
значения опций по умолчанию файла установок для любого рисунка, созданного в сессии
Pro/ENGINEER. Если эта опция не установлена, система использует значения опций по
умолчанию файла установок. При наличии лицензии для Pro/DETAIL, можно устанавливать
типовые файлы установок рисунка для DIN, ISO и JIS из каталога loadpoint/text со
следующими именами:

· din.dtl

· iso.dtl

· jis.dtl

Вызовите эти файлы установок для настройки требуемой среды в вашем рисунке.

Обратите внимание: формат рисунка всегда имеет свой собственный файл установок -
независимый от файла установок рисунка - но он ограничен.

Создание Файла Установок Рисунка
Используя Create в меню DTL SETUP, можно создавать файл установок рисунка.

1. Выберите DRAWING > Advanced > Create.

2. Введите имя нового файла установок рисунка. Текущий файл установок рисунка по
умолчанию появляется на экране в окне редакторе. Опции организованы в списке согласно
выполняемой функции.

3. После редактирования файла, сохраните любые изменения и выйдите из редактора.
Новый файл сохраняется в текущий каталог и становится доступным для использования
другими рисунками.

4. В меню Pro/ENGINEER View, выберите Repaint. Система перерисовывает рисунок,
используя параметрические значения нового файла установок рисунка.
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Совет: Изменение Текстового Редактора
Опция "drawing_file_editor� файла конфигурации определяет заданный по умолчанию
текстовый редактор. Для использования другого редактора, укажите пользовательскую
команду редактора как значение опции "pro_editor_command" файла конфигурации.

Вызов Файла Установок Рисунка
При вызове существующего файла установок рисунка, Pro/ENGINEER считывает его
значения в текущий рисунок.

1. Выберите DRAWING > Advanced > Retrieve.

2. Выберите файл установок рисунка из списка в меню.

3. Из меню Pro/ENGINEER View, выберите Repaint или Regen View. Система
перерисовывает рисунок, используя значения параметров вызванного файла.

Изменение Файла Установок Текущего
Рисунка
1. Выберите DRAWING > Advanced > Modify Val. Значения опций файла установок
текущего рисунка появляются на экране в заданном по умолчанию текстовом редакторе.

2. Отредактируйте значения, сохраните все изменения и выйдите из рисунка.

3. В меню Pro/ENGINEER View, выберите Repaint или Regen View. Система
перерисовывает рисунок, используя значения параметров вызванного файла.

Обратите внимание: Если значения опции файла установок текущего рисунка
изменяются, система изменяет только текущий рисунок. При этом файлы установок
рисунка на диске не изменяются, пока текущие значения не будут сохранены при помощи
команды Save.

Сохранение Файла Установок Рисунка на
Диск
1. Выберите DRAWING > Advanced > Save.

2. Введите имя файла. Если такой файл существует, Pro/ENGINEER запрашивает
подтверждения заменить текущий файл. Система создает новый файл установок рисунка с
именем "filename.dtl", содержащим значения опций файла установок текущего рисунка и
записывает его в каталог, из которого был запущен Pro/ENGINEER.
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Указание Собственного Каталога Файлов
Установок
Используя опцию "pro_dtl_setup_dir� файла конфигурации, можно определить полный путь
к каталогу, содержащему собственные файлы установок. При выборе Retrieve из меню
DTL SETUP и, затем, Setup Dir, Pro/ENGINEER автоматически переходит в каталог,
который содержит ваши файлы установок рисунка. Если путь не был указан с
использованием этой опции файла конфигурации, Pro/ENGINEER переходит в каталог
установок, заданный по умолчанию.
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Работа в Нескольких Окнах
Различные листы рисунков можно отображать в нескольких окнах (или один и тот же лист в
нескольких окнах) и выбирать любое окно.

1. Из меню Pro/ENGINEER Windows выберите New.

2. Введите номер листа для отображения в новом окне. К рисунку можно также добавить
новый лист. Новое окно появляется с выбранным листом.

Выбор в Нескольких Окнах
Можно осуществлять выбор в нескольких окнах, используя команды в меню GET SELECT,
но при этом учитывайте следующее:

· Можно выбирать из любого активного листа в любом окне. Например, можно выбирать
элементы для удаления во всех окнах.

· При выборе элемента в окне, которое не является текущим, система постоянно
переключается в выбранное окно. Например, при выборе размера в окне, это окно
становится текущим, и этот размер затем можно разместить.

Объекты и Процедуры, Изменяемые во
Всех Окнах
При работе с несколькими окнами, Pro/ENGINEER одновременно отображает изменения во
всех окнах одного рисунка для следующих типов объектов:

· размеры;

· примечания;

· оси;

· символы;

· опорные элементы;

· виды.

Система также одновременно отражает следующие процедуры во всех окнах одного и того
же рисунка:

· изменение цвета нарисованных объектов, косметических элементов, примечаний или
вхождений символа.

· Создание или изменение эскизного объекта.

· Управление опорными эскизными элементами.

· Удаление допусков на размер.
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Настройка Среды
Множество опций файла конфигурации и несколько команд в диалоговом окне
Environment управляют отображением элементов в рисунке и доступом к файлам.
Параметры настройки в диалоговом окне Environment имеют преимущество перед
параметрами настройки файла конфигурации. Поэтому, если некоторые команды
используются редко (типа сетки рисунка), то для удаления сетки следует использовать
опцию файла конфигурации, а кнопку диалогового окна Environment использовать только,
когда она потребуется.

Опции Файла Конфигурации для Режима
Рисунка
Следующие опции файла конфигурации определены для функций режима Рисунка. См.
Опции Файла Конфигурации в Pro/HELP для полной информации относительно этих опций
и для полного списка опций файла конфигурации, доступных в Pro/ENGINEER.

allow_move_view_with_move

allow_mod_attach_draft_dim

allow_move_attach_in_dtl_move

auto_associative_dimensions

auto_regen_views

create_drawing_dims_only

default_draw_scale

dim_fraction_format

display_dwg_tol_tags

display_in_adding_view

disp_trimetric_dwg_mode_view

draw_models_read_only

draw_points_in_model_units

drawing_file_editor

drawing_setup_file

drawing_view_origin_csys

dwg_select_across_pick_box

force_wireframe_in_drawings

format_setup_file

highlight_erased_dwg_views

highlight_new_dims

make_parameters_from_fmt_tables
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make_proj_view_notes

pro_dtl_setup_dir

pro_format_dir

rename_drawings_with_object

save_drawing_picture_file

save_modified_draw_models_only

selection_of_removed_entities

switch_dims_for_notes

sym_leader_orient_move_text

todays_date_note_format

update_drawings_on_retrieval

variant_drawing_item_sizes
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Режим «Только-Чтение»

Вызов в Режиме «Только-Чтение»
При наличии лицензии для Pro/DETAIL, можно значительно уменьшить количество
времени, необходимое для вызова рисунка или отчета, используя режим View-Only.

Система не вызывает никаких сопутствующих твердотельных моделей, если рисунок
вызывается, выбирая Open в меню File Pro/ENGINEER и, затем, выбирая флажок Retrieve
Drawing as View Only в списке в правом верхнем углу диалогового окна File Open. Так как
твердотельные модели не находятся в сессии, система временно замораживает рисунки,
чтобы их нельзя было изменять.

Отображение Рисунка в Режиме Только-
Чтение
1. Сохраните существующую отображаемую информацию, выбирая Save Display в
диалоговом окне Environment или устанавливая опцию "save_display" файла
конфигурации в «yes». Для регенерации всего вида или отображения текущего листа (или
всех листов), выберите View > Regen View в меню Pro/ENGINEER.

2. Выберите File > Save для сохранения рисунка с необходимой отображаемой
информацией.

3. Выберите File > Open; затем выберите флажок Retrieve as View Only в списке в правом
верхнем углу диалогового окна File Open.

4. Вызовите рисунок. Система отображает рисунок в режиме Только-Чтение (View-Only).
Выберите Sheet для перехода на другой лист.

5. Для определения, отсутствует ли в отображении какая либо информация, выберите
Drawing > Display Info в меню Info Pro/ENGINEER. Если присутствует вся информация,
система отображает сообщение. Если что либо отсутствует - отображается текстовое окно,
определяющее отсутствующую информацию.

Изменение Рисунка в Режиме Только-
Чтение
Для изменения рисунка в режиме Только-Чтение, необходимо выбрать Retr Models из
меню VIEWONLY DRW. Система входит в режим Рисунка и вызывает все модели рисунка
для текущего рисунка.
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Ограничения Режима Только-Чтение
В режиме Только-Чтение существуют следующие ограничения:

· если в отображении вида отсутствует геометрия, система отображает пустую границу
вида.

· Пока Pro/ENGINEER не вызовет никакую из связанных твердотельных моделей, вывод на
печать (например, проверка наложения) в режиме Рисунка не функционирует должным
образом, потому что многое из информации отсутствует.

· При вызове рисунка, который уже находится в памяти, в текущее окно в другом режиме
(например, рисунок - в режиме Только-Чтение, а он вызывается посредством
Search/Retrieve, или наоборот), рисунок остается в своем исходном режиме, а
Pro/ENGINEER выдает предупреждающее сообщение.

· Нельзя изменять или сохранять рисунки, если не используется Retr Models в меню
VIEWONLY DRW для вызова всех моделей.

· При сохранении отображения с линиями привязки в режиме Рисунка, система чертит их в
режиме Только-Чтение.

· На рисунке с несколькими листами, если вызывается только один лист, но требуется
сохранить отображение на экране, система отображает только один лист, потому что
другие виды еще не регенерированы.

Для регенерации всех листов, выберите Regen View из меню View Pro/ENGINEER и All
Sheets. Это необходимо делать вручную перед сохранением рисунка, если необходимо,
чтобы функциональные возможности Только-Чтение работали для всех листов.

· При сохранении отображения (выбирая Save Display в диалоговом окне Environment или
устанавливая опцию файла конфигурации "save_display" в «yes»), Pro/ENGINEER не
рассчитывает отображение вида. В результате, можно значительно уменьшить время
вызова в режиме Рисунка.

Совет: Сохранение Отображения
Если опция "save_display файла конфигурации установлена в «yes», система сохраняет
геометрию вида и элементы типа размеров твердотельных элементов, и отображает их
при вызове рисунка в режиме Только-Чтение. Если эта опция установлена в «no», система
их не отображает. Однако, вместо изменения файла конфигурации, можно выбрать опцию
Save Display в диалоговом окне Environment, которая выполняет ту же функцию.
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Сохранение Рисунков
Pro/ENGINEER сохраняет некоторых из объектов и информацию, которую можно создавать
или изменять в рисунке в модели иначе, чем с рисунком. Это важно, так как такие
изменения, сделанные в рисунке, могут влиять на модель, которую он описывает.
Например, если размер устанавливается как базовый, он становится теоретически точным,
и система удаляет все его допуски.

Pro/ENGINEER обязательно сохраняет с рисунком косметическую информацию
следующего типа:

· все нарисованные объекты;

· вид, в котором объект отображается;

· размещение объекта на листе;

· зигзаги и разрывы в выносках и линиях размеров;

· вставку размеров в примечаниях;

· шрифт, высоту, ширину и угол наклона текста

Однако, с моделью сохраняется много информации из рисунка, типа следующего:

· допуски на размер (их можно сохранять также в рисунке)

· информация по размерам (также ссылочные и управляемые размеры), включая
следующее:

•  дополнительный текст;

•  стандартные/ординатные типы размеров;

•  присоединенный список допусков на размер;

•  присоединенный набор ссылок на базу или ось;

•  значение и информация по допуску;

•  различие между первичными и вторичными единицами, если они явно установлены;

•  основные и контрольные атрибуты;

•  заданная информация по базе и оси;

•  информация по обозначению базы;

•  обработка поверхности, включая тип и значение;

•  упрощения (используя By View и All Views);

•  информация по принадлежности слоям для всех объектов в модели.

Отмена Изменений, Влияющих на Модель
Для отмены изменений, влияющих на модель и сделанных в режиме Рисунка, установите
опцию файла конфигурации "draw_models_read_only" в «yes». В этом случае, при попытке
сделать изменение, воздействующее на модель, Pro/ENGINEER выдаст предупреждение и
изменение не будет проведено.
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Сохранение Рисунка без Сохранения
Модели
Всякий раз при сохранении рисунка после проведения изменений, которые затрагивают
модель, Pro/ENGINEER сохраняет модель с рисунком. Однако, если изменений в модели
не было сделано, и необходимо сохранить рисунок без сохранения модели, установите
опцию "save_modified_draw_models_only" файла конфигурации в «yes».
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Регенерация Видов и Рисунков
При регенерации рисунка, Pro/ENGINEER обновляет рисунок и модель, которую он
представляет; а не просто перерисовывает их. Следовательно, если какое либо из
значений размера модели в режиме Рисунка было изменено, система обновляет модель,
чтобы отобразить эти изменения при регенерации рисунка. Регенерированный рисунок
отображает обновленную модель и все изменения, которые в ней произошли. При
перерисовке рисунка, система перерисовывает экран, но не обновляет модель.

При создании управляемых или чертежных размеров, необходимо регенерировать рисунок
после перемещения нарисованных объектов и когда требуется показать изменения,
сделанные в рисунке опцией "draft_scale" файла установок рисунка. Регенерация рисунка
обновляет управляемые размеры и привязывает ассоциативные размеры к объектам
рисунка. При использовании управляемых размеров в уравнениях модели, модель в
рисунке необходимо регенерировать для их обновления.

Регенерация Вида
Команда Regen View в меню View Pro/ENGINEER работает вместе с опцией файла
конфигурации "auto_regen_views".

Регенерация Вида Рисунка После
Проведения Изменений в Модели
1. В меню Pro/ENGINEER, выберите View > Regen View > All Sheets, или выберите вид(ы)
для обновления. Система подсвечивает каждый вид сиреневой границей при его выборе.

2. Выберите Done Sel по завершении. Система регенерирует выбранные виды и отражает
изменения, сделанные в модели.

Регенерация Размеров Модели или
Рисунка
Всякий раз при изменении модели, используете команду Regenerate для ее регенерации и
соответствующего обновления видов рисунка. Используя эту команду, можно также
обновлять ассоциативные размеры чертежа при изменении объектов рисунка.

1. Выберите DRAWING > Regenerate.

2. Сделайте одно из следующего:

•  для обновления модели и соответствующего перерисовывания всех видов, выберите
REGENERATE > Model.

•  Для регенерации только ассоциативных размеров рисунка, выберите REGENERATE >
Draft (эта команда не регенерирует модель, даже при ее изменении).
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Опция Файла Конфигурации
auto_regen_views
При установке этой опции в «yes», система автоматически обновляет отображение рисунка
при переходе из одного окна к другому, как если бы была изменена модель в подокне в
процессе работы над рисунком в главном окне. Можно перерисовывать или
регенерировать рисунок для отображения изменений, сделанных в модели. При ее
регенерации, система обновляет модель для отображения изменений, сделанных в
рисунке.

Если значение "auto_regen_views" установлено в «no», можно обновить только рисунок,
выбирая Regen View в меню View в Pro/ENGINEER и Pick View, Current Sheet или All
Sheets. Ни команда Repaint в меню View, ни команда Regenerate в меню DRAWING не
обновляет рисунок, когда эта опция установлена в «no», даже если в модели проводятся
изменения в режиме Рисунка (типа изменения значения размера). Можно выбирать
столько видов, сколько требуется для регенерации.

При попытке изменить вид, который не был обновлен, Pro/ENGINEER выдаст сообщение
об ошибках, сообщающее, что изменения в рисунке не будут проведены, пока к виду не
будет применена команда Regen View. При регенерации родительского вида, его дочерние
виды не регенерируются; необходимо отдельно выбрать каждый вид в рисунке, включая
выносные виды. Всякий раз при сохранении изменений в модели, система отображает их в
рисунке при следующих открытиях, независимо от регенерации видов рисунка.
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Пример: Использование Команды Regen
View
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Масштабы Рисунка и Вида
В рисунке можно использовать два типа масштабов: глобальный (при добавлении видов с
использованием команды No Scale) и индивидуально для вида (при добавлении видов с
использованием команды Scale).

· Для глобального масштаба (или масштаба рисунка), система масштабирует рисунки в
соответствии с параметром рисунка SCALE в нижней части листа рисунка. Например, .25
масштабирует виды рисунка до одной четверти от фактического размера модели. Можно
установи масштаб рисунка по умолчанию, используя опцию "default_draw_scale" файла
конфигурации, или можно перезаписать параметры настройки, изменяя масштаб.

· Для масштаба для отдельного вида, система назначает видам индивидуальный
масштабный коэффициент, который появляется под каждым видом в примечании "Scale
value". При изменении масштаба рисунка, эти виды не изменяются, так как масштабные
коэффициенты являются независимыми.

При изменении размер рисунка, масштаб рисунка изменяется соответственно, сохраняя
виды пропорционально размеру листа. Однако, выносные элементы и масштабируемые
виды сохраняют свой первоначальный масштаб независимо от изменений в размерах
рисунка.

Масштабы Вида, Управляемые
Уравнениями
Можно использовать уравнения для управления масштабом видов, которые были
размещены с использованием команды Scale; однако, их нельзя использовать для
управления какими либо видами, которые масштабировались глобально с использованием
команды No Scale. При вводе уравнения для масштаба вида, система вычисляет
выражение и сохраняет информацию. Такая функциональная возможность позволяет
связать масштаб вида, используя размеры модели. Система сохраняет уравнения с
моделью и обновляет масштаб вида и всех элементов, связанных с ним каждый раз при
изменении размеров модели.

Обратите внимание: При повторном масштабировании вида рисунка, Pro/ENGINEER
также повторно масштабирует все зависимые родительские/дочерние виды (проецируемые
виды, виды с разрывами и т.д.).

Изменение Уравнения для Масштаба Вида
1. Выберите DETAIL > Modify > Value.

2. Выберите масштаб вида в левом нижнем углу, используя правую кнопку мыши.

3. Введите фактическое значение или уравнение и нажмите ENTER.

Обратите внимание: при использовании уравнения, введите только правую часть
выражения. Система вычисляет левую часть как масштаб вида.
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Формат Масштаба Рисунка
Масштабы рисунка можно выражать в десятичном или дробном формате, устанавливая
опцию файла установок рисунка "view_scale_format" ("десятичный формат" является
значением по умолчанию). Для установки образца дробных масштабов, используйте опцию
файла установки рисунков "view_scale_denominator".
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Рисунки на Нескольких Листах
При наличии лицензии для Pro/DETAIL, можно использовать команду Sheets в меню
DRAWING для создания рисунков на нескольких листах и перемещать элементы с одного
листа на другой. Такие листы можно просматривать, используя базовый модуль
Pro/ENGINEER. Если рисунок имеет более одного листа, в нижней части основного окна
появляется дополнительный ярлычок, SHEET # OF [].

При работе с рисунками на нескольких листах, имейте в виду следующее:

· при переносе проекционного вида на другой лист, он становится независимым. Затем
можно перемещать родительский вид, и система не обновляет проекционный вид
относительно другого листа. При повторном переносе этого вида на том же самом листе,
проекционный вид немедленно становится дочерним.

· Можно изменять масштабы рисунка на каждом листе независимо.

· При изменении масштаба на листе, некоторые виды с других листов не изменяются.

· При стирании вида на одном листе, можно восстановить его на любом другом листе.

· Можно устанавливать, который лист будет активным, используя пиктограмму Sheet spin
box на инструментальной панели.

Добавление Листа к Рисунку
Для добавления дополнительного листа к рисунку, выберите Add из меню SHEETS.
Pro/ENGINEER автоматически добавляет новый лист к последнему листу рисунка.

Удаление Листов из Рисунка
1. Выберите SHEETS > Remove.

2. Введите номера листов для удаления. Можно отделить их, используя запятые или
дефисы и вставить пробелы, например, [1,3-5,12,15-20]. Номер слева от черточки должен
всегда быть меньше номера справа.

Система удаляет указанные листы из рисунка. Если удаляется текущий лист, текущим
листом устанавливается первый остающийся лист.

Причины Процедуры Автоматической
Отмены
Pro/ENGINEER отменяет процедуру и не удаляет никаких листов если не будет выполнено
какое либо из следующих действий:

· будет нажато ENTER без указания числа;

· будет использован неправильный синтаксис в строке ввода;
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· будет указана пара чисел в неправильном порядке или числа не будут отделены
дефисом;

· будут указаны несуществующие листы (однако, можно включать один и тот же лист более
одного раза; например, [1-5,3-8] � соответствует записи [1-8]);

· будет указано удаление всех листов рисунка (если присутствует только один лист,
команда Remove - недоступна);

· будет указано удаление листа, содержащего родительский вид дочернего вида,
показанного на другом листе, который остается (однако, можно удалять оба листа сразу).

Переупорядочивание Листов в Рисунке
1. Выберите SHEETS > Reorder. Pro/ENGINEER отображает список номеров страниц
рисунка.

2. Введите новый номер для текущего листа. Система перестраивает листы рисунка,
вставляя текущий лист в указанную позицию в рисунке.

Перенос Элементов на Другой Лист в То
же Место
Используя команду Switch Sheet в меню SHEETS, можно перемещать элементы на другой
лист.

1. Выберите SWITCH OPTS > Switch Items. Меню DWG ITEMS отображает следующие
команды:

•  Dwg Views - переносит виды рисунка.

•  Draft Items - переносит элементы без выносок.

•  Dwg Tables � переносит таблицы рисунка.

2. Выберите команду; затем выберите переносимые элементы.

3. Для подтверждения выбора, выберите Done Sel. Система подсвечивает выбранные
элементы сиреневым цветом.

4. Выберите DWG ITEMS > Done и введите номер листа для переноса. Можно также
создать новый лист, введя номер нового листа. Если в качестве листа для переноса будет
введен номер текущего листа, система запросит повторно ввести номер.

5. Элементы появляются на указанном листе. Для продолжения переноса элементов,
выберите SHEETS > Switch Sheet и повторите процесс.

Перенос Элементов в Любое Место
Другого Листа
1. Выберите SWITCH OPTS > Switch/Move.

2. Выберите команду из меню DWG ITEMS.
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3. Выберите элементы для переноса. Для подтверждения выбора, выберите Done Sel.
Система подсвечивает выбранные элементы сиреневым цветом.

4. Выберите DWG ITEMS > Done и введите номер листа для переноса.

5. Выберите метод определения вектора перемещения, выбирая соответствующие
команды в меню GET VECTOR:

6. Элементы появляются на указанном листе в указанном месте. Для продолжения
переноса элементов, выберите SHEETS > Switch Sheet и повторите процесс.

Элементы Рисунка
Нельзя перемещать элементы рисунка, которые имеют выноски, присоединенные к
объектам типа позиций (balloons), примечаний и размеров. Если рисунок имеет только один
лист, система автоматически создает второй лист после выбора элементов для переноса.

Меню Get Vector
· Horiz - переносит объекты в горизонтальном направлении. Введите значение в единицах
рисунка для переноса объектов. Положительное направление - в правую сторону листа.

· Vert - переносит объекты в вертикальном направлении. Введите значение, в единицах
рисунка для переноса объектов. Положительное направление - в верхнюю сторону листа

· Ang/Length - переносит объекты под углом на указанное расстояние в направлении, при
котором положительный угол отсчитывается от горизонтали против часовой стрелки.
Появляется стрелка, указывая положительное направление переноса.

· From-To - переносит объекты вдоль вектора, определяемого начальной и конечной
точкой.

Сохранение Размера и Положения
Моделей Рисунка
При переносе между листами двумерной модели рисунка, используйте опцию файла
конфигурации "variant_drawing_item_sizes" для управления, будут ли элементы рисунка
сохранять свой размер и положение на листе при изменении размера листа или единиц
рисунка.

· Если эта опция установлена в «yes», некоторые элементы масштабируются и-или
переносятся с сохранением размера или местоположения при выводе их на печать, в то
время как другие элементы масштабируют и-или занимают положение самостоятельно, с
сохранением этих параметров на экране.

· Если эта опция установлена в «no», элементы, которые перемещаются или копируются на
другой лист той же или другой двухмерной модели (или элементы листа, размер или
единицы измерения которых изменяются) сохраняют тот же размер на бумаге и ту же
относительную ориентацию, что и прежде.
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Настройка Рисунков-Прототипов

Концепция Рисунков-Прототипов
Рисунки-прототипы используется при создании рисунка. Они автоматически создают виды,
устанавливают требуемое отображение вида, создают линии привязки и отображают
размеры модели на основании шаблона.

Рисунки-прототипы содержит три основных типа информации для создания новых
рисунков. Первый тип � базовая информация, по которой создается рисунок, но которая не
зависит от модели рисунка, типа примечаний, символов и т.д. Эта информация копируется
из прототипа в новый рисунок.

Второй тип - команды используемые при настройке видов рисунка и действий, которые
выполняются с этими видами. Команды используются для формирования нового рисунка с
новыми объектами (модели).

Третий тип - параметрические примечания. Параметрические примечания - примечания,
которые обновляются в соответствии с новыми параметрам модели рисунка и значениями
размеров. Примечания повторно анализируются или обновляются, когда прототип
получает новые значения.

Используйте прототипы для:

· определения компоновки видов;

· установки отображения видов;

· размещения примечаний;

· размещения символов;

· определения таблиц;

· создания линий привязки;

· отображения размеров;

Можно также создавать пользовательские рисунки-прототипы для различных типов
создаваемых рисунков. Например, можно создавать шаблон для детали, обрабатываемой
на станке, или отливки. Прототип обрабатываемой на станке детали может задавать виды,
которые обычно создаются для рисунков такого типа деталей, устанавливать отображение
для каждого вида (например, отображение невидимых линий), размещения стандартных
технических требований компании и автоматического создания линий привязки для
размещения размеров. Создание прототипа позволяет создавать элементы рисунков
автоматически, используя настраиваемый прототип.

Создание Рисунка-прототипа
1. Нажмите File > New. Открывается диалоговое окно New.

2. Щелкните по Drawing, и введите название создаваемого прототипа или оставьте
значение по умолчанию.

3. Снимите переключатель Use default template (использовать прототип по умолчанию),



Pro/DETAIL Выпуск Документации Pro/ENGINEER 2000 i2

30

затем, нажмите OK. Открывается диалоговое окно New Drawing.

4. Нажмите Empty или Empty with format, затем определите ориентацию прототипа,
щелкая по Portrait, Landscape или Variable.

5. Укажите размер прототипа, затем нажмите OK.

6. В меню Applications нажмите Template для входа в режим прототипа Рисунка, затем
нажмите Views > Add Template. Открывается диалоговое окно View Instructions Template.

7. Введите Название Вида или примите значение по умолчанию, затем укажите
Ориентацию Вида.

8. В текстовом поле Model �Saved View� Name, установите ориентацию вида.

9. Определите опции и значение вида в зонах View Options и View Values.

10. Нажмите Place View и выберите местоположение Общего (General) вида.

Обратите внимание: После размещения вида становятся доступными опции,
перемещения символа, редактирования символа вида или замены символа вида.

11. Для размещения дополнительных видов, нажмите New, введите название нового вида
и сориентируйте новый вид. Определите опции и значения нового вида.

12. По завершении размещения всех видов, нажмите OK. Сохраните прототип.

Создание Рисунка, Используя Рисунок-
прототип
1. Нажмите File > New. Открывается диалоговое окно New.

2. Нажмите Drawing, затем введите название создаваемого рисунка или примите значение
по умолчанию.

3. Снимите переключатель Use default template, затем нажмите OK. Открывается
диалоговое окно New Drawing.

4. Выберите модель, для которой требуется создать рисунок.

5. Определить прототип, щелкая по Use template. Введите название прототипа, который
требуется использовать или выберите прототип из списка Прототипов. Нажмите OK. Будет
создан рисунок.

Обратите внимание: виды с корректными атрибутами создаются и в шаблоне, и в модели.
Если атрибуты, заданные в прототипе - отсутствуют в модели, происходит ошибка при
создании рисунка. Открывается диалоговое окно Drawing Template Error Info с
перечислением ошибок.

Для вызова диалогового окна Drawing Template Error Info, нажмите Info > Drawing >
Template Failure Info.
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Диалоговое Окно Template View
Instructions
Используйте следующие опции в диалоговом окне Template View Instructions для
настройки рисунков-прототипов:

· View Name � устанавливает имя вида рисунка, используемое в качестве обозначения
символа вида.

· View Orientation - создает Основной или Проекционный вид.

· Model "Saved View" Name � ориентирует вид в соответствии с именованным видом в
модели.

Опции Вида Значения Вида
X-Section � устанавливает поперечное сечение.
Поддерживаются только полные поперечные сечения.

X-Section Name

Arrow Placement View

Scale � введите значение масштаба или no scale. View Scale

Explode State � устанавливает покомпонентный вид. Explode Name

Simplified Rep � устанавливает упрощенное
представление вида. Если он не является упрощенным
представлением, по умолчанию создается мастер-
представление (master representation).

Simplified Rep Name

Process Step � устанавливает шаг обработки (process
step) для вида.

Step Number

Model Display � устанавливает тип отображения для
вида рисунка.

Wireframe, Hidden Line, No
Hidden, Default

Tan Edge Display � устанавливает отображение
касательных кромок.

Tan Solid, No Disp Tan, Tan
Ctrln, Tan Phantom, Tan
Dimmed, Tan Default

Snap Lines � устанавливает количество, промежуток и
смещение линий привязки.

Number, Incremental Spacing,
Initial Offset

Dimensions � устанавливает размеры в виде. Create Snap Lines, Incremental
Spacing, Initial Offset

Balloons � устанавливает выноски в рисунке.

· Place View � размещает вид после установки соответствующих опций и значений.

· Edit View Symbol - позволяет редактировать символ вида, используя диалоговое окно
Symbol Instance.

· Replace View Symbol - позволяет заменять символ вида, используя диалоговое окно
Symbol Instance.
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Сборочные Чертежи
В сборочном чертеже, можно отображать и стирать размеры деталей и сборок. Можно
также создавать размеры на отдельных компонентах непосредственно в виде сборки.
Однако, имейте в виду следующее:

· можно отображать параметры для элементов сборки и всех компонентов сборки в
примечаниях сборочного чертежа, но нельзя вводить параметры детали.

· размеры в сборочном чертеже доступны только в том случае, если сборка, для которой
был создан рисунок, находится в сессии.

Вызов Косметических Элементов
При подавлении деталей или подсборок в сборочном чертеже, система сохраняет
информацию по некоторым косметическим элементам в этих видах. При их вызове, также
вызываются следующие косметические элементы:

· размещение размера;

· размещение символа обработки поверхности;

· параметрический текст во вхождениях примечаний и символах;

· штриховка косметических элементов;

· ссылки на пересекающиеся кромки;

· косметические элементы осей деталей;

· отображаемая информация по компоненту, кромке и базе;

· чертежные допуски на размер, ссылающиеся на опорные элементы детали.
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Информация по Рисунку
При выборе Drawing из меню Info Pro/ENGINEER, можно вызывать информацию по
рисунку следующими путями.

· подсвечивая отображаемые объекты, используя фильтры.

· Выводя геометрическую и косметическую информацию относительно объекта.

· Записывая примечание в файл.

· Отображая значения угла и промежутка сетки.

· Получая информацию по устаревшему отображению в рисунке.

Вызов Информации по Рисунку
1. Выберите Info > Drawing.

2. Выполните следующее:

•  Выберите Highlight By Attributes для подсветки отображаемых в настоящий момент
объектов, используя следующие фильтры:

− тип объекта;

− местоположение (рисунок или трехмерная модель);

− слой;

− тип размера;

− связь вида;

•  Выберите Entity Info для вывода информации по геометрическим и косметическим
элементам выбранного объекта на экран или в указанный файл.

•  Выберите Write Note для записи примечания в файл.

•  Выберите Grid Info для отображения значений угла наклона и промежутка сетки.

•  Выберите Display Info для получения информации по устаревшему отображению в
рисунке, выводя его на экран или в указанный файл, и выполняя рекомендуемые
действия для обновления рисунка (типа перерисовки и регенерации).

•  Выберите View Info для получения информации по выбранному виду, затем выберите
вид. Информационное окно отображает информацию по названию вида,
родителю/потомку (если существует), типу вида, масштабу, названию модели, имени
упрощенного представления, информации представления рисунка, номеру листа и
отображению невидимых линий. Выберите File > Save для записи информации в файл
с именем viewinfo.inf, или выберите File > Save As для записи информации в указанный
файл.
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Форматы Рисунка

Стандартные Форматы
Можно использовать стандартные или эскизные форматы рисунка в любом количестве
рисунков и, затем, изменять или заменять их в любое время. Формат � пользовательская
компоновка для листа рисунка. Он содержит штамп, границы, таблицы и эмблему Вашей
компании. Для создания стандартных форматов, необходимо находится в режиме Формата
(Format) и иметь лицензию для Pro/DETAIL. Можно выбрать требуемый размер формата из
списка рисунков стандартных размеров, или создать новый размер, указывая значения
длины и ширины. Для создания эскизных форматов, необходимо использовать режим
Эскиза в базовом модуле Pro/ENGINEER. Так как их можно изменять параметрически,
можно создавать форматы нестандартного размера или семейства форматов.

Стандартные форматы состоят из текста примечания, символов, таблиц и эскизной
геометрии, включая поперечные сечения и заштрихованные области. Стандартный формат
создается или изменяется так, как если бы он был рисунком. При этом также используются
файлы установок рисунка. Если присутствует лицензия Pro/DETAIL, в режиме Формата
можно делать следующее:

· создавать эскизную геометрию и примечания.

· Перемещать, зеркально отображать, копировать, группировать, переносить и пересекать
геометрию.

· Использовать и изменять сетку рисунка.

· Определять пользовательские атрибуты.

· Создавать таблицы в рисунке.

· Использовать инструментальные средства для вывода на печать, создания файлов DXF,
DWG, SET, TIFF, CGM и IGES.

· Импортировать в формат файлы IGES, DXF и SET.

· Создавать пользовательские типы линии.

· Создавать, использовать и изменять символы.

· Включать в формат поперечные сечения рисунка.

Создание Стандартного Формата

1. В меню Pro/ENGINEER, выберите File > New.

2. В диалоговом окне New, нажмите Format и введите название формата в поле Name, или
примите заданное по умолчанию имя. Нажмите OK.

3. В диалоговом окне New Format укажите размер формата, выбирая Set Size и выполните
следующее:

· щелкните по Portrait в поле Orientation (высота больше ширины) и выберите
стандартный размер в списке Standard Size.

· Нажмите Landscape в поле Orientation (ширина больше высоты) и выберите
стандартный размер в списке Standard Size.
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· Нажмите Variable в поле Orientation, чтобы указать размер по ширине и по высоте.
Выберите Inches или Millimeters и введите значения в поля Width и Height.
4. Щелкните по ОК. Система отображает указанный формат и появляется меню FORMAT.

Создание Геометрии Формата

Для создания геометрии формата используются примитивы. Для создания эскизной
геометрии выберите Detail из меню FORMAT, Sketch из меню DETAIL и любую команду из
меню DRAFT GEOM.

Рамка Листа

Рамка листа � контур выбранного стандарта рисунка, как показано на следующем рисунке.
Поскольку она является фактической границей, она не может чертиться на перьевых
графопостроителях, если размер бумаги не будет превышать размер рисунка. Все,
находящееся в пределах внешней границы также выводится на печать, но необходимо
учитывать припуск на прижимные ролики графопостроителя.

Пример: Создание Стандартного Формата

Изменение Стандартного Формата

Для изменения значений символов текста, высоты символов и текста примечаний в
стандартном формате рисунка, используются те же команды, которые доступны в процессе
создания. Для изменения существующего формата, выберите Open... из меню File
Pro/ENGINEER, вызовите формат и выберите Modify из меню DETAIL. Не забудьте
сохранить формат командой Save в меню File перед выбором Done/Return в меню EDIT
FORMAT.
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Размещение Параметрических Примечаний в Формате

При размещении параметрического примечания в формате, формат приобретает
соответствующее значение при использовании его в рисунке. Например, при создании в
формате примечания "&model_name", система, отображает его как �model name (имя
модели)�

При использовании формата в рисунке, примечание отображает фактическое имя модели.
В системе, для обновления этих параметров при добавлении формата к рисунку, можно
включать в параметрические примечания только ярлычки рисунка, перечисленные в
Приложении B, Системные Параметры для Рисунков (кроме &todays_date). Следует
включать все параметры пользовательской модели и рисунка в ячейки таблицы формата в
форме "&param", используя Enter Text, чтобы система обновляла их в рисунке.

Режим Формата использует следующие типы параметрических примечаний:

· примечания с вхождениями символа;

· примечания со стандартными системными символами;

· примечания с ярлычками (labels) рисунка;

· примечания с заданным по умолчанию допуском.

Использование Таблиц в Стандартном Формате

Используя команду Table в меню FORMAT, в форматы рисунков можно включать таблицы.
При добавлении формата к рисунку, Pro/ENGINEER копирует все таблицы формата в
рисунок. После копирования, таблицы становятся независимыми от исходного формата. Их
можно перемещать, изменять или удалять.

При Добавлении/Замене (Add/Replace) формата или Удалении (Remove) его, система
подсвечивает таблицу, скопированную из старого формата и запрашивает, можно ли
удалить таблицу. Можно выбирать один из следующих вариантов: (Y) да, (N) нет, (K)
сохранить все, (R) удалить все. При добавлении таблицы к формату, система не обновляет
рисунки, которые ссылаются на этот формат, чтобы показать новую таблицу. Таблица
должна быть частью формата при первом копировании его в рисунок. Поэтому, чтобы
использовать измененный формат в рисунке, необходимо выбрать Sheets из меню
DRAWING, Format из меню SHEETS и Add/Replace.

Использование Таблиц в Стандартном Формате

При добавлении к рисунку формата, который содержит таблицу формата, система
сохраняет значения, определенные в таблице, как параметры рисунка, если опция файла
конфигурации "make_parameters_from_fmt_tables� установлена в «yes». Можно вызывать
параметры, используя команду Parameters в меню ADV DWG OPTS. Если эта опция
установлена в «no», при добавлении формата к рисунку система запросит ввести все
значения снова, и не пересчитает значения на следующих листах рисунка в таблице
формата. Эти значения будут считаться непараметрическим текстом. Для системы,
повторно запрашивающей относительно параметров текста, необходимо выбрать Sheets
из меню DRAWING, Format из меню SHEETS и Add/Replace.

Обратите внимание: нельзя использовать зарезервированные параметры модели. Если
опция файла конфигурации "make_parameters_from_fmt_tables� установлена в «yes»,
Pro/ENGINEER не запрашивает ввести значение зарезервированных параметров модели,
потому что не может добавить их к рисунку.

При изменении размера формата рисунка с таблицей, система масштабирует таблицу
(подобно масштабированию любого вида и примитива) для сохранения его
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местоположения относительно других элементов и границ листа. Так как опция
"drawing_text_height� файла настройки рисунка управляет высотой любого текста в
таблице, Pro/ENGINEER не масштабирует текст, включенный в таблицу. Поэтому, он не
сохраняет размер, пропорциональный для остальной части таблицы. Высоту текста
необходимо изменять вручную.

Пример: Таблица, Включенная в Стандартный Формат Рисунка

Использование Параметров в Качестве Ярлычков в Таблице
Формата

Можно включать параметрические ярлычки, типа названия рисунка, названия модели и
номера листа, как текст в таблице формата. Для рисунка с несколькими моделями можно
ввести в таблице формата любые параметры, связанные с первой и со второй моделью.
Для включения параметрических ярлычков в таблицу, выберите Enter Text из меню TABLE;
затем, в процессе редактирования формата введите соответствующий ярлычок (типа
"&dwg_name"). Ярлычок появляется в таблице в том виде, в котором он был введен.

Правила Использования Параметрических Ярлычков в Формате
Таблицы

При включении параметров в качестве ярлычков в таблицах формата используются
следующие правила:

· Pro/ENGINEER только тогда правильно интерпретирует параметрические ярлычки,
включенные в таблицу формата, если рисунок создается первым, затем добавляется
модель и, затем, добавляется формат. Ярлычки не будут интерпретированы правильно,
если сначала создается рисунок, затем добавляется формат и только затем добавляется
модель.

· При добавлении формата к рисунку, содержащему более одной модели, параметрические
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примечания могут ссылаться только на активную модель рисунка.

· Для включения текста в таблицу в качестве блока заголовка, используйте команду Enter
Text в меню TABLE. При перемещении таблицы, система не сохраняет текст, который был
добавлен в виде примечания с таблицей.

При добавлении формата к рисунку, Pro/ENGINEER анализирует все поддерживаемые
параметрические символы и отображает правильные значения в таблице. Это делается
для каждого листа рисунка, в котором используется формат, чтобы название рисунка, имя
модели или любой другой используемый стандартный параметр, отображался на каждом
лист, где используется этот формат.

Присвоение Формату Тех же Параметрических Значений, Что и
Для Рисунка

Каждый создаваемый формат рисунка имеет свой собственный файл установок, который
является полностью независимым от файла установок рисунка.

Опция "format_setup_file� файла конфигурации назначает указанный файл установок для
каждого создаваемого формата, но не делает этого для рисунков. Эти два файла
установок необходимо редактировать отдельно, чтобы иметь одни и те же значения. Для
присвоения формату тех же значений параметров, что и для рисунка, к которому он
добавляется, вызовите файл установок этого рисунка в формат, используя команду Set
Up в меню FORMAT; система будет считывать только те опции файла установок формата,
которые используют форматы.

Ограничения Файла Установок Формата

Файл установок формата имеет ограничения. Можно использовать только следующие
опции:

· drawing_units (эту опцию нельзя изменять)

· drawing_text_height

· draw_arrow_style

· draw_arrow_length

· draw_dot_diameter

· draw_attach_sym_width

· draw_attach_sym_height

· leader_elbow_length

· default_font

· aux_font

· text_width_factor

· line_style_standard

· node_radius

· yes_no_parameter_display

· sym_flip_rotated_text
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Повторное Использование Формата в Системе Наследования

Для повторного использования существующего формата (то есть того, который был создан
в другой системе), используйте опции интерфейса (типа DXF, SET, IGES, TIFF и т.д.) для
импорта его в требуемый формат.

Сохранение Стандартного Формата

Перед использованием стандартного формата в рисунке, необходимо его сохранить. Для
сохранения формата, выберите Save из меню File Pro/ENGINEER; затем введите название
формата.

Создание Форматов
Для создания эскиза формата, необходимо находится в режиме Эскиза. При создании
формата, Pro/ENGINEER присваивает ему имя "filename.sec". При первом добавлении
формата к рисунку, создается его копия в памяти и этому файлу присваивается
расширение ".frm".

Когда Pro/ENGINEER создает "filename.frm", этот файл разрывает все ассоциативные связи
с той частью, где он был создан; поэтому, "filename.frm" не отражает изменения,
производимые в "filename.sec" и наоборот.

При добавлении эскизного формата к рисунку, система совмещает левый нижний угол
(начало координат) формата с левым нижним углом (начало координат) рисунка и, затем,
выравнивает по центру все элементы в новом листе рисунка в соответствии с их позициям
на исходном листе. Если требуется, при этом корректируется масштаб рисунка для
сохранения относительных расстояний между элементами.

Обратите внимание: чтобы копировать файл, необходимо сохранить файл "filename.frm"
выбирая Save As из меню File Pro/ENGINEER и вводя название формата.

Создание Эскиза Формата

1. В меню Pro/ENGINEER, выберите File > New > Sketch.

2. Введите название эскиза, используемого для формата.

3. Создайте границы, блок заголовка и т.д., и образмерьте их.

4. Когда Pro/ENGINEER успешно регенерирует эту часть, сохраните ее, используя команды
меню File. Нельзя сохранять текст в эскизном формате.

5. Создайте рисунок и сделайте одно из следующего:

•  Выберите Retrieve Format в диалоговом окне Create Format и введите имя эскиза в
поле Format.

•  После создания рисунка выберите Sheets > Format > Add/Replace. Выберите имя
эскиза (установите фильтр "type" в значение "sketcher").

Замена Существующего Формата Измененным Форматом

Для замены существующей версии формата на измененный, сделайте следующее:

· переименуйте эскиз измененного формата так, чтобы имя отличалось от текущего
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формата и используйте команду Add/Replace для замены измененного эскиза в рисунке.

· Используйте команду Remove, чтобы удалить существующий формат и переименовать
его файл ".frm". Добавьте измененный эскиз к рисунку.

Обратите внимание: необходимо переименовать один из форматов; иначе, при попытке
заменить текущий формат, он просто заменит себя тем же "filename.frm".

Изменение и Замена Эскиза Формата в Режиме Эскиза

1. Вызовите эскиз формата в режиме Эскиза. Pro/ENGINEER не может вызвать
"filename.frm" в режим эскиза, так как должен существовать "filename.sec".

2. Измените эскиз. Можно повторно создать эскиз или повторно образмерить по новой
системе отсчета, но нельзя добавлять примечания, символы или примитивы.

3. Сохраните эскиз формата.

Действительные Расширения Формата

Используя режим Эскиза, можно вызывать и изменять эскиз формата. При замене
форматов, Pro/ENGINEER ищет сначала формат с расширением ".frm", и не принимает
".sec" как достоверное расширение для названий формата.

Действие Размера Формата

Pro/ENGINEER автоматически назначает требуемый размер бумаги эскизу формата.
Например, если формат - 7 x 10 дюймов, он автоматически размещается на листе размера
A. Это происходит, даже если рисунок был первоначально создан с другим размером. Если
к рисунку добавляется формат другого размера, рисунок принимает размер формата. При
этом соответственно масштабируются все виды и примитивы.
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Пример: Эскиз Формата

Использование Форматов в Рисунке
Pro/ENGINEER сохраняет форматы рисунка в отдельном файле. При изменении формата,
автоматически обновляются все рисунки, которые его используют. При вызове рисунка,
если используемый формат не может быть найден, в области сообщений отображается
сообщение об ошибке.

Для рисунка с несколькими листами, можно иметь два формата по умолчанию, один для
первого листа и второй для оставшихся листов.

Первый создаваемый лист принимает по умолчанию лист первого формата. Все
оставшиеся листы используют лист второго формата.

Можно изменять формат любого листа (включая первый лист) независимо от форматов на
других листах; поэтому, можно использовать различные форматы на каждом листе
рисунка. Для добавления или замены единственного формата на всех существующих
листах рисунка, необходимо добавить формат к каждому отдельному листу.
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Добавление или Замена Формата в Существующем Рисунке

1. Выберите SHEETS > Format > Add/Replace.

2. Введите название формата. Pro/ENGINEER сначала ищет файл с расширением ".frm".
Если это эскиз формата, используйте файл с расширением ".sec" при замене формата с
тем же самым именем.

Добавление Формата При Создании Рисунка

1. Нажмите File > New... > Drawing > OK.

2. В диалоговом окне New Drawing, нажмите Retrieve Format.
3. Выберите название формата, делая одно из следующего:

•  Выберите имя в списке Name в поле Format.

•  Введите [?] в списке Name и выберите название в диалоговом окне Open.

•  Щелкните по Browse... и выберите название в диалоговом окне Open.

4. Щелкните по ОК.

Удаление Формата из Рисунка

После добавления формата к рисунку, можно использовать Remove в меню DRAW
FORMAT для удаления формата из рисунка.

Скрытие или Отображение Формата в рисунке

После добавления формата к рисунку, можно использовать Blank или Unblank в меню
DRAW FORMAT для скрытия или отображения формата.

Отображение Списка Форматов

После добавления формата к рисунку, можно выбрать List в меню DRAW FORMAT для
отображения списка форматов, доступных в текущем каталоге.

Создание Прототипов Листа для Сборочных Чертежей Обработки

При работе с рисунком Pro/PROCESS for ASSEMBLIES или Pro/PROCESS for
COMPONENTS можно использовать команду Copy Process в меню SHEETS для создания
прототипа с текущего листа. При нажатии OK в диалоговом окне Process State, система
добавляет лист к рисунку, используя текущий лист в качестве прототипа. Новый лист
содержит копии видов и таблиц, которые были на листе прототипа, и они ссылаются на
шаг, который был подсвечен при нажатии OK. Виды сохраняют свою ориентацию.
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Правила Создания Прототипов Листа

При создании прототипов листа используются следующие правила:

· нельзя использовать лист в качестве прототипа, если он содержит виды более одной
модели.

· Команда Copy Process появляется в меню SHEETS только при работе со сборочным
рисунком процесса и имеется лицензия Pro/PROCESS for ASSEMBLIES или Pro/PROCESS
for COMPONENTS.

Библиотеки Форматов

Настройка Библиотеки Форматов

Для установки библиотеки форматов, используйте опцию "pro_format_dir" файла
конфигурации. Эта опция использует имя пути как его значение таким образом, что можно
создавать отдельный набор форматов, каждый из которых может использовать система, и
размещать их всех в отдельном каталоге. Используйте опцию файла конфигурации для
автоматического поиска каталога для форматов компании при добавлении или замене
форматов в рисунке и компоновке. Pro/ENGINEER размещает измененные форматы в этом
каталоге при их сохранении.

Вызов Формата из Библиотеки Форматов

Используя диалоговое окно File Open, можно вызвать форматы из каталога библиотек
форматов в Pro/ENGINEER. Для вызова формата, выберите Open из меню File
Pro/ENGINEER; затем выберите Format Dir из списка Look In в диалоговом окне File Open.
Перемещайтесь по дереву меню для поиска формата.
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Базовые Методики

Создание Рисунка
При создании рисунка, можно указать модель для автоматического размещения ее видов.

1. В меню Pro/ENGINEER, выберите File > New ....

2. В диалоговом окне New, щелкните по Drawing и введите имя рисунка в поле Name (или
используйте значение по умолчанию); затем нажмите OK.

3. В поле Name диалогового окна New Drawing, введите название модели, которая
находится в текущем каталоге, чтобы использовать ее по умолчанию. После указания
необязательной модели по умолчанию, система автоматически вызывает формат с
параметрическим окном вызова (например, &model_name"), так как рисунок ищет модель
для названий параметров. Можно также ввести [?] или нажать Browse... для выбора имени
в диалоговом окне Open. Имя по умолчанию � последняя вызванная модель.

4. Определите размер рисунка или вызовите формат.

•  Для определения размера, выберите Set Size и сделайте следующее:

•  Нажмите Portrait (высота больше ширины) в поле Orientation и выберите стандартный
размер в списке Standard Size.

•  Нажмите Landscape (ширина больше высоты) в поле Orientation и выберите
стандартный размер в списке Standard Size.

•  Нажмите Variable в поле Orientation, чтобы указать размер по ширине и по высоте.
Выберите Inches или Millimeters и введите значения в поля Width и Height.

•  Для вызова формата, выберите Retrieve Format и выберите имя в списке Name: в поле
Format. Можно также ввести [?] или нажать Browse ..., чтобы выбрать имя в
диалоговом окне Open.

5. Щелкните по ОК. Система отображает указанный рисунок и появляется меню DRAWING.

Добавление Формата к Рисунку

1. Выберите DRAWING > Sheets > Format > Add/Replace.

2. Введите название ранее созданного формата рисунка, находящегося в текущем
каталоге, или введите [?] для выбора из списка ранее созданных форматов. Для выбора из
списка имен, сделайте следующее:

•  Выберите Current Dir и выберите название доступного формата в этом каталоге.

•  Выберите Format Dir и выберите название каталога форматов.

•  Выберите название другого каталога для вызова форматов.

Система добавляет формат к рисунку таким образом, чтобы левый нижний угол формата,
совпадал с левым нижним углом листа рисунка.
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Импорт Форматов Рисунка

Можно также импортировать форматы рисунка посредством IGES, DXF, TIFF, CGM или
SET.

Следующие элементы можно добавлять к рисунку в любом порядке: форматы рисунка,
эскизную геометрию и виды модели.

Добавление Примитивов к Рисунку

После создания рисунка, к нему можно добавлять примитивы при наличии лицензии для
Pro/DETAIL или Pro/INTERFACE. При наличии лицензии для Pro/DETAIL, можно
импортировать и изменять двухмерные IGES файлы, DXF файлы, файлы CGM и файлы
SET. При наличии лицензии Pro/INTERFACE можно импортировать те же самые файлы, но
объекты нельзя изменять, если отсутствует лицензия Pro/DETAIL.

Добавление Первой Модели

1. Выберите DRAWING > Views.

2. Введите название модели. Можно ввести название или указать [?] для выбора из списка
имен объектов в текущем каталоге.

3. Добавьте первый вид, выбирая VIEWS > Add View; затем выберите описание вида из
меню VIEW TYPE.

Операции До и После Добавления Видов

Перед началом добавления видов, необходимо добавить к рисунку модель (если это еще
не сделано путем указания необязательной модели по умолчанию). При вызове модели,
которая имеет вхождение, необходимо определить, требуется ли вызывать вхождение или
базовую модель. Можно использовать единственную модель для создания любого числа
рисунков. При создании каждого нового рисунка, присваивайте рисунку уникальное имя.

После добавления первого вида, информация в нижней части основного окна изменяется в
соответствии с этим видом. Pro/ENGINEER устанавливает масштаб таким образом, чтобы
в рисунке могли поместиться несколько видов. Этот масштаб можно изменять в любое
время после добавления первого вида.

Вызов Рисунков

Используя диалоговое окно File Open, можно вызвать существующий рисунок, выбирая его
из списка рисунков в текущем каталоге. Список включает названия всех каталогов,
содержащихся в существующем каталоге и команды для перехода на следующий уровень
каталогов. При выборе Working directory кнопкой Drop Down в диалоговом окне File
Open, система отображает все рисунки в рабочем каталоге. При вызове рисунка -
вызывается модель (и) и регенерируется рисунок.

Копирование Чертежных Файлов с Переименованием Объектов

Используя опцию "rename_drawings_with_object" файла конфигурации, можно копировать
рисунок и деталь одновременно и, затем, переименовать рисунок. Если будет указано
значение �both� или �part� и, затем, выбрано Save As из меню File Pro/ENGINEER для
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детали, система также переименовывает чертежный файл, связанный с переименованной
деталью, который имеет то же самое название, что и деталь.

Пример: Копирование Чертежного Файла с Переименованием
Объекта

Виды Рисунка

Виды Рисунка

Первый вид, который Pro/ENGINEER добавляет к рисунку - общий вид. Изначально, он
отображается на листе с ориентацией по умолчанию, но его можно ориентировать,
используя диалоговое окно Orientation. Для каждого вида, необходимо определить
следующие свойства:

· тип вида или как он создается (типа ориентации, независимой от других видов,
проецирования от существующего вида);

· что отображается в виде;

· имеет ли вид поперечное сечение;

· масштабируется ли вид.

Следующая таблица объединяет действительные комбинации меню этих типов вида.
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Действительные Комбинации Меню Типов Видов

Projection
(проекци-
онный)

Auxiliary
(выносны
й)

General
(основ-
ной)

Detailed
(вынос-
ной эле-
мент)

Revolved
(поверну-
тый)

Graph
(диа-
грамма)

Full View
(полный вид) Х Х Х Х Х Х

Half View
(половинный
вид)

Х Х Х

Broken View
(вид с
разрывом)

Х Х

Partial View
(частичный
вид)

Х Х Х Х

Section
(сечение) Х Х Х Х

No Xsec Х Х Х
Of Surface
(по
поверхности)

Х Х Х

Scale
(вид с
масштабиров
анием)

Х Х Х

NoScale
(вид без
масштабиров
ания)

Х Х Х Х Х

Виды Рисунка
Используя команду Draft View в меню TOOLS, можно устанавливать текущий вид рисунка
таким образом, чтобы Pro/ENGINEER связывал все новые примитивы с этим видом. При
связывании примитивов с видом рисунка, они перемещаются с видом при его
перемещении, сохраняя свое местоположение относительно этого вида. Также, при
масштабировании вида или рисунка, система одинаково масштабирует все примитивы,
связанные с видом.

Система использует масштаб текущего вида при создании примитивов.

Если вид сделан текущим (используя DETAIL > Tools > Draft View > Set Current), система
использует масштаб текущего вида для примитивов, типа линий и окружностей, и
размеров, связанных с примитивами.

Масштаб текущего вида используется только, если текущий вид находится на текущем
листе рисунка.

Использование текущего вида рисунка иллюстрирует ассоциативность между эскизными
объектами и текущим видом рисунка. Можно связывать примечания без выносок, символов
и допусков на размер с видом рисунка дополнительно к эскизной геометрии. Однако,
нельзя связывать базовые элементы рисунка с видом рисунка.
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Создание Основного Вида

1. Выберите General в меню VIEW TYPE и примите команды по умолчанию Full View, No
Xsec и No Scale. Выберите Done.

1. Выберите в рисунке положение центра нового вида.

2. Сориентируйте вид, используя команды в диалоговом окне Orientation. Если требуется
вызвать ранее сохраненный вид модели в этой ориентации, выберите DRAW VIEW >
Names и выберите название вида.

3. Выберите Done/Return после определения ориентации.

При создании проекционного вида и перемещении основного вида, проекционный вид
перемещается вслед за основным видом в новое место.

Опция Конфигурации DISPLAY_IN_ADDING_VIEW

Опция "display_in_adding_view� файла конфигурации управляет отображением модели в
рисунке. Если эта опция установлена в �wireframe,� система добавляет каждый новый вид в
каркасном отображении и показывает опорные элменты. Если опция установлена в
"minimal_wireframe", каждый новый вид сначала отображается в каркасном отображении
без опорных элементов, осей или кромок силуэта. Можно также использовать отображение
вида по умолчанию для добавления видов с или без невидимых линий.

Пример: Создание и Ориентирование Основного Вида

Установка Вида Рисунка в Качестве Текущего Вида

1. Выберите DETAIL > Tools > Draft View > Set Current.
2. Выберите вид для установки в качестве текущего.

3. Выберите Add для добавления существующих примитивов к текущему виду рисунка. Для
связи объектов с видом, сначала необходимо добавить к виду эскизные объекты, а затем
их образмерить. Если объекты уже были связаны с другим видом, система удаляет их
(разрывает связь) из исходного вида, если они добавляются к новому виду.
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•  Для удаления примитивов, выберите Remove. При удалении, система разрывает связь
этих объектов с видом.

•  Обратить внимание: опции Add и Remove доступны только, когда установлен
текущий вид.

•  Для сброса текущего вида рисунка, сделайте текущим no view, используя Unset Cur.

Работа со Слоями

Слои в Режиме Рисунка

В Pro/ENGINEERа, слой - группа эскизных элементов (размеры, эскизы), а также
компоненты модели типа элементов и опорных плоскостей. Группировать элементы можно
по разным причинам (например, только в целях изготовления или для отдельной
проверки). Основная причина использования слоев для скрытия выносной геометрии (типа
опорных поверхностей и кривых), которые не должны отображаться в рисунке.

Хотя слои могут представлять различные объекты, они всегда имеют три общих свойства:
name (имя), display status (статус отображения) и contents (содержание). Состояние
отображения (отображаемый, скрытый или изолированный) контролирует отображение
элементов на слое. Слои могут включать другие элементы в базе данных Pro/ENGINEER
типа элементов, размеров, примечаний, геометрических допусков (gtols) и другие слои.
Элементы можно размещать на слоях используя два основных метода: копируя их со
слоев другого рисунка, детали или сборки или, выбирая их непосредственно из рисунка.

Управление Отображением Слоев в Отдельных Видах
Виды рисунка не имеют отдельных слоев для каждого вида; они используют слои рисунка.
Однако, Pro/ENGINEER может управлять состоянием отображения слоев рисунка отдельно
для каждого вида. Слои рисунка можно отображать независимо для отдельных видов или
делать отображение слоя, зависящим от рисунка.

Устанавливая отображение слоев рисунка независимо от моделей и индивидуально для
каждого вида, можно делать следующее:

· включать элементы деталей и сборок непосредственно в слое рисунка без включения их в
слое модели.

· Управлять отображением слоев рисунка для включения элементов модели без отметки
модели, как измененной.

· Изменять отображение отдельной модели в различных видах рисунка.

При определении независимого отображения вида, оно имеет приоритет для основного
рисунка для этого вида. При создании независимого вида, слой состояние основного
рисунка по умолчанию. При создании выносных элементов вида, по умолчанию слой
отображает все, что принадлежит родительскому виду. Можно изменять отображение
независимо для любого вида или отображать содержимое рисунка. Можно копировать
статус отображения рисунка или вида в любой другой вид или рисунок и, затем, изменять
отображение отдельно для каждого из них.
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Добавление Элементов к Слою Рисунка

Используя команду Add в меню Item диалогового окна Layers, можно добавлять элемент
на слой.

1. Выберите Layers из меню View Pro/ENGINEER. Открывается диалоговое окно Layers.

2. Выберите один или более слоев в Дереве Слоев.

3. Выберите Item > Add (или нажмите ярлычок в инструментальной панели или
используйте RMB). Появляется запрос CONFIRMATION, добавить ли указанный уровень к
активному рисунку.

4. Нажмите Yes; появляется меню LAYER OBJ со списком возможных типов элементов.

5. Выберите один или более типов элемента и укажите выбор элемента, используя меню,
которые появляются для каждого типа элемента.

6. Выберите требуемые элементы для помещения на выбранные слои:

•  Если рисунок Независимый (Independent), можно выбирать элементы модели для
помещения на слой рисунка. Выберите элементы в графическом окне, в Дереве
Модели или, перемещаясь по меню.

•  Если рисунок Зависимый (Dependent), на слой рисунка можно помещать только
элементы рисунка. Выберите элементы в графическом окне или, перемещаясь по
меню.

Изменение Отображения Слоев в Виде Рисунка

1. Выберите Layers в меню View Pro/ENGINEER. Открывается диалоговое окно Layers.

2. В диалоговом окне Layers, выберите Drawing View в списке Active Object. Система
подсвечивает границы вида.

· отображение слоя, границы которого имеют голубой цвет, зависит от отображения слоя в
рисунке.

· отображение слоя, границы которого имеют зеленый цвет, не зависит от отображения
слоя в рисунке.

3. Щелкните по виду для его выбора и управления отображением его слоя. При выборе
вида, отображение его слоев становится независимым от рисунка, и система обновляет
окно Active Object с именем выбранного вида.

4. Используйте диалоговое окно для изменения отображения различных слоев в виде
рисунка. По завершении работы с видом, выберите другой объект в списке Active Object
для управления отображением слоя.

Совет: Изменение Слоев Рисунка не Влияет на Модель

Изменение отображения слоя в рисунке не помечает никакие детали или сборки как
измененные. Поэтому, нет необходимости сохранять детали и сборки и повторно
передавать их в Pro/PDM при переключении и сохранении слоев. Также, рисунок выглядит
так, как он был вызван; независимо от возможных изменений, проведенных в слоях
модели. Поскольку одно из преимуществ установки "ignore_model_layer_status" состоит в
том, что в модели или слоях модели не будут сделаны изменения, не следует добавлять
элементы или удалять их из слоев модели. Однако, можно управлять элементами
непосредственно на слоях рисунка.
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Игнорирование Статуса Слоя в Рисунке Модели

Используя диалоговое окно Layer Status Control, можно управлять отображением слоев
модели в рисунке без необходимости проводить какие либо изменения в детали или
сборке, в которой этот элемент был создан.

Можно заставить рисунок полностью игнорировать состояние слоя в его модели при
определении, следует ли отображать элемент на слое. Система отображает все элементы
на слоях модели в рисунке, и можно управлять ими отдельно на уровне рисунка. Можно
скрывать или отображать слои на уровне рисунка без проведения изменения в детали или
сборке, в которой элемент был создан, и модель не будет изменена. Для установки
рисунка таким образом, чтобы он игнорировал статус слоя своей модели, сделайте
следующее:

· выберите Preferences в меню Status диалогового окна Layers и выберите первый
флажок (Ignore display status of layers in the model) в диалоговом окне Layer Status
Control.
· Установите опцию "ignore_model_layer_status� файла установок рисунка в «yes» (значение
по умолчанию). Если эта опция будет установлена в "no", статус слоя рисунка будет
отображать статус модели.

Невидимые Элементы Рисунка Модели

Если элемент в детали или сборке не имеет установки отображения в рисунке, по
умолчанию он отображается. По умолчанию, элементы в рисунке модели будут
отображаться пока не будет выполнено одно из следующих условий:

· элемент включен непосредственно в слой рисунка;

· элемент находится на слое детали или сборки с тем же именем, что и слой рисунка, а
опция файла установок рисунка "draw_layer_overrides_model" установлена в «yes».

· элемент находится на слое детали или сборки, который был включен в слой рисунка.

Для этих трех случаев, система определяет отображение элемента на основании
информации состояния слоя рисунка.

Управление Слоями Модели с Одинаковыми Именами Рисунка

Можно установить, чтобы слои рисунка модели повторяли отображение слоев рисунка с
теми же именами. Например, если слой рисунка с опорными элементами скрыт, система
также скрывает все элементы на слоях опорных элементов всех компонентов модели
рисунка. Если модель является сборкой, и добавляется другой компонент со слоем с таким
же названием, отображение любых элементов на слое модели с именем опорных
элементов автоматически становится подобным слою рисунка. Чтобы компоненты слоя
опорных элементов не изменялись, разместите требуемый слой непосредственно на
другом слое рисунка. Для установки отображения, сделайте следующее:

· выберите Preferences в меню Status диалогового окна Layers и выберите второй флажок
(Change display of model layers with the same names in drawing only) в диалоговом окне
Layer Status Control.
· Установите опцию "draw_layer_overrides_model� файла установок рисунка в «yes». Если
эта опция установлена в none (значение по умолчанию), система игнорирует слои, не
принадлежащие рисунку при установке статуса отображения слоев в модели рисунка с тем
же именем.
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Пример: Управление Статусом Слоя

Следующий пример содержит рисунок сборки с именем "Plate_Bolt", состоящий из двух
деталей, "Plate" и "Bolt". Все три модели "Plate_Bolt", "Plate" и "Bolt" содержат слой с
именем "DATUMS". Слои детали содержат опорные плоскости. Рисунок также имеет слой с
именем "DATUMS", который содержит некоторые объекты рисунка.

При отображении слоя "DATUMS", система показывает все объекты, находящиеся на слое
с именем "DATUMS". В этом случае, рисунок, сборка и обе детали появляется под именем
"DATUMS". При скрытии слоя "DATUMS" любой из двух деталей, система скрывает
опорные плоскости только для одной из этих двух деталей в рисунке. Если в рисунке
скрывается слой сборки, система скрывает слои детали автоматически.

В этом примере, так как в диалоговом окне Layer Status Control был выбран первый
флажок (Ignore display status of layers in the model), при изменении статуса отображения
слоя в рисунке, система не изменяет состояние отображения слоя непосредственно в
модели. Поэтому, при вызове модели, слой не скрывается. Однако, если будет выбран
второй флажок (Change display of model layers with the same names in drawing only), и
скрыт слой рисунка "DATUMS", система скрывает отображение всех слоев модели с
именем "DATUMS" только в рисунке. Система скрывает опорные элементы детали в
рисунке, но не делает этого в деталях или сборках при их вызове.

Использование Диалогового Окна Layer Status Control

При использовании диалогового окна Layer Status Control для управления статусом
отображения слоя, учитывайте следующее:

· если первый флажок (Ignore display status of layers in the model) не выбран, то второй
флажок (Change display of model layers with the same names in drawing only) будет
недоступен. Затем можно увидеть изменения на слоях модели в рисунке модели.

· если ни один из переключателей не выбран и если скрывается какой либо из слоев
детали в рисунке, система скрывает элементы в рисунке и в детали при вызове детали.
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Создание Зависимости Отображения Слоя в Виде Рисунка от
Отображения Слоя

1. Выберите Layers в меню View Pro/ENGINEER. Открывается диалоговое окно Layers.

2. В диалоговом окне Layers, выберите Drawing View в списке Active Object; затем
выберите вид рисунка с независимым отображением слоя. Если активный объект
находится на независимом виде рисунка, ярлычок инструментальной панели Make
Dependent становится доступным.

3. Измените вид рисунка на зависимый, используя один из следующих методов:

•  нажмите ярлычок инструментальной панели Make Dependent.

•  Выберите Status > Preferences, и в диалоговом окне Layer Status Control снимите
галочку с первой опции Ignore display status of layers in the model..

4. Когда система запросит, действительно ли требуется сделать статус слоя вида рисунка
зависимым от статуса слоя рисунка, нажмите Yes. Система обновляет рисунок и Active
Object возвращается в состояние The Drawing.

Перенос Элементов из Одного Слоя на Другой

Используя команду Switch в меню Item диалогового окна Layers, можно перемещать
элементы из одного слоя на другой в активном рисунке. Команда Switch доступна, когда в
Дереве Слоев ничего не выбрано или когда в Дереве Слоев выбрано не менее одного слоя
элемента.

1. Выберите Layers из меню View Pro/ENGINEER. Открывается диалоговое окно Layers.

2. Выберите один или более элементов слоя в Дереве Слоев.

3. Выберите Item > Switch (или используйте RMB). Открывается диалоговое окно Select
Layers, перечисляющее доступные слои в активном рисунке. Исходный слой (слой,
который содержит перемещаемый элемент) подсвечивается.

4. Укажите слои для переноса элемента (ов). Доступны только слои родительского объекта
элемента. Можно оставить элемент на его исходном слое и добавить его к нескольким
другим слоям.

•  Для удаления элемента со слоя, в котором он уже присутствует, сотрите имя слоя.

•  Для добавления элемента к слою, в котором его нет, выберите имя слоя.

Если элемент не скрыт, он подсвечивается зеленым цветом.

Если элемент является элементом скрытой геометрии (типа отверстия или скругления),
или скрытого компонента, геометрия остается видимой на экран, но подсвечивается
красным цветом. Система сообщает в области сообщения, что элемент является скрытым.

Если элемент скрыт и не видим на модели (типа опорного элемента или оси), элемент не
подсвечивается на модели.

Примечания:
· можно выбирать элементы, которые отображаются или скрыты. Однако, нельзя выбирать
подавленные элементы.

· Если элементы на модели видимы (вне зависимости � скрыты они или нет), они
подсвечиваются красным после того, как будут выбраны.

· При выборе скрытого компонента сборки, компонент отображается в сборке красным
цветом.
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· Если элементы типа опорных элементов и осей - скрыты, они не видны в модели и не
подсвечиваются.

Если элементы не скрыты, система подсвечивает первый выбранный элемент модели
зеленым цветом и отображает номер и тип элемента в области сообщения, например,
feature 6 (ROUND). Появляется меню LAYER SEL со списком слоев активной модели. Слои,
в которых элемент уже присутствует, подсвечиваются.

5. Выберите Done Sel. Система удаляет элемент (если он присутствовал ранее) со всех
слоев, которые не были выбраны, и добавляет его (если еще не присутствует) ко всем
выбранным слоям.

6. Повторите операцию для каждого дополнительно выбранного элемента.

7. По завершении, выберите Done/Return.

Совет: Добавление Элементов

В случае нескольких элементов, можно группировать их на слое и, затем, копировать этот
слой как элемент на другие слои.

Копирование Элементов с Одного Слоя на Другой

Используя команду Copy в меню Item диалогового окна Layers, можно копировать
элементы с одного слоя на другой.

1. Выберите Layers в меню View Pro/ENGINEER. Открывается диалоговое окно Layers.

2. Выберите один или более элементов слоя в Дереве Слоев.

Можно копировать весь слой, выбирая его в качестве копируемого элемента.

3. Выберите Item > Copy (или используйте RMB). Элемент (ы) копируются в буфер обмена.

4. Выберите один или более существующих слоев в Дереве Слоев, или выберите New
Layer для создания нового слоя.

5. Для всех подсвеченных слоев назначения, выберите Item > Paste (или используйте
RMB). Элемент (ы) размещаются на слоях.

Обратите внимание: копирование элементов из одного слоя на другой � единовременная
операция. При добавлении другого элемента к исходному слою, система не добавляет
элемент на слой назначения.

Сохранение Слоя Модели на Диск

1. Выберите Layers в меню View Pro/ENGINEER. Открывается диалоговое окно Layers.

2. В модели выберите File > Save Status File. Система сохраняет в файл слои активной
модели и их текущее состояние.

Эти слои и их статус отображения можно использовать для других объектов, или вызывать
их позже.

Примечания:
При вводе названия layer_file в ответ на запрос, файл получает имя layer_file.pro.

Система не сохраняет изменения отображения при сохранении модели, если не будет
нажато Save Status до выхода из диалогового окна Layers.
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Замена Модели
Диалоговое окно Select Instance доступно при замене модели одного вхождения таблицы
семейства на другое. Это диалоговое окно отображает все доступные вхождения и
позволяет заменять модель текущего рисунка другой моделью того же семейства, без
необходимости запоминать и вводить имя заменяемого вхождения.

Если модель, которая используется в рисунке � принадлежит семейству деталей или
сборок, эту модель можно заменять другим компонентом семейства. Система сохраняет
размеры, присоединенные примечания и другие аннотации рисунка при замене одной
модели на другую.

Используйте диалоговое окно Select Instance, чтобы выбрать вхождение для замены
модели.

1. Выберите VIEWS > Dwg Models > Replace.

2. � (пропущено в оригинале примечание переводчика) Заменяется в качестве активной
модели. При замене модели одного вхождения таблицы семейства на другое открывается
диалоговое окно Select Instance.

3. Выберите название другого компонента семейства для замены.

4. Диалоговое окно Select Instance отображает список всех вхождений выбранной модели
таблицы семейства. Можно выбрать одно из них, чтобы использовать в качестве замены
модели. Можно выбрать вхождение по имени на странице By Name (по умолчанию), или
щелкнуть по ярлычку By Parameter, чтобы выбрать вхождение по параметру.

5. После выбора заменяющего вхождения, нажмите Open. Текущая модель будет
заменена выбранным вхождением.

Обратите внимание: при использовании автоматической замены, если система
отображает размеры в сборочном чертеже на компоненте, который заменен новым
вхождением, отображаются эквивалентные размеры. Однако, при ручной замене
компонента, размеры не сохраняются.

Если модель, используемая в рисунке, является компонентом семейства деталей или
сборок, эту модель можно заменять другим компонентом семейства. Система сохраняет
размеры, присоединенные примечания и другие аннотации рисунка при замене одной
модели другой.

Отображение Рисунка

Увеличение Области Рисунка

1. Выберите View > Pan/Zoom....
2. Укажите увеличиваемую область, очерчивая мышью прямоугольник. Система
отображает указанную область.

При зуммировании рисунка отображаемая область удваивается в масштабе. Для
уменьшения области рисунка, используйте Zoom Out в меню PAN-ZOOM. Используйте
команду Reset для размещения в пределах экрана всей модели, сохраняя текущую
ориентацию вида. При панорамировании рисунка, можно выбирать новый центр экрана.
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Панорамирование к Центру Экрана

1. Выберите PAN-ZOOM > Pan.

2. Выберите местоположение на экране, которое станет новым центром экрана.

Pro/ENGINEER сдвигает отображение рисунка таким образом, чтобы выбранная точка
стала центром отображения на экране.

В режиме Рисунка, можно сохранять, вызывать и удалять установки панорамирования-
зуммирования видов рисунка. Для сохранения вида, выберите Saved Views... в меню View,
затем Save. Для вызова сохраненного отображения, выберите его название в диалоговом
окне Saved Views; для удаления вида, нажмите Delete.

Отображение Нескольких Окон

Выбирая New из меню Windows Pro/ENGINEER, можно отображать несколько листов
рисунка в различных окнах (или один лист в нескольких окнах), и можно выбирать любой из
них.

Изменение Отображения Выбранных Видов

Для изменения отображения выбранных видов, компонентов сборки или, даже, отдельных
кромок, используйте команду Disp Mode в меню VIEWS. Обратите внимание, что
изменения, сделанные этой командой в режиме визуального отображения, имеют
преимущество над глобальными параметрами настройки в диалоговом окне Environment.
Обратите внимание: При установке режима визуального отображения видов и кромок в
Hidden Line, они отображаются на экране шрифтом phantom, но выводятся на печать в
виде пунктирных линий.

Можно назначать цвет сегментам опорной кривой, выбирая Model Display... из меню View
Pro/ENGINEER и With Datum Curves на страничке Shade диалогового окна Model Display.

Отображение Вида

По умолчанию, вид рисунка отображается как определено в диалоговом окне Environment.
В ходе сессии Pro/ENGINEER, можно изменять заданное по умолчанию отображение.
Однако, при этом изменяется отображение всех видов в рисунке.

Пример: Установка Режима Отображения

Добавьте вид при включенной опции Wireframe. Затем, можно установить отдельные
кромки или выбранные виды на выбранное отображение, используя команду Disp Mode.
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Выносные Элементы
При наличии лицензии Pro/DETAIL, можно создавать на виде эскизные размеры. В режиме
Рисунка, можно также отображать размеры модели в рисунке.

Добавление Примечаний, Символов и Геометрических Допусков
В рисунок можно включать примечания, символы и допуски на размер.

Управление Выносными Элементами
Используя команды в меню DETAIL, можно управлять размерами, примечаниями,
допусками на размер, символами обработки поверхности, стрелками поперечных сечений,
установками баз и размером текста следующими способами:

· перемещать их (в пределах вида или между видами);

· присоединять выноски к другому объекту;

· добавлять дополнительные выноски;

· переносить;

· удалять (стирать) с экрана;
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· отображать;

· удалять;

· изменять значения;

· связывать с видом;

· связывать с текстом размера.

Создание Эскизного Размера

1. Выберите DETAIL > Create > Dimension.

2. Выберите на виде два объекта или кромки.

3. Разместить размер, используя среднюю кнопку мыши.

Перемещение Размера Эскизного Элемента

Используя опцию Mod Attach в меню DETAIL, можно перемещать размеры эскизных
элементов (например, созданных в модели отливки) тем же способом, которым
перемещаются радиусные размеры элемента скругления и размеры фаски и отображать
их в новом положении.

Отображение Размера Модели в Рисунке

1. Выберите DETAIL > Show/Erase.

2. В диалоговом окне Show/Erase, нажмите Dimension в окне Type.

3. Для указания ординатного размера, нажмите Options, и выберите Switch to Ordinate.

4. Нажмите Pick Bases и выберите базовую линию.

5. Выберите Feature, Feat & View или View. Для отображения всех размеров текущей
модели, нажмите Show All.
6. Для предварительного просмотра выполняемых изменений, нажмите Preview и укажите
отображаемые элементы.

Перемещение Выносных Элементов

Можно перемещать текст размера, примечания, допуски на размер, символы вхождений,
символы обработки поверхности, стрелки поперечного сечения, базы и текст размера. Для
перемещения элемента, используйте один из следующих методов:

· выберите одну из команд Move в меню DETAIL и выберите текст, связанный с элементом
(для стрелки поперечного сечения, щелкните непосредственно по стрелке). Используйте
левую кнопку мыши для указания нового положения.

· Нажмите кнопку Move Many в меню Pro/ENGINEER (или выберите Move Many в меню
DETAIL) и выберите несколько элементов. Выберите Done Sel в меню GET SELECT и
разместите элементы в новом месте при помощи левой кнопки мыши. Для отсечения
выносных линий размеров за раз, выберите выносную каждого размера; система
совмещает выбранные конечные точки вместе.

· Используйте выпадающее меню.
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Совет: Использование Перемещения Текста

Система определяет вид перемещения на основании того, где был выбран элемент. Также
можно использовать команды Clip и Move Text для выполнения тех же операций.

Динамическое Перемещение Элемента

При динамическом перемещении элемента в рисунках, элемент становится серым
(обозначая первоначальное положение элемента). При перемещении, система
подсвечивает его красным цветом (весь текст отображается в виде рамок, позволяя
быстрое перемещение элементов). Используйте левую кнопку мыши, чтобы установить
элемент в новом положении; используйте среднюю кнопку мыши или команду меню для
возвращения элемента в исходное положение; и используйте правую кнопку мыши для
зеркального отображения стрелок размеров. Все операторы в круглых скобках после
каждого помеченного символа элемента поясняют, как можно выполнять эти действия,
используя меню выбора.

Используя динамическое перемещение можно выполнять следующие задачи:

· перемещать элемент в направлении выносной линии и линии выноски (выберите Move из
меню DETAIL и выберите элемент).

· Перемещать текст размеров, примечания, допуски на размер, примитивы, эскизные
группы, символы обработки поверхности, оси, ярлычки опорных элементов и позиции
спецификации материалов (BOM) (выберите Move из меню DETAIL).

· Перемещать текст размеров, примечания, допуски на размер, ярлычки опорных
элементов, символы обработки поверхности и оси (выберите Move из меню DETAIL и
выберите сторону текста, или используйте Move Text).
· Перемещать присоединенные размеры радиусов, фасок элементов; примечания; допуски
на размер; символы обработки поверхности; и позиции BOM (выберите Move из меню
DETAIL и выберите окончание стрелки выноски, или используйте Mod Attach).

· Выравнивать линейные и ординатные размеры (выберите Move или Align из меню
DETAIL).

· Наклонять отображение выносных линий линейных размеров (выберите Move из меню
DETAIL) и выберите окончание выносной линии, ближайшей к тексту.

· Обрезать выносные линии линейных размеров, опорные элементы и оси (выберите Move
из меню DETAIL и выберите выносную линию для отсечения или выберите Clip из меню
DETAIL). Размер не отображается в исходном положении в процессе перемещения.

· Изменять положение таблицы в пределах отдельного листа рисунка (выберите Move из
меню TABLE). Система стирает исходную таблицу и подсвечивает таблицу белым цветом.

Перемещение Элемента в Пределах Вида

1. Из меню DETAIL, выберите Move или Move Text.
2. Выберите перемещаемый элемент.

3. Укажите новое положение элемента, используя левую кнопку мыши. Для отмены
изменения и возвращения элемента, выберите среднюю кнопку мыши.
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Перемещение Элемента Между Видами

Можно перемещать элементы, присоединенные к модели с линиями выноски (или
присоединенные непосредственно к кромке) с одного вида на другой из той же модели.

1. Выберите DETAIL > Switch View (или нажмите пиктограмму Switch View в панели
Pro/ENGINEER).

2. Выберите перемещаемый элемент.

3. Выберите вид, в который требуется переместить элемент.

Пример: Перемещение Элементов Между Видами

Изменение Объектов с Присоединенной Выноской

1. Выберите DETAIL > Mod Attach.
2. Выберите изменяемое примечание, допуск на размер, символ или символ обработки
поверхности.

3. Выберите MOD OPTIONS > Change Ref.
4. Выберите перемещаемую выноску.

5. Выберите новый элемент в точке присоединения выноски. Используйте среднюю кнопку
мыши, чтобы установить выноску в ее новое положение.

Обратите внимание: при выборе MOD OPTIONS > Change Ref или DETAIL > Move, можно
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перемещать выноску с тем же примечанием или символом просто выбирая ее.

Добавление Новой Линии Выноски к Примечанию,
Геометрическому Допуску или Символу

1. Выберите DETAIL > Mod Attach.

2. Выберите элемент, к которому требуется добавить выноску.

3. Выберите MOD OPTIONS > Add Ref.
4. Выберите ссылочную точку на виде для выноски.

5. Выберите GET SELECT > Done Sel и ATTACH TYPE > Done.

6. Для добавления боле одной выноски, повторите шаги 3 и 4. Для удаления выноски,
выберите MOD OPTIONS > Remove.

Перемещение Зигзага

Используя команду Move, можно перемещать зигзаги (jogs), которые были добавлены к
размерам и тексту выносок. Выберите перемещаемый зигзаг и выберите новое положение,
используя левую кнопку мыши. Достигнув требуемого положения, нажмите левую кнопку
мыши для установки зигзага.

Перемещение Эскизных и Не Присоединенных Объектов

Для перемещения примитивов и аннотаций, не присоединенных к кромке, используйте
команду Translate в меню TOOLS. В отличие от команды Move, перемещать можно любое
количество элементов за раз; после перемещения система автоматически снимает с них
выделение.

1. Выберите DETAIL > Tools > Translate.

2. Выберите элементы рисунка для перемещения; затем выберите Done Sel.
3. Определите вектор перемещения, выбирая конечные точки левой кнопкой мыши.
Конечные точки соответствуют начальному и конечному местоположению ссылочной точки
на экране. Система переносит выбранные элементы на расстояние, равное длине вектора
в направлении вектора.

Пример: Перемещение Элементов

Стирание Элементов с Экрана

При стирании (erase) элементов, система удаляет их с экрана, но не удаляет из рисунка.
Их изображение можно восстановить в любое время.
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1. Выберите DETAIL > Show/Erase.

2. В диалоговом окне Show/Erase, нажмите Erase и сделайте выбор в поле Erase By:

•  Selected Items - стирает только указанные элементы.

•  Feature - стирает выносные элементы выбранного объекта.

•  Feat & View � стирает выносные элементы выбранного объекта, которые принадлежат
выбранному виду.

•  Part - стирает выносные элементы, связанные с деталью в выбранном месте сборки.

•  Part & View - стирает выносные элементы, связанные с деталью в виде.

•  View - стирает все выносные элементы в выбранном виде.

•  Erase All -стирает все выносные элементы в рисунке.

3. Выберите кнопку в поле Type, соответствующую элементам, которые необходимо
удалить из отображения.

Отображение Косметических Элементов
Pro/ENGINEER отображает косметические элементы (кроме косметических резьб) в видах
до тех пор, пока их эскизная плоскость не станет перпендикулярна экрану. Можно
управлять отображением резьб в рисунке, используя опцию файла установок рисунка
"hlr_for_threads". Если опция установлена в «yes», кромки резьбы соответствуют стандарту
ANSI или ISO при отображении невидимой линии (устанавливается опцией
"thread_standard"). Если опция будет установлена в "no" система отображает кромки
резьбы как поверхности, как если бы они находились в режиме Детали.

Можно отображать или стирать эскизные косметические элементы, элементы сварки и
косметические резьбы в виде рисунка без отображения или стирания опорных плоскостей.

Обратите внимание: стирание или отображение этих элементов в выносном виде всегда
соответствует родительскому; нельзя изменять его отдельно.

Элементы, Которые Можно Стирать

Используя диалоговое окно Show/Erase можно стирать следующие элементы:

- размеры;

- допуски на размер;

- примечания рисунка;

- примечания вида (имя выносного вида, масштаб вида, имя поперечного сечения, имя
вида элемента диаграммы);

- позиции;

- оси;

- символы;

- символы обработки поверхности;

- опорные элементы;

- косметические элементы.

Примечание: команда Show/Erase не доступна в меню DETAIL, если рисунок не имеет
модели.
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Отображение или Стирание Косметических Элементов.

Для отображения косметических элементов выберите Show/Erase в меню DETAIL, затем
щелкните по Show и Cosmetic Feature в диалоговом окне Show/Erase. Для стирания
щелкните по Erase и Cosmetic Feature. Можно стереть все косметические резьбы в окне
рисунка.

Примечание: щелкните по Note в поле Type диалогового окна Show/Erase, чтобы стереть
примечания массивов, примечаний, которые отображают количество компонентов массива
(например 2 HOLES)

Отображение Косметических Элементов

Pro/ENGINEER отображает косметические элементы (кроме косметических резьб) в видах
до тех пор, пока их эскизная плоскость не станет перпендикулярна экрану. Можно
управлять отображением резьб в рисунке, используя опцию файла установок рисунка
"hlr_for_threads". Если опция установлена в «yes», кромки резьбы соответствуют стандарту
ANSI или ISO при отображении невидимой линии (устанавливается опцией
"thread_standard"). Если опция будет установлена в "no" система отображает кромки
резьбы как поверхности, как если бы они находились в режиме Детали.

Можно отображать или стирать эскизные косметические элементы, элементы сварки и
косметические резьбы в виде рисунка без необходимости также отображать или стирать
опорные плоскости.

Обратите внимание: стирание или отображение этих элементов в выносном виде всегда
соответствует родительскому; нельзя изменять его отдельно.

Отображение Резьб в Видах Поперечных Сечений Сборки

Для отображения резьб в поперечных сечениях сборочных чертежей согласно стандарту
ISO или ANSI, используйте опцию файла установок рисунка "thread_standard" совместно с
"hlr_for_threads".

· для отображения резьб в соответствии со стандартом ANSI, установите опцию
"thread_standard" файла установок рисунка в "std_ansi_imp_assy".

· для отображения их в соответствии со стандартом ISO 6410, установите опцию в
"std_iso_imp_assy".

Условия, Заставляющие Болт Перекрывать Штриховку Отверстия

При отображении в соответствии со стандартом ISO, если диаметр болта равен диаметру
резьбового отверстия, и диаметр резьбы болта равен диаметру отверстия, болт
перекрывает штриховку отверстия, если выполняется одно из следующих условий:

· болт и отверстие соосны;

· обе оси находятся в поперечном сечении.

· поперечное сечение плоское и параллельно экрану (перпендикулярно направлению
обзора).

В случае смещения поперечного сечения, часть поперечного сечения, которая
пересекается парой болт/отверстие должна быть плоской и параллельной экрану.
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Отображение Элемента

1. Выберите DETAIL > Show/Erase.

2. В диалоговом окне Show/Erase, нажмите Show и выберите следующее в поле Show By:

•  Feature � детально показывает выбранный элемент.

•  Part � детально показывает элементы, связанные с деталью в выбранной точке сборки.

•  View � детально показывает все элементы в выбранном виде.

•  Feat & View � детально показывает выбранный элемент, принадлежащий выбранному
виду.

•  Part & View � детально показывает элементы, связанные с деталью в виде.

•  Show All � показывает все выносные элементы в рисунке.

3. В случае необходимости, нажмите Options и сделайте следующее:

•  Выберите Erased, чтобы показать только те элементы, которые были предварительно
стерты.

•  Выберите Never Shown, чтобы показать только те элементы, которые не были
предварительно стерты.

4. Чтобы просмотреть, как рисунок будет выглядеть после проведения изменений, нажмите
Preview и выберите With Preview.

Флажок With Preview выбирается по умолчанию при первом открытии диалогового окна
Show/Erase. Можно изменить установку и последняя установка останется значением по
умолчанию, пока не будет изменена снова. При отображении или стирании размера, With
Preview показывает изменения прежде, чем они будут завершены. Элементы временно
отображаются голубым цветом и можно указать стираемые элементы, щелкая по кнопке в
поле Show By.

Обратите внимание: функциональные возможности предварительного просмотра не
доступны при отображении косметических элементов.

Удаление Элемента

Используя команду Delete, можно удалять из рисунка ссылочные размеры, примечания и
допуски на размер, также как и снимать любые ссылочные базы. Для удаления нескольких
элементов за раз, можно использовать кнопку Delete Many в панели Pro/ENGINEER.

1. Выберите DETAIL > Delete.

2. Выберите удаляемый из рисунка элемент.

Обратите внимание: использование команды Delete для установленной базы или
базового размера отключает gtol, ссылающийся на этот элемент (но удаляет его).

После удаления элемента из рисунка, его нельзя повторно отобразить, используя команду
Show/Erase. Если удаляется примечание, которое содержит ранее отображаемый размер,
система продолжает отображать размер.

Элементы, Которые Можно Отображать После Стирания

Используя диалоговое окно Show/Erase, можно отобразить следующие элементы в
рисунке после их стирания:

· размеры;
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· допуски на размер;

· примечания рисунка;

· примечания вида (имя выносного вида, масштаб вида, имя поперечного сечения, имя
элемента вида диаграммы);

· позиции;

· оси;

· символы;

· символы обработки поверхности;

· опорные элементы;

· косметические элементы;

· примечания модели.

Обратите внимание: команда Show/Erase не доступна в меню DETAIL, если рисунок не
имеет модели.

Изменение Значения

Можно изменять числовые значения допусков на размер обработки поверхности и
размеров. Однако, при изменении значений размеров, необходимо регенерировать
рисунок прежде, чем система обновит деталь или ассоциативные эскизные размеры с
новым значением.

1. Выберите DETAIL > Modify > Value.

2. Выберите изменяемое значение.

3. Введите новое значение.

Связывание Выносных Элементов с Видом Рисунка

Используя команду Relate View в меню VIEWS, можно связывать выносные элементы
(типа примитивов, примечаний и символов без выносок) с видом.

1. Выберите VIEWS > Relate View > Add Items.

2. Выберите вид, с которым требуется связать выносные элементы.

3. Выберите связываемые выносные элементы; затем выберите Done Sel.

Разрыв Связи Выносных Элементов с Видом Рисунка

1. Выберите VIEWS > Relate View > Remove Items.

2. Выберите элементы, связь которых разрывается; затем выберите Done Sel.
После связывания элементов с видом, можно использовать меню Info Pro/ENGINEER для
идентификации объектов в любом виде или в указанном виде.

Идентификация Объектов, Связанных с Видом

1. Info > Drawing > Highlight by Attributes.

2. В диалоговом окне Highlight By Attributes, выберите 2D Sketched Entity в поле Item
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Type.

3. Сделайте следующее:

•  Выберите Any в поле Displayed in View для подсветки атрибутов в любом виде.

•  Выберите Selected и щелкните по Select View, чтобы выбрать указанный вид.

Система подсвечивает все отображаемые элементы, которые были связаны с видом или
указанными видами.

Связывание Существующего Примечания, Допуска на Размер или
Символа с Размером

После создания примечания, допуска на размер или символа, их можно связать
непосредственно с текстом размера таким образом, чтобы они перемещались с размером,
когда размер изменяет свое местоположение. Можно связывать эти элементы детализации
с размером при указании его положения.

1. Выберите Tools > Relate Dim > Add Items.

2. Выберите размер, с которым система должна связать элементы.

3. Выберите примечания, символы или эскизные gtols для связи с выбранным размером.

4. Для удаления их, выберите Remove Items из меню RELATE DIM.

Команда Relate View

При использовании этой команды, учитывайте следующее:

· нельзя связывать эскизные опорные элементы с видом модели.

· При создании примечания или символа, используя команду Free Point, их нельзя
связывать с видом. Система присоединяет стандартное примечание (с выноской) к виду
или эскизному объекту.

· Элементы рисунка, связанные с видом рисунка, ведут себя также, как и вид. При
выполнении действия с видом, типа перемещения, стирания или удаления, система
выполняет те же действия на связанных эскизных элементах.

Совет: Элементы, Связанные с Размером

При стирании, перерисовывании изображения или удалении размера, система также
стирает, перерисовывает или удаляет все элементы, связанные с ним.

Работа с Опорными Плоскостями Модели
Pro/ENGINEER отображает опорные плоскости в рисунке при следующих условиях:

· Временно, при ориентировании модели в процессе создания вида рисунка (это
единственный случай отображения опорной плоскости, которая не перпендикулярна
экрану).

· Когда опорный элемент является эскизным опорным элементом. При выборе Display
Datum Planes в диалоговом окне Environment и опорные плоскости перпендикулярны
экрану.
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· Когда опорная плоскость установлена в качестве ссылочного опорного элемента и она
перпендикулярна экрану.

Для управления установленными опорными элементами, используйте команды меню
DETAIL. Установленные опорные элементы отображаются независимо от установки в
диалоговом окне Environment, но их можно стирать в виде, выбирая Show/Erase в меню
DETAIL или скрывать их на слое.

Использование Выпадающего Меню
Используя всплывающее меню Pro/ENGINEER, можно изменять и управлять трехмерными
установленными опорными элементами следующими способами:

· перемещать в различное положение на листе рисунка;

· переопределять;

· стирать и восстанавливать;

Создание Элемента Опорной Плоскости

В режиме Рисунка, в модели можно создавать элементы опорной плоскости; однако,
нельзя создавать опорную плоскость в модели, если модель в рисунке только для чтения.

1. Выберите DETAIL > Create > Datum > 3D Datum.

2. В диалоговом окне Datum, введите название в поле Name. Если название не будет
указано, система назначит его по типу DTM#.

3. Щелкните по Define...
4. Сделайте следующее:

· Щелкните по On Surface... для размещения элемента опорной плоскости на плоской
поверхности модели.

· Привяжите опорный элемент, выбирая команды из меню DATUM PLANE; затем выберите
Done.

5. В случае создания установленного опорного элемента, нажмите Free или In Dim для
указания его положения.

Когда система наложит все зависимости на опорный элемент, считается, что он создан;
однако, опорный элемент будет отображаться только, если он перпендикулярен экрану и в
диалоговом окне Environment выбрано Display Datum Planes.

6. Для продолжения создания опорных элементов, нажмите New, введите другое имя в
поле Name и нажмите Define... или On Surface...

Переименование Опорного Элемента Модели

1. Выберите DETAIL > Modify > Datum/Axis.

2. Выберите опорный элемент на экране.

3. В диалоговом окне Datum, введите новое название в поле Name.

4. Нажмите OK для сохранения изменений и закройте диалоговое окно.

Изменение Отображения Установленных Опорных Плоскостей

Можно удлинять или обрезать установленные опорные плоскости, используя команды
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Move и Clip.

· команда Move перемещает любую сторону опорного элемента. После выбора
перемещаемого опорного элемента, щелкните в любом месте и текст опорного элемента
сместится в соответствующее положение. Название опорного элемента также сместится к
выбранной стороне опорного элемента.

· Команда Clip перемещает оконечную часть напротив названия опорного элемента. После
выбора перемещаемого опорного элемента, щелкните в любом месте и опорная плоскость
сместится в соответствующую точку. Название опорного элемента не смещается.

Отображение Опорных Плоскостей

Опорные плоскости, которые уже установлены в качестве ссылочных опорных элементов,
автоматически отображаются в тех видах, где опорные элементы перпендикулярны экрану
(по кромке). Если установленная опорная плоскость была стерта, ее можно отобразить,
выбирая Show/Erase в меню DETAIL. В диалоговом окне Show/Erase, щелкните по Show и
Datum Plane.

Стирание Установленного Опорного Элемента

1. Выберите DETAIL > Show/Erase.

2. В диалоговом окне Show/Erase, нажмите Erase.

3. Нажмите кнопку Datum Plane в поле Type; затем выберите кнопку в поле Erase By для
указания элемента, вида или детали.

Для вызова, нажмите Show, кнопку Datum Plane в поле Type и кнопку в поле Show By для
указания элемента, вида или детали.

Стирание Установленного Опорного Элемента из Компонента
Сборки

Если рисунок имеет несколько вхождений одной и той же детали в сборке, установленный
опорный элемент можно стирать в конкретном компоненте сборки с сохранением его
отображения в других вхождениях компонента.

Обратите внимание: можно стирать только установленные опорные плоскости (set datum
planes) в рисунке. Для удаления изображения любых других опорных плоскостей модели
(не эскизных опорных элементов), снимите галочку с Display Datum Planes в диалоговом
окне Environment.

Создание Эскизной Опорной Плоскости

1. Выберите DETAIL > Create > Datum > Draft Datum.

2. Нажмите левую кнопку мыши для создания опорной плоскости.

3. Создайте опорную плоскость в требуемом направлении. Укажите конечную точку,
щелкая по левой кнопке мыши.

4. Введите название опорной плоскости.

Обратите внимание: для перемещения или переориентирования эскизных опорных
элементов, выберите Move или Clip в меню DETAIL, или выберите Rotate или Translate в
меню TOOLS.
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Отображение Опорных Плоскостей

Pro/ENGINEER отображает опорные плоскости при помощи кромок, делая красные и
желтые стороны видимыми. Используя выпадающее меню, можно перемещать, удалять и
восстанавливать эскизные опорные элементы.

Управление Размером и Формой Опорных Точек

В режиме Рисунка, можно управлять размером опорных точек модели и создавать опорные
точки, указывая значение опции файла установок рисунка datum_point_size. Значение по
умолчанию - .3125.

Для отображения эскизной или опорной точки в виде крестика, точки, круга, треугольника
или квадрата, укажите значение опции "datum_point_shape� файла установок рисунка.

Опция Конфигурации datum_point_symbol

Эта опция файла установок рисунка управляет отображением точек только в режиме
Рисунка. Для изменения отображения символа опорного элемента в режиме Part или
Assembly, установите опцию "datum_point_symbol" файла конфигурации.

Оси Модели
Осями цилиндрических или конических поверхностей можно управлять независимо от
параметров настройки диалогового окна Environment. Однако, учитывайте следующее:

· система показывает ось в виде линии на виде сбоку и в виде перекрестья, когда ось
ориентирована нормально к экрану.

· В режиме Рисунка, если с опции Display Datum Axes в диалоговом окне Environment не
снята галочка, имена осей не появляются в рисунке.

· Оси в рисунке можно создавать при наличии лицензии Pro/DETAIL; однако, эти оси будут
принадлежать рисунку, а не модели.

· эскизная ось всегда отображается в виде осевой линии.

Использование Выпадающего Меню
Используя выпадающее меню Pro/ENGINEER, можно изменять и управлять
установленными и не установленными осями модели следующими способами:

· перемещать их в другое положение на листе рисунка;

· изменять их присоединение;

· переопределять их;

· стирать и восстанавливать их;

Создание Опорной Оси

Система отображает эскизные оси в стиле выноску с шрифтом centerline.

1. Выберите DETAIL > Create > Axis > 3D Axis.

2. В диалоговом окне Axis, введите название в поле Name.
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3. Щелкните по Define....
4. Наложите зависимости на опорную ось, выбирая команды из меню DATUM AXIS; затем
выберите Done.

5. Для продолжения создания опорных осей, нажмите New, введите другое название в
поле Name и нажмите Define....

Переименование Оси Опорного Элемента

1. Выберите DETAIL > Modify > Datum/Axis.

2. Выберите опорную ось на экране.

3. В диалоговом окне Axis, введите новое название в поле Name.

4. Нажмите OK, чтобы закрыть диалоговое окно и сохранить изменения.

Создание Установленной Опорной Оси

1. Выберите DETAIL > Modify > Datum/Axis.

2. Выберите опорную ось на экране.

3. В диалоговом окне Axis, нажмите -A- (set). Система заключает ось в рамку символа
предельных отклонений.

4. Нажмите OK, чтобы закрыть диалоговое окно и сохранить изменения.

Определение Размещения Установленной Опорной Оси

1. Нажмите In Dim и Pick Dim... в диалоговом окне Axis.

2. Выберите размер в модели. Система размещает установленную ось на экране под
размером.

3. Нажмите OK, чтобы закрыть диалоговое окно и сохранить изменения.

Обратите внимание: если опция "gtol_datums" файла установок рисунка установлена в
"STD_ASME" или "STD_ISO", установленную опорную ось можно размещать на
геометрическом допуске. Нажмите In Gtol и Pick Gtol...; затем выберите gtol в модели.

Совет: Команда Show/Erase

Команда Show/Erase в меню DETAIL отображает оси цилиндрических и конических
поверхностей в рисунке и стирает оси, которые система показывает в рисунке. Поскольку
оси принадлежат модели, подобно размерам, их нельзя удалять.

Обратите внимание: отображение или стирание оси в радиальном массиве влияет на
соответствующие оси во всех вхождениях массива.

Отображение Осей в Рисунке

1. Выберите DETAIL > Show/Erase.

2. В диалоговом окне Show/Erase, нажмите Show.

3. Нажмите Axis в поле Type; затем выберите кнопку в поле Show By для указания
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элемента, вида или детали. При выборе Feat & View,, выберите элемент, выберите Done
Sel, затем выберите вид для отображения оси.

Управление Отображением Осей

Устанавливая опцию "axis_interior_clipping" файла установок рисунка в «no», можно
устанавливать отображение оси согласно следующих трех требований стандарта ANSI
Y14.2M:

· линия начинается и заканчивается черточкой.

· перпендикулярные осевые линии пересекаются короткой черточкой;

· очень короткие осевые линии не разрываются;

Оси, которые установлены в "CTRLFONT" фактически отображаются как "CTRLFONT_S_L"
или "CTRLFONT_L_L", в зависимости от их ориентации. Ими можно управлять,
устанавливая "line_style_length" в "CTRLFONT_S_L" или "CTRLFONT_L_L", а не
"CTRLFONT". Для управления осями, которые перпендикулярны виду, установите
"line_style_length" в "CTRLFONT_S_L"; для управления осями, которые параллельны виду,
установите их в "CTRLFONT_L_L".

Эта опция воздействует на отображение осей следующим образом:

· оси, параллельные экрану отображаются в одну линию шрифтом centerline, начинаясь и
заканчиваясь с длинной черточки. Выберите Move в меню DETAIL для изменения любой
конечной точки.

· Оси, перпендикулярные экрану отображаются двумя линиями, каждая из которых состоит
из двух сегментов.

· Перпендикулярные линии пересекаются в короткой черточке.

· Можно управлять только конечными точками, используя команду Move (команда Clip не
доступна для перпендикулярных осей).

· Нельзя перемещать конечную точку перпендикулярной оси за пределы центра оси.

· Если какая либо ось слишком коротка, она отображается шрифтом solid line.

Используя опцию "radial_pattern_axis_circle" файла установок рисунка, можно
устанавливать режим визуального отображения для осей вращения, перпендикулярных
экрану в радиальных массивах элементов. При установке опции в «yes», ось кругового
массива отображается и линия оси проходит через центр массива (см. Приложение A,
Опции Файла Установок Рисунка для справок). Однако, это воздействует только на
массивы, которые были созданы с использованием команды Dim Pattern. При установке
этой опции файла установок рисунка в «yes» вводятся следующие ограничения:

· нельзя перемещать, отсекать или изменять тип линии общей оси кругового массива
(circular shared axis), которая отображается при выборе кнопки Show в диалоговом окне
Show/Erase.

· Нельзя использовать команду Mod Attach для осей или окружностей элементов массива.

· В обрезанном виде, система отображает только части линий и окружностей, которые
находятся внутри границы вида.

· Нельзя использовать радиальные массивы групповых элементов.

· Нельзя отображать осевые окружности оси радиальных массивов для ссылочных
массивов.
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Изменение Стиля Линии Модели или Эскизной Оси

1. Выберите LINE STYLES > Modify Lines.

2. Выберите имя оси или собственно ось (для осей элементов модели).

3. В диалоговом окне line style, выберите тип линии в списке Style.

4. Щелкните по Apply. Ось получает указанный тип линии. Для возвращения ее к старому
стилю, нажмите Reset и Apply
Обратите внимание: при установке опции "axis_interior_clipping" файла установок рисунка
в «no», можно продолжать изменять тип линии оси. Однако, при этом отключается
автоматическое выставление массива.

Изменение Длины Оси

Для изменения длины оси, используйте команды Move и Clip. Обе команды удлиняют или
уменьшают осевые линии. Команда Move перемещает выбранный конец линии. Команда
Clip перемещает часть оси в пределах окружности к или от начала координат. Также
можно использовать эту команду для эскизных осей, которые не перпендикулярны экрану.

Создание Разрыва в Осевой Линии Модели

1. Выберите DETAIL > Break > Add.

2. Используя левую кнопку мыши, выберите первую точку на осевой линии, где начнется
разрыв.

3. Выберите вторую точку для завершения разрыва. Система создает разрыв.

Удаление Части Оси, Перпендикулярной Экрану

1. Выберите DETAIL > Delete.

2. Выберите удаляемую осевую линию.

3. Для возобновления отображения всех частей оси, выберите DETAIL > Show/Erase;
затем нажмите Axis в поле Type диалогового окна Show/Erase. При выборе
перпендикулярной экрану оси, система стирает все линии этой оси.

Пример: Удаление Линий Оси

Создание Осевой Линии Симметрии

Используя команду Sym Line в меню AXIS ADD, можно создавать удлинение между
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крестиками осей, показывая, что оси симметричны относительно размера.

1. Выберите DETAIL > Create > Axis > Sym Line.

2. Выберите две оси, перпендикулярные плоскости экрана (отображаемые в виде
крестиков). Используйте Move для удлинения линии симметрии к любой стороне.

Пример: Осевые Линии Симметрии

Оси Вращения

Используя опцию Mod Attach, можно вращать оси модели, которые перпендикулярны
экрану. При вращении оси, она остается перпендикулярна экрану; однако, крестик
изменяет ориентацию согласно указаниям.
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Вращение Осей
Меню Rotate Axis содержит следующие опции:

· Through Geom � выбирает кромку, опорную точку или центр оси, перпендикулярной
экрану через которую проходит осевая линия, ближайшая к этой точке.

· Pick Point - выбирает точку на экране, через которую проходит осевая линия.

· Parallel - выбирает линейную кромку или опорную кривую, к которой осевая линия
параллельна.

· Horizontal - возвращает ось в ее стандартную ориентацию.

· Enter Angle � указывает угол вращения оси относительно оси X.

Создание Эскизной Оси

1. Выберите DETAIL > Create > Axis > Draft Add.

2. Нажмите левую кнопку мыши для создания оси.

3. Удлините ось в требуемом направлении. Укажите конечную точку, щелкая левой кнопкой
мыши.

4. Введите название оси. Система отображает ее красным цветом.

5. Для перемещения или изменения ее ориентации, выберите Move или Clip из меню
DETAIL, или выберите Rotate или Translate из меню TOOLS. Также можно использовать
выпадающее меню, как описано в следующем разделе.

Работа с Выпадающим Меню

Использование Выпадающего Меню

Используя выпадающее меню или меню EDIT ACTIONS, можно изменять любой объект в
рисунке в дереве меню.

При активном окне рисунка, можно в любой момент прерывать процесс и активизировать
объект рисунка для изменения. По завершении изменений, система возвращается к
первоначальному положению в дереве меню. Эти меню можно также вызывать, выбирая
Any Item в меню MODIFY DRAW.

Управление Линиями Привязки
Используя выпадающее меню Pro/ENGINEER, можно изменять и управлять линиями
привязки следующими способами:

· изменять интервал;

· изменять присоединение;

· удалять окончания линий привязки;

· перемещать окончания линий привязки.
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Изменение Элемента, Используя Выпадающее Меню

1. Используя правую кнопку мыши, выберите какой либо объект в окне рисунка.
Появляется выпадающее меню с доступной опцией Modify Item. Удерживая правую кнопку
мыши, выберите Modify Item; затем отпустите кнопку. Появляется меню GET SELECT с
подсвеченной по умолчанию опцией Pick. Также появляется меню START EDIT с
подсвеченной по умолчанию опцией Activate.

Обратите внимание: правую кнопку мыши необходимо держать нажатой примерно
полсекунды до появления выпадающего меню.

2. Выберите изменяемый элемент. Система подсвечивает этот элемент сиреневым
цветом, указывая, что этот объект изменяется. После выбора, START EDIT > Activate,
появляется меню EDIT ACTIONS, перечисляющее операции редактирования, допустимые
для этого конкретного объекта. Система подсвечивает по умолчанию Move/Activate.

3. При выборе Move/Activate, система отображает маленькие квадратики, называемые
метками (handles) для выделения частей, которые можно перемещать. Эти части
подсвечиваются красным цветом при наведении на них указателя мыши.

4. Сделайте следующее:

− графически выберите часть элемента при помощи левой кнопкой мыши и перетащите
ее в новое положение. Система подсвечивает выбираемые детали объекта красным
цветом в процессе его перетаскивания.

− Выберите другую команду из меню EDIT ACTIONS. Pro/ENGINEER вызывает
соответствующему интерфейсу для выполнения проводимых изменений.

Обратите внимание: в любой момент в течении этого процесса, можно использовать
правую кнопку мыши для повторного отображения выпадающего меню и выбора команды
из этого меню. Выпадающее меню теперь содержит те же самые команды, которые
доступны в меню EDIT ACTIONS, а также Pick и Query Sel (если появляется меню GET
SELECT) и Finish Modify.

5. Для снятия выделения с выбранного объекта, графически выберите другой объект,
используя левую кнопку мыши. В некоторых операциях, типа расчленения (exploding)
символа, система автоматически снимает выделение активного элемента, потому что
объект больше не существует в той же форме.

6. Для выхода выберите Finish Modify из выпадающего меню. Также можно выбрать Done
Sel или Quit Sel, если выбранного объекта не существует, или когда система находится в
режиме Move/Activate.

Изменение Элементов, Используя Выпадающее Меню

При использовании выпадающего меню или меню EDIT ACTIONS для изменения элемента,
имейте в виду следующее:

· при перемещении примечания в таблице посредством Move в меню DETAIL или
Move/Activate в меню EDIT ACTIONS, система перемещает таблицу.

· Нельзя изменять не установленные трехмерные опорные элементы.

· При удалении размеров, на команду Delete в меню EDIT ACTIONS и меню DETAIL
накладываются те же ограничения. Например, нельзя удалять размеры, которые
принадлежат элементам.

Использование Маркеров
Как и в режиме Эскиза, маркеры можно использовать для управления объектами



Pro/ENGINEER 2000 i2 Pro/DETAIL Выпуск Документации

 - 79 -

различными способами, включая следующее:

· изменения радиуса эскизной окружности, выбирая один из маркеров.

· Перетаскивания конечной точки линии, используя один из маркеров.

· Выберите маркер на малой или большой оси эллипса; затем вращайте и изменяйте
размеры при помощи точки центра, оставляя другую ось неподвижной.

· Перемещения размера текста, который не имеет изгиба (elbow).

· Перемещения одной конечной точки дуги, при неподвижной другой точке.

Совет: Вызов Выпадающего Меню, Используя Команду Any Item

При выборе Any Item из меню MODIFY DRAW и выборе элемента, появляется меню EDIT
ACTIONS со списком операций редактирование, допустимых для этого конкретного
объекта. Для изменения элемента, выберите Any Item; затем выполните шаги с 3 по 7
предыдущей процедуры.

Пример: Маркеры
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Виды

Добавление Видов к Рисунку

Основные Типы Видов

Используя меню VIEW TYPE, можно задать восемь типов основных видов, а также задать
ориентацию модели в виде, наличие поперечного сечения и масштаб вида.

· основной вид (general) - вид, который не зависит от других видов в рисунке и
отображается с ориентацией, заданной в среде Pro/ENGINEER по умолчанию.

· выносной вид (detailed) � вид части модели, показанной в другом виде. Его ориентация
соответствует виду, по которому он был создан, но его масштаб может отличаться для
лучшей визуализации части модели. Отображение кромок в выносном виде соответствует
виду, по которому он был создан (его родительскому виду).

· проекция вида (projection) - ортогональная проекция геометрии другого вида вдоль
горизонтального или вертикального направления. Тип проекции можно указывать в файле
установок рисунка, на основании правила трех углов (по умолчанию) или первого угла.

· вспомогательный вид (auxiliary) - проекция геометрии одного вида под прямым углом к
выбранной поверхности или по оси. Выбранная поверхность в родительском виде должна
быть перпендикулярна плоскости экрана.

· повернутый вид (revolved) - плоское поперечное сечение области существующего вида,
повернутое на 90 градусов вокруг проекции плоскости сечения и смещенный вдоль ее
длины. Он может быть полным, частичным, разнесенным или не разнесенным.

Обратите внимание: Выносной, проекционный, вспомогательный и повернутый виды
имеют то же представление и расстояние разнесения (если таковые имеются),
соответствующие их родительским видам. Можно упрощать, восстанавливать и изменять
расстояние разнесения каждого вида без изменения родительского вида. Однако,
выносные виды всегда отображаются с теми же расстояниями разнесения и геометрией,
что и их родительские виды.

· диаграмма (graph) � отображает эскиз элементов диаграммы и ее размеры. Система
параметрически обновляет любые изменения.

· вид flat ply (м.б. сложный разрез примечание переводчика) - плоский вид с единственным
сгибом составной модели. Он может существовать в стандартном рисунке или в
нескольких рисунках.

· скопированный и ломаный вид (copy&align) - выровненный по указанной кромке и по
существующему виду.

Добавление Основного Вида

1. Выберите DRAWING > Views.

2. Введите имя модели для деталировки в рисунке. Можно ввести [?] для перечисления
моделей и выбора названия.
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3. Выберите VIEWS > Add View > General и другие доступные команды в меню VIEW
TYPE.

4. Выберите Done, чтобы принять команду, или Quit, чтобы прекратить создание вида.

5. Выберите местоположение для вида. Система устанавливает масштаб таким образом,
чтобы имелось достаточно места для создания других видов в рисунке.

6. Выберите Modify View > Reorient и выберите вид.

7. Если вид имеет какие либо зависимые (дочерние) виды, система подсвечивает их и
предупреждает, что они также будут переориентированы. Введите [Y], чтобы продолжить.

8. Используя диалоговое окно Orientation, выполните стандартную процедуру для
определения ориентации вида.

Основные Виды

Первый вид, которое добавляется к рисунку - основной вид. Другие основные виды
добавляются тем же способом, что и первый. Система размещает их на экране в
ориентации по умолчанию. При изменении ориентации основного вида, который имеет
дочерние виды в рисунке, система также изменяет ориентацию этих видов. Основные виды
можно перемещать в любое место рисунка и масштабировать их, в случае необходимости.

Изменение Ориентации По Умолчанию
Если опция файла конфигурации "disp_trimetric_dwg_mode_view" установлена в «yes»
модель отображается на экране в ориентации по умолчанию. Если она установлена в «no»,
модель не отображается, пока не будет выбрано Default из диалогового окна Orientation.
Однако, при создании вида рисунка с использованием ориентации по умолчанию, при
изменении этой опции файла конфигурации, ориентация не изменяется. Как только вид
устанавливается в ориентацию по умолчанию, система замораживает его.

Например, при размещении основного вида с ориентацией по умолчанию и выборе
Trimetric в списке Default Orientation в диалоговом окне Environment, система не
переориентирует вид, при выборе Isometric или регенерации рисунка с установкой в
изометрическое отображения. Для изменения ориентации вида, выберите Reorient в меню
MODIFY VIEWS, затем Default.
При изменении ориентации вида рисунка по умолчанию, учитывайте следующее:

· при удалении или подавлении геометрии, используемой системой для ориентирования
вида, ориентация вида и всех его дочерних элементов изменяется в значение по
умолчанию. Если геометрия была удалена, вернуть первоначальную ориентацию вида
нельзя. Однако, вызов подавленного элемента восстанавливает первоначальную
ориентацию вида.

· Система замораживает ориентацию видов по умолчанию во всех рисунках, версии до 18.0
после сохранения их в версии 18.0.

· Перед размещением поперечного сечения, определенного планарным в виде,
необходимо ориентировать вид таким образом, чтобы плоскость сечения была
параллельна плоскости экрана. Если поперечное сечение - повернутое, плоскость сечения
должна быть перпендикулярна экрану.
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Совет: Повторный Вызов Сохраненного Вида

В режиме Рисунка, можно повторно вызывать виды, сохраненные как именованные
ориентации видов в режимах Детали и Сборки и использовать их для создания вида
рисунка.

1. Выберите VIEWS > Add View.

2. Добавьте основной вид.

Обратите внимание: выбранный вид использует заданный по умолчанию вид как
исходную точку при ориентировании. Если после создания вида в диалоговом окне
Environment был выбран другой тип вида по умолчанию, они не будут одинаковыми. В
этом случае измените вид по умолчанию. Выберите название в списке Saved Views в
диалоговом окне Orientation при изменении ориентации основного вида.

3. Выберите Retrieve; затем выберите название сохраненного вида в списке меню.
Создаваемый вид принимает ориентацию сохраненного вида. Однако, его масштаб не
изменяется.

Добавление Выносного Вида

1. Выберите Detailed и другие доступные команды в меню VIEW TYPE.

2. Выберите Done для принятия команды или Quit для прекращения создания нового вида.

3. Выберите местоположение нового вида в рисунке.

4. Введите значение масштаба вида.

5. Выберите точку на кромке существующего вида. Появляется красный крестик,
представляющий ссылочную точку для геометрии, находящейся в выносном виде. Эта
ссылочная точка необходима системе для корректной регенерации выносного вида.

6. Выберите всю геометрию, которую требуется отобразить в выносном виде. Создайте
границу вокруг красного крестика, используя левую кнопку мыши для выбора точек.

7. Введите название выносного вида (система поставит перед названием слово "DETAIL").

8. В меню BOUNDARY TYPE, выберите Circle, Ellipse, H/V Ellipse или Spline. Создайте
сплайн на родительском виде, который соответствует выбранному типу ограничивающей
кромки.

9. Замкните границу, нажимая на среднюю кнопку мыши. Если сплайновая граница не
включает в себя красный крестик, граница должна быть определена повторно.

10. Выберите положение для примечания, которое присоединяется к родительскому виду.
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11. Если было выбрано Ellipse, H/V Ellipse или Spline в качестве окружности выносного
вида, выберите точку присоединения выноски для примечания выносного вида.

12. Система отображает вид с его названием и масштабом под ним. Круг приблизительно
описывает границы выносного вида. Сделайте следующие изменения при необходимости:

•  измените размер границы.

•  Используйте команду Value в меню MODIFY DRAW для изменения параметра "Scale
value", где value представляет отношение вида к масштабу модели. Сотрите название
масштаба, используя диалоговое окно Show/Erase.

•  Отредактируйте название выносного вида выбирая MODIFY DRAW > Value (Можно
ввести до 80 символов для названия вида).

•  Измените отображение круга, выноски и примечания, изменяя установку этих опций
файла установок рисунка:

− detail_circle_line_style

− detail_view_circle

− view_note

•  Сделайте отображение выносного вида независимым от его родительского вида,
выбирая VIEW DISP > Det Indep. Для возврата зависимости, выберите From Parent.

•  Сотрите примечание выносного вида, используя диалоговое окно Show/Erase.

Обратите внимание: при создании выносного вида детали, содержащей ось, которая
находится вне детали (то есть геометрия модели не включает ее), ось не отображается в
выносном виде.

Выносные Виды

Выносной вид отображает часть модели, показанной в другом виде. Для его создания,
определите сплайновую границу вокруг части существующего вида. Как показано в
следующем рисунке, система отображает название вида и значение масштаба под ним,
часть родительского вида и присоединяет примечание, идентифицирующее выносной вид.

Отображение выносного вида повторяет вид, по которому он был создан. Например, если
родительский вид отображает невидимые линии в области, которая выносится, выносной
вид (который является просто частью своего родителя) также отображает эти невидимые
линии. Если элемент родительского вида стирается, система стирает его также и на
выносном виде. Из-за этой зависимости, такие характеристики как штриховка и
отображение невидимых линий в выносном виде можно изменять только, если изменяется
родительский вид. Однако, выносной вид можно делать независимым от его родителя.
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Пример: Выносной Вид

Добавление Проекции Вида

1. Выберите Projection и другие доступные команды в меню VIEW TYPE.

2. Выберите Done для принятия команды или Quit для прекращения создания нового вида.

3. Выберите положение для нового вида в рисунке. Система отображает проекцию вида.

4. Сделайте следующие изменения, при необходимости:

− отобразите или удалите стрелки, которые указывают на вид, по которому создавалась
проекция, выбирая Add Arrows или Del Arrows в меню VIEW MODIFY.

− Автоматически добавьте названия вида к проекциям видов в формате "VIEW viewname-
viewname", устанавливая опцию "make_proj_view_notes" файла конфигурации в «yes».

5. Измените название вида или имя стрелки проекции вида, выбирая MODIFY DRAW >
Value.

Проекции Видов

Pro/ENGINEER автоматически создает проекции видов слева, справа, сверху и снизу
выбранного вида для определения ориентации. Стрелки в следующем рисунке показывают
направление взгляда системы для создания проекции вида. При обнаружении конфликта в
ориентации вида, необходимо выбрать вид в качестве родительского. Затем, создается
вид по выбранному виду. Если система не может найти другой вид в направлении линии
видимости, необходимо снова указать другое положение для размещения проекции.

Проекция вида получает масштаб своего родительского вида.
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Пример: Добавление Проекции Вида

Добавление Выносного Вида

1. Выберите Auxiliary и другие доступные команды в меню VIEW TYPE.

2. Выберите Done для принятия команды или Quit для прекращения создания нового вида.

3. Выберите положение нового вида в рисунке.

4. Выберите кромку или ось на поверхности модели в виде для создания выносного вида.
Если выбранная кромка находится в виде, который имеет изометрическую или подобную
ей ориентацию, система переориентирует новый вид так, чтобы он рассекал базовый
элемент. Иначе, он ориентируется по выбранной поверхности, параллельно плоскости
рисунка.

Обратите внимание: после создания выносного вида, можно упростить или
регенерировать его воздействуя на родительский вид.

5. Выберите Add Arrows или Del Arrows в меню VIEW MODIFY для отображения или
удаления стрелок, указывающих на вид, по которому создавалась проекция.

Вспомогательные Виды

Вспомогательные виды поясняют истинный размер и форму плоской поверхности детали.
Система делает проекцию модели, перпендикулярно выбранной кромке. Вспомогательный
вид можно создавать по любому другому типу вида.
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Пример: Вспомогательный Вид

Добавление Повернутого Вида Поперечного Сечения

1. Выберите VIEWS > Add View > Revolved > Section > Done. Меню XSEC TYPE не
появляется; система создает поперечное сечение автоматически в виде поперечного
сечения области.

2. Выберите положение вида, приблизительно вдоль проекции плоскости сечения в
родительском виде; затем выберите родительский вид.

3. Выберите название поперечного сечения из меню. Повернутый поперечный разрез
появляется в местоположении по умолчанию, со всеми временно показанными опорными
плоскостями и осями. Pro/ENGINEER присваивает им имена, используя правило "Revolved
_ <view_id>".

4. Измените осевую линию симметрии, при необходимости:

− замените границу плоскости осевой линией симметрии, выбирая опорную плоскость
или ось в повернутом виде, параллельном проекции секущей плоскости в
родительском виде. Система центрирует повернутый вид таким образом, чтобы
выбранная плоскость (или ось) была коллинеарна секущей плоскости в родительском
виде. Если вместо этого нажать среднюю кнопку мыши, плоскость сечения пройдет
через центр повернутого вида.

− Сотрите и восстановите осевую линию, выбирая Del Arrows или Add Arrows в меню
VIEW MODIFY.

− Обрежьте осевую линию, выбирая DETAIL > Move. Выберите конечную точку осевой
линии и новое положение; затем нажмите среднюю кнопку мыши.

− При выборе существующей оси (которая является перпендикулярной к экрану) для
центрирования вида, отобразите ось, щелкая по Axis в поле Type диалогового окна
Show/Erase.

Повернутые Виды

Повернутые области поперечных сечений могут быть полными или частичными видами.
Pro/ENGINEER создает повернутую область поперечного сечения по родительскому виду,
в котором плоскость сечения перпендикулярна экрану. Сечение поворачивается на 90
градусов вокруг проекции плоскости сечения и смещается по ее длине.
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При создании этот типа вида, система автоматически создает линию симметрии; однако,
эта осевая линия не является осью. Повернутый вид можно перемещать параллельно
секущей плоскости в родительском виде, и их центрирование относительно линии секущей
плоскости всегда остается тем же самым. Линию симметрии можно изменять различными
способами.

Пример: Повернутое Поперечное Сечение

Добавление Диаграммы

1. Выберите VIEWS > Graph.

Обратите внимание: в случае отсутствия элементов диаграммы модели текущего
рисунка, команда GRAPH не доступна в меню VIEW TYPE.

2. Выберите No Scale или Scaled и введите значение. Для масштабируемых видов
диаграмм, масштаб появляется в рисунке под названием вида.

3. Выберите центральную точку для вида рисунка.

4. Из меню GRAPHS, выберите диаграмму для отображения в виде. Система размещает
вид, отображая имя элемента диаграммы ниже границы вида.

Обратите внимание: так как элемент диаграммы всегда остается двухмерным, он не
ориентируется.

5. Сделайте следующие изменения, в случае необходимости:

− измените масштаб вида, выбирая значение на экране, или выберите MODIFY VIEW >
Change Scale.

− Переопределите тип вида (с No Scale на Scaled или наоборот) выбирая VIEWS >
Modify View > View Type.

− Отобразите размеры элемента диаграммы в виде, используя диалоговое окно
Show/Erase.
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− Отобразите или сотрите название вида элемента диаграммы, используя диалоговое
окно Show/Erase.

Виды Диаграмм

Используя команду Graph в меню VIEW TYPES, можно отображать виды элементов
диаграммы в рисунке. Обычно используется стандартный элемент диаграммы для
контроля переменного сечения элемента протягивания при создании геометрии.
Диаграмма - фактический опорный элемент, который создается в режиме Эскиза,
используя команды Datum и Graph. Система отображает эскиз элемента диаграммы и его
размеры в виде и параметрически обновляет любые изменения.

Типичный пример детали, который использует элемент диаграммы - кулачок. Конструктор
кулачка может показать профиль кулачка для иллюстрации линейного движения толкателя
при вращении кулачка. Следующий рисунок показывает деталь кулачка и его
соответствующий профиль, представленный элементом диаграммы, который управляет
переменным сечением элемента протягивания. Система использует переменное сечение
элемента протягивания для создания поверхности детали; другими словами, элемент
диаграммы (профиль кулачка) управляет радиусом кулачка.

Пример: Вид Диаграммы
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Добавление Ломаного Частичного Вида

1. В меню VIEW TYPE, выберите Copy и Align, примите значения по умолчанию и
выберите Done.

2. Выберите центр для вида.

3. Выберите существующий частичный вид, по которому выравнивается текущий вид.

4. Ломаный вид временно отображается полностью. Выберите ссылочную точку для
определения центра частичного вида.

5. Создайте сплайн для определения границы частичного вида.

6. На текущем частичном виде, выберите прямолинейный объект: кромку, ось, опорную
кривую или сегмент кабеля. Текущий частичный вид выравнивается по существующему
частичному виду вдоль выбранного объекта.

7. Используйте Ref Point, Boundary, Add Arrows, Del Arrows и Snapshot для изменения
вида, как если бы он был стандартной проекцией вида. Можно изменять отображение
ломаного частичного вида индивидуально для каждого частичного вида, независимо от
отношений родитель - потомок, которые могут существовать между видами. Если он не
имеет дочерних элементов, его можно удалить.

Обратите внимание: команды Origin и Perspective в меню VIEW MODIFY, и команды Add
Breakout и Del Breakout в меню VIEW BNDRY не доступны для ломаных частичных видов.

Ломаные Частичные Виды

При наличии частичного вида в рисунке, можно создавать ломаный частичный вид,
определяя границу вида и указывая направление выравнивания относительно
существующего частичного вида. Можно также выравнивать ломаный частичный вид по
выносному виду. Можно выравнивать частичный вид по другому частичному виду в рисунке
вдоль выбранного прямолинейного объекта (типа оси, кромки, опорной кривой или
сегменту кабеля). Это дает возможность создавать несколько частичных видов, которые
выборочно показывают геометрию модели в той же ориентации вида, а также сохраняют
относительное положение между этими частичными видами.

Исходный частичный вид - родительский вид � определяет различные свойства
последующих ломаных частичных видов, типа следующих:

· ломаный вид использует те же самые атрибуты вида (например, атрибуты,
определяющие масштабирование или разнесение вида), что и его родительский вид.

· Нельзя изменять масштаб ломаного частичного вида независимо; он изменяется при
изменении масштаба родительского частичного вида.

· Нельзя изменять ориентацию ломаного частичного вида, используя команду Reorient
непосредственно, так как это - зависимый вид. Однако, при изменении ориентации
родительского вида, система перестраивает ломаные частичные виды.

Поскольку ломаный частичный вид - зависимый вид, его местоположение зависит от его
родителя (вида, по которому он был выровнен). Поэтому, всякий раз, при перемещении
родительского вида, местоположение ломаного вида также изменяется. Ломаный вид
можно перемещать только в направлении выравнивания, ближе или дальше от родителя.
При стирании родительского вида или перемещении его на другой лист, можно
перемещать ломаный вид без ограничений, пока родительский вид не будет восстановлен
или возвращен назад.

Обратите внимание: ломаный частичный вид, созданный с использованием команды
Copy и Align, имеет свои собственные местные поперечные сечения. То есть при его
создании, он не приобретает местных поперечных сечений родительского вида. Их можно
добавлять и удалять позже.
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Пример: Ломаный Частичный Вид

Управление Видимостью Модели
Можно управлять длиной отображения модели в рисунке, создавая полный, половинный,
частичный вид и вид с разрывом.

При определении основного типа вида можно использовать команды в меню VIEW TYPE
для управления тем, какая часть модели будет видна в рисунке:

· Full View � полностью отображает модель.

· Half View - удаляет часть модели в виде по одну сторону от секущей плоскости.

· Broken View - удаляет часть модели между двумя выбранными точками и соединяет две
оставшиеся части в пределах указанного расстояния.

· Partial View - отображает часть модели в виде в пределах замкнутой границы. Система
отображает геометрию в пределах границы, но удаляет геометрию вне ее.

Для Создания Половины Вида

1. Следуйте процедуре для добавления проекционного, выносного или основного вида;
затем выберите VIEW TYPE > Half View.

2. Выберите секущую плоскость в любом другом виде рисунка (она должна быть
перпендикулярна экрану в новом виде).

3. В новом виде появляются стрелки, указывающие сторону, которая должна остаться в
виде. Выберите Flip для изменения направления стрелки или ОК, чтобы принять
направление и продолжить.

Вид на экране изменяется. Система скрывает часть вида, которая осталась за стрелками
сечения; сами стрелки тоже исчезают из рисунка.

Создание Половины Вида

Когда Pro/ENGINEER создает половину вида в рисунке, он разрезает модель по плоскости,
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удаляя одну ее часть и отображая остальную. Плоскостью сечения может являться
плоская поверхность или опорный элемент, которая должна быть перпендикулярна к
экрану в новом виде. Команда Half View доступна только для проекционных, выносных и
основных видов.

Пример: Половина Вида

Для Создания Частичного Вида

1. Выполните процедуру добавления проекционного, выносного или основного вида; затем
выберите VIEW TYPE > Partial View.

2. Выберите точку на кромке нового вида. Появляется красный крестик, представляющий
ссылочную точку на геометрии, отображаемой в новом виде. Эта ссылочная точка
необходима системе для корректной регенерации частичного вида.

3. Нарисуйте границу вокруг красного крестика, охватывая всю геометрию, которую
необходимо отобразить в частичном виде. Выбирайте точки, используя левую кнопку
мыши. Для замыкания границы, нажмите среднюю кнопку мыши. Только часть вида,
находящаяся внутри сплайна, останется видимой.

Создание Частичного Вида

Для создания частичного вида необходимо определить и ориентировать вид, затем
создать замкнутую границу вокруг нового вида. Система отображает геометрию,
находящуюся внутри замкнутой границы, но не геометрию вне ее. Команда Partial View
доступна только для проекционных, выносных и основных типов видов. Их можно
масштабировать, рассекать и создавать несколько границ или разрывов (breakouts) для
включения местного поперечного сечения области.

Пример: Частичный Вид
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Для Создания Вида с Разрывом

1. Выберите Projection или General и Broken View в меню VIEW TYPE.

2. Выберите местоположение для центра нового вида. Появляется объект. Сориентируйте
вид в случае необходимости.

3. Для каждого разрыва в виде, определите границы вертикальной или горизонтальной
удаляемой области. Выберите Add или Delete из меню ADD/DEL BRK, или выберите
Vertical или Horizontal в меню BREAK DIR.

Обратите внимание: нельзя добавлять горизонтальные линии разрыва на горизонтально
спроецированный вид с разрывом, или добавлять вертикальные линии разрыва к
вертикально спроецированному виду с разрывом.

4. Для добавления линии разрыва, выберите кромку модели. Для каждых двух
добавляемых линий разрыва, система создает один разрыв и удаляет часть вида,
находящуюся между ними.

Вид с Линиями Разрыва

5. По завершении добавления линий разрыва, выберите ADD/DEL BRK > Done. Система
удаляет область между линиями разрыва и отображением модели, обозначая разрыв
единственной горизонтальной или вертикальной линией.

Вид с Удаленной Областью Между Линиями Разрыва

6. Создайте сплайновое представление разрыва. Выделите все разрывы в одном
направлении, которые должны использовать тот же самый сплайн. Вертикальные и
горизонтальные разрывы должны создаваться отдельно.

Эскиз Сплайновых Разрывов

7. Выберите Done Sel; затем сделайте эскиз сплайна. Выполните это для каждого разрыва,
который имеет другое представление сплайна. Если сплайн для разрыва не будет создан,
разрыв будет представлен прямой линией. Для нескольких линий разрыва в единственном
эскизе, создайте линии разрыва в месте первого выбранного разрыва; иначе, все линии
разрыва сдвинутся.

8. Выберите Done по завершении. На виде появляются разрывы с созданными контурами и
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промежутками между каждой частью (задаются опцией "broken_view_offset" файла
установок рисунка).

Окончательный Вид с Разрывом

Создание Вида с Разрывом

Виды с разрывом можно создавать в вертикальном и горизонтальном направлении с
любым количеством разрывов. Можно также создавать виды с разрывом с местными
поперечными сечениями.

Промежуток между "разрывами" - расстояние смещения, определяемое как вертикальное
или горизонтальное расстояние между двумя последовательными частями вида.
Отображение вида с разрывом сохраняет расстояние смещения постоянным между
отображенными частями вида, при изменении:

· геометрии модели;

· масштаба рисунка;

· ссылочных точек вида с разрывом;

Расстоянием смещения можно управлять при создании разрыва установкой опции
"broken_view_offset� файла установок рисунка. Интервал по умолчанию - 1 единица
рисунка. Можно изменять интервал, используя Move View для перемещения одного из
подвидов (subview), или частей вида с разрывом.

Линию разрыва для вида с разрывом можно создавать тремя способами:

· Sketch � нарисуйте сплайн.

· S-Curve - для линии разрыва создается S-образный сплайн.

· Heartbeat - для линии разрыва создается волнообразный сплайн.

При выборе S-Curve или Heartbeat в качестве типа сплайна, доступны следующие две
опции:

· View Outline - масштабирует сплайн на основании контура вида в этом направлении.

· Geometry - масштабирует сплайн на основании расстояния между двумя выбранными
точками.

По виду с разрывом можно создавать проекцию. Точки излома проецируются, позволяя
создавать новые сплайны в дочернем виде.

Обратите внимание: форма S-образной и волнообразной кривой непостоянная; то есть
любое изменение в размерах пропорционально влияет на ее длину и ширину.

Совет: Перемещение Видов с Разрывом

При перемещении вида с разрывом, для любого выбранного подвида (subview) (или части
вида), все подвиды справа и снизу от него перемещают на то же расстояние. Для
перемещения всего вида с разрывом в другое место рисунка, выберите левый верхний
подвид. При этом весь вид перемещается без изменения промежутков между подвидами.
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Выбор любой другого подвида перемещает все подвиды ниже и вправо от него на
одинаковое расстояние.

Перемещение Вида с Разрывом

Добавление Сегмента к Виду с Разрывом

1. Нажмите, VIEWS > Modify View > Boundary.

2. Выберите вид для переопределения. Сегменты вида временно соединяются вместе.

3. В меню VIEW BREAK, нажмите Add Segment. Сегменты вида возвращаются в их
предыдущее положение.

4. Выберите границу вида, по которой требуется создать новый сегмент. При этом
создается новый сегмент вида с разрывом. Этот шаг можно повторять столько раз, сколько
потребуется для создания дополнительных сегментов.

Обратите внимание: новый сегмент вида с разрывом создается в виде и любых
соответствующих проекциях вида. Новый сегмент имеет те же ссылочные точки и форму
сплайна, что и его соседи, и смещен на то же расстояние.

Удаление Сегмента из Вида с Разрывом

1. Нажмите VIEWS > Modify View > Boundary.

2. Выберите вид для переопределения. Сегменты вида временно соединяются вместе.

3. В меню VIEW BREAK нажмите Del Segment. Сегменты вида возвращаются в свои
предыдущие положения.

4. Выберите сегмент для удаления. Сегмент подсвечивается.

5. Выберите сторону подсвеченного сегмента, где требуется сохранить форму сплайна.
При этом сегмент удаляется.

Обратите внимание: удаленный сегмент исчезает в текущем виде и любых
соответствующих проекциях вида.
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Покомпонентные Виды в Рисунке

Покомпонентные Виды Сборки

При создании рисунка сборки, можно добавлять покомпонентное (разнесенное)
изображение сборки без необходимости разносить его в режиме Сборки. Если сборка
сохраняется в ее покомпонентном состоянии в режиме Сборки и, затем, в режиме Рисунка
вызывается вид из списка Saved Views в диалоговом окне Orientation, система размещает
вид с соответствующей ориентацией, но не в покомпонентном состоянии.

Создание Покомпонентного Вида

1. Выберите VIEWS > Add View.

2. Выберите команды из меню VIEW TYPE Exploded и Done.

3. Выберите центр вида.

4. Определить тип ориентации, используя диалоговое окно Orientation. Система
добавляет покомпонентный вид сборки к рисунку.

Обратите внимание: при наличии лицензии для Pro/PROCESS for ASSEMBLIES,
появляется меню SEL STATE. Затем можно выбирать состояние покомпонентного вида и
ориентировать его.

Создание Покомпонентных Изображений

В одном и том же рисунке можно создавать различные покомпонентные изображения. При
создании покомпонентного изображения, используя команду Add View, Pro/ENGINEER
копирует текущие размеры разнесения модели в вид. После этого, расстояния разнесения
этого вида становятся независимыми от других видов и непосредственно от модели.

При изменении значений Expld Status сборки в режиме Сборки (переключая их вкл. и
выкл.), система не может показывать более одного покомпонентного изображения.
Размерами разнесения можно управлять в режиме Рисунка, но для глобального
управления компонентами, используйте команду Expld Status в режиме Сборки.
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Пример: Покомпонентное Изображение

Изменение Расстояния Разнесения Между Компонентами

1. Выберите VIEW MODIFY > Mod Explode.

2. Выберите изменяемый вид.

3. Выберите EXPLD STATE > Redefine > Position.

4. Измените расстояние разнесения, используя команды в меню MTNPREF.

Обратите внимание: если лицензия Pro/PROCESS для СБОРОК отсутствует, вместо
меню EXPLD STATE появляется меню MOD EXPLODE. Можно выбрать Position для
вызова меню MTNPREF или Explode Status.

При выборе Exploded из меню VIEW TYPE, необходимо указать, какое состояние
разнесения использовать, путем выбора его из меню SEL STATE. Если вид, который
необходимо использовать, является обрабатываемым видом модели, необходимо выбрать
состояние разнесения из меню SEL STATE.

Изменение Расстояния Разнесения для Покомпонентных
Изображений

Значения разнесения, указанные в сборке управляют расстоянием разнесения между
компонентами в модели. Можно изменять размеры разнесения в виде рисунка, выбирая
Mod Explode из меню VIEW MODIFY. Однако, эта команда только косметически изменяет
рисунок и не меняет фактические размеры разнесения модели. При изменении сборки в
режиме Сборки путем выбора Redefine в меню EXPLD STATE, нельзя изменять параметры
разнесения в рисунке.
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Пример: Изменяемое Расстояние Разнесения

Виды с Единственной-Поверхностью в
Рисунке

Создание Вида с Единственной-Поверхностью

1. Выберите VIEW TYPE > Of Surface и любые другие команды, за исключением Detailed.

2. Если вид с Единственной-Поверхностью является основным (General) � ориентируйте
модель как обычно.

3. Выберите единственную поверхность детали для отображения. Система стирает всю
другую геометрию.

Создание Вида с Единственной-Поверхностью

При наличии лицензии Pro/DETAIL, можно создавать виды с Единственной-Поверхностью
для поверхности твердотельного элемента или опорной лоскутной поверхности.

Pro/ENGINEER всегда отображает их в каркасном виде, но не отображает опорные
элементы, косметические элементы и системы координат. При этом стирается вся
геометрия, кроме выбранной поверхности. Помимо стандартных проекционных видов
можно создавать проекционные виды Единственной-Поверхности по видам с
Единственной-Поверхностью.
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Пример: Виды с Единственной-Поверхностью

Перспективные Виды в Рисунке

Перспективные Виды

Перспективный вид модели в рисунке можно создавать, определяя расстояние до точки
просмотра, или фокусное расстояние, и диаметр вида.

Для Создания Перспективного Вида

1. Выберите VIEWS > Add View > General > Full > No Xsec > Perspective > Done.

2. Выберите точку для размещения вида.

3. Введите расстояние до точки просмотра в единицах модели (дюймы).

4. Введите диаметр вида в единицах листа (дюймы).

5. Основной вид отображается в перспективе. Сориентируйте вид, используя команды в
диалоговом окне Orientation; затем выберите Done/Return для завершения.
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Создание Перспективного Вида

При создании и изменении перспективных видов, учитывайте следующие ограничения:

· в перспективе можно отображать только основные виды.

· Перспективные виды не могут иметь поперечных сечений.

· Нельзя использовать перспективные виды для создания проекционных видов или
выносных элементов.

· Размеры, опорные плоскости и оси в перспективных видах не отображаются (кроме как
при ориентировании вида).

· Нельзя использовать команды Intersect и Midpoint для присоединения элементов с
выносками к перспективным видам.

· В режиме Детали, при создании перспективного вида From/To и, затем, присвоении ему
имени (вводя название в поле Name диалогового окна Orientation), нельзя использовать
такой именованный вид в рисунке. Система помещает его в вид, заданный по умолчанию.

Пример: Перспективный Вид

Изменение Перспективного Вида

1. Выберите VIEW MODIFY > Perspective.

2. Выберите вид на экране.

3. Используя меню MOD PERSPECT, сделайте следующее:

− измените расстояние до точки просмотра, выбирая Viewing Dist и вводя значение,
и/или

− измените диаметр, выбирая Diameter и вводя значение.
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Создание Видов Поперечных Сечений

Поперечные Сечения

Поперечное сечение можно создавать в режиме Детали и Сборки и отображать его в
рисунке, или можно добавлять его к виду в режиме Рисунка в процессе его создания. При
наличии лицензии для Pro/DETAIL, можно использовать команды в меню XSEC TYPE для
создания десяти типов поперечных сечений:

· полное (full) поперечное сечение отображает вид целиком, учитывая, что местное (local)
поперечное сечение показывает часть модели в пределах замкнутой области поперечного
сечения, а не за ее границами.

- Полное и местное (full & local) поперечное сечение показывает полное поперечное
сечение с местными поперечными сечениями.

· Половинное (half) поперечное сечение показывает часть модели по одну сторону секущей
плоскости, без другой стороны.

· Полное (total) поперечное сечение отображает область сечения, и кромки модели,
которые будут видны после создания поперечного сечения.

· Поперечное сечение области (area) отображает только поперечное сечение без
геометрии.

· Ломаное (aligned) поперечное сечение отображает поперечное сечение области,
развернутой вокруг оси. Общее ломаное (total aligned) поперечное сечение показывает
ломаное поперечное сечение основного, проекционного, выносного или полного вида.

· Развернутое (unfolded) поперечное сечение показывает плоскую область поперечного
сечения основного вида. Общее развернутое (total unfolded) поперечное сечение
показывает общее развернутое поперечное сечение основного вида.

Создание Полного Поперечного Сечения (Full Cross-Sectional)

1. Выберите VIEW TYPE > Section.

2. Используя меню XSEC ENTER, сделайте следующее:

− Выберите Create и сделайте поперечное сечение по ходу построения.

− Выберите Retrieve и выберите поперечное сечение из меню XSEC NAMES.

3. Выберите Planar из меню XSEC ENTER для создания плоского поперечного сечения или
выберите Offset для создания поперечного сечения со смещением.

4. Выберите Done и введите имя поперечного сечения.

5. Создайте сечение.

6. Продолжайте процесс создания вида.



Pro/ENGINEER 2000 i2 Pro/DETAIL Выпуск Документации

 - 101 -

Виды с Полным Поперечным Сечением

При создании вида, можно вызвать любое из существующих поперечных сечений или
создать новое поперечное сечение по ходу построения. Для управления отображением
опорных кривых, резьб, элементов косметических объектов и косметической штриховки на
виде с полным поперечным сечением, используйте опцию "remove_cosms_from_xsecs"
файла установок рисунка. Если опция установлена в "all", опорные и косметические
элементы можно удалять со всех типов поперечных сечений.

Создание Половинного Поперечного Сечения (Half Cross-
Sectional)

1. Выберите тип вида из меню VIEW TYPE.

Обратите внимание: Half доступно только при выборе Full View из меню VIEW TYPE. Эта
команда не доступна для частичного, с разрывом или половинного видов.

2. Выберите ТИП XSEC > Half > Done.

Обратите внимание: меню XSEC TYPE появляется только при наличии Pro/DETAIL.
Иначе, система выбирает Area Xsec автоматически.

3. Сориентируйте вид как требуется; затем выберите плоскость ссылки для половинного
поперечного сечения.

4. Стрелки показывают направление создания половинного поперечного сечения.
Подтвердите направление, выбирая Okay, или переверните их, выбирая DIRECTION >
Flip.

5. Выберите или создайте поперечное сечение, используя команды в меню XSEC ENTER.

6. Выберите вид для отображения стрелок поперечного сечения или нажмите среднюю
кнопку для их отмены

Половинные Поперечные разрезы

Используя команду Half в меню VIEW TYPE, можно создавать половинное поперечное
сечение. Часть поперечного сечения модели зависит от направления стрелки рассечения.
Направление стрелки рассечения можно менять.

Пример: Половинное Поперечное Сечение
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Создание Местного Поперечного Сечения

1. Выберите VIEW BNDRY > Add Breakout.
2. Укажите поперечное сечение, используемое для местного поперечного сечения,
выбирая опцию из следующего меню NEW BREAKOUT:

− Current Xsec - использует поперечное сечение, которое было создано предыдущим
поперечным сечением.

− Choose Xsec - создает поперечное сечение по ходу построения или вызывает
существующее. Используйте команды в меню XSEC ENTER.

3. Выберите вид для отображения стрелок или нажмите среднюю кнопку мыши для их
отмены. (При выборе Current Xsec этот шаг не требуется)

4. Выберите ссылочную точку на геометрии вида, которая станет центром местного
поперечного сечения.

5. Создайте сплайн, чтобы он не пересек другие сплайны. Закончите сплайн, нажимая
среднюю кнопку мыши. Для завершения созданного поперечного сечения, выберите Done.

Местные Поперечные Сечения

Можно создавать частичный спроецированный, вспомогательный, основной или
повернутый вид с разрывами для местного поперечного сечения. Можно создавать
местные поперечные сечения при создании вида, или можно добавлять их позднее, при
изменении вида. В обоих случаях, меню VIEW BNDRY содержит следующие команды для
добавления, удаления или изменения местных поперечных сечений:

· Mod Breakout - изменяет границы местного поперечного сечения

· Add Breakout - добавляет местное поперечное сечение

· Del Breakout - удаляет местное поперечное сечение

· Move Ref Pnt - перемещает ссылочную точку местного поперечного сечения

Обратите внимание: нельзя создавать вложенные разрывы в видах с местными
поперечными сечениями.

Пример: Местное Поперечное Сечение
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Создание Частичного Вида или Вида с Разрывом с Местным
Поперечным Сечением

1. В меню VIEW TYPE выберите Partial View или Broken View.

2. Выберите Section > Done > Local.
Обратите внимание: Local не доступен для половинного вида. Он доступен только при
выборе Full View или Partial View в меню VIEW TYPE.

3. Выберите центр для вида и сориентируйте его как требуется.

4. Создайте или вызовите поперечное сечение в качестве ссылки для местного
поперечного сечения. Используйте команды в меню XSEC ENTER.

5. Выберите вид для отображения стрелок или нажмите среднюю кнопку мыши для их
отмены.

6. Сделайте следующее:

− если создается частичный вид, выберите центр для частичного вида, создайте сплайн,
определяющий границы частичного вида и выберите центр для разрыва. Для создания
нескольких местных поперечных сечений, укажите поперечное сечение для ссылки и,
затем, определите центр и границы разрыва. Выберите VIEW BNDRY > Done.

− При создании вида с разрывом, выберите центр для разрыва и следуйте шагам 7 и 8.

7. Добавьте разрывы, выбирая ссылочные точки и выберите ADD/DEL BRK > Done.

8. Выберите линии, используемые этим же сплайном; затем создайте сплайн.

9. Выберите EXIT > Done.

Пример: Частичный Вид С Местными Поперечными Сечениями
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Создание Полного Поперечного Сечения с Местным Поперечным
Сечением

1. В меню VIEW TYPE, выберите Projection или Auxiliary; затем выберите Full View или
Partial View.

Обратите внимание: этот тип вида может быть только полным поперечным сечением.

2. Выберите Section > Done > Full & Local.
Обратите внимание: опция Full & Local не доступна для половинного вида и вида с
разрывом.

3. Выберите центральную точку для вида и сориентируйте его требуемым образом.

4. Выберите или создайте поперечное сечение, используя команды в меню XSEC ENTER.

5. Выберите вид для отображения стрелок или нажмите среднюю кнопку мыши для их
отмены. Система создает полное поперечное сечение.

6. Для частичного вида, создайте внешнюю границу, выбирая ссылочную точку и создавая
эскиз границы.

Обратите внимание: граничные и ссылочные точки местных поперечных сечений
отображаются оранжевым цветом; внешние границы вида и ссылочная точка отображается
зеленым цветом.

7. Определите другое поперечное сечение для ссылки местного поперечного сечения,
выбирая одну из следующих команд в меню NEW BREAKOUT:

− Current Xsec - использует текущее поперечное сечение для создания местного
разрыва. Эта команда действительна только, если выбирается поперечное сечение,
ссылающееся на ранее созданное местное поперечное сечение.

− Choose Xsec - определяет поперечное сечение для ссылки местного поперечного
сечения. Создайте или вызовите его, используя команды в меню XSEC ENTER.

8. Выберите вид для отображения стрелок или нажмите среднюю кнопку мыши для их
отмены.

9. Выберите центр для местного поперечного сечения.

10. Создайте сплайн таким образом, чтобы он не пересекал другие сплайны. Сплайн
отображается оранжевым цветом.

11. Если требуется, создайте дополнительные местные поперечные сечения указанием
первого поперечного сечения в качестве ссылочного, затем, указывая центр и границы
разрыва.

12. По завершении выберите VIEW BNDRY > Done.

13. Измените штриховку для местного разрыва, чтобы она отличилась от штриховки
полного поперечного сечения.
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Пример: Полное Поперечное Сечение с Местным Поперечным
Сечением

Создание Вида с Полным Поперечным Сечением или
Поперечного Сечения Области

1. Добавьте вид, используя опции General, Section, Full и Total Xsec или Area Xsec.

Обратите внимание: Total Xsec или Area Xsec доступно только при выборе Full из меню
XSEC TYPE.

2. Выберите положение для вида.

3. Выберите или создайте сечение, используя команды в меню XSEC ENTER.

4. Выберите вид для отображения стрелок и установите направление взгляда, выбирая
DIRECTION > Flip > Okay. Если не требуется выбирать вид для отображения стрелок,
нажмите среднюю кнопку мыши.

Виды с Полным Поперечным Сечением и Поперечным Сечением
Области

Полные поперечные сечения показывают не только область поперечного сечения, но и
кромки модели, которые станут видны по завершении создания поперечного сечения, тогда
как поперечное сечение области отображает только поперечное сечение без геометрии.
Поперечные сечения области отображают только геометрию, которая находится в секущей
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плоскости. Косметические элементы, опорные элементы и системы координат не
показываются.

Лоскутные поверхности не видны в полных поперечных сечениях; однако, они появляются
в созданных поперечных сечениях области, используя команду Model & Quilts. В видах с
плоскими поперечными сечениями области, можно показывать все элементы
косметических эскизов и опорных кривых, которые лежат в секущей плоскости,
устанавливая опцию "draw_cosms_in_area_xsec� файла установок рисунка в «yes».

Пример: Виды с Полным Поперечным Сечением и Поперечным
Сечением Области

Создание Вида с Ломаным или Полным Ломаным Поперечным
Сечением

1. В меню VIEW TYPE, выберите Projection, Full View, Section, No Scale и Done.

2. В меню XSEC TYPE, выберите Full, Align Xsec (или Total Align) и Done.

Обратите внимание: команды Align Xsec и Total Align доступны только при выборе Full
из меню XSEC TYPE.

3. Выберите центр для вида.

4. Выберите или создайте ступенчатое сечение, чтобы использовать в развернутом виде.
Используйте команды в меню XSEC ENTER.

5. Выберите ось, относительно которой секущие плоскости при повороте становятся
параллельными экрану. Учитывайте соответствующие ограничения.

6. Выберите вид для отображения стрелок, обозначающих направление обзора и
положение секущей плоскости. Если не требуется выбирать вид для отображения стрелок,
нажмите среднюю кнопку мыши.

7. Выберите Flip и Okay для изменения или подтверждения направления стрелок.

Ломаные (Aligned) Поперечные сечения

Ломаное поперечное сечение отображает поперечное сечение области, развернутое
вокруг оси. Система вращает все секущие плоскости ступенчатого поперечного сечения
относительно выбранной оси, пока они не сориентируются параллельно экрану (листу).

Ломаные поперечные сечения создают поперечные сечения типа области. Полное
ломаное поперечное сечение отображает ломаное полное поперечное сечение для
основного, проекционного, выносного или полного вида. По ломаному поперечному
сечению можно создавать выносной вид.
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На ломаные поперечные сечения и полные ломаные поперечные сечения накладываются
следующие ограничения:

· выравнивать можно только ступенчатые поперечные сечения.

· Ось поворота плоскости сечения, должна быть параллельна экрану.

· Ось должна лежать на всех секущих плоскостях.

· Ось должна быть соосна всем цилиндрам в сечении.

· В ломаном поперечном сечении, нельзя отображать размеры модели. Размеры могут
быть созданы в пределах одного сегмента поперечного сечения.

· если вид является основным, модель следует ориентировать таким образом, чтобы ось
разворота (unfolded) была параллельна экрану.

· Pro/ENGINEER создает ломаные и развернутые поперечные сечения в виде поперечных
сечений области. Штриховка не будет отображаться при отсутствии лицензии Pro/DETAIL.

Пример: Ломаные Поперечные Сечения
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Создание Развернутого или Полного Развернутого Поперечного
Сечения

1. Выберите VIEWS > Add View.

2. В меню VIEW TYPE, выберите General, Full, Section, No Scale (или Scale) и Done.
3. Сделайте следующее:

− для создания развернутого поперечного сечения, выберите Full, Unfold Xsec и Done
из меню XSEC TYPE.

− Для создания полного развернутого поперечного сечения, выберите Full, Total Unfold
и Done из меню XSEC TYPE.

Обратите внимание: опции Unfold Xsec и Total Unfold доступны только при выборе Full
из меню XSEC TYPE.

4. Выберите местоположение для вида.

5. Выберите или создайте сечение, используя команды в меню XSEC ENTER.

6. Выберите вид для отображения стрелок и установите направление взгляда, выбирая
DIRECTION > Flip > Okay. Если не требуется выбирать вид для отображения стрелок,
нажмите среднюю кнопку мыши

7. После отображения вида, его можно ориентировать, вращая на указанный угол.
Выберите FLAT ORIENT > Angles > Norm. Введите значение угла вращения (угол вокруг
перпендикулярной оси) и выберите Done/Accept. Вид отображается с новой ориентацией.

8. Для завершения создания вида, выберите Done Orient. Для прерывания процесса
выберите Quit Orient.

Развернутые Поперечные Сечения Области

Можно создавать развернутое поперечное сечение или полное развернутое поперечное
сечение основного вида чертежа путем разворачивания (растягивания) плоскостей
сечения, пока они не станут параллельными экрану.

При разворачивании поперечного сечения, накладываются следующие ограничения:

·можно разворачивать только ступенчатые поперечные сечения, которые были созданы с
использованием команды Both Sides.

· Объекты, используемые для определения поперечного сечения, должны быть линиями.

· Нельзя создавать проекцию вида по развернутому поперечному сечению.

· Pro/ENGINEER не поддерживает размеры детали в развернутом поперечном сечении
вида чертежа.

· Нельзя создавать частичный и половинный развернутые виды.

· Нельзя создавать проекции видов полного развернутого вида.

· В виде можно отображать размеры элементов, если каждый размер остается в пределах
одного сегмента сечения.

· При удалении ступенчатого сечения полного развернутого поперечного сечения из
модели или при невозможности его регенерации (например, при подавлении эскизной
опорной плоскости), полное развернутое поперечное сечение становится стандартным
основным видом.

Можно управлять отображением стыков (кромок секущей плоскости) в полных развернутых
поперечных сечениях, используя опцию "show_total_unfold_seam� файла установок
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рисунка. При установке ее в �yes�, стыки видны. При установке ее в �no�, система их
скрывает. Для обновления отображения вида после сброса опций установки файла
рисунка, выберите Regenerate View в меню View Pro/ENGINEER.

Пример: Развернутые Поперечные Сечения

Включение Геометрии Поверхности в Виды Поперечных Сечений

Поверхности включаются в поперечные сечения рисунка путем изменения значения �no�
опции "show_quilts_in_total_xsecs� файла установок на «yes». Исключение поверхности
производится изменением значения �yes� обратно в �no�.

Геометрия поверхности (поверхности и лоскутные поверхности) разрезаются плоскостью
поперечного сечения в виде рисунка только, когда поперечное сечение создается как
Model & Qlts или Surf/Quilt в режиме Детали или Сборки. Если поперечное сечение
создается как Модель (значение по умолчанию), геометрия поверхности не будет
разрезаться секущей плоскостью.
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Управление Видами
Используя команды в меню VIEWS, можно управлять видами несколькими способами:

· перемещать виды.

· Переносить виды на другой лист.

· Удалять виды.

· Связывать виды с объектами рисунка.

· Стирать и восстанавливать виды.

Перемещение Вида

Можно перемещать нулевую точку вида или любую точку вида в новое положение. Точка,
выбранная на виде, будет установлена в новое положение.

1. Выберите VIEWS > Move View. Отображаются границы всех видов, а также метки в
четырех углах границы и в нулевой точке.

2. Выберите точку на виде для перемещения. Появляется меню GET POINT.

Для перемещения нулевой точки или угла вида, выберите точку около метки вида. Для
перемещения другой точки вида, выберите точку на виде. Для точного перемещения,
используйте команды меню GET POINT (типа Rel Coords и Abs Coords) для определения
точных координат, смещения, объекта или вершины.

3. Выберите требуемое положение вида. Вид перемещается в выбранное место.

Если опция "allow_move_view_with_move" файла конфигурации установлена, команда
DETAIL > Move перемещает выбранную точку вида в указанное положение. Меню GET
POINT не доступно.

Перемещение Видов

При перемещении вида, с которого были сняты другие виды (родительский вид),
проецируемые виды (дочерние) также перемещаются для сохранения выравнивания вида.
Например, при перемещении вида спереди на следующем рисунке вертикально, вид
справа также переместится для сохранения выравнивания, потому что он проецировался с
вида спереди.

Вид спереди можно перемещать только вертикально, потому что он является дочерним по
отношению к виду сверху и должен сохранять с ним выравнивание. Такое выравнивание и
отношения родитель / потомок между проекциями видов сохраняются даже при изменении
модели. Можно перемещать основной и выносные виды в любое новое положение, потому
что они не являются проекциями других видов.

Используя меню GET POINT, можно точно скомпоновать рисунок для размещения видов.
Например, чтобы точно совместить один вид с другим общим видом, установите нулевую
точку вида, используя опцию Origin в меню MODIFY VIEW и меню GET POINT.При этом
устанавливается ссылочная точка для перемещения вида таким образом, чтобы можно
было легко размещать его в рисунке относительно другого вида.
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Пример: Перемещение Вида

Перенос Видов на Другой Лист

Виды рисунка можно перемещать с одного листа на другой, используя команду SWITCH
SHEET в меню SHEETS.

Удаление Вида

Для удаления видов в рисунке, используйте команду Delete View в меню VIEWS. Нельзя
удалять родительский вид, пока существуют его дочерние виды; необходимо сначала
удалить дочерние виды.

Связывание Выносных Элементов с Видом

Используя команду Relate View в меню VIEWS, можно связывать выносные элементы с
указанным видом в рисунке с несколькими моделями.

Стирание Вида

1. Выберите стираемый вид.

2. Удалите все стрелки или круги, связанные с видом (если они присутствуют).

3. Выберите CONFIRMATION > Confirm. Система стирает вид.
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Восстановление Стертого Вида (или Видов)

1. Выберите VIEWS > Resume View.

2. Выберите название вида в списке меню. Если требуется применить изменение ко всем
видам, выбирать Select all. Для отмены выбора всех видов, выберите Unsel All.
3. Выбранные виды выделяются голубой границей. Выберите Done Sel; виды появляются
вновь.

Обратите внимание: при переносе вида на другой лист и последующем стирании его, вид
можно восстановить на исходном или на текущем листе.

Стирание и Восстановление Видов

Можно стирать вид в рисунке без воздействия на другие виды, примечания или стрелки
поперечного сечения. Стирание и восстановление видов - эффективный метод для
уменьшения времени регенерации вида и перерисовки сложных рисунков.

Применяются следующие правила:

· если к стертому виду присоединены примечания или символы, система стирает выноски,
присоединенные к стертому виду. При восстановлении вида, выноски появляются вновь.

· Нельзя отображать размеры на других видах, если они показаны на стертом виде.

· При стирании родительского вида, содержащего выносной вид, который имеет местное
поперечное сечение области, система преобразует местное поперечное сечение в
выносном виде в полное поперечное сечение.

· При восстановлении вида, который был стерт на текущем листе, название вида
появляется в меню для выбора, и на листе появляется рамка вида.

· При восстановлении вида, который был стерт на другом листе, название вида появляется
в меню для выбора. Никакая рамка не появляется. Вид можно восстановить на другом
листе.

· Для управления отображением рамок стертых видов используется опция Highlight Erased
Views. Этой опцией можно управлять, используя опцию "highlight_erased_dwg_views"
файла конфигурации (значение по умолчанию - "yes").

· Границы и названия стертых видов на печать не выводятся.

Изменение Видов
Используя команды в меню VIEW MODIFY, можно выполнять следующие процедуры:

· переименовывать вид;

· изменять масштаб вида;

· переопределять виды, изменяя тип вида;

· изменять состояние вида обрабатываемой сборки;

· сбрасывать нулевую точку вида;

· изменять выравнивание вида;

· изменять или повторно создавать границы вида;

· изменять расстояния разнесения покомпонентных изображений;
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· скрывать всю графику за указанной плоскостью, используя Z-Clipping;

· изменять, удалять или заменять поперечные сечения вида;

· изменять штриховку.

Кроме того, используя команду Disp Mode в меню VIEWS, можно изменять режим
визуального отображения различными способами.

Переименование Вида

Используя команду View Name в меню VIEW MODIFY можно изменять имя вида в сессии.

1. Выберите VIEWS > Modify View > View Name.

2. Выберите переименовываемый вид.

3. Введите новое имя.

Изменение Типа Вида

1. Выберите VIEW MODIFY > View Type.

2. Выберите переопределяемый вид рисунка.

3. Выберите команды из меню VIEW TYPE. (Если вид является поперечным сечением,
появляется меню XSEC TYPE со всеми текущими подсвеченными командами. Затем
можно выбирать команды в верхней половине меню, а также из Area Xsec, Total Align и
Total Xsec).

4. После проведения всех необходимых изменений в виде, система его перерисовывает.
Если основной вид был изменен на проецируемый или вспомогательный, система
подсвечивает все виды, на которые может повлиять это изменение, и необходимо указать,
требуется ли переориентация вида. Если вид не нужно переориентировать, он остается
основным.

При определении или переопределении проецируемых или вспомогательных видов,
учитывайте следующее:

− для проецируемого вида, необходимо выбрать его родительский вид. Для
вспомогательного вида, необходимо выбрать грань или ось в качестве ссылочных, как
при создании вида.

− При преобразовании проецируемого или вспомогательного вида в основной,
переориентировать вид не требуется. Вместо этого, система копирует информацию об
ориентации из родительского вида.

Изменение Типов Вида

Используя команду View Type в меню VIEW MODIFY, можно переопределять виды рисунка
следующими способами:

− Изменять тип ориентации вида в следующих пределах:

•  проецируемый, вспомогательный и основной.

•  Полный, половинный и частичный.

− Изменять тип ориентации вида в следующих пределах:

•  полное поперечное сечение и поперечное сечение области.
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•  Масштабируемый и не масштабируемый.

•  Разнесенный и неразнесенный

При переопределении вида, накладываются следующие ограничения:

− Нельзя переопределять виды, которые определены как Detailed, Of Flat Ply и Copy &
Align.

− Нельзя переопределять проекцию вида на вид с разрывом.

− Нельзя изменять следующие типы вида на вид того же типа, но показывающий другую
часть модели:

•  вид с разрывом.

•  Вид с перспективой.

•  Вид по поверхности.

•  Повернутый вид (единственное допускаемое изменение для этого типа вида � с
частичного на полный, или с разнесенного на не разнесенный).

•  Вид с полным развернутым поперечным сечением.

•  Вид с развернутым поперечным сечением области.

•  Выровненный вид.

Пример: Изменение Типа Вида

Изменение Состояния Вида

Используя команду View State в меню VIEW MODIFY, можно изменять виды сборочных
чертежей, а также видов рисунка Pro/PROCESS for ASSEMBLIES или Pro/PROCESS for
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MANUFACTURING, следующими способами:

· изменять состояние обработки;

· изменять упрощенное представление;

· заменять упрощенное представление.

Можно также использовать команду View State для изменения упрощенного
представления модели вида рисунка

Обратите внимание: команда View State доступна только при работе с видом состояния
обработки или моделями упрощенного представления.

Сброс Начала Координат Вида

1. Выберите VIEW MODIFY > Origin > On Item.

2. Выберите вид.

3. Выберите точку, обозначающую начало координат вида. Используйте команды в меню
GET SELECT, в случае необходимости.

Обратите внимание: если геометрия, на которую ссылается вид подавлена или удалена,
система предупредит, что геометрия модели отсутствует. Для видов, ориентируемых по
подавленным или удаленным ссылкам, вид возвращается в свою ориентацию по
умолчанию.

4. После установки начала координат вида, переходите к установке начала координат
другого вида.

Сброс Начала Координат

По умолчанию, начальная точка вида рисунка находится в центре его контура. Используя
команды ORIGIN в меню VIEW MODIFY, можно сбрасывать начало координат вида рисунка
путем параметрической ссылки на геометрию модели. При этом выбранная геометрия
присоединяется к своему текущему положению в рисунке, что предотвращает ее от
смещения при изменении геометрии модели.

Можно сбрасывать начальную точку основного, вспомогательного и вида с разрывом в
любой момент после их создания, при этом текущее положение вида не изменяется. Новая
начальная точка действует только, когда система обновляет виды для отображения
изменений в геометрии модели. Однако, если сбрасывается начальная точка
перспективного вида, текущее положение вида изменяется, потому что начало координат
вида является частью ориентации.

Обратите внимание: нельзя изменять начальную точку полного развернутого поперечного
сечения.

Для выбора точки в качестве начальной, можно выбирать кромку модели, опорную кривую,
опорную точку, систему координат или косметический элемент. Однако, при выборе точки,
учитывайте следующее:

· для основного вида, выбранная точка становится фиксированной (fixed).

· Для проекции и вспомогательного вида, система проецирует выбранную точку на луч,
проходящий через начальную точку родительского вида в направлении проецирования.
Эта проецируемая точка становится началом координат вида.

· Для выбора системы координат в качестве начала координат последнего созданного вида
или измененного вида, определите его название как значение опции
"drawing_view_origin_csys" файла конфигурации. Если не требуется, чтобы система
использовала предварительно установленную систему координат, определите значение
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как «no».

Совет: Сброс Начальной Точки Видов с Разрывом

Можно устанавливать начальную точку вида с разрывом для любого из его компонентов,
используя тот же метод, который используется при установке начальной точки основного,
проекционного или вспомогательного вида. Новая установленная начальная точка
становится начальной для всех компонентов. Ее можно сбросить в любой момент, выбирая
At Center в меню VIEW ORIGIN. Если вид с разрывом не имеет начала координат, центр
вида по умолчанию находится в центре трехмерной модели в первом виде с разрывом.

Пример: Обновление Видов в Зависимости от их Нулевых Точек

Выравнивание Вида

1. Нажмите VIEWS > Modify View > Alignment > Align View.

2. Выберите выравниваемый вид.

3. Выберите вид, по которому требуется выровнять подсвеченный вид. Вид можно
выравнивать вертикально или горизонтально.

4. После выбора вида по которому требуется выравниваться, первый выбранный вид
привязывается к его новому положению и выравнивается по второму виду.

Обратите внимание: вид остается выровненным и перемещается подобно проекции вида,
пока выравнивание не будет снято.

Снятие Выравнивания с Вида

1. Нажмите, VIEWS > Modify View > Alignment > Unalign View.

2. Выберите вид для снятия выравнивания.
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3. Нажмите Done Sel или среднюю кнопку мыши. Вид больше не выровнен ни по какому
другому виду.

Изменение Выравнивания Вида

1. Нажмите, VIEWS > Modify View > Alignment > Modify Align.
2. Выберите изменяемый вид. Нажмите Confirm.

3. Нажмите Parent или Child для определения точки выравнивания по родителю или
потомку.

•  Нажмите Origin для задания начальной точкой вида в качестве точки выравнивания.

•  Нажмите Selection для выбора в виде точки выравнивания.

4. Дочерний вид привязывается к своему новому местоположению, используя новую точку
выравнивания.

Обратите внимание: если выбранный вид является родителем/потомком по отношению к
другим видам, вся связанные виды подсвечиваются синим цветом и также могут
перемещаться при изменении выравнивания.

Изменение Границ

Можно изменять внешние границы выносных, частичных и видов с разрывом, перемещая
их ссылочные точки. Можно также повторно создавать границы вида.

Изменение Ссылочной Точки

1. Выберите VIEWS > Modify View > Ref Point.
2. Выберите изменяемый вид.

3. Система подсвечивает ссылочную точку красным цветом. Выберите для нее новое
положение:

•  для выносного вида, выберите родительский вид.

•  Для частичного вида, выберите вид внутри границы разрыва. Если требуется выбрать
точку вне границ вида, сначала измените разрыв.

•  Для вида с разрывом, переназначьте ссылочную точку для каждой стороны вида.

Повторное Создание Границ Выносного вида

1. Выберите VIEWS > Modify View > Boundary.

2. Выберите выносной вид.

3. Выберите VIEW BNDRY > Mod Breakout.

Стирание или Отображение Внешней Границы

1. Выберите VIEWS > Modify View > Boundary.

2. Выберите выносной или частичный вид.
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3. Выберите Erase Outer или Show Outer; затем выберите VIEW BNDRY > Done. Система
обновляет вид.

Обратите внимание: нельзя отображать или стирать границу выносного или частичного
местного поперечного сечения.

Для Исключения Геометрии Модели, Находящейся за Указанной
Плоскостью

1. Выберите VIEWS > Modify View > Clipping.

2. Выберите вид.

Обратите внимание: нельзя выполнять Z-отсечение для следующих типов видов:
развернутых поперечных сечений, поперечных сечений области, разнесенных и
перспективных.

3. Выберите Z CLIPPING > Add/Change.
4. Для ссылочной точки, выберите кромку, поверхность или опорную плоскость
параллельную виду. Ее можно размещать в любом виде. Ссылочная точка отображается
сиреневым цветом в выбранном виде и в любой из его проекций или вспомогательных
видах (если выбранный вид является проекцией или вспомогательным видом, контрольная
точка отображается сиреневым цветом в основном виде).

Вся геометрия за указанной плоскостью отсечения по Z скрывается, но любая геометрия,
полностью находящаяся в плоскости, отображается. Система отсекает геометрию, которая
пересекается плоскостью. Отображается только геометрия, находящаяся перед
плоскостью.

Исключение Геометрии Модели, Находящейся за Указанной
Плоскостью

При наличии лицензии Pro/DETAIL, можно указать плоскость, плоскостью отсечения по Z.
При выполнении Z-отсечения в виде, учитывайте следующее:

· если система не может регенерировать ссылку для плоскости отсечения, Z-отсечение не
действует в виде (появляется сообщение об ошибках).

· Z-отсечение выносного вида - всегда соответствует таковому его родителя. Нельзя
изменять его индивидуально.
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Пример: Исключение Геометрии Модели, Находящейся за
Указанной Плоскостью
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Определение Масштаба Вида

Определение Масштаба

При создании вида, можно определить независимый масштаб или предопределенное
значение масштаба. Для создания вида с независимым значением масштаба,
отображаемым под видом, выберите Scale из меню VIEW TYPE. Для создания
масштабируемого вида с заданным по умолчанию масштабом, отображаемым в левом
нижнем углу экрана, используйте команду No Scale. Установка опции "default_draw_scale"
файла конфигурации управляет начальной установкой заданного по умолчанию масштаба;
иначе, система выбирает его на основании размера модели.

Изменение Масштаба
После создания вида, можно изменять масштаб рисунка и, собственно, масштаба вида.
Для отображения или стирания примечания масштаба вида, используйте диалоговое окно
Show/Erase.

Изменение Масштаба Рисунка

1. Выберите DETAIL > Modify.

2. Выберите параметр Scale, выбирая значение параметра.

3. Введите новое значение масштаба рисунка. Все виды активного рисунка модели, за
исключением детального и масштабированного видов, изменяют размер в соответствии с
новым значением масштаба.

Масштаб Рисунка

Нельзя изменять значение масштаба до выхода из меню DRAW VIEW. В режиме Рисунка,
параметр масштаба рисунка, отображаемый в левом нижнем угле основного окна,
управляет масштабом видов (кроме выносных и масштабируемых видов). Параметр
представляет собой отношение масштаба рисунка к масштабу модели. Например, при
значении 0.25, Pro/ENGINEER масштабирует виды рисунка на 1/4 от фактического размера
модели.

Изменение Масштаба Вида

1. Выберите масштабируемый вид.

2. Введите новое значение масштаба. Система изменяет масштаб вида и регенерирует его
изображение.

Масштаб Вида

Используя команду Change Scale в меню VIEW MODIFY, можно изменять масштаб вида.
Однако, если родительский вид проекции вида - масштабируемый вид, то эту команду
нельзя использовать для изменения масштаба проекции вида.
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Пример: Изменение Масштаба Вида

Изменение Поперечных сечений
Используя команды в меню VIEW MODIFY, можно изменять поперечные сечения
следующими способами:

· изменять ссылочные точки местного поперечного сечения в проекции или основном виде.

· Изменять границу местного поперечного сечения в проекции или основном виде.

· Создавать полное поперечное сечение при удалении разрыва.

· Изменять частичный вид с местным поперечным сечением.

· Изменять вид с разрывом с местным поперечным сечением.

· Удалять или заменять поперечное сечение.

· Зеркально отображать полное поперечное сечение.

Используя команды меню DETAIL, можно также отображать установленные опорные
плоскости в поперечных сечениях области и перемещать стрелки или текст поперечного
сечения. Для переопределения стороны и направления ступенчатых поперечных сечений,
можно использовать меню XSEC MODIFY.
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Изменение Ссылочных Точек Местного Поперечного Сечения

1. Выберите VIEWS > Modify View > Ref Point.
2. Выберите проекцию или основной вид. Система подсвечивает границы и ссылочные
точки местных поперечных сечений.

3. Выберите ссылочную точку и переместите ее.

4. Можно продолжать изменять другие местные области. По завершении, выберите EXIT >
Done.

Изменение Границы Местного Поперечного Сечения

1. Выберите VIEWS > Modify View > Boundary.

2. Выберите проекцию или основной вид. Система подсвечивает границы и ссылочные
точки местных поперечных сечений.

3. Выберите VIEW BNDRY > Mod Breakout.
4. Выберите границу и повторно создайте ее.

5. По завершении, выберите VIEW BNDRY > Done.

Создание Полного Поперечного Сечение При Удалении Разрыва

1. Выберите VIEWS > Modify View > Boundary > Del Breakout.
2. Выберите разрыв. Если это последний разрыв, укажите, следует ли сделать его полным
поперечным сечением.

3. При вводе [yes], система создает полное поперечное сечение. По завершении, выберите
VIEW BNDRY > Done.

Изменение Частичного Вида с Местными Поперечными
Сечениями

1. Выберите VIEWS > Modify View > Boundary.

2. Выберите частичный вид.

3. Используя команды в меню VIEW BNDRY, сделайте следующее:

•  Повторно создайте сплайновую границу местного поперечного сечения, выбирая Mod
Breakout.

•  Переместите ссылочную точку местного поперечного сечения, выбирая Move Ref Pnt.

•  Добавьте новое местное поперечное сечение, выбирая Add Breakout.

•  Удалите местное поперечное сечение, выбирая Del Breakout.
4. По завершении, выберите VIEW BNDRY > Done.

Изменение Ссылочных Точек Вида с Разрывом

1. Выберите VIEWS > Modify View > Ref Point, и выберите вид с разрывом.
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2. Сделайте следующее:

•  Для изменения ссылочных точек местных поперечных сечений, перейдите к Шагу 5.

•  Для изменения ссылочных точек внешних границ вида с разрывом, выберите MOD REF
POINT > View Break. Система отображает текущие ссылочные точки.

3. Выберите переопределяемую ссылочную точку и определите новое местоположение.
Сделайте то же самое для всех других ссылочных точек, которые требуется изменить.

4. После определения новых мест, выберите GET SELECT > Done и EXIT > Done. Система
обновляет вид.

5. Для изменения ссылочных точек местных поперечных сечений на виде с разрывом,
выберите MOD REF POINT > Breakout.
Обратите внимание: половинные виды не могут иметь разрывов. При выборе Half для
вида, который имеет разрывы, система удаляет их после выбора Done.

6. Введите [Y], чтобы временно полностью отобразить вид с разрывом. Отображаются
текущие ссылочные точки.

7. Выберите ссылочную точку и укажите ее новое местоположение.

8. После изменения вида, выберите EXIT > Done.

Изменение Граничных или Местных Поперечных Сечений Вида с
Разрывом

1. Выберите VIEWS > Modify View > Boundary.

2. Выберите изменяемый вид.

3. Для изменения местного поперечного сечения, перейдите к Шагу 6. Для изменения
внешних границ, выберите BROKEN VIEW > View Break.

4. Выберите линии, которые совместно используют одни и те же сплайны; затем выберите
Done Sel.
5. Повторно создайте сплайн; затем выберите EXIT > Done.

6. Для изменения местного поперечного сечения на виде с разрывом, выберите BROKEN
VIEW > Breakout.
7. Введите [Y], чтобы временно полностью отобразить вид с разрывом.

8. Выберите VIEW BNDRY > Mod Breakout и выберите границу. Повторно нарисуйте ее;
затем выберите Done.

Удаление или Замена Поперечного Сечения Вида

1. Выберите VIEW MODIFY > X-Section.

2. Выберите удаляемый или изменяемый вид рисунка, который содержит поперечное
сечение.

3. Выберите часть поперечного сечения вида, как если бы требовалось изменить
штриховку (если вид является поперечным сечением с разрывом, щелчок по разрыву
выбирает его сечение; щелчок в виде, но вне какого либо разрыва, выбирает внешнее
поперечное сечение).

4. Выберите команду в меню XSEC ENTER:

•  При выборе Create для создания нового поперечного сечения, необходимо выбрать
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вид для отображения стрелок, если они еще не показаны. Если одно и то же
поперечное сечение повторно отображается в нескольких разрывах, новое поперечное
сечение заменяет старое во всех его разрывах. (Нельзя переназначать только
некоторые из разрывов из одного поперечного сечения в другое. Для этого используйте
команду Boundary и удалите или повторно создайте разрыв.)

•  При выборе Retrieve и вызове того же поперечного сечения, которое является плоским
поперечным сечением, система сбрасывает направление обзора поперечного сечения.

•  При выборе Retrieve и вызове ступенчатого поперечного сечения, выберите Flip или
Okay.

•  При выборе None, система удаляет выбранное поперечное сечение и все его разрывы
из вида и его выносных дочерних элементов.

Система обновляет вид, и все выносные элементы появляются вновь.

Обратите внимание: при регенерации поперечного сечения в рисунке, когда добавляется
или удаляется геометрия модели, создаются новые кромки в рисунке, на которые можно
ссылаться. Поскольку эти кромки добавлены на постоянной основе к системе, модель
изменяется, когда эти кромки создаются первый раз. Поперечное сечение принадлежит
модели.

Зеркальное Отображение Полного Поперечного Сечения

Используя команду Flip в меню XSEC ENTER, можно зеркально отображать полное
поперечное сечение для сохранения противоположной половины вырезанной детали. Эта
команда является модальной, если требуется зеркально отобразить другое полное
поперечное сечение, можно немедленно выбрать другой вид. Для замены поперечного
сечения другим, выберите Replace из меню XSEC ENTER. Команда Flip переключает -
между одной стороной модели и другой - часть модели, удаленной вырезом поперечного
сечения. Стрелки поперечного сечения, которые появляются на перпендикулярном виде,
также зеркально отображаются. Они переворачиваются потому, что стрелки поперечного
сечения всегда указывают на ту часть модели, которая остается после использования
поперечного сечения для удаления материала из вида модели.

Обратите внимание: использование команды Flip не изменяет ориентации модели в виде.
Зеркально отображается только поперечное сечение. Необходимо выбрать Reorient в
меню VIEW MODIFY для создания новой ориентации вида для поперечного сечения.

Пример: Зеркальное Отражение Полного Поперечного Сечения
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Удаление Поперечного Сечения из Модели

Используя команду Delete в меню MOD VW XSEC, можно удалять поперечное сечение из
модели без необходимости вызывать модель.

1. Выберите VIEWS > Modify View > X-Section > Delete.

2. Из меню DRAW MODELS выберите название модели для удаления поперечного
сечения.

3. Из меню XSEC NAMES выберите название удаляемого поперечного сечения.
Поперечное сечение удаляется из модели.

Примечания:

•  Нельзя удалять поперечное сечение, если оно используется рисунком в сессии.

•  Удаление поперечного сечения в рисунке также удаляет его в других рисунках.

Переименование Поперечного Сечение в Режиме Рисунка

Используя команду Rename в меню MOD VW XSEC, можно переименовывать поперечное
сечение, используемое в настоящее время в рисунке без необходимости перехода в режим
Детали или Сборки для вызова модели.

1. Выберите VIEWS > Modify View > X-Section > Rename.

2. Выберите вид, который содержит переименовываемое поперечное сечение и введите
новое имя.

Система обновляет название поперечного сечения в текущем рисунке, в модели, которая
содержит поперечное сечение и во всех рисунках, которые используют поперечное
сечение.

Отображение Поперечного Сечения Опорных Плоскостей

Используя команду Show/Erase в меню DETAIL, можно отображать установленные
опорные плоскости в поперечных сечениях области. Установленные опорные элементы,
которые отображаются таким образом, ведут себя аналогично элементам в других видах;
над ними можно выполнять все стандартные операции, включая образмеривание.

Для Перемещения Стрелок Поперечного Сечения или Текста

1. Выберите DETAIL > Move.

2. Сделайте следующее:

•  выберите текст для перемещения независимо от стрелок.

•  Выберите стрелку для перемещения стрелки и текста вместе, независимо от другой
стрелки поперечного сечения.

•  Выберите линию стрелки для одновременного перемещения стрелок.

3. Выберите новое положение для стрелки. Используйте левую кнопку мыши для
завершения перемещения стрелки
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Перемещение Стрелок Поперечного Сечения или Текста

При наличии лицензии Pro/DETAIL, можно использовать опцию Move в меню DETAIL для
перемещения стрелки или текста поперечного сечения. При выборе стрелки поперечного
сечения, ее можно перемещать независимо от другой стрелки. Для одновременного
перемещения стрелок, выберите линию стрелки. Для изменения текста поперечного
сечения, измените название поперечного сечения в режиме Детали или Сборки.

Изменение Текста Поперечного Сечения

1. Выберите DETAIL > Modify > Text > Text Style.

2. Выберите какое либо из названий поперечного сечения.

3. В диалоговом окне Text Style, снимите флажок Use Default для Height, и введите новое
значение.

4. Снимите флажок Use Default, включите Width Factor и введите новое значение.

5. Щелкните по Apply. Высота и ширина выбранного элемента будет изменена.

6. Для возврата текста к старому стилю, нажмите Reset > Apply.

Обратите внимание: для отображения или стирания названия поперечного сечения,
используйте диалоговое окно Show/Erase.

Управление Отображением Линий Сечения

Отображением линии сечения в поперечном сечении можно управлять, устанавливая
следующие опции файла установок рисунка:

· "cutting_line" - определяет стандарт (ANSI, ISO) для отображения линии сечения.

· "cutting_line_adapt" - устанавливает отображение всех line fonts, используемых для
отображения поперечных сечений приспособленных таким образом, чтобы они начались в
середине полного сегмента линии и заканчивались в середине полного сегмента линии.

· "cutting_line_segment" - управляет длиной утолщенной части линии сечения.

Переопределение Ступенчатого Поперечного Сечения

Можно переопределять сторону и направление ломаных поперечных сечений, используя
команду Redefine в меню XSEC MODIFY в режиме Детали или Сборки, но не в режиме
Рисунка.

1. Выберите X-Section и Modify Xsec.

2. Выберите название поперечного сечения из меню XSEC NAMES.

3. Выберите XSEC MODIFY > Redefine и одну из следующих команд в меню REDEFINE:

•  Attributes - переопределяет поперечное сечение с одной или обеих сторон.

•  Direction - переопределяет направление.

•  Section - переопределяет поперечное сечение ломаного поперечного сечения.

•  Scheme - переопределяет схему ломаного поперечного сечения



Pro/ENGINEER 2000 i2 Pro/DETAIL Выпуск Документации

 - 127 -

Изменение Штриховки
Используя команду Xhatching в меню MODIFY DRAW, можно изменять штриховку
выносных видов и отдельных компонентов в поперечных сечениях сборки.

· Поперечные Сечения Сборки - при изменении поперечного сечения сборки, можно
изменять отдельные компоненты сборки, пересеченных поперечным сечением.

· Выносные Виды - штриховка выносного вида, может повторять штриховку его
родительского вида, или можно делать выносной вид независимым от его родителя. Для
изменения штриховки выносного вида, необходимо сделать выносной вид независимым от
его родителя, используя команду Det Indep в меню MOD XHATCH.

Обратите внимание: при наложении штриховок в рисунке (какая либо комбинация
заштрихованных косметических элементов, поперечных сечений или эскизных поперечных
сечений), выберите Query Sel в меню GET SELECT для выбора и изменения штриховки.

Использование Интеллектуальной Штриховки по Умолчанию
При создании поперечного сечения сборки, система автоматически применяет
«интеллектуальную» (�smart�) штриховку к детали, которая обеспечивает улучшенное
визуальное отображение поперечного сечения. Интеллектуальная штриховка использует
интервал штриховки, соответствующий размеру модели и назначает различные углы
штриховки различным деталям в сборке. Интеллектуальная штриховка использует
случайный угол штриховки между смежными компонентами, облегчая возможность
различения деталей в сборочных чертежах и сокращает время, необходимое для очистки
рисунка с поперечными сечениями и штриховкой.

Используются следующие правила:

· интеллектуальная штриховка по умолчанию влияет только на новые поперечные сечения.
При вызове ранее сохраненных рисунков, интеллектуальная штриховка не действует.

· Для поперечных сечений сборки, интеллектуальная штриховка по умолчанию изменяет
интервал и угол. Для поперечных сечений детали, интеллектуальная штриховка по
умолчанию изменяет только интервал. По умолчанию, для деталей используется угол 45
градусов.

· для изменения параметров интеллектуальной штриховки по умолчанию для вновь
создаваемых поперечных сечений, определите параметры поперечного сечения
"default_xhatch_spacing" и "default_xhatch_angle". Поперечные сечения других смежных
деталей, которые не определены, будут изменены соответственно.

· Интеллектуальная штриховка по умолчанию не будет применяться после изменения ее
параметров, пока не будет создан новый вид.

· Изменения, сделанные в режиме Рисунка, не отображаются в режиме Детали или Сборки.
Изменения автоматически изменяют интеллектуальную штриховку по умолчанию в
рисунке.

Управление Интервалом и Углом Штриховки с Использованием
Параметров

Устанавливая параметры, можно управлять интервалом и углом штриховки по умолчанию
в новых созданных плоских и ступенчатых поперечных сечениях. Для управления
отображением, установите численные параметры "default_xhatch_spacing" и
"default_xhatch_angle" используя меню SETUP или меню RELATIONS. Эти параметры
влияют только на новые поперечные сечения; они не затрагивают ранее созданные в
детали или сборке поперечные сечения.
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Изменение Характеристик Штриховки

1. Выберите Modify > Xhatching.

2. Выберите изменяемые поперечные сечения.

3. Используя меню MOD XHATCH, сделайте следующее:

•  Измените интервал. Выберите Spacing; затем выберите Half, Double или Value из
меню MODIFY MODE. Определите изменяемые линии, выбирая Individual или Overall.
Система автоматически масштабирует смещение штриховки и интервал, согласно
выбранной команде для интервала.

•  Измените угол. Выберите Angle; затем выберите Individual или Overall из меню
MODIFY MODE. Система изменяет только первую линию штриховки. Выберите угол (0,
30, 45, 60, 90, 120, 135, 150) или Value для указания другого угла.

•  Измените смещение. Выберите Offset; затем введите значение смещения в единицах
рисунка.

•  Измените тип линии. Выберите Line Style; затем используйте диалоговое окно line
Style для изменения типа линии.

Измените линии штриховки. Выберите Next Line и Prev Line и выберите линию штриховки;
затем выберите Add Line или Delete Line.

Обратите внимание: также можно изменять характеристики штриховки для косметических
элементов и замкнутых опорных кривых.

Изменение Характеристик Штриховки

Можно изменять следующие характеристики штриховки, создавать заполненную область и
вызвать или сохранять штриховку:

· интервал (spacing);

· угол (angle);

· смещение (offset);

· тип линии (line style);

· число линий (number of lines).
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Пример: Характеристики Штриховки

Для Создания Заполненного Поперечного Сечения

1. Выберите MODIFY DRAW > Xhatching.

2. Выберите поперечное сечение.

3. Выберите MOD XHATCH > Fill > Done.

4. После определения поперечного сечения как заполненного, можно использовать Line
Style для установки соответствующего цвета заполненной области, или Save для
сохранения ее на диск с расширением ".xch". Позже, можно использовать Retrieve для
вызова ее, как сохраненного образца штриховки.

Создание Заполненной Области

Можно отображать поперечные сечения рисунка как заполненные области (то есть
отображать цветом solid), изменяя штриховку для заполнения; но сначала необходимо
создать поперечное сечение. Для переключения между заштрихованным и заполненным
поперечным сечением, используйте команды Hatch и Fill в меню MOD XHATCH.

При создании заполненного поперечного сечения, учитывайте следующие правила:

· заполненные поперечные сечения можно создавать только в видах без отсечения
(clipping). При попытке изменения штриховки обрезанных видов (типа выносного или вида с
разрывом), система выдает сообщение об ошибках и не позволяет продолжать.
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· Если поперечное сечение, которое требуется заполнить, имеет выносные виды, система
предупредит, что этот вид имеет дочерние виды перед продолжением. Выносной вид
появляется без какой либо или со штриховкой или заполнением. Затем можно установить
его штриховку независимой от родителя.

· Можно изменять только плоские поперечные сечения для заполнения.

Для Сохранение Образца Штриховки

1. Выберите MODIFY DRAW > Xhatching.

2. Выберите вид, содержащий образец штриховки, который требуется сохранить. Для
поперечного сечения сборки могут потребоваться команды Next Xsec или Prev Xsec в
меню MOD XHATCH для выбора компонента.

3. Выберите Save.

4. Введите название для образца штриховки.

5. Если опция "pro_crosshatch_dir" файла конфигурации не установлена, система сохраняет
образец штриховки в текущем каталоге, присваивая ему указанное имя и расширение
".xch". Если требуется сохранить образец в отдельный каталог, содержащий образцы
штриховки, необходимо сначала сохранить образец и, затем, переместить его в новое
место, используя команды операционной системы.

Сохранение Образца Штриховки

Штриховке можно назначать имя, копировать и сохранять ее для дальнейшей работы,
используя опцию "pro_crosshatch_dir" файла конфигурации для указания основного
каталога образцов штриховки. Значением является полный путь каталога по умолчанию.

Вызов Образца Штриховки

1. Выберите MODIFY DRAW > Xhatching; затем выберите изменяемое поперечное
сечение.

2. Выберите MOD XHATCH > Retrieve.

Pro/ENGINEER ищет в текущем каталоге по пути, указанном в опции"pro_crosshatch_dir"
файла конфигурации и системном каталоге. Затем, он отображает меню, содержащее
названия всех образцов штриховки в текущем каталоге, всех образцов штриховки в
заданном по умолчанию каталоге штриховок и девять стандартных образцов штриховки,
поставляемых с Pro/DETAIL.

Обратите внимание: выбранный образец штриховки заменяет текущую штриховку вида
(или компонента сборки). При изменении типа штриховки в рисунке, модель не изменяется;
при изменении штриховки в модели, ее рисунки также не отображают этих изменений.
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Пример: Образцы Штриховки

Изменение Отображения Компонента Сборки в Поперечном
Сечении

1. Выберите MODIFY DRAW > Xhatching. Выберите изменяемое поперечное сечение.

2. Выберите соответствующе поперечное сечение компонента сборки, используя Next
Xsec, Prev Xsec или Pick Xsec.

3. Выберите Excl Comp для удаления компонента или выберите Restore Comp для
восстановления исключенного компонента. Система отображает поверхности компонента,
который был исключен из поперечного сечения так, как если бы он находился в виде без
поперечного сечения, пока исключенный компонент не станет частью поперечного сечения
области. При исключении компонента из поперечного сечения области, он полностью
исчезает.

Обратите внимание: на штриховку не влияет HLR (удаление срытых линий примечание
переводчика) и она, поэтому, не скрывается исключенными компонентами.
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Изменение Поперечных Сечений Сборки

При изменении поперечного сечения сборки, меню MOD XHATCH отображает пять
дополнительных команд: Excl Comp, Restore Comp, Next Xsec, Prev Xsec и Pick Xsec.

· Используя Excl Comp и Restore Comp, соответственно, можно исключать компоненты
поперечного сечения сборки или восстанавливать их в поперечном сечении.

· Используя Next Xsec и Prev Xsec, можно перемещаться по всем компонентам.

· Используя Pick Xsec, можно выбирать непосредственно в графическом окне вместо
перебора через все компоненты (эта команда доступна также при изменении штриховки в
режиме Сборки).

Изменение Режима Визуального
Отображения
Используя команду Disp Mode в меню VIEWS, можно изменять режим визуального
отображения (Hidden Line, Wireframe, No Hidden) отдельного вида, кромки или
компонента сборки.

Опция �hlr_for_quilts� файла конфигурации управляет тем, как система отображает
лоскутные поверхности в процессе удаления невидимых линий. Если она установлена в
�yes�, система включает лоскутные поверхности в процесс удаления невидимых линий.
Если опция установлена в "no�, система не включает лоскутные поверхности в процесс
удаления невидимых линий.

Изменение Режима Визуального Отображения Индивидуальных
Видов

1. Выберите VIEWS > Disp Mode > View Disp.

2. Выберите изменяемые виды; затем выберите Done Sel.
3. В меню VIEW DISP, выберите следующее:

•  Wireframe � устанавливает каркасный режим визуального отображения.

•  Hidden Line - устанавливает режим визуального отображения в скрытых линиях.

•  No Hidden - устанавливает режим визуального отображения в состояние без скрытых
линий.

•  Default - устанавливает режим визуального отображения в соответствии с установкой в
диалоговом окне Environment.

•  Qlt HLR - включает лоскутные поверхности в процесс удаления невидимых линий
(кроме поперечных сечений).

•  No Qlt HLR - исключает лоскутные поверхности из процесса удаления невидимых
линий во всех видах (кроме поперечных сечений).

•  Tan Solid � отображает касательные кромки.

•  No Disp Tan � выключает отображение касательных кромок.

•  Tan Ctrln � отображает касательные кромки шрифтом centerline.
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•  Tan Phantom - отображает касательные кромки шрифтом phantom.

•  Tan Dimmed - отображает касательные кромки серым цветом.

•  Tan Default � устанавливает отображение в соответствии с установкой в диалоговом
окне Environment

4. Выберите Done. Система обновляет выбранные виды.

Обратите внимание: после установки режима визуального отображения для указанного
вида, он остается установленным независимо от установки в диалоговом окне
Environment, если не будет выбрано Default в меню VIEW DISP.

Отключение Выбора Кромок No Hidden в Рисунках

В сложных моделях, иногда трудно найти требуемую кромку, которую необходимо выбрать.
В режиме визуального отображения No Hidden, можно отключать выбор кромок в рисунках
при использовании Query Select.
Опция "select_hidden_edges_in_dwg� файла конфигурации дает возможность отключать
выбор кромок No Hidden (н е  с к р ы т ы х  примечание переводчика) в рисунках. Эта опция
файла конфигурации отключает выбор кромок No Hidden, игнорируя кромки, находящиеся
за первой поверхностью в плоскости просмотра. Применяются следующие требования:

· выбор игнорируется для видов рисунка только в режиме визуального отображения No
Hidden.

· Для поперечных разрезов требуется регенерация вида.

· Можно отключать выбор кромок в основных видах поперечных сечений.

Изменение Отображения Выносного Вида

1. Выберите DISP MODE > View Disp.

2. Выберите выносной вид на экране; затем выберите Done Sel.
3. Выберите View Disp > Det Indep.

4. Выберите Select для соответствующих условий; затем выберите Done.

Управление Отображением Выносных Видов

После создания выносного вида, независимого от его родителя, можно определить круг
выносного вида, а также изменить тип объекта вокруг родительского вида.

Определение Круга, Представляющего Выносной Вид

1. Выберите VIEW TYPE > Detailed.

2. Выберите вид.

3. Используя команду в меню BOUNDARY TYPE, создайте сплайн вокруг области, которую
требуется вынести:

•  Circle � рисует круг в родительском виде для выносного вида. Создает примечание в
родительском виде, присоединенное к выбранному граничному объекту и размещает
другое примечание ниже выносного вида.

•  Ellipse � рисует эллипс в родительском виде для выносного вида, напоминающий
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сплайн, и запрашивает выбрать точку присоединения примечания вида к эллипсу.

•  H/V Ellipse � рисует эллипс с горизонтальной или вертикальной главной осью и
запрашивает выбрать точку присоединения примечания вида к эллипсу.

•  Spline - отображает фактическую сплайновую границу на родительском виде для
выносного вида и запрашивает выбрать точку присоединения примечания вида к
эллипсу.

4. Родительский вид появляется с указанной границей. При создании эллипса или сплайна,
можно изменять точку присоединения, выбирая DETAIL > Mod Attach.

Изменение Типа Объекта Описывающего Родительский Вид

1. Выберите VIEWS > Modify View > Boundary.

2. Выберите выносной вид.

3. Из меню VIEW BNDRY, выберите следующее:

•  Circle � рисует круг в родительском виде для выносного вида. Создает примечание
выносного элемента в родительском виде, присоединенное к выбранному граничному
объекту и размещает другое примечание под выносным видом.

•  Ellipse � рисует эллипс в родительском виде для выносного вида, напоминающий
сплайн и запрашивает выбрать точку присоединения примечания вида к эллипсу.

•  H/V Ellipse � рисует эллипс с горизонтальной или вертикальной главной осью и
запрашивает выбрать точку присоединения примечания вида к эллипсу.

•  Spline - отображает фактическую сплайновую границу на родительском виде для
выносного вида и запрашивает выбрать точку присоединения примечания вида к
эллипсу.

Система изменяет объект вокруг родительского вид, как указано.

Изменение Отображение Кромки Выносных Видов

Если отображение кромки выносного вида соответствует таковой его родительского вида,
нельзя использовать команду Edge Disp в меню DISP MODE для изменения вида
независимо от родителя. Для изменения отображения кромки выносного вида, выберите
Edge Disp и укажите родительский вид. Необходимо выбрать Regen View из меню View
Pro/ENGINEER (но не команду Repaint) для корректного обновления отображения
выносного вида после изменения родительского вида.

Обратите внимание: можно изменять только отображение кромки выносного вида, если
он отличается от таковой его родительского вида.

Изменение Отображения Индивидуальных Кромок

1. Выберите VIEWS > Disp Mode > Edge Disp.
2. Выберите одну из следующих команд в меню EDGE DISP:

•  Erase Line - стирает видимую линию в отображении вида.

•  Wireframe � отображает выбранную кромку в каркасном стиле.

•  Hidden Style � отображает выбранную кромку стилем невидимой линии.

•  Hidden Line � отображает скрытую кромку как невидимую линию.
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•  No Hidden - удаляет скрытую кромку из отображения вида.

•  Default - отображает кромку, используя текущую установку среды.

3. Определите метод выбора, выбирая одну из следующих команд в меню EDGE DISP:

4. Выберите GET SELECT > Pick Many для выбора кромок. Система выбирает
совпадающие кромки, полностью закрытые верхней кромкой.

5. Выберите ERASE DISP > Highlight Mod для подсвечивания всех измененных кромок
модели.

Управление Отображением Индивидуальных Кромок

Используя команды в меню EDGE DISP, можно устанавливать режим визуального
отображения индивидуальных кромок, которые обычно видны на экране. Для изменения
отображения кромки, отключите команду Wireframe в диалоговом окне Environment. Все
кромки модели должны быть видны.

Необходимо использовать команду Edge Disp в меню DISP MODE для проведения
незначительных косметических изменений и для отображения выбранных скрытых кромок
в видах с режимом отображения, установленным в No Hidden. Эту команду нельзя
использовать для стирания следующих элементов:

· границы всех поперечных сечений.

· Внешних кромок, пересекающих обрезающие (clipped) сплайны.

· Косметических резьб в видах рисунков (выберите Show/Erase из меню DETAIL; затем
щелкните по кнопке Cosmetic Feature в поле Type диалогового окна Show/Erase)

· Кромок силуэта, за исключением следующего:

•  Кромок силуэта цилиндров и конусов.

•  Кромок силуэта торов, которые являются дугами, то есть оси торов параллельны или
перпендикулярны экрану.

•  Силуэтов основных поверхностей вращения, чьи оси параллельны экрану

Обратите внимание: при стирании одной кромки силуэта, система стирает все кромки
силуэта, также принадлежащие этой поверхности.

Выбор Примитивов
Если опция "selection_of_removed_entities" файла конфигурации установлена в «yes»,
можно выбирать примитивы и активизировать их для выполнения различных действий,
типа отображения размера и размещения элементы на слое. Также можно активизировать
объекты для выбора элементов, которые находятся перед поперечным сечением
(плоскими или ломаным), которые были удалены Z-обрезанием или были стерты
посредством Erase Line в меню EDGE DISP.

Обратите внимание: если режим визуального отображения вида установлен в Wireframe,
система не стирает и не перерисовывает изображение его кромок пока отображение вида
не будет изменено на Hidden или No Hidden.

Касательные Линии
Используя команды в меню TAN EDGEDISP (подменю в EDGE DISP), можно выбирать
некоторые касательные линии для отображения в видах рисунка, при стирании других:

· Tan Solid - отображает выбранные касательные кромки независимо от установки
отображения касательных кромок в диалоговое окно Environment. Касательная кромка -
пересечение, в котором две поверхности касательны. Например, скругление всегда
создает касательную кромку с поверхностями сопряжения.
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· Tan Ctrln - отображает выбранные касательные кромки осевыми линиями независимо от
установки отображения касательных кромок в диалоговое окно Environment.
· Tan Phantom - отображает выбранные касательные кромки линиями типа phantom
независимо от установки отображения касательных кромок в диалоговое окно
Environment.
· Tan Dimmed - отображает выбранные касательные кромки серым цветом.

· Tan Default - отображает касательные кромки в соответствии с установкой в диалоговом
окне Environment.
Обратите внимание: команды Erase Line и No Hidden в меню EDGE DISP имеют
приоритет перед командами меню TAN EDGEDISP. При выборе Erase Line или No Hidden,
выбранные касательные кромки не отображаются.

Если опция "hidden_tangent_edges" файла установок рисунка установлена в �dimmed�,
скрытые касательные кромки вида можно выводить на печать, используя перо 7. Линии
отображаются пунктиром тем же цветом, что и серые видимые касательные кромки.
Однако, необходимо выбрать Erase Line или No Hidden в списке Display Style в
диалоговом окне Environment. Если эта опция установлена в �erased�, система
автоматически удаляет все скрытые касательные кромки на экране и при печати.

Пример: Типы Отображения Кромок

Изменение Типа Линии Выбранного Компонента Сборки

1. Выберите VIEWS > Disp Mode > Member Disp > Style.

2. Выберите компоненты сборки; затем выберите Done Sel. Можно использовать Sel By
Menu в меню GET SELECT для выбора деталей или подсборок для изменения.

3. Измените стиль, выбирая команду из меню MEMB STYLE:

•  Standard - отображает выбранный компонент вида сплошной линией.

•  PhantomOpque - отображает выбранный компонент вида типом линии phantom.
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•  PhantomTrnsp - отображает выбранный компонент вида типом линии phantom, но
процесс удаления невидимой линии на него не влияет.

•  User Color - создает пользовательский цвет и назначает его компонентам сборки.

4. Выберите Done.

Управление Отображением Компонентов Сборки

Можно управлять отображением компонентов сборки, изменяя отображение их невидимых
линий, изменяя их тип линий или скрывая и отображая их.

При выборе Member Disp в меню DISP MODE, меню MEMB DISP отображает следующие
команды:

· HLR Display - изменяет отображение невидимых линий выбранных компонентов, отменяя
соответствующую установку отображения вида.

· Style - изменяет тип линии выбранных компонентов сборки.

· Blank � скрывает выбранные компоненты сборки.

· Unblank - возвращает отображение ранее скрытых компонентов. Временные контуры
становятся синими только для видов, содержащих скрытые компоненты. Выберите
соответствующий вид для подсветки скрытых компонентов и их выбора. Также можно
выбирать компоненты в Дереве Модели.

Также можно определить, где необходимо произвести изменения, выбирая Picked View,
This Sheet или All Views в меню MEMB DISP.

Изменение Отображения Невидимых Линий
Отображение невидимых линий выбранных компонентов можно изменять (замещая
установку отображения вида), используя команду HLR Display в меню MEMB DISP. Можно
устанавливать отображение выбранных компонентов по виду или по листу, или во всех
видах.

При выборе Hidden line в меню HLR DISPLAY и последующем выборе компонента можно
получить следующие результаты:

· если вид установлен в No Hidden, система отображает невидимые линии компонента;

· если вид установлен в Hidden line, отображение невидимых линий компонента не
изменяется;

· если вид установлен в Wireframe, отображение невидимых линий компонента не
изменяется.

При выборе No Hidden в меню HLR DISPLAY и последующем выборе компонента можно
получить следующие результаты:

· если вид установлен в No Hidden, отображение невидимых линий компонента не
изменяется;

· если вид установлен в Hidden line, система не отображает невидимые линии компонента;

· если вид установлен в Wireframe, отображение невидимых линий компонента не
изменяется.

Если выбран один компонент, или все выбранные компоненты имеют одинаковую
установку меню HLR DISPLAY обозначает установку, подсвечивая команду в меню. Если
выбрано более одного компонента, и они имеют различные параметры настройки, система
не подсвечивает команду в меню HLR DISPLAY.
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Обратите внимание: установка, назначенная командой Edge Disp, замещает любую
установку, назначенную командой HLR DISPLAY; в свою очередь установка, назначенная
командой HLR DISPLAY замещает любую установку, назначенную командой View Disp.

Отображение Осевых Линий Трубопроводов
Если опция "hlr_for_pipe_solid_cl� файла установок рисунка установлена в «yes», удаление
невидимых линий влияет на осевые линии трубопровода. Если она установлена в «no»
(значение по умолчанию), - не влияет.

Обратите внимание: опция "hlr_for_pipe_solid_cl" работает только для трубопроводов,
созданных в Pro/PIPING, а не для элементов канала в детали.

Пример: Изменяемые Типы Линий Выбранного Компонента
Сборки

Если вид устанавливается с использованием опции No Hidden, система скрывает объекты
за ним, если они отображаются стилем PhantomTrnsp, PhantomOpque или Standard.

Примеры использования Стиля Standard

При изменении типа линии выбранного компонента на PhantomOpque, он отображается
стилем линии phantom. Если вид устанавливается с использованием опции No Hidden,
система скрывает объекты за ним, если они отображаются стилем PhantomTrnsp,
PhantomOpque или Standard.

Примеры использования Стиля PhantomOpque
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При изменении типа линии выбранного компонента на PhantomTrnsp, он отображается
стилем линии phantom. Если вид устанавливается с использованием опции No Hidden,
система скрывает объекты за ним, если они отображаются стилем PhantomTrnsp. Однако,
при отображении объектов в стиле PhantomOpque или Standard, процесс удаления
невидимых линий не изменяется и можно видеть их кромки.

Примеры использования Стиля PhantomTrnsp
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Двухмерное Проектирование

Эскизирование в Режиме Рисунка
В режиме Рисунка (draft), можно делать следующее:

· создавать конструктивную геометрию;

· соединять геометрию;

· делать размеры эскизных объектов ассоциативными;

· создавать эскизную геометрию;

· определять поперечные сечения рисунка;

· изменять, копировать и перемещать геометрию рисунка

· получать информацию относительно геометрии рисунка

Используя команду Sketch в меню DETAIL, можно в любой момент добавлять примитивы к
рисунку. Pro/ENGINEER использует следующие объекты рисунка:

· объекты, созданные с использованием меню DRAFT GEOM (например, двухмерная
геометрия рисунка).

· Объекты, выбранные в процессе создания объекта (например, присоединение символа
допуска на размер к размеру рисунка).

· Объекты, считанные в рисунок из файлов IGES, DXF или SET.

· Аннотации, размещенные в модели Pro/ENGINEER без какой либо ассоциативности
(например, свободное примечание).

Геометрия Рисунка
Используя команды в меню DRAFT GEOM или OTHER GEOM, можно создавать различные
типы геометрии: линии, круги, дуги, сплайны, эллипсы, точки и фаски.

Создание Конструктивной Линии

Объекты конструктивной геометрии - линии и окружности, которые можно использовать
для размещения и создания двухмерной эскизной геометрии. Они отображаются на экране
шрифтом phantom, но их можно передавать через файлы IGES и выводить на печать.

1. Выберите DRAFT GEOM > Construction > Constr Line.

2. Используя меню CONSTR LINE, сделайте следующее:

•  Выберите Horiz или Vert для создания горизонтальной или вертикальной линии.
Используя команды в меню GET POINT разместите линии.

•  Выберите Crossed Pair для создания двух конструктивных линий, перпендикулярных
друг к другу под данным углом. Используйте меню GET POINT для выбора точки в
рисунке; затем введите угол поворота. Система создает две конструктивных линии,
проходящие через выбранную точку. Одна из линий проходит под указанным углом;
другая перпендикулярна первой.
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•  Выберите Angle для создания наклонной линии. Используйте команды меню GET
POINT для размещения точки поворота линии; затем введите угол для каждой
создаваемой линии. Каждый угол представляет из себя �абсолютное� положительное
значение в направлении против часовой стрелки и отрицательное значение - по
часовой стрелке. Нажмите ENTER для выхода.

•  Выберите Offset для создания линии, смещенной от другой. Выберите линию для
смещения; затем введите величину коррекции. Положительное значение - смещает в
направлении стрелки; отрицательное значение � в обратном направлении. Каждое
значение смещения, введенное после первого, принимается относительно линии,
созданной последней. Нажмите ENTER для выхода.

•  Выберите Pnt/Angle для создания конструктивной линии через точку и под указанным
углом к выбранному объекту. Используйте команды меню GET POINT для выбора
точки, через которую пройдет конструктивная линия. Затем выберите объект,
относительно которого будет отсчитываться угол. Введите угол между �360° и 360°.
Создается конструктивная линия под указанным углом, отсчитываемым против часовой
стрелки от выбранного объекта.

Совет: Создание Конструктивных линии

Обратите внимание: нельзя смещать конструктивную линию от осевой линии.

Пример: Конструктивные Линии

Создание Конструктивной Окружности

1. Выберите DRAFT GEOM > Construction > Constr Circle.

2. Используйте команды в меню CIRCLE для создания окружности.
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Совет: Выбор Конструктивных Объектов для Стирания

При удалении конструктивных объектов, при выборе Across Box из меню PICK BOX,
можно выбирать линии или круги, которые полностью или частично находятся в пределах
рамки.

Пример: Конструктивные Окружности

Для Соединения Объектов в Процессе Эскизирования

Можно соединять геометрию для создания объединенных объектов, выбирая точки
предыдущих объектов в качестве начальных точек для новых объектов.

Для формирования объединенных объектов, выберите Start Chain. Для завершения
формирования объединенных объектов, выберите End Chain или выйдите из меню DRAFT
GEOM. В процессе формирования, маленький желтый квадратик указывает точку, от
которой продолжается цепочка. При эскизировании объектов в процессе формирования
цепочки, если точка выбрана левой кнопкой мыши, цепочка продолжается; при выборе
средней кнопкой мыши, система создает конечную точку и формирование
приостанавливается или останавливается в этой точке. По завершении создания
соединенных примитивов, можно выбрать End Chain или продолжать создавать эскизную
геометрию. Новый объект начинается в месте остановки последней цепочки. Чтобы начать
соединение других объектов, выберите End Chain для завершения первой цепочки и
выберите Start Chain для начала новой; иначе, соединение новых примитивов просто
продолжится от предыдущих.

Соединение Объектов в Процессе Эскизирования

Соединение геометрии воздействует только на создание объектов. После их создания,
каждый объект существует независимо от других, независимо от любых общих центров или
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конечных точек.

Можно соединять вместе окружности и эллипсы, когда они используют общие центры.
После указания центра первого эллипса или окружности, система использует его для
каждой последующей окружности или эллипса, пока цепочка не будет завершена.

Пример: Соединенная Геометрия

Создание Линии

Используя команды в меню LINE, можно создавать следующие типы линий, соединенных
непрерывно или в виде отдельных объектов:
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· горизонтально или вертикально между любыми двумя точками;

· под углом, отсчитываемым от оси X (0);

· касательно к кривой в ее второй конечной точке;

· параллельно или перпендикулярно к указанной линии;

· перпендикулярно к кривой;

· касательно к дуге или сплайну

· касательно к двум окружностям или сплайнам;

· касательно к кривой и параллельно или перпендикулярно к оси координат.

Создание Окружности

Используя команды в меню CIRCLE, можно создавать окружность следующим образом:

· указывать ее центр и определять точки;

· создавать ее касательно другим объектам;

· указывать ее центр и определять точки касания с другими объектами;

· указывать ее центр и радиус или диаметр окружности;

· создавать ее касательно к трем другим объектам;

· создавать ее касательно к двум другим объектам с указанием радиуса;

· использовать любые три точки, которые лежат на окружности

Создание Дуги

Используя команды в меню ARC, можно создавать дуги следующим образом:

· выбирая конечную точку, касательную другому незамкнутому объекту (то есть не
окружности или эллипсу);

· выбирая любые три точки, принадлежащие дуге;

· использовать центр дуги и две конечные точки;

· использовать центр дуги, начальную точку и угол, отсчитываемый от начала дуги в
направлении против часовой стрелки;

· создание дуги касательно к трем другим объектам;

· создание дуги касательно к двум другим объектам, с указанным радиусом.

Создание Сплайна

Используя команду Spline в меню OTHER GEOM, можно создавать сплайн, указывая
начальную точку и любое количество интерполяционных точек.

1. Выберите DETAIL > Sketch > Other > Spline.

2. Используя меню GET SELECT, выберите начальную точку и, затем, любое количество
интерполяционных точек, определяющих сплайн.

3. Для завершения сплайна в последней выбранной точке, нажмите среднюю кнопку мыши.



Pro/DETAIL Выпуск Документации Pro/ENGINEER 2000 i2

146

Создание Эллипса

Используя команды в меню ELLIPSE, можно создавать эллипсы следующим образом:

· выбирая центр, точку, указывающую главную ось и угол поворота геометрии
относительно главной оси;

· определяя длину и ориентацию главной оси и определяя угол поворота относительно
главной оси;

· располагая центр, точку, указывающую главную ось и точку, указывающую вторую ось;

· выбирая две точки, определяющие главную ось и третью точку, принадлежащую эллипсу;

· используя угол поворота относительно главной оси. Угол представляет поворот
окружности вокруг оси, лежащей в плоскости экрана; чем больше угол поворота, тем
меньше видна окружность. Например, при вводе 0 градусов, система создает окружность;
при вводе 90 градусов, создается линия.

Пример: Создание Эллипса

Создание Фаски

Фаски - линии, которые пересекают и обрезают другие линии. Система вычисляет
пересечение линий таким образом, чтобы линии фактически не касались; размеры фаски
применяются к этим точкам пересечений. При создании фаски, срезанная часть линий
удаляется. Используя команды в меню CHAMFERS, можно создавать фаски следующим
образом:

· создавать линии между двумя другими линиями под 45 градусов от первой выбранной
линии и размером "d" вдоль обоих выбранных линий;

· использовать одно значение размера вдоль обоих выбранных линий;

· использовать различные размеры фаски для каждой выбранной линии;

· использовать размеры фаски под углом к ссылочному объекту.

Выбор Объектов Рисунка

Выбор Нескольких Примитивов

Можно выбирать несколько примитивов для одновременного изменения, выбирая Pick
Many из меню GET SELECT, с последующим Pick Box. При выборе Inside Box в подменю,
можно выбирать только те элементы, которые полностью находятся в пределах рамки. При
выборе Across Box, можно выделите все объекты рисунка, которые частично или
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полностью находятся в пределах рамки. Используя левую кнопку мыши для указания
противоположных углов рамки, нажмите среднюю кнопку и нажмите левую кнопку для
завершения операции.

Выбор Примитивов для Эскиза

При выборе точек для эскиза в Pro/DETAIL, можно выбирать примитивы или геометрию
модели. Для определения конечных точек и центров, используйте команды в Abs Coord
для размещения точек относительно текущей системы координат рисунка.

Меню GET POINT

· Pick Pnt, размещает точку на экране.

· Vertex размещает точку в конечной точке, а также в середине незамкнутой кривой (линия,
дуга, сплайн), центре эскизной дуги или окружности, или в месте пересечения двух
объектов.

· On Entity размещает точку на объекте (эскиз или модель). Система размещает точку на
выбранном объекте, ближайшем к месту выбора. При выборе конца объекта, размещает в
конечной точке.

· Rel Coords размещает точку относительно последней выбранной точки, используя
указанные значения координат x и y в единицах рисунка.

Совет: Выбор Нескольких Примитивов

Если опция "dwg_select_across_pick_box" файла конфигурации установлена в «yes»,
система по умолчанию подсвечивает команду Across Box, когда появляется меню PICK
MANY. Если опция установлена в «no», по умолчанию подсвечивается команда Inside Box.

Совет: Выбор Точек для Эскиза

Используйте опцию "draw_points_in_model_units" файла конфигурации для определения
значений координат текущего вида рисунка как единиц модели, а не единиц рисунка. Меню
GET POINT использует масштаб вида рисунка и единицы модели вида рисунка для
относительного и абсолютного ввода координат и отображения в области сообщения.

Эскизные Размеры
Эскизные размеры и геометрия, на которую они ссылаются, полностью независимы от друг
друга, пока не будет включено ассоциативное образмеривание. Размеры примитивов
можно делать ассоциативными, чтобы система обновляла их для отображения изменений
в установках эскизных объектов путем установки опции файла установок рисунка
�associative_dimensioning� в"yes" (значение по умолчанию). Система рассматривает
отношения родитель/потомок между эскизными объектами и их ассоциативными
размерами, и выполняет для них следующие процедуры:

· стирание;

· переключение на другой лист рисунка;

· перенос;
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· поворот;

· изменение масштаба, включая изменение размера формата рисунка.

Примечания:
Система назначает статус ассоциативности только на новые размеры.

Эскизные размеры - управляемые размеры. При изменении масштаба эскизных объектов,
значения их ассоциативных размеров также изменяются.

При выборе эскизного объекта для любой из предшествующих процедур, неявно
выделяются все его размеры. Для всех процедур при выборе размера, кроме стирания,
также выбирается родительский объект и все его другие размеры. При неявном выборе
размера путем выбора объекта:

· снятие выбора объекта также снимает выбор размера, пока размер не будет выбран как
размер другого объекта, или отдельно.

· Нельзя снимать выделение размера, пока не будет снят выбор непосредственно объекта.

Pro/ENGINEER рассматривает эскизные группы для предшествующих процедур как
родительские для всех размеров их объектов.

Масштаб Объектов, Независимый от Масштаба Вида
Масштаб объектов полностью независим от масштаба вида. Хотя эскизный объект,
связанный с видом, отображается в другом размере на экране, когда масштаб этого вида
изменяется, значения размера эскизного объекта не изменяются никогда.

Пример: Изменение Формата Рисунка и Перемещение Примитивов

Следующий рисунок показывает, что при уменьшении размера рисунка в два раза, система
масштабирует виды и эскизные объекты по виду, хотя они имеют тот же размер на экране.
Высота текста не изменяется, но система уменьшает в два раза значение размеров
поперечных сечений.

Воздействие Изменения Формата Рисунка на Ассоциативные Размеры Примитивов
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Перемещение Примитивов Без Ассоциативного Образмеривания

Эскизные Поперечные Сечения
Используя команды Fill и Hatch в меню DRAFT XSEC, можно заливать или штриховать
эскизное поперечное сечение. Pro/ENGINEER определяет границу эскизного поперечного
контуром, охватывающим геометрию.

При работе с эскизными поперечными сечениями, учитывайте следующее:

· можно определять островки, или не залитые и не заштрихованные области в пределах
контура.

· Островки не могут пересекать внешнюю границу; при этом они не могут пересекать друг
друга.

· Можно включать любое число контуров.

· Можно включать оба типа (залитый и заштрихованный) в форматах непараметрических
рисунков, если требуется.

· Система не рассматривает эскизное поперечное сечение в виде единого объекта.
Поэтому, для размещения его на слое, контур и штриховку необходимо добавлять
отдельно.
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· Можно изменять только одно эскизное поперечное сечение за раз. Нельзя изменять
эскизные поперечные сечения, которые имеют открытые контуры.

· Можно удалять либо все поперечное сечение (со штриховкой или заливкой и контуром)
или штриховку/заливку.

Создание Эскизного Поперечного Сечения или Залитой Области

1. Выберите DETAIL > Create > Filled Area.

2. Из меню DRAFT XSEC, выберите Hatch или Fill.
3. Определите внешнюю границу области поперечного сечения, выбирая примитивы для
поперечного сечения в направлении против или по часовой стрелке; затем выберите Done
Sel.
4. Сделайте следующее:

•  При выборе Fill, система заполняет замкнутую область цветом, соответствующим
текущему типу линии. Определите островки поперечных сечений, выбирая контуры
эскизной геометрии; затем выберите Done Sel.

•  При выборе Hatch, укажите имя поперечного сечения; затем выберите MOD XHATCH >
Hatch > Done.

Пример: Эскизное Поперечное сечение

Изменение Эскизного Поперечного Сечения

1. Выберите MODIFY DRAW > Xhatching.

2. Выберите эскизное поперечное сечение, выбирая границу поперечного сечения или
штриховку.

3. Выберите команды в меню MOD XHATCH. Можно вызвать предварительно сохраненный
образец штриховки для использования его в эскизном поперечном сечении.

Удаление Заштрихованной или Залитой Области Без Удаления
Границы

1. Выберите DETAIL > Delete.

2. Щелкните внутри заштрихованной или залитой области.

3. Выберите DWG SELECT > Done Sel. Система удаляет штриховку или заливку, оставляя
объекты границы. Если граница не видна, выберите Repaint.
Обратите внимание: для удаления всего поперечного сечения с его границей, выберите
точку на контуре; затем выберите Done Sel.
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Использование Pick Many для Выбора Объектов

Можно использовать Pick Many для выбора объектов в контуре. Система подсвечивает
некорректные объекты (которые не формируют контур) сиреневым цветом. Если объекты
почти формируют контур, но оставляют небольшой промежуток, подсвечиваются конечные
точки объекта около промежутка.

Выбор Done Без Какого Либо Выбора

При выборе Done без какого либо выбора в меню MOD XHATCH, система создает
штриховку, используя значения по умолчанию.

Группировка Примитивов
Используя команду Group в меню TOOLS, можно создавать, подавлять, восстанавливать и
расчленять эскизные группы. Pro/ENGINEER работает со всеми объектами в группе
одинаково. Однако, изменение типа линии сгруппированного объект воздействует только
на этот объект.

При группировке объектов, учитывайте следующее:

· нельзя использовать другие команды типа Intersect or Trim для изменения объектов,
принадлежащих группе.

· При выборе Delete и выборе группы, можно удалять все объекты группы или удалять
группу, но сохранять объекты (аналогично Explode).

· Можно помещать примитивы на слой и скрывать их всех за раз, выбирая этот слой.

·Можно включать примечания, символы и допуски на размер, кроме тех, которые были
созданы с использованием On Item, в эскизных группах.

· Система создает эскизное поперечное сечение в виде группы, содержащей штриховку и
граничные объекты. Нельзя расчленять штриховку, но ее можно удалять.

Для изменения сгруппированных примечаний, размеров и символов, используйте команды
Modify, Text Line и Full Note в меню MODIFY TEXT, как и для примечаний.

Создание Эскизной Группы

1. Выберите TOOLS > Group > Create.

2. Используя меню DWG SELECT, выделите все объекты для включения в группу.

3. Введите название группы.

Подавление Эскизной Группы

1. Выберите DRAFT GROUP > Suppress.

2. Используя меню GROUP ACCESS, сделайте следующее:

•  Выберите Select и выберите группу.

•  Выберите By Name и введите название группы.
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Восстановление Подавленной Группы

1. Выберите DRAFT GROUP > Resume.

2. Сделайте следующее:

•  Выберите восстанавливаемую группу в меню GROUP NAMES.

•  Выберите Names и введите название группы.

Расчленение Восстановленной Группы

1. Выберите DRAFT GROUP > Explode.

2. Сделайте следующее:

•  выберите расчленяемую группу, выбирая один из ее объектов мышью.

•  Выберите ACCESS > By Name и введите название группы.

Изменение Эскизной Группы

1. Выберите DRAFT GROUP > Edit.

2. Сделайте следующее:

•  выберите группу, выбирая один из ее объектов мышью.

•  Выберите ACCESS > By Name и введите название группы.

•  Добавьте примитивы к группе, выбирая Add и указывая объекты для добавления к
группе.

Обратите внимание: нельзя добавлять эскизные опорные элементы, трехмерные
опорные элементы, эскизные оси, линии симметрии или позиции к эскизной группе.

3. Удалите объекты из группы выбирая Remove и указывая удаляемые из группы объекты.

Копирование Примитивов

Вырезание, Копирование и Вставка

Элементами можно управлять, используя функцию вырезания, копирования и вставки.
Вырезание, копирование и вставка используют концепцию буфера обмена, позволяющую
копировать или вырезать выносные элементы типа примечаний, символов, эскизных
объектов и таблиц, и вставлять на тот же лист, другой лист или другой рисунок.

Выносными элементами, которые можно вырезать, копировать и вставлять являются:

· примечания (с и без выносок);

· позиции;

· символы;

· примитивы;

· эскизные размеры;
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· таблицы.

Примечания, позиции и символы с выносками копируются вместе с выносками. Выноска
копируется так, как она выглядит в исходном рисунке. Конечную точку выноски в рисунке-
получателе можно перетаскивать в нужное место.

Параметры в примечаниях копируются как параметры и перерассчитываются в рисунке-
получателе. Если параметр не может быть рассчитан в рисунке, отображаются три
звездочки.

Таблицы со стандартным текстом (не повторяющиеся области (repeat regions)) копируются
как текст. При вставке, текст выглядит, как он был на исходном рисунке. Таблицы с
повторяющимися областями (repeat regions) копируются с символами имен сообщения и
должны быть изменены в рисунке-получателе с использованием Update Tables.

Команды Cut, Copy и Paste доступны в меню Edit или непосредственно в пиктограммах
верхней инструментальной панели.

Команды Cut, Copy и Paste позволяют копировать выносные элементы и вставлять их в
рисунки, сообщения, форматы, компоновки и диаграммы. Поддерживаются следующие
комбинации Из - В:

· Рисунок - Рисунок, Отчет или Формат.

· Отчет - Рисунок, Отчет или Формат.

· Формат - Рисунок, Отчет или Формат.

· Компоновка - Компоновка (ограничивается аналогичным типом).

· Диаграмма - Диаграмма (ограничивается аналогичным типом).

Также могут использоваться горячие клавиши для выполнения функций вырезания,
копирования и вставки:

· вырезание - CNTRL X;

· копирование � CNTRL С;

· вставка - CNTRL V.

Команда Cut работает подобно команде Copy, в которой выбранный элемент копируется в
буфер обмена. Однако, команда Cut перемещает выбранный элемент из его
первоначального местоположения в новое место.

Копирование Элементов в Пределах Листа, Используя Буфер
Обмена

1. Щелкните по пиктограмме в верхней инструментальной панели.

2. Выберите элементы, которые требуется копировать в буфер обмена и, затем, щелкните
по пиктограмме Открывается Drawing Clipboard, содержащий скопированные
выносные элементы.

3. Укажите начальную точку переноса, выбирая точку в диалоговом окне Drawing
Clipboard. Начальная точка переноса отображается в виде желтого квадратика.

4. Выберите место в рисунке, где требуется разместить скопированные элементы. Это
действие вставляет скопированные элементы.

Обратите внимание: При необходимости переместить выносные элементы, используйте
вместо
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Копирование Элементов из Одного Листа на Другой, используя
Буфер Обмена

1. Щелкните по пиктограмме в верхней инструментальной панели.

2. Выберите элементы на исходном листе, которые требуется копировать в буфер обмена.

3. Выберите рисунок-получатель в меню Window. Это действие открывает рисунок-
получатель.

4. В литсе-получателе щелкните по . Открывается Drawing Clipboard, содержащий
скопированные выносные элементы из исходного рисунка.

5. Укажите начальную точку переноса, выбирая точку в диалоговом окне Drawing
Clipboard. Начальная точка переноса отображается в виде желтого квадратика.

6. Выберите место в рисунке, где требуется разместить скопированные элементы. Это
действие вставляет скопированные элементы.

Обратите внимание: При необходимости переместить выносные элементы, используйте
вместо

Копирование Элементов из Одного Рисунка в Другой, используя
Буфер Обмена

1. Щелкните по пиктограмме в верхней инструментальной панели.

2. Выберите элементы в исходном рисунке, которые требуется копировать в буфер
обмена.

3. Перейдите на лист-получатель при помощи меню Sheets или, используя ползунок
Sheets в инструментальной панели.

4. В листе-получателе щелкните по . Открывается Drawing Clipboard, содержащий
скопированные выносные элементы из исходного листа.

5. Укажите начальную точку переноса, выбирая точку в диалоговом окне Drawing
Clipboard. Начальная точка переноса отображается в виде желтого квадратика.

6. Выберите место в рисунке, где требуется разместить скопированные элементы. Это
действие вставляет скопированные элементы.

Обратите внимание: При необходимости переместить выносные элементы, используйте
вместо

Копирование Элементов из Рисунка в Другой Рисунок

Используя команду Copy из меню TOOLS, можно копировать выносные элементы, типа
чертежных таблиц, примечаний, символов, примитивов и позиций из одного рисунка в
другой. Элементы, часто используемые во всех рисунках, могут быть сохранены в одном
основном рисунке для копирования в новые рисунки.

1. Выберите DETAIL > Tools > Copy > Other Drawing.

2. В диалоговом окне Open File выберите имя исходного рисунка для копирования
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элементов. Выбранный рисунок отображается в другом окне Pro/ENGINEER и появляется
меню DETAIL ITEMS.

3. Если исходный рисунок содержит более одного листа, используйте команды в меню
PLACE SHEET для перехода к нужному листу и выберите Done.

4. Выберите команду из меню DETAIL ITEMS для указания копируемых элементов. При
выборе Draft Items или Dwg Tables, выберите копируемые элементы и выберите Done
Sel; затем нажмите Done.

•  Entire Sheet - копирует все текущие элементы на текущем листе в другой рисунок.

•  Draft Items (выбирается по умолчанию) - позволяет выбирать элементы рисунка для
копирования из исходного рисунка.

•  Dwg Tables - позволяет выбирать чертежные таблицы для копирования в другой
рисунок.

•  Done - копирует выбранные элементы в рисунок-получатель.

•  Quit - отменяет текущий выбор и возвращает в меню TOOLS.

5. Выберите точку в исходном рисунке для определения первой точки вектора переноса.
Эта выбранная точка указывает, где будут помещены элементы в рисунке-получателе.

6. Выберите точку в рисунке-получателе для указания конечной точки вектора переноса.
Элементы помещаются в рисунок относительно первой точки вектора переноса.

После того, как выбранные элементы будут скопированы в рисунок-получатель, система
возвращается в меню TOOLS.

Не следует масштабировать элементы после того, как они будут помещены в рисунок-
получатель. Система автоматически масштабирует элементы, скопированные между
рисунками различного размера. Например, если элементы копируются из рисунка размера
E в рисунок размера B, элементы масштабируются с тем же коэффициентом.

Правила Копирования Элементов из Рисунка в Рисунок

На копирование элементов из рисунка в рисунок налагаются следующие правила и
ограничения:

· исходные и рисунки-получатели должен использовать одинаковые единицы измерения.

· Примечания, позиции и символы с выносками копируются с выноской. Выноска
копируется так, как она выглядит в исходном рисунке. Конечную точку выноски можно
перемещать в рисунке-получателе путем перетаскивания в требуемое положение.

· Обратите внимание, что параметры размера (то есть &d23) не могут быть скопированы.
Другие параметры можно копировать.

· Таблицы копируются следующим образом:

•  Таблицы без повторяющихся областей (repeat regions) копируются как текст и выглядят
так же, что и в исходном рисунке.

•  Таблицы с повторяющимися областями (repeat regions) копируются с названиями
символов отчета и должны быть обновлены в рисунке-назначения, используя Update
Tables.

Перенос и Копирование Примитивов

Используя команду Copy в меню TOOLS, можно копировать примитивы или свободные
примечания, перенося их в направлении оси Y и-или Х или, вращая их относительно точки.
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Для переноса или вращения примитивов без создания копий, используйте команды в меню
MOD ENTITY.

Обратите внимание: нельзя вращать символы.

1. Выберите TOOLS > Copy > Translate.

2. Выделите все копируемые или переносимые объекты. Выберите Done Sel.
3. Выберите команду из меню GET VECTOR для определения направления переноса
новых объектов.

4. Введите число создаваемых копий.

Вращение и Копирование Примитивов

1. Выберите TOOLS > Copy > Rotate.

2. Выделите все копируемые и переносимые объекты. Выберите Done Sel.
3. Введите угол поворота объектов. Система отсчитывает угол от горизонтали в
направлении против часовой стрелки.

4. Выберите центр вращения, используя команды меню GET POINT.

5. Введите число создаваемых копий.

Меню GET VECTOR

· Horiz - переносит объекты вдоль горизонтали. Введите значение, в единицах рисунка, для
переноса объектов. Положительное направление - в правую часть листа.

· Vert - переносит объекты вдоль вертикали. Введите значение, в единицах рисунка, для
переноса объектов. Положительное направление - вверх листа рисунка.

· Ang/Length - переносит объекты под углом на указанное расстояние, отсчитывая угол
относительно горизонтали в направлении против часовой стрелки. Отображается стрелка,
показывающая положительное направление переноса.

· From-To � переносит объекты вдоль вектора, определенного начальной и конечной
точками.

Зеркальное Отображение Объектов
Используя команду Mirror в меню TOOLS, можно создавать копии примитивов, одиночных
символов и одиночных примечаний, отображая их относительно эскизной линии.

1. Выберите TOOLS > Tools > Mirror.
2. Выберите выносные элементы для зеркального отображения; затем выберите Done Sel.
3. Выберите эскизную линию для отражения объектов.
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Пример: Зеркальное Отображение Объектов

Пересечение Объектов
Используя команду Intersect в меню TOOLS, можно находить пересечение между двумя
объектами и разрывать оба объекта в месте пересечения создавая, таким образом, четыре
объекта из двух. Если имеется более одного возможного пересечения, типа сплайна,
пересекающего линию в нескольких местах, система создает пересечение, ближайшее к
точке выбора. Конструктивная геометрия пересечения становится обычной эскизной
геометрией.

Совет: Пересечение Объектов

Если выбранные объекты фактически не пересекаются, система не находит пересечение.
В этом случае, необходимо использовать команду Trim.

Обрезание Конструктивной Геометрии
Используя команду Trim в меню TOOLS, можно удлинять или обрезать эскизную
геометрию. Система использует определение геометрии при поиске ее пересечения с
режущим объектом.

1. Выберите TOOLS > Trim.

2. Выберите команду в меню TRIM.

3. Выберите обрезаемый объект (нельзя обрезать конструктивную геометрию). Для
обрезки объекта, выберите ту часть объекта, которую необходимо сохранить в рисунке.
Для удлинения, выберите объект в любом месте.

4. Выберите Done Sel.
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Меню TRIM

· Bound � обрезает по указанному объекту или точке.

· Length - обрезает по указанной длине.

· Increm - обрезает или удлиняет на указанную величину.

· Corner - обрезает два объекта по их пересечению.

Совет: Если Сплайн Не Пересекает Граничный Объект

Если сплайн или продолжение дуги не пересекают ограничивающий объект, система не
может рассчитать пересечение и не обрезает объект.

Смещение Конструктивной Геометрии
Используя команду Offset в меню TOOLS, можно смещать эскизную геометрию по
отношению к другим примитивам и геометрии модели. Можно выбирать осевую линию,
опорную плоскость, эскизную опорную плоскость или эскизную опорную ось для создания
смещения эскизного объекта. Эта осевая линия может начинаться от любой отображаемой
оси вне зависимости от ориентации. При создании смещения от оси перпендикулярно
экрану (то есть перекрестье курсора), смещение необходимо создавать отдельно для
горизонтали и вертикали.

Образующаяся линия смещения не связана с осевой линией или опорным элементом. Это
означает, что, когда ось или опорный элемент обрезаются, перемещаются или стираются,
эскизная линия остается неизменной.

Новая эскизная линия автоматически связывается с видом. При смещении эскизного
объекта от кромки модели или другого примитива, уже связанного с видом, система
автоматически связывает его с видом, в котором была выбрана кромка модели или другой
эскизный объект.

1. Выберите TOOLS > Offset > Single Ent.
2. Выберите параллельную или перпендикулярную ось.

3. Выберите атрибуты эскизной линии из меню OFFSET TYPE и выберите Done/Return.

4. Введите расстояние смещения.

При выборе Single Ent из меню OFFSET OPER отображается меню OFFSET TYPE со
следующими командами:

•  Fixed - создает эскизный объект с единственным значением смещения.

•  Tapered - создает эскизный объект с различными смещениями в каждой конечной
точке.

•  Trimmed - смещает только часть примитива. Укажите границы, выбирая эскизную или
некоторую произвольную точку на объекте.

•  Untrimmed - создает эскизный объект, который использует длину исходного
примитива.

Используя команду Ent Chain в меню OFFSET OPER, можно одновременно выбирать
несколько объектов для смещения. Объекты должны быть связанными, но можно выбирать
их в любом порядке или использовать команду Pick Box.

Обратите внимание: команда Ent Chain не доступна при выборе осей.
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Пример: Создание Примитивов с Использованием Смещения

Перемещение Примитивов

Команда Translate

Используя команду Translate в меню TOOLS, можно перемещать примитивы и аннотации
относительно рисунка если они не присоединены к кромке. Команда Translate отличается
от команды Move следующим образом:

· можно перемещать любое количество элементов за раз.

· При перемещении выбранных объектов, система автоматически снимает с них
выделение. Используя команду Move, можно перемещать элемент несколько раз, пока не
будет нажата средняя кнопка мыши.

Обратите внимание: нельзя использовать Translate в меню TOOLS для копирования
объектов, как если бы использовали команду Copy в меню TOOLS с последующим
Translate в меню COPY TYPE.

Перемещение Эскизных и Одиночных Объектов

1. Выберите TOOLS > Translate.

2. Выберите перемещаемые примитивы. Выберите Done Sel по завершении.

3. Выберите команду из меню GET VECTOR для определения направления переноса
новых объектов. Системы использует указанное расстояние между всеми копиями
геометрии рисунка.
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Пример: Перемещение Эскизных и Одиночных Объектов

Перемещение Примитивов на Другой Лист

Используя меню DWG SELECT, можно выбирать элементы рисунка, которые не связаны ни
с каким видом и перемещать их на другой лист. Система перемещает элементы рисунка,
которые связаны с видом на другой лист при переносе вида, которому они принадлежат, на
этот лист.

Изменение Примитивов

Разрыв Примитивов

1. Выберите DETAIL > Break.

2. Выберите объект.

3. Укажите разрывы, выбирая начальную и конечную точку каждого разрыва.

4. После того, как система разорвет эскизный объект на два отдельных объекта, выберите
первую точку разрыва на любом из двух объектов для выполнения следующего разрыва.

Для Растягивания Эскизного Объекта

1. Выберите DETAIL > Tools > Stretch.

2. Используйте левую кнопку мыши для включения растягиваемых объектов в рамку
выбора.

Обратите внимание: залитые (filled) примитивы не могут быть растянуты.

3. Для изменения выбора, выберите отдельные объекты, которые требуется исключить и
нажмите среднюю кнопку мыши.

4. Определите вектор перемещения, выбирая первое положение � точку «от»; затем
выберите конечную точку.

Растягивание Эскизного Объекта

Процесс растяжения не влияет на положение объектов, не попавших в рамку выбора.
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Для линий, которые пересекают рамку выбора, система перемещает точку расположения
вдоль вектора перемещения.

Процесс растяжения не влияет на окружности и дуги, центры которых не попали в рамку
выбора.

Система не сохраняет условие касательности в процессе растяжения.

Пример: Использование Команды Растяжения

Деление Эскизного Объекта

1. Выберите объекты для деления(divide). Введите число равных сегментов, на которые
необходимо разделить объект. При выборе нескольких объектов, система делит их все
одинаково на равные сегменты. После разделения объекта, его точки разрыва
подсвечиваются.

Пример: Деление Примитива

Изменение Типа Линии Примитивов

Можно использовать команду Line Style в меню MODIFY DRAW для изменения типа линии
выбранных объектов а также переопределения некоторых или всех элементов стиля линии
типа шрифта линии (line font), цвета и толщины.
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Масштабирование Конструктивной Геометрии

1. Выберите TOOLS > Rescale.

2. Выберите масштабируемую эскизную геометрию и размеры. Используйте команды меню
GET POINT для выбора точки, относительно которой производится масштабирование
объектов.

3. Введите значение масштаба. Число больше 1 увеличивает объекты; число меньше 1
уменьшает. Например, при значении 0.25, Pro/ENGINEER масштабирует рисунок на 1/4 от
фактического размера модели.

4. В случае необходимости, выполните регенерацию для повторного вычисления
ассоциативных размеров.

Команда Rescale

Используя команду Rescale в меню TOOLS, можно изменять размер геометрии рисунка.
Когда система регенерирует рисунок, она обновляет ассоциативные размеры для
измененной геометрии. Однако, не ассоциативные размеры с геометрией необходимо
масштабировать для сохранения их относительного положения. Эти значения не
изменяются при масштабировании.

Для Изменения Диаметра Дуги или Окружности

1. Выберите Mod Arc Diam из меню EDIT ACTIONS или выпадающего меню.

2. Выберите изменяемый эскизный объект.

3. Введите новый диаметр для примитива. Объект отображается с вновь измененным
значением.

4. Для обновления любых связанных эскизных размеров, выберите, DRAWING >
Regenerate > Draft.

Изменение Диаметра Дуги или Окружности

Система не обновляет несвязанные эскизные размеры для отображения изменений в
размере объекта.

Использование Кромки Модели для
Создания Примитивов

Создание Эскизного Объекта, Используя Кромку Модели

1. Выберите TOOLS > Use Edge.

2. Выберите кромку модели и выберите Done Sel.
3. Введите [Y], чтобы стереть выбранную кромку. Регенерируйте вид для перерисовки
изображения выбранного вида.
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Использование Кромки Модели

Используя команду Use Edge в меню TOOLS, можно создавать эскизный объект, используя
кромку модели; система автоматически связывает ее с видом. При стирании вида, система
стирает все выносные элементы, присоединенные к нему. При удалении вида, система
удаляет все присоединенные выносные элементы; однако, можно использовать Relate
View в меню VIEWS, чтобы удалить элементы рисунка и сделать их независимыми от вида.

Изменение Сплайнов

Перемещение Точек Сплайнов

1. Выберите Modify Spline в меню EDIT ACTIONS или выпадающем меню.

2. Выберите изменяемый сплайн. Появляются точки сплайна.

3. Выберите MOD SPLINE > Move Pnts > Single Pnt.
4. Выберите перемещаемую точку сплайна.

5. Выберите новое местоположение для точки. Система обновляет сплайн соответственно.
(В качестве альтернативы, можно выбирать Pnt Range и указывать две граничных точки
для настройки диапазона. Как только система подсветит ограничивающие точки, выберите
любую точку в пределах этого диапазона; затем укажите ее новую позицию.)

6. Выберите Done Move для завершения.

Изменение Сплайна и Диаметра Дуги или Окружности

Используя выпадающее меню или меню EDIT ACTIONS, можно изменять сплайн или
диаметр эскизной дуги или окружности.

Добавление Точек к Сплайну

1. Выберите MOD SPLINE > Add Pnts.

2. Сделайте следующее:

•  Выберите Interior и добавьте точки к внутренней части сплайна, выбирая любое место
сплайна между двумя существующими точками.

•  Выберите Exterior и удлините сплайн, добавляя точки за пределами его
существующих конечных точек. Выберите конечную точку сплайна для удлинения;
затем выберите дополнительные точки.

Изменение Сплайна, Используя Control Poly

1. Выберите MOD SPLINE > Control Poly.

Отображается белый контрольный многоугольник сплайна. Контрольные точки сплайна
отображаются между сегментами сплайна.

Сегменты начинаются и заканчиваются в начальной и конечной точке сплайна;
промежуточные сегменты остаются касательными к сплайну. Эти сегменты визуально
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помогают изменять форму сплайна.

Обратите внимание: нельзя использовать эту команду для сплайна, который имеет
условие касания только для одного конца.

2. Скорректируйте форму сплайна, выбирая точку на контрольном многоугольнике и
перетаскивая ее в новое место. Нельзя выбирать конечные точки. При перемещении точки
сплайн принимает свою новую форму.

3. Разместите контрольную точку, нажимая левую кнопку мыши.

Удаление Точки Сплайна

1. Выберите MOD SPLINE > Delete Pnts.

2. Выберите удаляемую точку сплайна. Точка исчезает.

Уменьшение Числа Точек Сплайна, Используя Значение
Отклонения

1. Выберите MOD SPLINE > Sparse.

2. Введите значение отклонения для перерисовки сплайна с меньшим количеством точек.
Это значение должно быть положительным. Система подсвечивает сплайн и сообщает,
сколько точек будет удалено.

3. Для принятия измененного сплайна, выберите Accept; для отклонения, выберите Reject,
и введите другое значение отклонения. (Для каждого сплайна следует попробовать
несколько различных значений отклонения для достижения требуемого результата.)

Сглаживание Сплайна

1. Выберите MOD SPLINE > Smooth.

2. Введите усредненное количество точек для сглаживания сплайна:

•  Введите [1] для сохранения сплайна как есть.

•  Введите [3] для усреднения по центральной точке в группе и по одной точке с каждой
стороны от нее.

•  Введите [5] для усреднения по центральной точке в группе и по две точке с каждой
стороны от нее.

3. Результирующий сплайн отображается зеленым цветом. Для принятия его, выберите
Accept; для отмены, выберите Reject, и попытайтесь снова с другим количеством точек.

Получение Информации по Примитивам

Получение Информации по Геометрии

Для идентификации эскизной геометрии в рисунке, выберите Drawing из меню Info
Pro/ENGINEER, с последующим Highlight by Attributes. Чтобы получить информацию по
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конкретным примитивам, выберите Measure Draft Entities... из меню Info Pro/ENGINEER.
Появляется диалоговое окно Draft Measure.

Измерение Расстояния

Для измерения расстояния между двумя параллельными линиями, двумя точками или
точкой и линией, выберите Distance из содержимого Type; затем используйте инструменты
выбора в поле Definition для выбора двух объектов. В поле Results, система отображает
измеренное расстояние.

Измерение Угла

Для измерения угла между двумя выбранными линиями, выберите Angle из содержимого
Type; затем используйте инструменты выбора в поле Definition для выбора двух линий. В
поле Results система отображает измеренный угол.

Определение Наклона Двух Объектов

Для определения, где наклон двух выбранных объектов равен, выберите Tangent Point из
содержимого Type; затем используйте инструменты выбора в поле Definition для выбора
объектов. В поле Results, система отображает угол наклона в точках касания, расстояние
между двумя точками касания и координаты точек касания.

Определение Точки Перегиба Двух Объектов

Для определения точки перегиба двух выбранных объектов, выберите Intersection point из
содержимого Type; затем используйте инструменты выбора в поле Definition для выбора
объектов. В поле Results, система отображает угол наклона в точке перегиба для обоих
объектов и значения координат пересечения (в системе координат текущего рисунка).

Диалоговое Окно Show/Erase

Отображение Размеров в Рисунке

Используя диалоговое окно Show/Erase, можно отображать размеры модели в рисунке, а
также отображать размеры для диапазона элементов. Для отображения размеров в
изометрическом виде, установите опцию "allow_3D_dimensions� файла установок рисунка в
«yes».

Местоположение отображенных размеров модели зависит от ориентации вида. Обратите
внимание на следующие специальные случаи:

· если эскизная плоскость выдавленного или вращаемого сечения не является ни
параллельной, ни перпендикулярной экрану, система все равно отображает линейные
размеры сечения параллельными экрану.

· Для обрезанных видов, Pro/ENGINEER поворачивает размеры сечения вращения до 180
градусов для переноса их в плоскость вида.

· когда система не может отображать на эскизной плоскости размеры элемента
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протягивания (sweep), нормального к траектории, она показывает их на другом конце или,
если это невозможно, на некоторой промежуточной плоскости.

· Pro/ENGINEER не показывает размеры (в виде) элементов, которые были подавлены с
помощью By View. По возможности, он отображает их в другом виде.

Отображение Размеров Модели в Рисунке

1. В диалоговом окне Show/Erase, нажмите Show.

2. Нажмите Dimension или Reference Dimension в поле Type.

3. Выберите кнопку в поле Show By, чтобы определить, где отображать размеры в
рисунке.

4. Нажмите Preview для просмотра изменений. Выберите With Preview для указания
отображаемых элементов.

5. Щелкните по Close.

Пример: Образмеренный Рисунок

Определение Размера для Диапазона Элементов

1. В диалоговом окне Show/Erase, нажмите Show.

2. Нажмите Dimension в поле Type и Feature (или Feat & View).

3. Выберите GET SELECT > Sel By Menu. Выберите модель, для которой требуется
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показать размеры элементы.

4. Выберите SPECIFY BY > Number Range.

5. Введите нижний и верхний предел диапазона элементов.

Отображение Размера в Выносном и Частичном Видах

Размер, который ссылается на не твердотельные геометрические элементы (оси, опорные
точки, опорные плоскости и т.д.) может присутствовать в выносном или частичном виде
только, когда удовлетворяются следующие требования:

· не менее, чем один образмериваемый объект должен находится в пределах сплайновой
границы.

· Этот объект должен также находиться в пределах границы вида; граница вида
определяется твердотельной геометрией детали. (Не твердотельные геометрические
элементы не считаются твердотельной геометрией).

Проверьте соответствие этим требованиям до изменения вида на выносной или
частичный, или размеры не будут отображаться в новом виде.

Опция "clip_dimensions" файла установок рисунка воздействует на отображение размеров в
выносных видах. При установке ее в «yes», размеры, которые полностью лежат за
границей вида, не отображаются. Размеры, которые пересекают границу вида
отображаются, а выноски, который, не имеют ссылок на геометрию отображаются с
двойной стрелкой (>>). Для изменения стиля стрелки, установите заданный по умолчанию
стиль стрелки обрезанных размеров, определяя значение опции "clip_dim_arrow_style"
файла установок рисунка ("double_arrow" - значение по умолчанию).

Для Отображения Размеров в Сборочном Чертеже

1. Выберите DETAIL > Show/Erase.

2. В диалоговом окне Show/Erase, нажмите Show; затем нажмите Dimension в поле Type.

3. Для отображения размеров детали без отображения размеров объединенных элементов
(merged), сделайте следующее:

•  Выберите Part в диалоговом окне Show/Erase и укажите деталь на экране.

•  Выберите GET SELECT > Sel By Menu для выбора размеров исходной детали в списке
меню.

4. Для отображения размеров объединенных элементов в сборочном чертеже, выберите
Feature в диалоговом окне, и выберите GET SELECT > Query Sel для выбора элементов
детали, которая использовалась для ссылки или копии.

Отображение Размеров в Сборочных Чертежах

В сборочных чертежах можно отображать параметры элементов сборки и всех
компонентов сборки; однако, нельзя показывать размеры подсборок. Размеры в сборочном
чертеже видны только на уровне сборки. Необходимо иметь сборку, рисунок по которой
был создан в сессии для того, чтобы размеры отображались для изменений.

Обратите внимание: при использовании автоматической замены для замены модели
сборки другой моделью того же самого семейства, появляются эквивалентные размеры,
если система отображает размеры в сборочном чертеже на компоненте, который
заменяется новым вхождением. При использовании ручной замены, размеры не
сохраняются.
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Стирание Размеров в Рисунке

Размеры можно удалять с экрана, стирая их; при этом они не удаляются из модели.
Pro/ENGINEER повторно не восстанавливает местоположение размера после его
стирания. При повторном отображении размера, он может не появиться в том же месте,
что и прежде.

1. Выберите DETAIL > Show/Erase.

2. В диалоговом окне Show/Erase, нажмите Erase.

3. Нажмите Dimension или Reference Dimension в поле Type.

4. В поле Erase By, выберите следующее:

•  Selected Items � стирает указанные размеры.

•  Feature - стирает размеры выбранного элемента.

•  Feat & View � стирает размеры выбранного элемента, которые принадлежат
выбранному виду.

•  Part - стирает размеры, связанные с деталью в выбранном месте сборки.

•  Part & View � стирает размеры, связанные с деталью в виде.

•  View - стирает все размеры в выбранном виде.

•  Erase All -стирает все размеры в рисунке.

Отображение и Стирание Примечаний Вида

Для стирания и отображения примечаний вида (имя выносного вида, масштаб вида, имя
поперечного сечения, имя вида элементы диаграммы), используйте диалоговое окно
Show/Erase.

Отображение Примечаний Модели в Рисунке

Используя диалоговое окно Show/Erase и (при необходимости) Окно Дерева Модели,
можно отображать примечания модели в рисунках. Их положение в рисунке зависит от их
фактического расположения в модели. Не размещенные примечания появляются в месте
по умолчанию при отображении примечаний модели в рисунке. Можно использовать текст
примечания модели для создания примечания рисунка, считывая примечание модели из
файла.

Советы При Работе с Примечаниями Модели в Рисунках

При работе с примечаниями модели в рисунках, учитывайте следующее:

· при отображении примечания модели в рисунке, система не изменяет ее присоединение
или местоположение при изменении чего либо в модели. Также, при проведении каких
либо изменений в присоединении примечания или местоположении его в рисунке, система
не проводит таких изменений в модели.

· Нельзя вызывать примечания уровня рисунка в моделях.

· При изменении содержания примечания модели в рисунке, модель изменяется.

· Для запрещения изменений в примечаниях модели, необходимо установить опцию
"draw_models_read_only" файла конфигурации в «yes».
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Образмеривание

Концепция Образмеривания

Создание Размеров

При создании размеров в режиме Рисунка, опция "create_drawing_dims_only� файла
конфигурации определяет, будет ли система сохранять их в детали или в рисунке в
качестве ассоциативных эскизных размеров. При установке этой опции в «yes» (значение
по умолчанию - «no»), все новые размеры, созданные в рисунке, сохраняются в самом
рисунке как ассоциативные эскизные размеры. Размеры, созданные в рисунке и которые
ссылаются на геометрию детали, всегда ассоциативны независимо от установки опции
файла установок рисунка.

Обратите внимание: длина размеров, созданных в режиме Рисунка соответствует длине
объекта, как он отображается в виде и, поэтому, связанна с масштабом отображения
рисунка.

В режиме Рисунка можно создавать следующие типы размеров:

· ссылочный;

· управляемый;

· эскизный.

Ссылочные Размеры
В режиме Рисунка можно создавать ссылочные размеры, используя геометрию модели в
виде рисунка. Система сохраняет размеры с моделью и связывает их с видом, в котором
они были созданы. Все ссылочные размеры имеют ссылку "REF", отличающую их от других
размеров. Система заключает их в круглые скобки, если опция "parenthesize_ref_dim�
файла конфигурации установлена в «yes».

Управляемые Размеры
Можно создавать управляемые размеры в рисунке, которые ссылаются на геометрию
модели, выбирая кромки, вершины кромок, опорные плоскости, оси, точки и косметические
элементы. Подобно ссылочным размерам, модель управляет их значениями.

При работе с управляемыми размерами, учитывайте следующее:

· управляемые размеры отображаются в рисунке, в котором они были созданы, но система
сохраняет их с моделью. Их нельзя увидеть в других рисунках, в режиме Детали или
Сборки.

·Можно изменять количество цифр в значениях управляемых размеров, но округленное
значение размера не управляет геометрией модели. Управляемые размеры отражают
изменения в геометрии детали или сборки, но их нельзя выбирать для изменения
значений.

Эскизные Размеры
Для создания эскизных размеров, используются те же команды, при помощи которых
создаются размеры модели; однако, эскизные размеры работают иначе, чем управляемые
размеры. Эскизные размеры могут быть ссылочными, ассоциативными или
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неассоциативными. Значение образуется на основании масштаба эскиза (указывается с
использованием опции "draft_scale� файла установок рисунка) и фактических единиц и
размера листа рисунка.

Масштаб эскиза - отношение между видимым размером объекта и его фактическим
размером. Например, примем кромку детали - длиной 4 дюйма:

· если масштаб эскиза 1.0, объект отображается на рисунке размером в 4 дюйма.

· если масштаб эскиза 4.0, объект отображается на рисунке размером в 16 дюймов (то есть
в четыре раза больше фактического).

· если масштаб эскиза 0.5, объект отображается на рисунке размером в 2 дюйма (то есть в
два раза меньше фактического).

Обратите внимание: стандартные не ассоциативные эскизные размеры не изменяются в
соответствии с масштабом эскиза.

Привязывание размера в объекту эскиза связывает их вместе, чтобы размер отражал
изменения в объекте. Если эскизный размер будет сделан ассоциативным (используя
опцию "associative_dimensioning� файла установок рисунка), значение эскизного размера
изменяется при изменении масштаба эскиза, перемещении объекта, его обрезании или
пересечении. Система отражает изменения масштаба эскиза в значении эскизного размера
при регенерации рисунка и создании новых примитивов со значением масштаба.

Создание Управляемого или Ссылочного Размера

1. Выберите DETAIL > Create; затем выберите Dimension или Ref Dim из меню DETAIL
ITEM.

2. Из меню LIN ORD, выберите тип размера. При выборе Standard, выберите объекты,
между которыми требуется поставить размер.

3. Выберите кромку, кромку и точку, две точки или вершину, используя команды меню
ATTACH TYPE:

•  On Entity - присоединяет размер к объекту в точке указания, согласно правилам
создания стандартных размеров.

•  Midpoint - присоединяет размер к средней точке выбранного объекта.

•  Center - присоединяет размер к центру круглой кромки. Круглыми кромками считаются
скругленная геометрия (отверстия, скругления, кривые, поверхности и т.д) и круглые
примитивы. При выборе некруглого объекта, размер присоединяется к объекту
аналогично On Entity.

•  Intersect - присоединяет размер к ближайшей точке пересечения двух выбранных
объектов.

•  Make Line � ссылается на текущие оси x- и y- в ориентации вида модели.

Обратите внимание: для создания размера, управляемого длиной дуги, выберите
конечные точки и середину дуги; затем выберите ARC DIM TYPE > Arc Length.

4. Разместите размер. При выборе двух дуг или окружностей (система подсвечивает
каждую дугу или окружность поочередно), используйте меню ARC PNT TYPE и сделайте
следующее:

•  выберите Center для создания размера между центрами дуг, эллипсов или кругов.

•  Выберите Tangent для создания размера между кромками круга, дуги или эллипса в
ближайшем месте к точке выбора.

5. Из меню DIM ORIENT, выберите одну из следующих команд:

•  Horizontal - отражает расстояние по горизонтали.
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•  Vertical - отражает расстояние по вертикали.

•  Slanted - отражает кратчайшее расстояние между двумя точками присоединения
(доступно только, когда размер присоединяется к точке).

•  Parallel - отражает расстояние в направлении, параллельном другому объекту.

•  Normal - отражает расстояние в направлении, перпендикулярном другому объекту.

Совет: Создание и Перемещение Размера

Обратите внимание: в процессе создания размеров можно также перемещать их.

Однако, если в процессе создания нового размера по неосторожности будет выбран
существующий размер, система подсветит этот размер и продолжит перемещать его пока
не будет нажата средняя кнопка мыши.

Пример: Управляемые Размеры

Создание Стандартного Размера из Стандартной Ссылки

1. В меню DETAIL ITEM, выберите Dimension или Ref Dim.

2. Выберите DIM REF > Common Ref. Система подсвечивает первую ссылку последнего
созданного размера и использует ее в качестве первой ссылки следующего создаваемого
размера.

Использование Стандартной Ссылки

Используя команду Common Ref в меню DIM REF, можно создавать стандартные размеры
из стандартной ссылки.

Однако, для использования стандартной ссылки, последний созданный размер должен
иметь более одного ссылочного объекта. Если, например, последний созданный размер -
угловой, который обозначает угол раскрытия дуги, то он имеет только один ссылочный
объект (дугу), и система не будет использовать ее в качестве первой ссылки для
следующего размера. То же самое условие применяется для эскизных объектов.
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Пример: Создание Стандартного Размеры из Стандартной Ссылки

Использование Управляемых и Ссылочных Размеров в
Уравнениях

Управляемые (или типа "ad") и ссылочные размеры можно использовать только в правой
части уравнений (для управления значением другого размера или параметра). Если
управляемый размер используется в уравнении для управления размером модели, размер
модели также изменяется при регенерации модели в режиме Рисунка. Можно использовать
ссылочные размеры для управления размерами модели, потому что они регенерируются в
режиме Детали или Сборки; однако не следует использовать управляемые размеры для
управления размерами модели, так как могут появиться некорректные размеры модели при
изменении модели в режиме Детали или Сборки. Для добавления уравнения, используйте
команду Relations в меню DWG Set Up. Управляемые размеры могут ссылаться на систему
координат.

Создание Зигзага

1. Выберите MOD DIM TYPE > Lin to Ord > One Jog.

2. Выберите размер для преобразования из линейного в ординатный. Размер исчезает с
экрана.

3. Укажите две точки, соответствующие первому и второму указателю выносной линии
ординатного размера. Система всегда размещает размерный текст на одинаковом
расстоянии от модели, как если бы это был линейный размер, так что необходимо
выбирать точки вдоль выносной линии и между размерным текстом и моделью.

Добавление Зигзага

Зигзаг (jog) может добавляться к ординатному размеру при создании ссылочной базовой
линии. Однако, эту команду необходимо выбирать до выбора изменяемого размера. Также,
можно добавлять зигзаг к существующему ординатному размеру.
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Пример: Создание Зигзага в Ординатном Размере

Создание Координатного Размера

1. Выберите MODIFY DRAW > Dim Params > Dim Type > Coord Dim.

2. Используйте меню GET SELECT для выбора геометрии модели, чтобы присоединить
выноску координатного размера.

3. Выберите кромку, объект или ось в месте присоединения координатного размера.

4. Выберите местоположение символа размера.

5. Выберите соответствующий x- и y- размер. Система создает координатный размер с
этими значениями.

Обратите внимание: нельзя выбирать "ad", "dd" и ординатные размеры в качестве
координатных размеров.

Пример: Координатные Размеры

Используя команду Coord Dim в меню DIM TYPE, можно создавать координатные размеры
в рисунке. Для их изменения, выберите Value в меню MODIFY DRAW.
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Перемещение Размера Между Видами

1. Выберите DETAIL > Switch View (или нажмите кнопку Switch View в инструментальной
панели Pro/ENGINEER).

2. Выберите перемещаемый размер. Для выбора нескольких размеров за раз, можно
использовать Pick Many в меню GET SELECT.

3. Выберите вид.

Примечания: Если Pro/ENGINEER не может отобразить размер в выбранном виде, он
выдает предупреждение и не перемещает его.

При выборе размеров размноженных элементов, перемещаются все размеры массива.

При переносе в вид базовой линии ординатного размера, все ординатные размеры,
которые ссылаются на нее, также переносятся в вид.

Выравнивание Размеров

1. Выберите DETAIL > Align.

2. Выберите горизонтальный или вертикальный ссылочный размер для динамического
перемещения за раз. Выберите Done Sel.
3. Выберите точку на экране для их размещения.

Изменение Стиля Стрелки Выносок

Используя команду Arrow Style в меню MODIFY DRAW, можно изменять стиль стрелки
выносок размеров, примечаний, трехмерных примечаний, допусков на размер, символов,
или позиций. Например, можно изменять стрелку на точку или квадратик.

1. Выберите Modify > Arrow Style.

2. Выберите стрелку изменяемого объекта, и выберите один из стилей стрелки в меню
ARROW STYLE.

Обратите внимание: опция "draw_arrow_style� файла установок рисунка управляет стилем
стрелки для всех элементов, использующих стрелки, включая выноски размеров,
примечаний, трехмерных примечаний, допусков на размер, символов и позиций.

Опция "dim_dot_box_style� файла установок рисунка управляет отображением
(заполненный или пустой) точек и квадратиков только для выносок линейных размеров.

Можно также управлять стрелками выносок размеров следующим образом:
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1. Установите заданный по умолчанию стиль стрелки обрезанных размеров, определяя
значение для опции файла установок рисунка "clip_dim_arrow_style" ("double_arrow" -
значение по умолчанию).

2. Измените их направление, выбирая Flip Arrows из меню DETAIL.

Обратите внимание: нельзя изменять стиль стрелки угловых, диаметральных и
радиальных размеров.

Пример: Стили Стрелок

Создание Размеров Без Изгиба

1. Установите опцию "default_dim_elbows� файла установок рисунка в «no».

2. Создайте размер в рисунке. Система назначает размеру изгиб с нулевым значением по
умолчанию и делает следующее:

•  центрирует линию текста, содержащего значение размера по концу линии выноски.

•  Обрезает линию выноски по рамке, содержащей все линии размерного текста.

•  Дополняет высоту символов наполовину.

•  Отображает текст, выровненный по центру относительно конечной точки линии
размеры.

Обратите внимание: размер с выноской, который не имеет изгиба, отображается иначе, с
текстом, выровненный по центру (заданное по умолчанию выравнивание).

Изменение Углового Размера Для Отображения с Изгибом

1. Выберите DETAIL > Move Text.
2. Выберите точку, подальше от конца линии выноски. Размер отображается с изгибом.

Текст справа от изгиба отображается выровненным по левому краю, а текст слева от
изгиба отображается выровненным по правому краю.

Обратите внимание: AutoCAD не поддерживает угловые размеры с изгибом; изгибы
теряются при экспорте в AutoCAD.

Изменение Углового Размера для Отображения Без Изгиба

1. Выберите DETAIL > Move Text.
2. Выберите точку в пределах половины длины символа от линии выноски. Размер
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отображается без изгиба, а текст отображается выровненным по центру.

Зеркальное Отображение Размерных Линий

1. Выберите Move; затем выберите текст размера.

2. Переместите текст размера между размерными линиями.

3. Переместите размер в противоположную сторону.

Пример: Зеркальное Отображение Размерных Линий

Изменение Размера, Чтобы Символ Размера Всегда Отображался

1. Измените размер, выбирая Full Note ли Text Line в меню MODIFY DRAW.

2. Обязательно замените символ "@D", который показывает размерное значение на "@S"
для отображения символа размера. Весь текст, который был добавлен к размеру, будет
потерян.

Возврат Размера Назад к а Нормальному Отображению

Для возврата размера назад к нормальному отображению, используйте предшествующую
процедуру, и измените @S обратно на @D или @O (для размеров, которые содержат текст
вместо значения размера).

Можно заменять символ без потери уравнений, содержащих размер.

Линейные и Ординатные Размеры

Типы Размеров

Размеры могут быть линейными (стандартные) или ординатными. Этот раздел обсуждает
следующее:

· создание стандартных (ссылочных, управляемых или эскизных) линейных размеров.

· Управление ординатными размерами.
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· Создание координатных размеров.

Стандартные Размеры
При создании ссылочных, управляемых или эскизных размеров, размер можно
присоединять к объекту в точке указания, средней точке или ближайшей точке
пересечения двух выбранных объектов. Можно изменять тип присоединения при создании
размера.

Отдельно, можно делать следующее:

· ссылаться на текущие оси x- и y- в ориентации вида модели.

· Создавать стандартный размер из обычной ссылки.

· Использовать управляемый и ссылочный размеры в уравнениях.

Ординатные Размеры

Линейные размеры можно изменять таким образом, чтобы они отображались как
ординатные размеры. При изменении размера на ординатный укажите рисунок, где они
также отображаются в режиме Детали или Сборки, и в любом другом рисунке в котором
отображается модель. Ординатные размеры используют единственную выносную линию
без выноски, и связаны с базовой ссылочной линией и показаны в следующем рисунке как
".00". Все размеры, которые ссылаются на ту же базовую линию, должны совместно
использовать общую плоскость или кромку. Можно использовать общую плоскость или
кромку для базовой ссылочной линии.

Пример: Рисунок с Ординатными Размерами

Изменение Линейного Размера на Ординатный

Для изменения типа размера с линейного на ординатный, необходимо сначала установить
базовую ссылочную линию. Для любого набора связанных размеров (размеры, которые
совместно используют общую плоскость или кромку), необходимо создать только одну
базовую ссылочную линию. При создании базовой линии, она остается установленной,
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пока не будет установлена другая, или до выхода из меню MOD DIM TYPE. Только одна
базовая ссылочная линия может быть текущий (установленной) в один момент времени.
Для установки другой, выберите Set Base и выберите существующую базовую ссылочную
линию, которую требуется установить. Можно выбирать размеры, которые имеют
вспомогательные линии, совпадающие с установленной базовой линией и
преобразовывать их из линейного типа в ординатный.

При преобразовании размеров, к выносной линии можно добавлять зигзаг для увеличения
интервала между размерами.

Пример: Рисунок с Линейными Размерами

Преобразование Линейного Размера в Ординатный

Размер, который будет преобразован в ординатный должен отображаться как линейный.
Следующие размеры не могут быть преобразованы в ординатные:

· диаметральные размеры, отображаемые как линейные

· размер по осевой линии

1. Выберите MODIFY DRAW > Dim Params > Dim Type > Ordinate Dim > Create Base.

2. Выберите размер или размерный текст, чья выносная линия должна стать базовой
ссылочной линией.

Обратите внимание: при изменении размера, используемого для создания базовой
ссылочной линии, обратно в линейный размер, базовая ссылочная линия продолжает
существовать и отображаться в рисунке.

3. Выберите выносную линию, которая станет базовой ссылочной линией. Размер
автоматически изменяется на размер ординатного типа со значением .00.

4. Выберите MOD DIM TYPE > Lin к Ord.

5. Выберите линейные размеры. Система размещает каждый из них на конце выносной
линии, которая не совпадает с текущей опорной линией.

Обратите внимание: Нельзя выбирать размеры, которые не используют общую базовую
ссылочную линию.
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При преобразовании размеров из линейных в ординатные, базовая ссылочная линия
регенерируется. Однако, если пустая опорная линия (которая не связана ни с одним из
размеров) имеет управляемые дочерние размеры, то базовая ссылочная линия и дочерние
размеры не регенерируются. Если несколько управляемых размеров в рисунке ссылаются
на пустую базовую линию, измените схему образмеривания путем выбора стороны для
присоединения базовой ссылочной линии. Затем базовая ссылочная линия регенерируется
в правильном положении. Для обновления дочерних размеров выберите Regenerate из
меню DRAWING и далее Draft.
Обратите внимание: при попытке создания ассоциативных размеров, использующих не
ассоциативную базовую линию, система запросит подтвердить создание ассоциативных
ординатных размеров, использующих базовую ссылочную линию.

Стирание или Удаление Базовой Ссылочной Линии
Базовые ссылочные линии отображаются в рисунке или в модели как ".00". Используя
диалоговое окно Show/Erase, можно стирать их в рисунке для повышения наглядности.
Также, можно использовать Delete в меню DETAIL для удаления базовой ссылочной
линии, которая больше не нужна (если ординатные размеры с ней не связаны).

Для Отображения Размеров в Качестве Ординатных

1. Если опорная линия не существует, убедитесь, что размер, который должен стать
базовой ссылочной линией виден. Следует выбрать элемент и отобразить его размеры.

2. Выберите DETAIL > Show/Erase. В диалоговом окне Show/Erase, нажмите Show; затем
нажмите Dimension или Reference Dimension в поле Type. Отображается меню LIN ORD.

3. Выберите LIN ORD > Ordinate > Pick Bases. Если базовая ссылочная линия не
существует, выберите DETAIL > Create > Dimension > Ordinate для создания базовой
ссылочной линии; затем можно отображать ординатные размеры.

4. Если необходимо отобразить любые другие стандартные размеры в качестве
ординатных, сотрите их перед продолжением.

5. Еще раз нажмите Show; затем нажмите Dimension или Reference Dimension в поле
Type диалогового окна Show/Erase.

6. Выберите LIN ORD > Ordinate > Pick Bases. Выберите базовую ссылочную линию (это
значение .00) на виде.

7. После установки опорных линий, выберите ORD BASES > Show Dim.

8. Используя диалоговое окно Show/Erase, выберите элементы и виды для отображения
размеров. Размеры, использующие эту базовую ссылочную линию отображаются как
ординатные.

Отображение Размеров в Качестве Ординатных

Можно отображать размеры или ссылочные размеры как линейный или ординатные
размеры.

· если система не может отображать размер как ординатный по отношению к выбранным
базовым ссылочным линиям, она не отображает его вообще.

· если размеры отображаются в рисунке как ординатные, они отображаются как
ординатные и в модели.

Как правило, Pro/ENGINEER не отображает отрицательные или положительные значения
размеров, если опция файла конфигурации "show_dim_sign� не установлена в «yes».
Однако, при создании размеров относительно системы координат, или назначении им
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отрицательных значений, отрицательное значение отображается, даже если эта опция
установлена в «no».

Изменение Ординатных Размеров на Линейные

При преобразовании ординатного размера в линейный, размер теряет свою
ассоциативность с базовой ссылочной линией. При преобразовании размера обратно в
ординатный размер, можно выбирать любую соответствующую базовую ссылочную линию.

1. Выберите MODIFY DRAW > Dim Params > Dim Type > Ordinate Dim > Ord to Lin.

2. Выберите любой ординатный размер для преобразования.

Преобразование Диаметрального Размера в Линейный

Диаметральный размер можно преобразовывать в линейный размер, или линейный
диаметральный размер в диаметральный без переключения вида. При переключении вида
для одного из этих преобразованных размеров, Pro/ENGINEER пытается отобразить
размер в своем формате до преобразования, затем в преобразованном формата и,
наконец, в его исходном отображении.

Обратите внимание: нельзя преобразовывать линейный размер (например, глубину
выдавленного паза) в диаметральному размеру.

1. Выберите ТУСКЛЫЙ PARAMS > Diam Dim Type.

2. Сделайте следующее:

•  Выберите диаметральный размер. Вид переключается на линейный размер.

•  Выберите диаметральный размер для преобразования. Вид переключается на
диаметральный размер.

3. В пределах 5 градусов размер привязывается к вертикали или горизонтали, но можно
полностью поворачивать его относительно центра дуги при изменении положения.
Выберите DETAIL > Mod Attach для изменения ориентации.

Создание Управляемых Ординатных Размеров

1. Выберите DETAIL > Create > Dimension > Ordinate > Create Bases.

2. Выберите стандартный размер для преобразования в ординатный размер.

3. Выберите Create Dims и выберите базовую ссылочную линию.

4. Выберите кромку для образмеривания левой кнопкой мыши. Базовая ссылочная линия
остается выбранной пока не будут размещены размеры. Можно создавать более одного
ординатного размера за раз. Для этого, после выбора опорной линии, выберите любое
число кромок, образмериваемых от текущей базовой ссылочной линии.

5. По завершении выбора кромок, разместите размеры при помощи средней кнопки мыши.
Система размещает размеры от той же опорной линии. Для выбора новой базовой
ссылочной линии перейдите к Шагу 4.

Удаление Управляемых Ординатных Размеров

Можно удалять управляемые ординатные размеры или те, которые были созданы при
помощи команды Ordinate из меню LIN ORD и, затем, Create Dims.
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Процесс удаления опорной линии для управляемых ординатных размеров отличается от
процесса удаления опорной линии, когда размеры с общей выносной линией были
преобразованы из линейных в ординатные. Базовую ссылочную линию и размер, который
был преобразован для создания базовой ссылочной линии нельзя удалять, пока они не
будут преобразованы в линейный размер.

Создание и Удаление Ординатных Управляемых Размеров

При создании ординатных управляемых размеров, необходимо создать базовую
ссылочную линию в требуемом направлении путем преобразования стандартного размера
в ординатный размер и, затем, создать ординатные размеры, используя базовую
ссылочную линию.

При создании ординатных управляемых размеров, учитывайте следующее:

· нельзя создавать ординатные размеры из базового размера, если опция файла
конфигурации "create_drawing_dims_only" установлена в «yes» и размер с типом символа
"d" или �ad" (обозначающий управляемый размер модели или ассоциативный эскизный
размер) является активной базовой ссылочной ординатной линией.

· Для управления ориентацией текста ординатного размера, установите опцию
"orddim_text_orientation� файла установок рисунка в �parallel� или �horizontal�.

· Если опция "ord_dim_standard� файла установок рисунка установлена, можно
подсоединять ординатные размеры, измеренные от одной базовой ссылочной линии к
линии. Когда размерные линии связаны, все зависимые размеры перемещаются при
перемещении одного из них.

· Нельзя переносить ординатные управляемые размеры на другой вид.

Удаление Базовой Ссылочной Линии

1. Выберите DIM TYPE > Ordinate Dim > Ord to Lin.

2. Выберите ординатный размер, соответствующий базовой линии, но не саму базовую
ссылочную линию. Размер преобразовывается из ординатного в линейный.

3. Возвратитесь в меню DETAIL и выберите Delete.

4. Выберите удаляемый линейный размер (который был предварительно назначен в
качестве базовой ссылочной линии ординатного размера).

5. Выберите Done Sel. Появляется ссылка".00" для любых оставшихся ординатных
размеров.

Выносные Линии

Изменение Выносных Линий

Когда Pro/ENGINEER размещает размер на модели, он оставляет промежуток между
моделью и выносной линией. Опция �witness_line_offset� файла установок рисунка
управляет фактическим размером промежутка. Иногда этот промежуток не виден в
рисунке. Однако, он становится заметным при выводе на печать. Для просмотра, как
рисунок будет выглядеть при печати, выберите File > Print > Screen.

Выносная линия может иметь зигзаги и разрывы. При добавлении зигзага к выносной
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линии, которая уже имеет разрывы, разрывы, которые были созданы как простые,
отображаются на первом сегменте выносной линии, который не имеет зигзага. Если
выносная линия имеет разрыв размера, вставка зигзага перемещает разрыв к новой точке
изгиба.

Можно управлять выносными линиями следующими способами:

· создать параметрические или простые разрывы в размерных выносных линиях и в линиях
выносок примечаний и символов.

· Изменить размеры промежутка, используя команду Clip или Move. Можно одновременно
отсекать несколько размеров, которые имеют такую ориентацию, что конечные точки их
выносных линий выравниваются. Используя Move Many в меню DETAIL (или
инструментальную панель Pro/ENGINEER), можно управлять выносными линиями
следующими способами:

•  отсекать обе выносные линии размеров за раз.

•  Отсекать выносные линии нескольких размеров за раз. При указании выносной линии
каждого размера, система перемещает каждую из конечных точек совместно.

− Стирать и восстанавливать выносные линии.

− Наклонять выносные линии.

− Добавлять и удалять зигзаг из выносных линий линейного (стандартный и
ординатный) и углового размеров, выносок примечаний и выносок символа.

− Создавать и изменять угловые, диаметральные, радиальные и линейные размеры с
и без изгиба.

Ссылка на Текущие Оси X- и Y- в Ориентации Вида

Можно ссылаться на текущие оси x- и y- в ориентации вида модели, создавая
горизонтальные или вертикальные выносные линии, проходящие через одну или две
вершины. Эти функциональные возможности можно использовать в следующих режимах
всякий раз, при создании управляемого или ссылочного размеров:

· С Pro/DETAIL в режимах Рисунка и Pro/LEGACY

· С Pro/DESIGN в режиме Компоновки (всегда, когда компоновка доступна)

· В режимах Детали и Сборки

Создание Горизонтальных или Вертикальных Выносных Линий
Через Одну или Две Вершины

1. Выберите ATTACH TYPE > Make Line.

2. Используя меню MAKELINE, сделайте следующее:

•  Выберите 2 Points и укажите две вершины. Система подсвечивает их белым цветом и
создает синюю линию типа phantom, обозначающую линию, которая создается между
ними.

•  Выберите Horiz Line или Vert Line и укажите вершину, через которую проходит
горизонтальная или вертикальная выносная линия. Можно выбирать конечную точку
опорной кривой, вершину твердотельного элемента, начало системы координат,
опорную точку, косметическую конечную точку элемента или эскизную вершину.
Система подсвечивает вершину белым цветом и отображает две синих стрелки,
указывающие горизонтально или вертикально от вершины.
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Отсечение Выносной Линии Линейного Размера

1. В меню DETAIL выберите Clip или Move.

2. Выберите отсекаемую выносную линию размера. Используйте среднюю кнопку мыши
для завершения выбора.

3. Измените выносную линию, устанавливая курсор возле требуемого места отсечения и
нажмите левую кнопку мыши (повторите Шаги 2 и 3 для отсечения других выносных линий).

Пример: Отсечение Размеров

Стирание Выносной Линии Угловых, Линейных или Ссылочных
Размеров

1. Выберите DETAIL > Modify > Dim Params > Wit Line Disp > Erase.

2. Используя меню GET SELECT, выберите стираемую выносную линию.

3. Выберите Done Sel или нажмите среднюю кнопку мыши. Система стирает размеры и
затем перерисовывает их. При этом выносные линии скрываются и на их месте
отображаются двойные стрелки.

•  Для перемещения стрелки, выберите DETAIL > Clip.

•  Для удаления или изменения стрелки, выберите DIM PARAMS > Style Style.

Стирание Выносных Линий

Можно стирать только одну выносную линию размера. Пи попытке стереть вторую линию,
система стирает вторую линию и восстанавливает первую. Нельзя стирать обе линии.

Нельзя стирать выносные линии ординатных размеров (включая ординатные размеры по
стандарту ISO с перекрестной линией между базовой ссылочной линией и размером).

Нельзя скрывать выносную линию обрезанного размера (который был отсечен в
результате отсечения вида), и нельзя использовать Show для восстановления выносной
линии, которая была автоматически стерта (отсечена в результате отсечения вида).
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Восстановление Стертой Выносной Линии Линейного Размера

1. Выберите WLINE DISP > Show.

2. Выберите размерный текст со стертой выносной линией.

3. Выберите Done Sel или нажмите среднюю кнопку мыши. Система перерисовывает
выбранный размер и отображает его выносную линию с одной стрелкой на выноске.

Создание Простого Разрыва на Выносной Линии Выноски или
Размера

Используя команду Break в меню DETAIL, можно создавать промежутки во
вспомогательных линиях размеров и в линиях выносок примечаний, символов и
радиальных размеров.

Используя команду Simple в меню BREAK TYPE, можно создавать простой разрыв, то есть
промежуток произвольного размера в любом месте. Используйте Simple для разрыва
выноски или разрыва линии напротив выносок диаметра и удлинения размерной стрелки.

1. Выберите DETAIL > Break.

2. Выберите первую точку на выносной линии размера или выноске примечания, символа,
или допуска.

Отображается меню BREAK TYPE, позволяя создавать простой или параметрический
разрыв. Можно сделать выбор в этом меню; система предполагает, что разрыв - простой
разрыв, если место следующего выбора находится на той же самой выносной линии.
Simple и Parametric выбираются по умолчанию. Снимите флажок Parametric для создания
простого разрыва.

3. Выберите вторую точку на той же линии, указывающую величину разрыва. Система
создает промежуток между этими двумя точками.

Обратите внимание: нельзя разрывать радиальный или диаметральный размер дуги или
окружности, потому что это не выносная линия, а удлинение размерной стрелки.

Создание Параметрического Разрыва в Месте Пересечения
Выносных Линий

Используя команду Break в меню DETAIL, можно создавать промежутки в выносных
размерных линиях и в линиях выноски примечаний, символов и радиальных размерах.

Используя команду Parametric в меню BREAK TYPE, можно создавать параметрический
разрыв, который автоматически создает промежуток в месте пересечения выносных линий.
Опция "witness_line_offset� файла установок рисунка управляет размером этого
промежутка. Команда Parametric не создает разрывов в месте пересечения линий
выноски.

При изменении рисунка, можно создавать параметрические разрывы напротив выносных
размерных линий или присоединять линии. При изменении рисунка и создании разрыва
напротив линии привязки, разрыв перемещается вместе с перемещением линии привязки,
и удаляется при стирании или удалении другого размера.

Обратите внимание: параметрические разрывы не могут быть созданы напротив выносок
символа или примечания.

1. Выберите DETAIL > Break.

2. Выберите выносную линию линейного, углового, ординатного или размера по длине
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дуги.

3. Отображается меню BREAK TYPE, позволяя создать простой или параметрический
разрыв. Выбор в этом меню необязателен; система предполагает, что разрыв -
параметрический, если следующая точка указания находится на выносной линии другого
размера или на линии привязки. Опции Simple и Parametric выбираются по умолчанию.
Снимите флажок Simple для создания параметрического разрыва.

4. Выберите выносную линию другого размера или линии привязки для разрыва.

5. Используя меню BREAK SIZE, выберите одну из следующих команд:

•  Выберите Default и укажите размер промежутка для выбранной точки пересечения.
Система назначает заданный по умолчанию размер разрыва, который является
равным удвоенному расстоянию "witness_line_offset", указанному в файле установок
рисунка.

•  Выберите Pick и установите размер промежутка разрыва, перемещая указатель вдоль
выносной линии и используя левую кнопку мыши для завершения выбора размера
промежутка.

•  Выберите Radius и укажите значение радиуса разрыва.

Система создает параметрический разрыв в ближайшей точке пересечения ранее
выбранной выносной линии и второй выносной линии или линии привязки.

6. Для удаления всех разрывов, относящихся к выбранному размеру, выберите, BREAK >
Remove.

Изменение Выносных Линий

Размеры отдельного разрыва можно изменять в интерактивном режиме при помощи мыши.

1. Выберите DETAIL > Move.

2. Для изменения размера разрыва, выберите конечную точку разрыва выносной линии и
протяните их до требуемого положения. Промежуток в интерактивном режиме изменяется
и параметрические разрывы сохраняют свою ассоциативность.

Для удаления разрыва, выберите конец выносной линии и протащите его. Уменьшение
размера выносных линий до нуля удаляет разрыв.

Обратите внимание: можно также выбрать Modify в выпадающем меню для изменения
размера разрыва; затем выбрать размер и маркер выбора разрыва.

Наклон Выносных Линий

1. Выберите DETAIL > Move.

2. Выберите наклоняемый размер; затем выберите его новое положение. Размер
поворачивается относительно своей точки присоединения. Значение размера и угол его
выноски не изменяются.

3. Нажмите левую кнопку мыши для завершения ориентирования размера и переходите к
следующему размеру.
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Пример: Наклон Выносной Линии

Добавление Зигзага к Выносной Линии Линейного Размера

1. Выберите DETAIL > Make Jog.

2. Выберите размер для добавления зигзага.

3. Выберите точку на выносной линии. Оставшаяся часть выносной линии перемещается
вместе с указателем.

4. Выберите местоположение для точек зигзага, нажимая левую кнопку мыши.

5. Нажмите среднюю кнопку мыши. Система размещает зигзаг.

•  Для снятия выделения точек зигзага или завершения добавления точек зигзага,
нажмите среднюю кнопку мыши.

•  Для его удаления, выберите DETAIL > Remove и выберите изгиб зигзага.

Примечания:
Первый и последний сегменты зигзагообразной выносной линии всегда параллельны.

Когда система размещает зигзаг, он остается в том же самом месте рисунка, независимо
от перемещения размера.
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Пример: Добавление Зигзага к Выносной линии

Добавление Зигзага к Угловому Размеру

1. Выберите DETAIL > Make Jog.

2. Выберите размер, к которому будет добавлен зигзаг.

Обратите внимание: к угловым размерам можно добавлять только два зигзага; для других
типов размеров, можно добавлять любое количество зигзагов.

3. Выберите точку на выноске; затем выберите местоположение зигзага.

Диалоговое Окно Modify Dimension

Перемещение Размеров в Виде

Размеры можно перемещать в пределах вида, переносить их в другой вид и выравнивать
размеры горизонтально или вертикально так, чтобы они перемещались вместе.

1. Сделайте следующее:

•  Выберите DETAIL > Move или Move Text. Выберите перемещаемый размер; затем
выберите GET SELECT > Done Sel.

•  Нажмите кнопку Move Many в инструментальной панели Pro/ENGINEER (или выберите
команду Move Many в меню DETAIL) и выберите размеры. Эта команда выравнивает
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размеры так, чтобы их линии выноски совпадали, и перемещает их вместе.

•  Выберите DETAIL > Modify > Dimension. В диалоговом окне Modify Dimension
нажмите Move... или Move Text... и выберите размер.

Обратите внимание: для выбора собственно размера (ов), можно выбирать зависимые
объекты типа допусков на размер и баз.

2. Разместите выбранные размеры в новом месте, используя левую кнопку мыши. Для
возврата их в первоначальное положение, нажмите среднюю кнопку мыши.

Обратите внимание: ординатный размер можно перемещать в одном направлении, если
он не имеет зигзагов, или в двух направлениях, если он имеет зигзаг. Размер может
двигаться вдоль и перпендикулярно направлению его выносных линий.

Размещение Двойных Размеров в Рисунке

Для размещения двойных размеров, можно использовать различные опции в диалоговом
окне Modify Dimension:

· чтобы разместить вторичный размер под первичным, выберите Below в поле Dual
Dimensioning.

· для размещения вторичного размера на той же линии, что и первичный размер, выберите
To Right в поле Dual Dimensioning.

· для указания числа десятичных знаков, используемых для вторичного размера, введите
значение в поле Dual Number of Digits.

Обратите внимание: при использовании метрических размеров в качестве первичных или
вторичных единиц в двойных размерах, метрические размеры не отображаются в виде
дробей, если установлен дробный формат.

Использование Двойного Образмеривания

Используя опцию "dual_dimensioning" файла установок рисунка, можно отображать
размерный текст в двух форматах единиц - первичных или вторичны (или обоих). Эти
опции файла установок рисунка работают вместе с опцией "dual_dimensioning" при
изменении отображения двойных размеров:

· "dual_secondary_units" - определяет вторичные единицы, используемые в рисунке.

· "dual_digits_diff" - определяет число десятичных знаков вторичных единиц, по сравнению с
первичными единицами.

· "decimal_marker" - определяет символ, используемый в качестве десятичной точки во
вторичных размерах.

· "dual_dimension_brackets" - определяет отображение скобок для размеров одних из
единиц.

Обратите внимание: при использовании двойного образмеривания с допусками на
размер, система округляет вторичные значения, чтобы они всегда соответствовали
пределу диапазона, обозначенного первичными единицами (то есть так, чтобы они были
более жесткими, чем первичные значения), и сохраняли содержание конструкции.

Добавление Текста к Размеру, Используя Диалоговое Окно Modify
Dimension

1. Выберите DETAIL > Modify > Dimension.
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2. Выберите размер, используя меню GET SELECT; затем выберите Done Sel. В
диалоговом окне Modify Dimension, нажмите Dim Text.
3. Введите новый текст в полях Prefix и Postfix, стоящий перед и после размерного текста.

4. Щелкните по ОК. Система сохраняет размерный текст с моделью, и отображает его в
режиме Детали или в режиме Сборки.

Изменение Размерного Текста Добавлением Размеров и
Параметром Массива

1. Выберите DETAIL > Modify > Text.
2. Используя меню MODIFY TEXT, сделайте следующее:

•  Выберите Full Note или Text Line. Добавьте другие параметрические размеры или
параметры вхождений массива для размерного текста.

•  Выберите Dimension, выберите размер и выберите GET SELECT > Done Sel. В
диалоговом окне Modify Dimension, укажите опции вызова параметра в поле Prefix
или Postfix.

Обратите внимание: размеры и текст параметра можно размещать в управляемых
размерах или ассоциативных размерах, принадлежащих той же модели; однако, нельзя
размещать их в эскизных размерах или ассоциативных эскизных размерах.

Пример: Изменение Размеров Добавлением Параметров

Замена Любой Текстовой Строки в Управляемом и Ссылочном
Размерах

1. Выберите DRAWING > Modify > Text.
2. Используя меню MODIFY TEXT, сделайте следующее:

•  Выберите Full Note или Text Line.

•  Выберите Dimension, выберите размер и выберите GET SELECT > Done Sel. В
диалоговом окне Modify Dimension, щелкните по Dim Text.

3. Замените символ "@D" на "@O"; затем введите требуемый текст. Символ "O"
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представляет перезапись; любой текст после него перезаписывает значение размера.

Модель теперь отображает текстовую строку вместо значения размера во всех режимах
(Деталь, Сборка, Рисунок и так далее).

Обратите внимание: размеры должны всегда иметь отображенное значение. Если после
"@O" текст не введен, система игнорирует процедуру изменения управляемых размеров и
отображает текст "REF" при изменении ссылочных размеров.

Изменение Количества Десятичных Знаков

1. Выберите DETAIL > Modify > Num Digits.

2. Введите количество десятичных знаков.

3. Сделайте следующее:

•  выберите размеры. Выберите GET SELECT > Pick Many для выбора всей группы
размеров.

•  Выберите DETAIL > Modify > Dimension.

4. Выберите размеры; затем выберите GET SELECT > Done Sel.
5. В диалоговом окне Modify Dimension введите новое значение в поле Number of Digits.
Нажмите OK.

Примечания:
Для независимого управления отображением значений размеров для первичных и
вторичных единиц в рисунке (будет ли значение размера иметь округление первых или
незначащих нулей), используйте опцию "lead_trail_zeros� файла установок рисунка.

Для указания символа в качестве десятичной точки в размере - точка, запятая или запятая
только для метрических единиц, используйте опцию "decimal_marker� файла установок
рисунка.

Отображение размеров в Формате Градус/Минута/Секунда Без
Десятичных Значений

1. В диалоговом окне Modify Dimension, выберите Fractional для изменения размера на
дробный формат.

2. Введите значение [3600] в поле Largest Denominator. Можно ввести значение 60, если
опция файла установок рисунка "draw_ang_units" установлена в "ang_min", так как это
значение уменьшает любой размер до целого числа с точностью до минуты.

Совет: Другой Способ Изменения Отображения Угловых
Размеров:

· Для изменения количества отображаемых десятичных знаков, установите опцию
"default_ang_dec_places� файла конфигурации в значение от "0" до "14" (значение по
умолчанию "1").

· Для удаления незначащих нулей, в целях соответствия стандартам ANSI, установите
опцию файла установок рисунка "draw_ang_unit_trail_zeros" в «yes» (значение по
умолчанию). Это используется только, если полные секунды или поле секунд/минут равно
нулю. Выберите Fractional и введите [3600] в поле Largest Denominator для проверки.
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Отображение Размерных Символов

1. В диалоговом окне Modify Dimension, нажмите Dim Text.
2. В поле Dimension Text, обратите внимание на текущую установку "@D". Замените
символ D на S.

3. Щелкните по ОК. Выбранные размеры теперь отображают свои символьные значения, а
не значения размеров. Укажите префикс или постфикс при необходимости добавить текст к
значению размера.

Отображение и Изменение Символов Размерного Текста

Символы размера - текстовые символы, введенные для замены заданного по умолчанию
символа размера Pro/ENGINEER "@D". Можно отображать все символы размера или
устанавливать индивидуальные размеры, чтобы система отображала символы размеров
постоянно. Для временного переключения отображения всех размеров, выберите Switch
Dims из меню Info Pro/ENGINEER. При повторном выборе Switch Dims, размеры снова
изменятся.

Пример: Изменение Символов Размера

Изменение Значения Символов Размера

1. Выберите DETAIL > Modify > Dimension.

2. Выберите изменяемый размер; затем выберите GET SELECT > Done Sel.
3. В диалоговом окне Modify Dimension, нажмите Dim Text.
4. Значение в поле Name - текущий символ размера. Введите новый текст для изменения
значения символа.
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5. Щелкните по ОК. Система сохраняет новый символ размера, как измененный в модели,
и обновляет все уравнения, использующие этот символ.

Отображение Углового Размера в Градусах, Минутах и Секундах

1. В меню DETAIL нажмите Modify > Dimension.

2. Выберите изменяемый угловой размер и, затем, щелкните средней кнопкой мыши или
нажмите Done Sel. Открывается диалоговое окно Modify Dimension.

3. В поле Angular Dim Units, выберите следующее:

•  Degrees � отображает угловой размер в градусах.

•  Degrees, Min � отображает угловой размер в градусах и минутах.

•  Degrees, Min., Sec. � отображает угловой размер в градусах, минутах и секундах.

4. Угловой размер изменяется до указанной единицы.

Обратите внимание: можно также глобально изменять отображение угловых размеров,
используя опцию "draw_ang_units� файла установок рисунка.

Диалоговое Окно Clean Dimensions

Упорядочивание Размеров

Используя диалоговое окно Clean Dimensions, можно автоматически упорядочивать
отображение размеров, делая следующее:

· центрировать размеры между выносными линиями (включая все текстовое поле с
допусками, символами диаметра, допусками и так далее).

· Размещать все размеры по одну сторону кромки модели, опорной плоскости, видимой
кромки, оси или линии привязки.

· Упорядочивать размеры во всем виде или, выбирая размеры индивидуально.

· Автоматически зеркально отображать стрелки.

· Смещать размеры от кромок и от границ вида.

Обратите внимание: нельзя обращаться к всплывающему меню Pro/ENGINEER при
использовании диалогового окна Clean Dimensions.

Для Упорядочивания Размеров

1. Выберите DETAIL > Tools > Clean Dims (или используйте кнопку Clean Dims в панели
Pro/ENGINEER).

2. Используя инструменты выбора, выберите размеры или весь вид; затем выберите GET
SELECT > Done Sel.
Обратите внимание: нельзя упорядочивать размеры, которые не параллельны выбранной
ссылочной линии или не находятся в пределах одного вида. Система подсвечивает эти
размеры зеленым цветом.

3. Введите начальную величину смещения в поле Offset. Для размещения выбранных
размеров, введите приращение смещения в поле Increment.
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4. Сделайте следующее:

•  Выберите View Outline для смещения размеров относительно границ их вида.
Переходите к Шагу 7.

•  Выберите Baseline для переноса размеров только в одном виде, чьи выноски
параллельны выбранной опорной линии Переходите к Шагу 5.

5. Выберите следующее для использования в качестве базовой линии упорядочивания:

•  опорную плоскость, перпендикулярную к экрану;

•  кромку модели;

•  линию привязки;

•  ось;

•  сторону границы вида.

6. Укажите направление, щелкая по Flip Arrow.

7. Щелкните по Apply. Система применяет косметическое упорядочивание ко всем
размерам. Нажмите Undo, чтобы возвратиться в предыдущее состояние и попытаться
снова без повторного выбора размеров.

Пример: Упорядочивание Размеров

Определение Косметического Упорядочивания Размеров

1. В диалоговом окне Clean Dimensions, щелкните по Cosmetic.

2. Выберите виды или отдельные упорядочиваемые размеры. Не следует выбирать
размеры повторно, если их уже упорядочивали с использованием страницы Placement
диалогового окна.

3. По умолчанию, система выбирает все переключатели. Снимите любой из них или все;
затем нажмите Apply:

•  Auto flip arrows - зеркально отображает стрелки внутри выносных линий, если они
выровнены (без наложения на текст); если они не выровнены или накладываются на
текст, они отображаются снаружи выносных линий.

•  Center text - выравнивает по центру текст каждого размера между его выносными
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линиями. Если текст не выравнивается, система перемещает его за выносные линии в
указанном направлении:

Horizontal � смещает текст влево или вправо.

Vertical � смещает текст вертикальных размеров вверх или вниз.

•  Create snaplines - создает линии привязки под всеми перемещенными размерами
(если размер уже не имеет линии привязки). Они отображаются только под размерами,
параллельными базовым линиям (если была выбрана базовая линия) или
параллельными границе вида (если была выбрана граница вида). При снятии этого
флажка, он остается снятым до конца сессии Pro/ENGINEER.

Размерный Текст

Изменение Размерного Текста

Используя команды в меню MODIFY DRAW и диалоговом окне Modify Dimension, можно
изменять размерный текст (содержание текста, а не положение текстовых строк)
различными способами:

· добавлять текст к размерам;

· добавлять параметры;

· заменять текст в управляемых и ссылочных размерах;

· изменять число цифр;

•  изменять десятичный разделитель;

•  изменять значения размеров;

•  отображать угловые размеры в формате градусы/минуты/секунды без десятичных
цифр;

•  изменять значение числа;

· связывать выносные элементы с размерным текстом.

Можно также отображать и изменять символы размерного текста, а также управлять
позиционированием размерного текста относительно линий выноски.

Добавление Текста к Размеру, Используя Меню MODIFY DRAW

1. Выберите DETAIL > Modify > Text.
2. Используя меню MODIFY DRAW, сделайте следующее:

•  Выберите Text Line и добавьте текст после размера.

•  Выберите Full Note и вызовите редактор операционной системы. Размер
представляется, как @D.

Обратите внимание: нельзя редактировать какой либо существующий текст, связанный с
размером. Например, для 12.0 REF, примечание отображается как "12.0 REF TYPICAL.".

3. Отредактируйте размер. При выборе Full Note, можно добавлять текст в любом месте
возле размера (до, после, выше или ниже). Можно также заменять текст, обычно
связываемый с размером. Например, размер диаметра обычно отображается как Æ 12.0,
но его можно заменять (выглядит как ^An^B в редакторе) словом "diameter". Размер теперь
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отображается как "diameter 12.0."

Обратите внимание: изменяйте размерный текст тем же способом, каким изменяете
стандартный текст. Однако после добавления текста к размеру, нельзя изменять никакие
текстовые параметры независимо от размерного текста.

Изменение Численного Значения Размеров Модели

1. Выберите DETAIL > Modify > Value.

2. Выберите значение изменяемого размера и введите новое значение.

3. Выберите Regenerate; затем выберите модель для обновления. Модель отражает
проведенные изменения.

Обратите внимание: нельзя изменять размеры в рисунке, которые принадлежат
обрабатываемой сборке.

Связывание Выносных Элементов с Размерным Текстом

Перед или после создания примечания, допуска на размер или символа, можно
непосредственно связать его с размерным текстом, чтобы выносной элемент перемещался
с размером, когда последний изменяет свое местоположение. При создании нового
символа, примечания, или свободного эскизного допуска на размер, можно связывать его с
размером при указании его размещения. Для связывания существующего выносного
элемента с размерным текстом, выберите Relate Dim в меню TOOLS.

Управление Ориентацией Размерного Текста

Можно управлять позиционированием размерного текста относительно линий выноски в
опции "рисунка text_orientation� файла установок.

· при установке его в horizontal (значение по умолчанию), размерный текст всегда
отображается горизонтально, по центру выноски.

· При установке его в parallel, размерный текст всегда отображается параллельно линиям
выноски, независимо от их ориентации. Можно использовать опцию
"parallel_dim_placement� файла установок рисунка для указания, будут ли отображаться
значения размеров как указано выше или под выноской. Размерный текст должен быть
параллельным, чтобы эта опция работала; эта опция не работает для двойных размеров.

Отображение угловых размеров контролирует опция "angdim_text_orientation� файла
установок рисунка, а не "text_orientation-controls�.

Как показано в следующем рисунке, "angdim_text_orientation� имеет следующие значения:
horizontal, horizontal_outside, parallel_outside, parallel_above, and parallel_fully_outside.

Отображение Текста Угловых Размеров
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При вызове рисунка, созданного до Версии 15.0, значения транслируются следующим
образом:

· если значение "text_orientation� установлено в parallel, значение "angdim_text_orientation�
устанавливается в parallel_outside.

· если значение "text_orientation� установлено в horizontal, значение
"angdim_text_orientation� устанавливается в horizontal.

Управление Отображением Размерного Текста Фаски

Устанавливая опцию "chamfer_45deg_dim_text" файла конфигурации, можно управлять
отображением размерного текста фаски без изменения выноски. Это воздействует только
на текст вновь создаваемых размеров. Для изменения размеров, созданных перед
изменением установки, необходимо вручную редактировать текст. Используя опции файла
установок рисунка "chamfer_45deg_leader_style", можно управлять типом выноски размера
фаски без изменения текста. Опции "chamfer_45deg_dim_text" и
"chamfer_45deg_leader_style" следует использовать вместе для выполнения
соответствующих стандартов. Для управления передними и незначащими нулями в
значении размеров, используйте опцию "lead_trail_zeros� файла установок рисунка.

Размерные Допуски

Допуски на Размер в Pro/DETAIL

С лицензией Pro/DETAIL, можно устанавливать стандартные допуски по ANSI или ISO и
переключать их отображение. Допусками на размер можно управлять, используя
установленные таблицы допуска. Система назначает каждой модели допуска по стандарту
ANSI или ISO.

· при переключении с ISO к ANSI, система назначает допуски ANSI на основании
номинального количества цифр размера и удаляет ссылочную таблицу допусков.



Pro/ENGINEER 2000 i2 Pro/DETAIL Выпуск Документации

 - 197 -

· при переключении с ANSI к ISO установленная таблица допусков управляет допусками по
стандарту ISO.

Создание Модели по Стандарту ISO в Режиме Рисунка

1. Выберите DRAWING > Advanced > Set Up.

2. Выберите DWG SET UP > Tol Setup > Standard > ISO/DIN.

Pro/ENGINEER загружает системные и пользовательские таблицы, и Общая (General)
таблица управляет всеми размерами.

Создание Модели по Стандарту ISO

Система загружает таблицы допусков в модель, при создании ее по стандарту ISO или
переключении стандарта допусков с ANSI к ISO. Для создания модели по стандарту ISO,
установите опцию файла конфигурации "tolerance_standard" в "ISO". Так как таблица
определяет регенерацию модели, система сохраняет их с моделью на постоянной основе,
и их можно использовать только с управляемыми размерами. Доступны четыре типа
таблиц допусков:

· General (Основная, одна в модели).

· Broken Edge (Притупление Кромок, одна в модели).

· Holes (Отверстия, несколько в модели).

· Shafts (Валы, несколько в модели).

При создании размера, система назначает ему допуск из Общей таблицы. При назначении
допуска на размер, таблица допусков и ее значения управляют теперь значениями допуска
размера. Можно переключать ссылку таблицы допусков размера на любую другую таблицу.
Размеры в моделях ISO, которые управляются Таблицами Отверстий или Валов,
отображаются следующим образом:

Для Изменения Класса Допуска

1. Выберите TOL SETUP > Model Class.

2. В меню TOL CLASSES, выберите имя класса.

3. Все размеры, управляемые таблицами General или Broken Edge получают новые
значения допуска. Регенерируйте модель.

Изменение Класса Допуска

Каждая модель по стандарту ISO имеет дополнительный атрибут называемый классом
допуска, который определяет общую точность обработки модели. Опция "tolerance_class�
файла конфигурации устанавливает заданный по умолчанию класс допуска для моделей
ISO (значение по умолчанию �medium (средний)"). Система использует класс допуска
вместе со значением размера при вызове допусков для размеров General или Broken Edge.
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Для Загрузки Системных и Пользовательских Таблиц

После загрузки новых таблиц, система назначает новые размерные допуски и можно
регенерировать модель.

При регенерации модели выбирая Regenerate в меню DRAWING и Model в меню
REGENERATE, система проходит по всем размерам и переназначает их допуска из таблиц
допусков. При изменении допуска размера, система удаляет ссылки этого размера на
таблицы допусков и значение допуска остается тем же, пока он не будет изменен снова
или не будет переназначена таблица допуска.

При ошибке регенерации после выбора Modify Value в меню TOL TBL ACT и Value в меню
MODIFY DRAW, все соответствующие размеры приобретают резервные значения допуска.
Однако, новые таблицы допусков остаются.

Загрузка Системных и Пользовательских Таблиц

Опция "tolerance_table_dir� файла конфигурации устанавливает каталог по умолчанию для
пользовательских таблиц допусков. Все таблицы Отверстий и Валов перезаписывают
существующие таблицы при загрузке. При загрузке таблиц General и Broken Edge,
учитывайте следующее:

· при загрузке одной таблицу, которая имеет тот же установленный класс имен, что и
модель, система принимает новую таблицу.

· при загрузке таблицы, которая содержит имена класса, которые конфликтуют с уже
загруженными в системе, система не загружает такие имена класса.

· при загрузке двух таблиц с именами класса, которые не конфликтуют с системными, но
отличаются от них, они перезаписывают системные.

· если класс модели по умолчанию не существует в новых именах, необходимо определить
новый класс.

Пример: Таблица Допуска
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 Изменение Ссылочной Таблицы Допусков

1. Выберите TOL SETUP > Tol Tables. Появляется меню TOL TBL ACT со следующими
командами:

•  Modify Value - отображает таблицы в меню TOL TABLES. Их содержание можно
изменять, используя Pro/TABLE.

•  Retrieve � вызывает установленные таблицы в модель.

•  Save - сохраняет таблицу допусков.

•  Show - отображает таблицу допусков, как показано ниже.

 2. Сделайте следующее:

•  Выберите Modify Value, выберите таблицу, выбирая General Dims или Broken Edges,
и выберите размеры.

•  Выберите Holes или Shafts; затем введите название таблицы и номер класса

Изменение Ссылочной Таблицы Допусков

Все вхождения в семействе используют одни и те же установленные таблицы допуска,
одного стандарта допусков и того же самого класса. При изменении ссылочной таблицы
допусков, учитывайте следующее:

· при изменении единиц модели, но сохранении всех размерных значений, система
обновляет значения допуска для отражения изменений всех размеров модели.

· если таблица допусков Отверстий или Валов управляет допусками размера, их нельзя
отображать в формате "плюс минус, симметричный". Система предполагает, что таблицы
General и Broken Edge имеют симметричные значения.

· при размещении допуска на размер в таблице семейства, система удаляет ссылку на нее
из таблицы допусков. Также, при переводе модели из стандарта ANSI в ISO или наоборот,
система сохраняет допуски в таблицах семейства и не назначает ссылочную таблицу на
эти размеры.

· если значение размера выходит за пределы диапазона, указанного в таблице, система
использует ближайший диапазон для получения допуска (то есть, использует последний
диапазон в таблице системы (2000-4000) для определения допусков для значений
размеров 2000 или более).

Установка Таблицы Допусков для Отдельных Размеров

1. Выберите DETAIL > Modify > Dimension.

2. Выберите размер. Выберите GET SELECT > Done Sel.
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3. В диалоговом окне Modify Dimension, выберите формат допуска в т списке Tolerance
Mode. Укажите значения в соответствующих полях:

•  для формата Limits, укажите значения в полях Upper Tolerance и Lower Tolerance.

Для форматов Nominal и Plus-Minus, укажите значения в полях Nominal Value, Upper
Tolerance и Lower Tolerance.

•  Для форматов +-Symmetric и As Is, укажите значение в поле Nominal Value.

4. Щелкните по ОК. При появлении допусков, система перечисляет значения допуска по
умолчанию в нижнем правом углу экрана.

Эти значения по умолчанию можно устанавливать в файле конфигурации или изменять их
индивидуально, выбирая DETAIL > Modify > Value.

Установка Отображения Допуска

Для включения/выключения отображения допуска, можно использовать опцию "tol_display�
файла установок рисунка. Отображение допусков размеров по умолчанию можно
устанавливать, используя опцию "tol_mode� файла конфигурации.

Используя опцию "maintain_limit_tol_nominal� файла конфигурации, можно сохранять
номинальное значение размера независимо от изменений, проводимых для значений
допуска. При установке опции в «yes», система не изменяет Nominal Value (номинальное
значение) размера на формат допуска Limit, при установке формата в Limits или
изменении значения верхнего или нижнее отклонения поля допуска.

Изменение Количества Десятичных Знаков в Примечании Допуска

Используя поле Number of Digits в диалоговом окне MODIFY DIMENSION или команду
NUM DIGITS в меню MODIFY DRAW, можно изменять число цифр для отдельных допусков.
При этом допуск сбрасывается в значение по умолчанию, соответствующее
указанному количеству десятичных знаков. Затем можно изменять значение отдельных
допусков.

Значение Num Digits зависит от установки опции "default_dim_num_digits_changes� файла
конфигурации:

· при установке опции в «yes» (значение по умолчанию), система устанавливает
количество цифр в последнее введенное значение. Также, при создании размера, по
умолчанию устанавливается количество цифр, связанных с установкой Num Digits.

· при установке опции в «no», опция использует значение опции файла конфигурации
"default_dec_places". Также, для созданных размеров по умолчанию устанавливается
значение "default_dec_places".

Если размер отображается в двойных единицах, система вычисляет значение допуска
вторичных единиц так, чтобы они всегда находились в пределах, установленных
значением допуска первичных единиц. Таким образом, может происходить сокращение, а
не округление вторичных допусков.

Изменение Допуска на Размер в Примечании

Можно создавать примечание, в котором допуск на размер, введенный как параметр,
заменяется его значением. Следующий рисунок иллюстрирует используемый формат.
Подобный формат можно использовать для включения углового значения допуска в
примечание. Например, ведите [&angular_tol_0_0] для отображения " 0.5" (значение по
умолчанию для одного десятичного числа).
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Формат Допусков Размеров

Поскольку система включает допуски в примечание как параметры, между значением
допуска в примечании и моделью существуют связь. При изменении значения допуска в
примечании, система обновляет таблицу допусков по умолчанию в режиме Детали. Для
изменения значение допуска в примечании, выберите Modify в меню DETAIL и Value в
меню MODIFY DRAW; затем введите новое значение допуска.

Обратите внимание: таблицы допусков не влияют на размеры резьбы. Размеры резьбы
входят в модель, имеющую те же допуски, с которыми система их сохранила. Для
изменения их допусков, необходимо выбрать Modify в меню DETAIL и Value в меню
MODIFY DRAW, после чего выбрать каждый размер.
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Примечания Рисунка

Создание и Сохранение Примечаний
Рисунка

Примечания Рисунка

В режиме Рисунка, можно считывать в примечание текстовый файл или непосредственно
вводить текст. Примечание может быть частью размера, присоединенного к одному или
более кромкам модели, или существовать в рисунке свободно. Pro/ENGINEER создает
примечания, используя значения по умолчанию (типа высота, шрифт), указанные в файле
установок рисунка.

В процессе создания примечания, можно определить следующие характеристики:

· Выноски

•  без выноски или несколько выносок.

•  Выноска присоединялся к кромке модели или эскизному объекту, указывая на любую
точку рисунка.

•  Выноска присоединялся к кромке модели или точке опорного элемента.

•  Линия выноски по стандарту ISO.

•  Выноска, перпендикулярная объекту.

•  Выноска, касательная к объекту.

· Формат / размещение

•  Горизонтальный.

•  Вертикальный.

•  Отображенный под указанным углом.

•  Выровненный по левой кромке.

•  Выровненный по правому знаку.

•  Центрированный.

•  Связанный с размерным текстом.

· Текстовый стиль.

После создания первого примечания, Pro/ENGINEER создает последующие примечания,
используя уже определенные атрибуты.
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Добавление Примечания в Рисунке Без Выноски

1. Выберите DETAIL > Create > Note > No Leader и любую из других доступных команд в
меню NOTE TYPES.

2. По завершении, выберите Make Note.

3. Выберите местоположение для примечания.

4. Сделайте следующее:

•  При выборе Angular, введите угол для примечания между 0 и 359°.

•  При выборе Enter, система переключает все размеры на символьное представление
для возможного ввода в текстовом режиме. Введите требуемый текст.

•  При выборе File, введите имя файла и расширение.

Добавление Примечания в Рисунке с Выносками

1. Выберите DETAIL > Create > Note > Leader и любые другие доступные команды в меню
NOTE TYPES, включая тип требуемой выноски:

•  Standard � использует заданный по умолчанию тип выноски.

•  Normal Ldr � создает выноску, перпендикулярную к объекту; в этом случае,
примечание может иметь только одну выноску.

•  Tangent Ldr � создает выноску, касательную к объекту; в этом случае, примечание
может иметь только одну выноску.

2. По завершении, выберите Make Note.

3. При выборе в качестве типа выноски Standard, укажите тип присоединения, выбирая в
меню ATTACH TYPE:

Возможна любая комбинация команд меню ATTACH TYPE. Выберите команду и
разместите выноску; выберите другую команду и разместите эту выноску, пока не
закончите.

4. По завершении, выберите команды для линий выноски и выберите конечную точку
(свободную или на объекте), выберите ATTACH TYPE > Done.

Примечание отображается в указанном местоположении, присоединенным к геометрии
кромки линиями выноски.

Обратите внимание: любое изменение ссылочной кромки соответственно перемещает
примечание после регенерации модели. Если примечание или символ с выноской
присоединен к геометрии, которая удалена или подавлена, то примечание или символ
автоматически становятся свободными.
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Пример: Примечание с Выносками

Пример: Примечания с Выносками, Присоединенными к Средним
Точкам
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Пример: Примечания

Добавление Примечания, Присоединенного к Кромке Модели или
Опорной Точке

1. Выберите DETAIL > Create > Note > On Item и любую другую из доступных команд в
меню NOTE TYPES.

2. По завершении, выберите Accept. Выберите местоположение на кромке или опорной
точке для примечания.

3. Введите угол примечания между 0 и 359°.

Обратите внимание: нельзя перемещать примечания, созданные с использованием On
Item, но его можно изменять любым способом.

Меню ATTACH TYPE в Pro/DETAIL

· On Entity - создает примечание с выноской, присоединенной к кромке модели или
геометрии рисунка. Выбор объекта около его вершины размещает выноску в вершине.

· On Surface - размещает выноску на геометрии модели или поверхностях. Можно
выбирать геометрию модели, резьбы и опорные поверхности. После присоединения к
поверхности и переориентации вида, присоединение остается. Если размер поверхности
изменяется, система соответственно обновляет точку выноски. Для изменения или
удаления существующих поверхностей присоединения, используйте команду Mod Attach в
меню DETAIL.

· Free Point - размещает выноску в любом месте рисунка. Необходимо иметь лицензию
Pro/DETAIL для создания примечания с использованием этой команды.

· Midpoint - размещает выноску в средней точке кромки модели или геометрии рисунка.
Следующий рисунок иллюстрирует, где может находиться средняя точка объектов типа
сплайнов, дуг, окружностей и эллипсов.

· Intersect - размещает выноску в месте пересечения двух кромок модели или двух
примитивов.

· Arrow Head - создает выноску со стрелкой.

· Dot - создает выноску с точкой.

· Filled Dot - создает выноску с залитой точкой.

· No Arrow - создает выноску без стрелки.

· Slash - создает выноску с наклонной чертой вправо.

· Integral - создает выноску с интегралом.

· Box - создает выноску с квадратом.

· Filled Box - создает выноску с заполненным квадратом.
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Связывание Примечания с Размерным Текстом

1. Выберите DETAIL > Create > Note > Dim Related и любую из других доступных команд в
меню NOTE TYPES.

2. По завершении, выберите Accept.
3. Выберите размерный текст и положение относительно текста.

Ввод Примечания из Файла

1. Выберите DETAIL > Create > Note > File и любые другие необходимые команды в меню
NOTE TYPES; затем Make Note.

2. Выберите местоположение в рисунке для примечания.

3. В меню SELECT FILE, сделайте следующее:

•  Используйте команду Enter NAME: для вызова примечания из указанного каталога и
введите имя файла с расширением (например, filename.xxx, где xxx � любая
комбинация буквенно-цифровых знаков).

•  Используйте команду Current Dir для вызова примечания из текущего каталога.

•  Используйте команду Note Dir для вызова примечания из заданного по умолчанию
каталога примечаний. Pro/ENGINEER не сохраняет примечания по умолчанию с
расширением ".txt". Если файл не имеет расширения ".txt", он не отображается в
каталоге примечаний по умолчанию.

В указанном месте появляется примечание.

Обратите внимание: в файле нельзя использовать табуляцию, так как текст примечания
при этом выравнивается в рисунке некорректно.

Ввод Примечания из Файла или с Клавиатуры

При вводе примечания из текстового файла, файл может находиться в текущем каталоге,
или может присутствовать в пути поиска файлов, указанному с использованием опции
"pro_note_dir� файла конфигурации. Примечание можно ввести из файла, который
содержит размеры, параметры, специальные символы и текст в под- или надстрочном
формате. Однако, нельзя вводить характеристики типа высоты, ширины, угла поворота и
угла наклона текста. Необходимо использовать команды в меню MODIFY TEXT для
изменения этой информацию вручную.

При использовании клавиатуры для ввода текста примечания вручную, можно добавлять
пустые строки, создавать под- или надстрочный текст, добавлять символы и включать
информацию о параметрах.

Добавление Пустой Строки к Примечанию

При вводе текста примечания, нажмите клавишу ENTER на пустой строке для выхода из
создания примечания.

Для включения пустой строки в текст примечания, нажмите клавишу "ПРОБЕЛ" и, затем,
клавишу ENTER.

Для добавления пустой строки между текстовыми строками в отдельном примечании,
используйте команду Full Note для редактирования и добавления пустых строк.
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Создание и Сохранение Примечаний Рисунка

Используя меню Info Pro/ENGINEER, можно сохранять в файл следующую информацию:

· аннотации к видам.

· Примечания с или без выноски, содержащие любое количество строк.

· Параметры (система заменяет параметры их значениями после копирования в файл).

Сохранение примечаний на диск с использованием Info > Drawing > Write Note
автоматически добавляет расширение .txt и приращение версии. Поэтому примечание
автоматически отображается в меню при их вызове.

Система сохраняет каждое выбранное примечание в отдельном файле. При указании
имени файла, имя вводится без расширения. Система автоматически добавляет
расширение .txt по умолчанию и приращение версии (например, note.txt.1). Примечания
можно сохранять с другим расширением (например, note.ascii.1). Система использует
указанное расширение вместо .txt и добавляет приращения версии (note.ascii.1). При вводе
имени существующего файла, система автоматически обновляет приращение версии
чтобы не перезаписать существующий файл (note.txt.2).

Обратите внимание: В процессе обработки, Pro/ENGINEER теряет информацию по
заключению в рамку и подчеркиванию и не сохраняет специальные символы. Для их
сохранения, откройте примечание в текстовом редакторе и сохраните его внутри
редактора.

Запись Примечания в Файл

1. В меню Pro/ENGINEER, выберите Info > Drawing > Write Note.

2. Выберите сохраняемое примечание.

3. Введите название файла. В случае необходимости, выберите другое примечание, и
введите имя файла.

4. Выберите Done Sel.

Добавление Примечания Позиции

1. Выберите DETAIL > Create > Balloon.

2. Выберите соответствующие команды в меню NOTE TYPES.

3. Выберите Done и укажите тип выноски, в случае необходимости.

4. Выберите кромки или начальную точку для выносок; затем выберите Done Sel.
5. Выберите местоположение примечания позиции и введите текст.

Обратите внимание: для управления примечанием позиции можно использовать
выпадающее меню, аналогично управлению примечаниями рисунка.

Добавление Примечания Позиции

Примечания позиции состоят из текста, заключенного в окружность. Их можно добавлять в
любом месте рисунка или присоединять к любому количеству кромок. При вводе
многострочного текста в примечание позиции, система заключает каждую строку в
окружность, размещая их в стеке горизонтально или вертикально рядом с друг другом, в
зависимости от выбранной опции Horizontal или Vertical в меню NOTE TYPES. Размер
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таких связанных позиций равен наибольшей из них.

Для ограничения размера позиции, используйте опции "max_balloon_radius� файла
установок рисунка или "min_balloon_radius".

Пример: Создание Примечания Позиции

Изменение Текста Примечаний

Создание Текста в Надстрочном и Подстрочном Формате

Для создания надстрочного текста, введите [@+text@#], а для создания подстрочного
текста, введите [@-text@#], где, text � надстрочный или подстрочный текст примечания.

Правила Создания Надстрочного и Подстрочного Текста

Надстрочным и подстрочным текстом может быть простой текст и специальные символы;
однако, таким форматом нельзя создавать размеры, номера вхождений, другие значения
параметров или допусков на размер. Надстрочным и подстрочным текстом может быть
отдельное примечание, включенная в текст строка или ее часть со стандартным текстом.
Система позиционирует текст относительно ближайшей строки стандартного текста, вне
зависимости является ли этот текст � частью другого примечания, или частью
создаваемого примечания.

Пример: Ввод Надстрочного и Подстрочного Текста

Надстрочный и подстрочный текст были введены в нижнем регистре с целью визуального
выделения.
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Размещение Эскизных и Ссылочных Размеров в Примечаниях и
Таблицах

Эскизные (add и dd) и ссылочные (rd) размеры можно размещать в примечаниях и
таблицах рисунка параметрически с использованием &add или &dd. Эскизные
(управляемые) и ссылочные размеры, созданные в рисунке обновляются при регенерации
модели.

Для размещения эскизных и ссылочных размеров в таблицах чертежей, выберите, TABLE
> Enter Text.. Выберите ячейку таблицы, и введите символ размера с предшествующим
ему символом амперсанта (&).

Ввод Специальных Текстовых Символов

При вводе строк текста в примечания, можно использовать специальные текстовые
символы, специальные символы и символы рисунка.

При необходимости отобразить символы & или @ в тексте примечания, необходимо ввести
их дважды.

Пример: Ввод Специальных Текстовых Символов

Например, введите [See Views 1 && 2 @@ Sheet 3]. При этом отобразится �See Views 1 & 2
@ Sheet 3�.

Ввод Специальных Символов

Специальные символы можно добавлять к текстовым строкам в примечаниях, вводя их с
клавиатуры, окна палетты или текстового файла.

Таблицу, содержащую все специальные символы, доступные в Pro/ENGINEER, а также их
определения и символьные представления ASCII, см. Руководство по Инсталляции и
Администрированию Pro/ENGINEER.

Добавление Специальных Символов к Текстовому Символу с
Использованием Клавиатуры

1. Нажмите CTRL-a для включения в файл специального символьного шрифта.

2. Введите символы ASCII, которые представляют специальные символы.

3. Нажмите CTRL-b для выключения файла специального символьного шрифта.

Система отображает специальное окно Symbol Palette при вводе текста примечания.

Добавление Символов Рисунка

Символ рисунка можно включать в примечание, если его образец присутствует в рисунке.
Для включения символа используйте следующий формат:

&sym(<symbolname>)

Введите имя файла символа без расширения.
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Обратите внимание: Нельзя вызывать символы рисунка в размерах, которые сохранены с
моделью (типа "d" или "ad").

При включении образца основного символа, после ввода имени символа, выберите группы,
которые составляют образец (это подобно созданию образцов основного символа).

При редактировании примечания с использованием команд Full Note или Text Line,
система представляет символ в следующем формате:

n:&sym(sym_path)

Где "n" - номер текстового элемента, а "sym_path" - имя или путь к символу.

Обратите внимание: Pro/ENGINEER отображает символ рисунка в текстовом примечании,
к которому он был добавлен, но не отображает его в строке размерного текста. Размерный
текст всегда находится в режиме детали и, поэтому, не может приобретать символы
рисунка, которые находятся в режиме Рисунка.

Опция Файла Конфигурации Symbol Palette Input

Для изменения размеров окна палетты можно использовать команды операционной
системы, но окно возвращается к своим нормальным размерам каждый раз при нажатии
клавиши ENTER. При установке опции "symbol_palette_input� файла конфигурации в «yes»,
палитра отображается всякий раз при вводе примечания. При установке опции в «no», окно
не отображается.

При перемещении указателя на каждый символ или символ в палетте, система
подсвечивает этот символ; при его выборе, символ вводится в эквиваленте ASCII
(заключается между ^A и ^B) в тексте создаваемого примечания. Для определения
собственного специального шрифта и символов, см. Руководство по Инсталляции и
Администрированию Pro/ENGINEER.

Пример: Добавление Символа Рисунка

Например, если рисунок содержит образец символа "bevel", то для включения символа в
примечание, введите [&sym(bevel)].

Включение Символа в Примечание

1. Выберите DETAIL > Create > Note.

2. Введите примечание в формате, описанном ранее.

3. Задайте высоту символа.

4. Для образца основного символа, выберите группы, составляющие образец. Для
завершения описания образца, введите любой текст, в случае необходимости.

5. Для завершения примечания, дважды нажмите клавишу ENTER.

Включение в Примечания Информации по Параметрам

При установке опции "yes_no_parameter_display� файла в �yes_no�, параметры могут иметь
значение "yes� или �no� в примечаниях рисунка. При установке опции в �true_false�
(значение по умолчанию), они могут иметь значение �true� или �false�.

Для определения информации по параметру в примечании, используйте следующий
формат:
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· размеры - &d# или &ad#, где # - идентификатор размера. Примеры: &d12. &ad5.

· Ссылочный размер - &rd#, где # - идентификатор размера. Пример: &rd2

· Номер образца - &p#, где # - идентификатор параметра. Пример: &p8

· Пользовательский параметр - &xxxx, где xxxx - символ, определенный в уравнении.

· Имя опорного элемента - &dtm_name, где name - название опорной плоскости.

· ярлычки рисунка - к рисунку можно добавлять следующие ярлычки:

•  &todays_date � добавляет дату создания примечания в форме dd-mm-yy (например, 2-
Jan-92). Его можно редактировать позже как любое другое непараметрическое
примечание, используя Text Line или Full Note. Если этот символ включается в
таблицу формата, система рассчитывает его при копировании формата в рисунок.

•  &model_name � добавляет модель, используемую для рисунка.

•  &dwg_name - добавляет название рисунка.

•  &scale - добавляет масштаб рисунка.

•  &type - добавляет тип модели рисунка.

•  &format - добавляет размер формата.

•  &linear_tol_0_0 through &linear_tol_0_000000 � добавляет значение линейного допуска с
первого по шестое десятичное место.

•  &angular_tol_0_0 through &angular_tol_0_000000 - добавляет значение углового допуска
с первого по шестое десятичное место.

•  &current_sheet - добавляет номер листа в котором расположено примечание.

•  &total_sheets - примечание общего количества листов рисунка.

· Параметры рисунка - &parameter:d, где parameter - название параметра. Можно изменять
значение, используя команду Value в меню MODIFY DRAW.

Параметры в Примечаниях

Дополнительно к текстовым и специальным символам, примечания могут включать
размеры модели, параметры вхождений массива, символы, ярлычки рисунка и параметры
рисунка. Опция "yes_no_parameter_display� файла установок рисунка управляет
отображением параметров yes/no в примечаниях рисунка и таблицах.

Правила Определения Информации по Параметрам в
Примечаниях

При определении информации по параметрам в примечании, учитывайте следующие
ограничения:

· при включении размеров в примечания, система удаляет их из исходных видов.

· Нельзя добавлять эскизные размеры (ассоциативные - add # или неассоциативные - dd#)
к примечанию.

· Название опорного элемента в примечании - только для чтения, поэтому его нельзя
изменять. В отличие от размеров, название опорного элемента не исчезает из вида
модели, если оно включено в примечание. Система заключает его название в
прямоугольник, как будто это установленный опорный элемент.

· Нельзя использовать ярлычки рисунка в уравнениях; их можно использовать только в
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примечаниях рисунка и таблицах.

· При отображении примечания, система заменяет размеры и параметры
соответствующими числовыми значениями. При установке опции "switch_dims_for_notes�
файла конфигурации в «yes», размеры отображаются как их символьные значения в
процессе создания примечания. При установке опции в «no», они остаются числовыми
значениями.

· Перед созданием ссылки на модель в параметрическом примечании, убедитесь, что эта
модель добавлена к рисунку. Иначе, система не рассчитывает параметры модели,
находящиеся в примечании.

· В примечание можно включать символ gtol, вводя его как параметр. Однако, в примечания
нельзя включать глобальные параметры (параметры, созданные в компоновке) и эскизные
размеры.

Пример: Символы Параметров для Примечаний
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Пример: Примечание с Параметрами

Изменение Текстовой Строки

После создания примечания, можно создавать, заменять и удалять текстовые стили.

Используйте опцию Text Line в меню MODIFY TEXT для замены текстовой строки другой
строкой, или используйте команду Full Note для их редактирования, используя редактор
операционной системы.

Если строка очень длинна (более 250 символов), вероятно, придется использовать Full
Note. Все примечание отображается в окне системного редактора.

Текстовые Строки

При редактировании текста, значения размеров отображаются следующим образом:

· @D (если отображается как числовое значение).

· @S (если отображается как символьное значение).

· @O (если размер не имеет значения, @O размещается в начале текста).

· Специальные символы отображаются между контрольными символами ^A и ^B.

При редактировании примечания с использованием Text Line и Full Note, система
сохраняет все атрибуты (шрифт, высота, ширина или угол наклона) текста. Однако,
примечание отображается сильно отличающимся от того, как оно выглядит в рисунке.
Система разрывает текстовую строку на части везде, где имеется новая строка текста или
параметра (типа размеров), и включает каждую часть текста в фигурные скобки ({}),
присваивая собственную метку. Метка идентифицируют исходный порядок текста, и все



Pro/ENGINEER 2000 i2 Pro/DETAIL Выпуск Документации

 - 215 -

атрибуты этой части. При редактировании или добавлении нескольких строк текста, можно
копировать атрибуты части текста с использованием этой метки.

Обратите внимание: При удалении специальных управляющих символов при
редактировании текста, текстовые строки изменяются. При удалении ^A, все специальные
символы принимают свой эквивалент ASCII; при удалении ^B, весь последующий текст,
становится специальным символом.

Можно редактировать примечания относящиеся к виду, типа примечаний сечения,
выносного вида и масштаба; однако, убедитесь, что символы, представляющие название
или масштаб вида не удалены или не изменены любым другим способом. При
редактировании этих символов, система игнорирует изменения, и отображает
первоначальное примечание:

· " &view_name" � имя вида

· " &view_scale" � имя основного масштабированного вида

· " &det_scale" � масштаб выносного вида

При установке опции "view_note" файла установок рисунка в "std_din", можно создавать
примечание, связанное с видом, с пропущенными словами �SECTION�, �DETAIL� и
�SEE_DETAIL�. Это воздействует только на создание примечаний, связанных с видом. При
переключении "std_ansi" на "std_din", система не обновляет примечания вида.

Правила Использования Меток Примечания

При использовании меток примечания, учитывайте следующее:

· система обрабатывает текст, который не включен в фигурные скобки или неправильно
помечен, как обычный текст.

· Текст, помеченный номером большим, чем тот, который фактически присутствует,
использует атрибуты метки с большим номером.

· Фигурные скобки можно отображать в текстовой строке. Для левой скобки включите
только скобку. Для правой скобки, чтобы система не интерпретировала ее как конец части
текста, введите две правых скобки подряд (}}). Например, для �Origin {X,Y,Z}�, введите
[{Origin {X,Y,Z}},}].

Изменение Строки Текста Примечания

1. Выберите DETAIL > Modify > Text > Text Line.

2. Выберите текст.

3. Текстовая строка отображается в области сообщения. Для перемещения в начало или
конец строки, используйте CTRL + левая стрелка и CTRL + правая стрелка,
соответственно.

Система вставляет или удаляет символ слева от позиции курсора.
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Пример: Эффект Редактирования Текста Примечания

Определение Существующего Текстового Стиля в Качестве
Текущего Стиля

При создании примечания, можно использовать существующий стиль текста, выбирая Cur
Style в меню NOTE TYPES. При изменении текущего стиля с установленного по умолчанию
на другой, это влияет только на новые примечания, текст позиций, символы и текст таблиц.

При выборе Default в меню SEL STYLE, система использует стиль, который определен
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опциями "drawing_text_height�, "text_width_factor� и "text_thickness� файла установок
рисунка.

Определение Шрифта по Умолчанию

По умолчанию, Pro/ENGINEER создает текст стандартным шрифтом ASCII, указанном в
меню. Утолщенная версия системного шрифта по умолчанию (залитый шрифт) также
доступна в качестве альтернативного шрифта. Можно определить шрифт ISO, как
заданный по умолчанию шрифт, устанавливая опцию "default_font� файла установок
рисунка в "isofont�, или можно установить любой из поддерживаемых Pro/ENGINEER
шрифтов, как значение по умолчанию для конкретного рисунка.

В дополнение к этим шрифтам, с Pro/ENGINEER поставляются четыре дополнительных
шрифта, перечисленные в следующей таблице и 41 шрифт True Type.

Leroy font set leroy

Calcomp Alphabetical font set cal_alf

Calcomp Greek and Mathematical Symbol set cal_grek

ISO font set isofont

Шрифты TrueType расположены в каталоге загрузки Pro/ENGINEER. Дополнительные
Шрифты TrueType могут быть куплены и помещены в каталог загрузки. Шрифты TrueType
более сложны, чем шрифты PTC и поэтому требуют большего времени для перерисовки.
См. Руководство по Инсталляции и Администрированию Pro/ENGINEER для информации
относительно расположения файлов шрифта в каталоге загрузки.

По умолчанию, любые шрифты, помещенные в каталог загрузки отображаются в
выпадающем списке в диалоговом окне Text Style. Может быть определен другой каталог,
используя опцию "pro_font_dir� файла конфигурации.

Следующая таблица перечисляет доступные Шрифты TrueType и их соответствующие
имена файлов.

Шрифты TrueType

Имя Шрифта Имя Файла Для Опции
Установки

Blueprint MT bluprnt.ttf

Blueprint MT Bold bluprntb.ttf

CG Century Schoolbook schlbk.ttf

CG Century Schoolbook Bold schlbkb.ttf

CG Century Schoolbook Bold Italic schlbkbi.ttf

CG Century Schoolbook Italic schlbki.ttf

CG Omega cgomg.ttf

CG Omega Bold cgomgb.ttf

CG Omega Bold Italic cgomgbi.ttf

CG Omega Italic cgomgbit.ttf

CG Times cgtime.ttf

CG Times Bold cgtimebd.ttf
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CG Times Bold Italic cgtimebi.ttf

CG Times Italic cgtimeit.ttf

CG Triumvirate trium.ttf

CG Triumvirate Bold triumb.ttf

CG Triumvirate Bold Italic triumbi.ttf

CG Triumvirate Condensed Bold triumcb.ttf

CG Triumvirate Italic triumi.ttf

Garamond garamd.ttf

Garamond Bold garamdb.ttf

Garamond Italic garamdi.ttf

Garamond Kursiv Halbfett garamdbi.ttf

Garth Graphic gargra.ttf

Garth Graphic Black gargrabl.ttf

Garth Graphic Bold Italic gargrabi.ttf

Garth Graphic Italic gargrai.ttf

Grotesque MT grotesq.ttf

Grotesque MT Bold grotesqb.ttf

Microstyle Extended microex.ttf

Microstyle Extended Bold microexb.ttf

Neographik MT neograph.ttf

Sackers English Script sackengs.ttf

Shannon shanno.ttf

Shannon Bold shannob.ttf

Shannon Extra Bold shannoeb.ttf

Shannon Oblique shannoo.ttf

Spartan Four MT sparton4.ttf

Spartan One Two MT sparton12.ttf

Spartan One Two MT Bold sparton12b.ttf

Triumvirate Inserat triin.ttf
Если требуются дополнительные шрифты TrueType, их можно купить. Для информации,
свяжитесь с Agfa Corporation по адресу http:\\www.agfadirect.com.

Создание Собственных Шрифтов

Можно создать собственный шрифт и установить его в качестве заданного по умолчанию
или вспомогательного шрифта в рисунке. Для информации относительно создания



Pro/ENGINEER 2000 i2 Pro/DETAIL Выпуск Документации

 - 219 -

пользовательских шрифтов, см. Руководство по Инсталляции и Администрированию
Pro/ENGINEER. Обратите внимание, что при запуске Pro/ENGINEER, система ищет файлы,
указанные в индексном файле, сначала в локальном каталоге. Если она их не находит, то
Pro/ENGINEER ищет в каталоге загрузки. При сохранении пользовательских шрифтов в
локальном каталоге, их необходимо перемещать в новый каталог всякий раз при
перемещении рисунка. Если система не находит шрифты, используемые в рисунках, она
использует другой шрифт. При этом текст изменяется соответственно. Поэтому, следует
содержать файлы шрифта в каталоге загрузки.

Изменение Текста Рисунка

1. Выберите, MODIFY TEXT > Text Style.

2. Выберите текст и выберите GET SELECT > Done Sel.
3. В диалоговом окне Text Style выберите необходимые опции.

4. Щелкните по Apply. Текст изменяется. Для возврата текста к старому стилю, нажмите
Reset Settings.

Диалоговое Окно Text Style

· Для изменения шрифта, выберите имя шрифта в списке Font.
· Для изменения текста, снимите флажок Default и введите значение в поле Height.
· Можно также изменять высоту выбирая MODIFY TEXT > Text Height.
· Для изменения ширины, снимите флажок Default и введите значение в поле Width Factor.
· Для изменения толщины, снимите флажок Default и введите значение в поле Thickness.

· Для изменения угла наклона, введите значение в поле Slant Angle.

· Для подчеркивания текста, выберите флажок Underline.

· Для изменения интервала между линиями, снимите флажок Default и введите значение в
поле line spacing.

· Для попорота текста, введите значение угла поворота в поле Angle (примечание можно
вращать относительно точки, выбирая TOOLS > Rotate).

· Для задания горизонтального выравнивания, выберите значение в списке Justify Horiz.

· Для задания вертикального выравнивания текста в индивидуальных ячейках таблицы,
выберите значение в списке Justify Vert.
· Для зеркального отображения текста, чтобы он читался наоборот, выберите флажок
Mirror. (Можно также отображать одиночное примечание относительно линии, выбирая
TOOLS > Mirror). Для отображения примечания, необходимо сначала его выбрать; затем
выбрать линию зеркального отображения.

Что Можно Изменять в Диалоговом Окне

Можно изменять шрифт, ширину и цвет существующего текстового стиля. Однако, система
автоматически не обновляет никакой текст, которому предварительно был назначен этот
стиль (то есть до проведения изменений). Изменения, сделанные с использованием этого
диалогового окна влияют только на текст, стиль которому был назначен после изменения в
диалоговом окне.
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Изменение Цвета Текста в Рисунке с Использованием Системных
Цветов

1. Выберите MODIFY TEXT > Text Style.

2. Выберите текст; затем выберите GET SELECT > Done Sel.
3. В диалоговом окне Text Style, выберите поле Color.
4. В диалоговом окне Color, выберите системный цвет в поле System Colors; затем
нажмите OK. Система отображает выбранный текст указанным цветом и закрывает
диалоговое окно.

5. Для возврата текста к старому стилю, нажмите Reset Settings. Для возврата
выбранному тексту его истинного цвета, нажмите Intrinsic в диалоговом окне Color.

Создание Собственного Цвета

1. В диалоговом окне Color, нажмите New....
2. Используя инструмент Pro/ENGINEER Color Editor, определите новый цвет, перемещая
ползунки RGB вправо и влево. Нажмите на цветовую область для установки требуемого
цвета или нажмите OK. Новый цвет отображается в поле User-defined Colors.

3. Для создания файла color.map для сохранения пользовательских цветов текстового
стиля, нажмите Store Map в диалоговом окне Color.
4. Щелкните по ОК. Диалоговое окно Color закрывается.

5. В диалоговом окне Text Style, нажмите Apply. Система отображает выбранный текст
указанным цветом, и сохраняет цвет в модели. Для возврата текста к старому стилю,
нажмите Reset Settings.

Обратите внимание: используйте опцию "line_style_standard" файла установок рисунка
для управления цветом текста в рисунках Pro/ENGINEER. Пока эта опция не будет
установлена в "STD_ANSI", весь текст в рисунках отображается синим цветом, а граница
выносных видов, видов с разрывом и половинных видов отображаются желтым цветом.

Создание и Редактирование Пользовательских Текстовых Стилей

Используя команду Style Lib в меню MODIFY TEXT, можно создавать новые текстовые
стили, а также изменять и удалять существующие стили.

1. Выберите MODIFY TEXT > Style Lib. В диалоговом окне Text Style Library, нажмите
New.....
2. В диалоговом окне New Text Style, введите название в поле Style Name, выберите
существующий стиль в списке Style Name или нажмите Select Text....
3. Определите атрибуты для нового стиля, делая соответствующий выбор или вводя
значения.

4. После изменения всех атрибутов, нажмите OK.

5. Закройте диалоговое окно и сохраните изменения, нажимая Close (кнопка Cancel
изменяется на Close после проведения каких либо изменений).
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Изменение Существующего Стиля Текста

1. Выберите MODIFY TEXT > Style Lib.

2. В диалоговом окне Text Style Library, просмотрите элементы в списке Styles и выберите
имя текстового стиля.

3. Щелкните по Modify... в диалоговом окне Modify Text Style, измените атрибуты стиля,
делая соответствующий выбор или вводя значения.

4. После определения всех атрибутов, нажмите OK. Текстовый стиль изменится.

5. Для возврата текст к старому стилю, нажмите Reset Settings.

Удаление Существующего Текстового Стиля

1. Выберите MODIFY TEXT > Style Lib.

2. В диалоговом окне Text Style Library, просмотрите элементы в списке Style и выберите
существующий стиль текста.

3. Щелкните по Delete.

4. В меню Confirm Deletion, нажмите Yes. Система удаляет текстовый стиль.

Изменение Параметров Примечания

Управление Форматом Даты, Отображаемой в Рисунке

Опция "todays_date_note_format� файла конфигурации управляет исходным форматом
даты, отображаемой в рисунке. Установленный формат - строка, состоящая из трех частей:
год, месяц и день. Эти элементы можно вводить в любом порядке. Значение по умолчанию
- "%dd- % mmm- % yy".

· Год

•  %yy, для 97

•  %yyyy, для 1997

· Месяц (если месяц содержит две цифры (например, 10), обе записи % mm, % м. или % м.,
дают одинаковый результат)

•  %Mmm, для Jan

•  %MMM, для JAN

•  %Month, для January

•  %MONTH, для JANUARY

•  %mm, для 01

•  %m, для 1

•  % м., для <пробел> 1

· День (Поэтому, запись "%dd %mm %yy" дает "01 01 97", а "%MMM %d %yyyy" дает �JAN 1
1997�)

•  %dd, для 01
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•  %d, для 1

•  % d, для <пробел>1.

Следующие форматы также действительны:

· %dd- % Mmm- % yy (= 01-Jan-97)

· %mm / % dd / % yy (= 01/01/97)

· %Mmm %dd, %yyyy (=Jan 01, 1997)

Ссылочные Параметры, Назначенные Объекту

В примечаниях модели и рисунка для ссылки на параметры, которые были назначены
объекту в режиме Детали или Сборки, используйте следующий формат:

· Для кромок:

&<param_name>:EID_<edge_name>

· Для поверхностей:

&<param_name>:SID_<surface_name>

· Для других объектов:

&<param_name>

Включение Параметра Элемента в Примечание

Для включения параметра элемента в примечание, используйте следующий формат:

&<param_name>:FID_<feat_ID>

Или

&<param_name>:FID_<FEAT_NAME>

Пример: Параметры в Примечаниях

Следующий пример иллюстрирует использование параметра в примечаниях:

1. В режиме детали, назначьте имя "A" поверхности.

2. Создайте параметр с именем "RAD" численного типа.

3. Назначьте этому параметру значение ".03".

4. В режиме Рисунка, создайте примечание, введя [Break sharp edge with R = &RAD:SID_A].
Это примечание отображается как: �Break sharp edge with R =.03�. (притупить острые
кромки R=0.3 примечание переводчика)

Если примечание рисунка присоединено в одном месте (определенное с использованием
On Item или одной линией выноски), можно отображать параметры объекта, к которому
оно присоединено, вводя в примечание следующую строку: &param_name:att. Система
интерпретирует param_name в различных вариантах, пока не рассчитает его успешно.
Сначала, она ищет собственно объект, к которому примечание присоединено, типа кромки.
Затем, система ищет элемент, которому принадлежит примитив. Если это не
удовлетворяет условиям параметра, система ищет модель, которой принадлежит элемент.
Наконец, если используется, система ищет компонент, который ссылается на модель. Если
требуется определить точный контекст в котором интерпретируется параметр, укажите
вместо этого полный постфикс �att_�.
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После создания примечания, при выборе Switch Dims в меню Info Pro/ENGINEER, система
добавляет постфикс �att_�, чтобы определить точный контекст, в котором интерпретируется
параметр.

param_name:att_edge Кромка

param_name:att_feat Элемент

param_name:att_mdl Модель

param_name:att_cmp Компонент

Например, если примечание присоединено к кромке единственной линией выноски (или
определена с использованием On Item), можно устанавливать примечание для
отображения зависимого параметра этой кромки, вводя [&Length:att]. Примечание
отображается следующим образом: &Length:att_edge.

Обратите внимание: примечание рисунка необходимо создавать после создания
параметра; иначе, система не рассчитает его правильно.

Ссылочные Примечания Модели в Примечаниях Рисунка

Для ссылки на примечание модели в примечании рисунка, сделайте следующее:

· создайте примечание в режиме Детали или Сборки, выбирая Notes в меню SETUP.

· Добавьте параметр примечания к модели, используя Add Param в меню RELATIONS;
значением для этого параметра является идентификатор примечания.

Включение Примечания Модели в Примечание Рисунка

Для включения примечания модели в примечание рисунка, используйте формат
"&<param_name>" .

Пример: Включение Примечания Модели в Примечание Рисунка

1. В модели, создайте следующее примечание: �all surfaces must be painted� (все
поверхности должны быть окрашены примечание переводчика) с идентификатором 1.

2. Добавьте параметр "part_note� со значением 1.

3. В режиме Рисунка, введите следующее примечание:

[Applies to all parts:

&part_note]
Появляется следующее примечание:

Applies to all parts:
all surfaces must be painted
Обратите внимание: нельзя вставлять текст "part_note" рядом с любым другим текстом
примечания. При вызове параметра примечания в другом примечании, вызванный
параметр отображается на новой строке.
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Отображение Данных Pro/PDM

Можно отображать имя базы данных модели на листе рисунка, а также номер версии
модели в этой базе данных изделия и ее уровень, вводя в примечание следующие записи:

· для отображения базы данных модели в нулевой точке, введите параметр "&PDMDB".

· для отображения версии модели, введите параметр "&PDMREV".

· для отображения номера версии рисунка, введите параметр "&PDMREV:D".

· для отображения уровня модели, введите параметр "&PDMRL".

Ссылка на Символ Масс- Инерционных Характеристик в
Примечании

Можно создавать параметрическое примечание, которое ссылается на символ масс-
инерционных характеристик. После изменения геометрии, примечание можно обновлять
для отображения последнего значения параметра масс-инерционных характеристик.

1. Установите пользовательский параметр. Например: [volume].

2. Добавьте уравнение, назначая этот параметр символу масс-инерционных характеристик,
на который ссылается примечание. Например: volume = mp_volume(��).

3. Добавьте примечание, содержащее пользовательский параметр. Например: [&volume].

Обновление Параметрического Примечания

1. Регенерируйте модель.

2. Сделайте следующее:

•  Вручную пересчитайте масс-инерционные характеристики, выбирая Info > Model
Analysis....

•  Включите инструкцию MASSPROP в программу модели, используя Pro/PROGRAM.

Управление Количеством Десятичных Знаков Параметров

При добавлении некоторые символов параметра с символом "[.#]", система отображает
такие параметры с количеством десятичных знаков, указанных в #, и которое является
целым числом. Система округляет число, но использует то же значение. Это относится к
следующим параметрам:

· пользовательские параметры модели или те, которые определены в уравнениях модели.

· Метки рисунка, типа &scale (масштаб рисунка) и &det_scale (масштаб выносного вида)

При добавлении примечания, которое содержит параметр, добавьте символ параметра
"[.#] ", где # - является числом отображаемых десятичных знаков. Например, если масштаб
выносного вида 1.125, а требуется отобразить только два десятичных знака, измените
метку рисунка (используя Text Line или Full Note в меню MODIFY TEXT) для &det_scale[.2].
Примечание масштаба при этом отображается как 1.13.
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Ограничения на Размеры и Другие Параметры Модели

Эти функциональные возможности нельзя использовать для размеров или других
параметров модели, типа параметров массива. Однако, если сделать пользовательский
параметр равным параметру модели и, затем, добавить пользовательский параметр в
примечание, можно управлять отображением числа десятичных мест параметра модели.

Пример: Управление Количеством Десятичных Мест в Параметрах

Например, для параметра модели "d1" со значением 12.37580:

1. Введите уравнение как [length= d1].

2. Добавьте примечание рисунка.

3. При определении параметра, введите [&length[.3]]. Параметр отображается как 12.376,
но в расчетах система использует значение 12.37580.

Можно также использовать команду Num Digits для изменения числа десятичных знаков в
масштабе.

Отображение Масштаба Отдельных Видов

Параметр рисунка scale_of_view_x рассчитывает масштаб рисунка или любого вида с
названием X.

Например, для вызова масштаба вида с именем DETAILED_BAR, введите
&scale_of_view_detailed_bar.

Размещение Указателей Местоположения
Видов
Можно определять зону или сетку местоположения в форматах рисунка, создавая
указатели местоположения. Сетка местоположения определяется с использованием
существующих линий формата или, используя равномерно распределенные приращения.
Используйте такую сетку для размещения видов рисунка с использованием
параметрических примечаний, указывающих расположение вида в листе и рисунке.

Параметрические указатели местоположения учитывают интеллектуальные примечания,
которые будут добавлены к рисункам для указания местоположения выносного вида или
сечения, сохраняя время и удаляя устаревшие примечания.

Указатели местоположения создаются, используя стандартный синтаксис:

· Положение вида - &pos_loc:view:<view name>

· Положение листа - &sheet:view:<view name>

· Положение примечания в родительском виде - &pos_loc:parent_note:<view name>

· Положение примечания в листе - &sheet:parent_note:<view name>

Например, если Detail A расположен в A3 на сетке указателя местоположения и на листе 2,
введите примечание:

See Detail A at &pos_loc:view:detail_a on sheet &sheet:view:detail_a
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Текст примечания отображается как:

See Detail A at A3 on sheet 2.

Синтаксис для указатели местоположения настраиваемый, который учитывает
дополнительный текст, добавляемый на основании индивидуальных стандартов компании.
Существует опция настройки pos_loc_format, определяющая синтаксис pos_loc и
параметров листа в указателе. Значение по умолчанию pos_loc_format - %s%x%y, и
отображается как 2D4.

%r, добавляемый к pos_loc_format повторяет строку синтаксиса для того же элемента, и
позволяет отображать его несколько раз в различных местах. Это используется для
элементов типа символов и соединителей, но не к видам, потому что виды имеют
уникальные названия. Синтаксис - %s%x%y, %r, где %r означает повтор подстроки с
первого специального символа до последнего.

Поведение &pos_loc:
Примечание местоположения обновляется после регенерации, если вид перемещается в
пределах рисунка. Если вид стерт или перемещен за сетку, значение указателей
местоположения изменяется на ***. Указатель обновляется при восстановлении вида или
его перемещении назад в сетку. Если вид удален, то указатель местоположения больше не
является параметрическим и его значение изменяется на ***.

Поведение &sheet:
При переносе вида на другой лист, указатель местоположения автоматически обновляется
на новый номер листа. Если вид стерт, значение указатели местоположения изменяется на
***. Указатель обновляет при восстановлении вида. Если вид перемещен за пределы сетки,
значение остается отображать правильный номер листа. Если вид удален, то указатель
местоположения больше не является параметрическим и его значение изменяется на ***.

Следует указать, который угол сетки размещения будет служить в качестве нулевой точки.
Нулевая точка сетки отображается как желтый X. По умолчанию, нулевой точкой сетки
является нижний левый угол сетки размещения.

Определение Сетки Указателя Размещения

1. В режиме Format, нажмите Advanced > Location Grid > Define.

2. Выберите следующее:

•  Grid Outline - определяет границу сетки, используя резиновую нить или размер листа.

•  Grid Origin � укажите точку, обозначающую нулевую точку сетки. Нижний правый угол
является нулевой точкой сетки по умолчанию.

•  Columns - определите количество и местоположение столбцов сетки числом или
указанием точек, затем определите ярлычки сетки по букве, номеру или другим
способом.

•  Rows - определите количество и местоположение рядов сетки числом или указанием
точек, затем определите ярлычки сетки по букве, номеру или другим способом.

3. Щелкните по Done/Return.

Отображение Указателя Местоположения в Новом Рисунке

1. В режиме Рисунка, нажмите Create > Note > Make Note в меню DETAIL.

2. Выберите позицию указателя местоположения.
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3. Введите примечание, затем введите следующее:

•  Для отображения местоположения вида на сетке: &pos_loc:view:<view name>

•  Для отображения только местоположения листа: &sheet:view:<view name>

•  Для отображения местоположения примечания в родительском виде:
&pos_loc:parent_note:<view name>

•  Для отображения местоположения примечания в листе: &sheet:parent_note:<view
name>

4. Щелкните по Done/Return. Указатель местоположения создан.

Пример: Указатель Местоположения

Для отображения местоположения вида с именем Main_view, введите следующее в
текстовом поле Enter NOTE:

Main_view is located in &pos_loc:view:main_view

Примечание отображает как:

Согласно указанной сетке указателя местоположения, Main_view расположен в секции 3B.

Изменение Примечаний Рисунка

Добавление Зигзага к Выноске

1. Выберите DETAIL > Make Jog.

2. Выберите примечание.

3. Выберите выноску, к которой добавляется зигзаг.

4. Выберите местоположение зигзага. Система добавляет зигзаг между первой и второй
указанными точками.
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Удаление Зигзага из Выноски

Если система добавила зигзаг к выноске, зигзаг остается в том же самом месте рисунка,
вне зависимости от положения размера. Для удаления зигзага, выберите, DETAIL >
Remove и выберите зигзаг.

Пример: Добавление Зигзага к Примечанию с Выноской

Добавление Дополнительной Линии Выноски к Примечанию

1. Выберите DETAIL > Attach.

2. Выберите примечание, к которому требуется добавить выноску.

3. Выберите MOD OPTIONS > Add Ref.
4. Выберите ссылочную точку на виде для выноски.

5. Выберите GET SELECT > Done Sel и ATTACH TYPE > Done. Система добавляет
дополнительную выноску.

•  Для добавления более одной выноски, повторите Шаги 4 и 5.

•  Для удаления выноски, выберите, MOD OPTIONS > Remove.

•  Для разрыва выноски используйте процедуру, аналогичную той, которая используется
при разрыве выносных линий размеров.

•  Для присоединения выноски к любой строке текста, введите параметр "@o� (буква, не
нуль) вначале этой строки. Добавьте параметр для строки при создании примечания
или введите его позже, используя Full Note или Text Line. При добавлении "@o" более,
чем к одной строке текста примечания, выноска присоединяется к первой строке с этим
параметром.
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Пример: Присоединение Выноски к Примечанию

Удаление Примечания

Удаление примечания удаляет его из рисунка на постоянной основе. Система возвращает
любые размеры или параметры, включенные в это примечание в их первоначальные
положения в рисунке. (примечания можно удалять при наличии лицензии для Pro/DETAIL.)

1. Выберите DETAIL > Delete (для удаления нескольких примечаний за раз используйте
кнопку Delete Many в инструментальной панели Pro/ENGINEER).

2. Выберите примечание (я).

3. Выберите GET SELECT > Done Sel. Выберите Repaint, в случае необходимости, для
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регенерации изображения рисунка.

Стирание Примечания

Примечания можно стирать с использованием команды Show/Erase в меню DETAIL.
Стирание примечания скрывает его в виде, но не удаляет из рисунка. Система также
скрывает все размеры или параметры, которые включены в стертое примечание, и не
возвращает в их первоначальное положение в рисунке.

1. Выберите DETAIL > Show/Erase.

2. В диалоговом окне Show/Erase, нажмите Erase и Note.

3. Выберите кнопку в поле Erase By. Соответствующие примечания больше не
отображаются. По завершении, нажмите Close.

4. Для регенерации изображения стертых примечаний, нажмите Show и Note.

Изменение Типа Выноски

При создании примечания с использованием команды Leader ISO в меню NOTE TYPES,
система подчеркивает примечание. Для переключения между стилем выноски по стандарту
ISO и "не ISO", выберите Leader Type в меню MODIFY TEXT и используйте меню GET
SELECT.

Включение Примечания в Текстовых Полях

Для включения слов или символов в поле, введите "@[" перед и "]@" за текстом в процессе
редактирования, используя команды Text Line или Full Note.

В текстовой строке можно размещать специальные символы, которые указывают поле
вокруг текста независимо от местоположения скобок ({}), которые размещают разрывы
текста.

Пример: Примечания Включения в Полях

Копирование Свободного Примечания Путем Трансляции

1. Выберите TOOLS > Copy > Translate.

2. Выберите копируемые примечания; затем выберите GET SELECT > Done Sel.
3. Укажите вектор перемещения.

4. Выберите первую точку; затем выберите конечную точку.

5. Введите число копий.
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Копирование Свободного Примечания Путем Поворота

1. Выберите TOOLS > Copy > Rotate.

2. Выберите копируемое примечание; затем выберите GET SELECT > Done Sel.
3. Выберите центр поворота.

4. Введите угол поворота в направлении против часовой стрелки.

5. Введите число копий.

Обратите внимание: в эскизные группы можно включать примечания.

Связывание Существующего Примечания с Текстом Размера

Существующее примечание можно связывать с текстом размера, чтобы оно перемещалось
с перемещением размера, с использованием команды Relate Dim в меню TOOLS. При
создании примечания, можно его связывать непосредственно с размерным текстом,
выбирая Dim Related в меню NOTE TYPES.

Перенос Примечания на Другой Вид

Примечание можно переносить с одного вида на другой вида, используя команду Switch
View в меню DETAIL (или кнопку Switch View в инструментальной панели Pro/ENGINEER).
Выберите переносимое на другой вид примечание; затем выберите новый вид.
Примечание отображается в соответствующем местоположении этого вида.

Отображение Примечания Резьбы в Рисунке

1. Для отображения параметров резьбы в качестве примечания, необходимо
предварительно определить их в детали, делая следующее:

•  При создании резьбы, введите значения параметра через среду Pro/TABLE.

•  После создания резьбы, отредактируйте параметры, выбирая Parameter в меню PART
SETUP.

2. Можно перемещать и удалять примечания резьбы как обычные примечания. В режиме
Рисунка, выберите, DETAIL > Show/Erase.

3. В диалоговом окне Show/Erase, нажмите Show; затем выберите Note в поле Type и Feat
& View.

4. Выберите резьбу в виде рисунка. Отображается примечание с параметрами резьбы.

5. Отобразите значения параметра, выбирая Switch Dims в меню Info Pro/ENGINEER.
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Пример: Отображение Примечания Резьбы
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Допуска на Размер

Концепция Допусков на Размер

Создание Допусков на Размер

В производстве, допуски на размер можно использовать для определения максимально
допустимого отклонения от точного размера и формы, указанных разработчиками. Можно
создавать, изменять, отображать, и удалять допуски на размер (gtols) в режиме Рисунка.

Допуски на размер обеспечивают наиболее полный метод определения, где на детали
критические поверхности, как они соотносятся, и как деталь должна быть проверена на
предмет годности. При сохранении допусков на размер Pro/ENGINEER в твердотельной
модели, она содержит параметрические ссылки на геометрию или элементы � ссылочные
элементы и параметрические ссылки на ссылочные опорные элементы и оси. В
результате, система обновляет отображение допусков на размер при переименовании
ссылочного опорного элемента.

В режиме Сборки, допуск на размер можно создавать в подсборке или детали. Допуск на
размер, созданный в режиме Детали или Сборки автоматически принадлежит детали или
сборке, находящейся в окне; однако, это может относиться только к установленным
опорным элементам, принадлежащим непосредственно этой модели, или к компонентам в
ее составе. Это не может относиться к опорным элементам, лежащим вне модели, в
некоторой обобщенной сборке, в отличие от элементов, созданных в сборке.

Функциональные возможности допуска на размер можно использовать в режиме Рисунка,
Детали и Сборки; однако для создания допуска на размер в режиме Рисунка, необходимо
иметь лицензию для Pro/DETAIL.

Добавление Допуска на Размер к Рисунку

1. Выберите DETAIL > Create > Geom Tol > Specify Tol.
2. В диалоговом окне Geometric Tolerance укажите модель для добавления допуска на
размер (система выбирает Model Refs). По умолчанию, текущей моделью для допусков на
размер становится модель текущего рисунка.

3. Выберите тип допуска на размер и ссылочный объект (укажите объект, на который
накладывается допуск на размер).

4. Нажмите Place Gtol. Если допуск на размер присоединяется непосредственно к
опорному элементу, он отображается (система выбирает Datum в списке Type). Иначе,
выберите элемент в списке Type и разместите допуск на размер в рисунке.

Обратите внимание: в случае продолжения создания допусков на размер, система
обновляет их в рисунке. Можно сразу проверять работу и вносить коррективы, в случае
необходимости.

5. Определите ссылочный (ые) опорные элементы и условие (я) материала, если
применяется.

6. Введите значение допуска и условие материала, если применяется.
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7. Определить символы и модификаторы, направление профиля и спроецированное поле
допуска, если применяется. Теперь в рисунке отображается завершенный допуск на
размер.

8. Сделайте следующее:

•  Закройте диалоговое окно и сохраните изменения, щелкая по OK. Система снимает
выделение с выбранных ссылочных объектов и размещает информацию в диалоговом
окне, но сохраняет все другие данные. При повторном входе в режим Создания
допуска на размер, все команды предыдущей сессии создания допуска на размер для
объекта сохраняются в текущем окне.

•  Создайте другой допуск на размер, щелкая по New Gtol.

•  Удалите допуск на размер из модели, выбирая GEOM TOL > Clear для удаления
допуска на размер из модели.

•  Выйдите из режима создания допуска на размер и отмените изменения, щелкая по
Cancel.

Совет: Добавление Допуска на Размер

Для добавления допуска на размер (gtol) к рисунку, можно использовать два, три, или все
четыре страницы диалогового окна Geometric Tolerance, в зависимости от указанных
характеристик создаваемого допуска на размер.

Размещение Допуска на Размер

Допуск на размер можно присоединять к размеру, опорному элементу, отдельной или
нескольким кромкам или другому допуску на размер. Можно также создавать управляемый
размер, к которому можно присоединять допуск на размер, размещать его свободно (в
любом месте рисунка) или связывать его с размерным текстом. Можно присоединять
объединенные (несколько) допусков на размер к другому допуску; или, если первый из
объединенных допусков присоединен к размеру, можно присоединять их к этому же
размеру. Однако, для присоединения допуска на размер непосредственно к другим
допускам на размер, размерам или опорным элементам, он должен принадлежать той же
модели, что и элемент, к которой он присоединяется.

Обозначение Проецируемой Зоны Допуск по Стандарту ISO

1. После выбора кнопки Location/Position, укажите ссылочные опорные элементы и их
условия материала.

2. Нажмите Symbols в верхней части диалогового окна.

3. Сделайте следующее:

•  Укажите спроецированное поле допуска и определите высоту, выберите поле Zone
Height и введите значение.

•  Укажите спроецированное поле допуска без указания высоты, помещая его на
отдельной строке под допуском на размер, выберите Below Gtol.

•  Укажите спроецированное поле допуска без указания высоты, помещая его на той же
линии рядом с допуском на размер, выберите Inside Gtol.

•  Без указания спроецированного поля допуска, выберите None.

Окончательный допуск на размер отображается с указанной спроецированной зоной
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допуска. Следующий рисунок представляет пример.

Пример: Спроецированное Поле Допуска

Обозначение Стандартного Допуска на Параллельность и
Перпендикулярность

После выбора кнопки Orientation/Perpendicularity или Orientation/Parallelism, укажите
ссылочный объект.

1. Нажмите Tol Value.

2. Определите значение допуска, делая следующее:

•  Для отображения только допуска на размер, без указания длины ограничения, введите
значение в поле Overall Tolerance.

•  Для указания длины ограничения, к которой применяется допуск, выберите флажок Per
Unit Tolerance и введите значения в полях Value/Unit и Unit Length или Unit Area.

Указание Значения «На Единицу Длины или Площади»

Для определения допусков на размер Form/Straightness и Form/Flatness «на единицу
длины или площади», укажите ограничивающую длину, к которой применяется допуск,
выбирая флажок Per Unit Tolerance и вводя значения в полях Value/Unit и Unit Length.

Создание Допуска на Размер в Рисунке Сборки

1. Выберите GEOM TOL > Specify Tol.
2. В диалоговом окне Geometric Tolerance, выберите Assembly в списке Model страницы
Model Refs.

3. Нажмите Place Gtol. Если допуск на размер присоединен непосредственно к опорной
величине, он отображается (система сама выбирает Datum в списке Type). Иначе,
выберите элемент в списке Type и разместите допуск на размер в рисунке.

Обратите внимание: в случае продолжения создания допуска на размер, система
обновляет его в рисунке. Можно проверять работу и вводить исправления, в случае
необходимости.

4. Определить ссылочный (ые) опорные элементы и условие минимума/максимума
материала (ов), если применяется.

5. Введите значение допуска и условие минимума/максимума материала, если
применяется.

6. Определите символы и модификаторы, направление профиля и спроецированное поле
допуска, если применяется. Законченный допуск на размер появляется в рисунке.
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7. Сделайте следующее:

•  Закройте диалоговое окно и сохраните изменения, щелкая по OK. Система снимает
выделение ссылочных объектов и размещает информацию из диалогового окна, но
сохраняет все другие данные. При повторном вводе допуска на размер в режиме
Создания, все команды из предыдущей сессии создания допуска на размер для
объекта в текущем окне сохраняются.

•  Создайте другой допуск на размер, щелкая по New Gtol.

•  Удалите допуск на размер из модели, выбирая GEOM TOL > Clear для удаления
допуска на размер из модели.

•  Выйдите из режима создания допуска на размер и отмените изменения, щелкая по
Cancel.

Создание Допусков на Размер в Рисунке Сборки

При создании допусков на размер в модели верхнего уровня (то есть деталь в рисунке
детали или сборка верхнего уровня в чертеже сборки) система связывает допуск с видом, в
котором был выбран ссылочный объект. Опорные ссылочные элементы, которые были
указаны для допуска на размер, должны принадлежать той же модели верхнего уровня;
однако, можно выбирать их в любом виде. Нельзя ссылаться на примитивы и эскизные
опорные элементы. Допуски на размер, накладываемые на эскизные объекты (эскизные
gtols) могут ссылаться на опорные элементы модели. Можно присоединять допуск на
размер сборки к размеру, опорному элементу или другому допуску на размер, если они оба
принадлежат одной сборке.

При создании допуска на размер в сборочном чертеже, если опция файла конфигурации
"draw_models_read_only" установлена в «yes», система устанавливает команду Drawing по
умолчанию в списке Model страницы Model Refs диалогового окна Geometric Tolerance.
Команды Part и Assembly не доступны для выбора; при попытке их выбрать, отображается
сообщение об ошибках. При установке "draw_models_read_only" в «no», когда на текущем
листе не существует никаких видов сборки, команда Part является значением по
умолчанию в списке Model. Если вид сборки присутствует, по умолчанию стоит Assembly.

Пример: Добавление Допуска на Размер в Рисунке

После процедуры описанной ниже, используйте характеристики и значения, данные в этой
таблице для создания типового допуска на размер.

Типовые Характеристики и Значения Допуска На Размер

Характеристика Значение
Примитив Отверстие

Положение Допуска Как часть диаметрального размера

Класс и Тип Location/Position (допуск «истинного
положения»)

Полное значение допуска 0.25

Условие минимума/максимума материала MMC

Первая База (A) Условие МММ RFS/Default

Вторая База (B) Условие МММ RFS/Default
1. Выберите DETAIL > Create > Geom Tol > Specify Tol.
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2. В диалоговом окне Geometric Tolerance, определите модель для добавления допуска
на размер (выбор системы - Model Refs). По умолчанию, текущая модель для допуска на
размер - модель текущего рисунка.

3. Щелкните по Location/Position.

4. Укажите тип объекта, на который накладывается допуск. Выберите Feature в списке
Reference Entity Type; затем щелкните по Select Entity для выбора отверстия в рисунке.

5. Нажмите Place geometric tolerance и выберите Dimension в списке Type. Выберите
размер отверстия. Допуск на размер отображается в рисунке под размером.

6. Нажмите Datum Refs в верхней части диалогового окна:

•  Для указания первого ссылочного опорного элемента, нажмите Primary; затем
выберите A и RFS (без символа) в списке Basic.

•  Для указания второго ссылочного опорного элемента, нажмите Secondary; затем
выберите B и RFS (без символа) в списке Basic.

7. Нажмите Tol Value в верхней части диалогового окна и введите [0.25] в поле Overall
Tolerance. Выберите MMC в списке Material Condition.

8. Нажмите Symbols в верхней части диалогового окна. Выберите флажок Diameter
Symbol, чтобы указать, что значение допуска относится к диаметральной зоне; затем
выберите None для спроецированного поля допуска.

9. Окончательный допуск на размер отображается, как показано в следующем рисунке.
Нажмите OK, чтобы закрыть диалоговое окно и сохранить изменения.

Типичный Gtol
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Диалоговое Окно Geometric Tolerance
Для работы с функциональными возможностями допуска на размер в режиме Рисунка,
выберите Geom Tol в меню DETAIL ITEM и Specify Tol в меню GEOM TOL.

Используя четыре страницы диалогового окна Geometric Tolerance, можно выполнять
следующие задачи:

· указывать модель для добавления допуска на размер, а также размещать допуск на
размер в рисунке.

· Определять ссылочный опорный элемент и условие МММ для допуска на размер, а также
ссылочный опорный элемент и значения составного допуска.

· Определять значение допуска и условие минимума/максимума материала.

· Определять символы допуска на размер и модификаторы, а также спроецированное поле
допуска.

Левая часть диалогового окна отображает символы допуска на размер, доступные для
выбора. Следующая таблица отображает типы допусков на размер и соответствующие
объекты, на которые можно ссылаться. При размещении курсора на одном из символов
допуска на размер, его тип отображается в диалоговом окне и в статусной строке.
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Пример: Классы и Типы Допусков На Размер
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Указание Модели

Используя кнопки на странице Model Refs диалогового окна Geometric Tolerance, можно
указать модель к которой добавляется допуск на размер, выбрать ссылочный объект и
разместить допуск на размер в рисунке.

Опции Model Refs

· Model - определяет модель для добавления gtol. Необходимо сначала явно выбрать
модель. Можно выбрать верхнюю модель из списка Model или нажать Select Model для
выбора подмодели. По умолчанию, текущей моделью допуска на размер является модель
текущего рисунка.

· Reference: To Be Selected - определяет тип ссылочного объекта (кромка, ось,
поверхность, элемент, опорный элемент, объект или ни одно из перечисленного).
Выберите элемент в списке Type или нажмите Select Entity.

· Placement � размещает допуск на размер в рисунке. Нажмите Place geometric tolerance,
и выберите элемент из списка типов:

•  Dimension � присоединяет допуск на размер к размеру. Опция "gtol_dim_placement�
файла установок рисунка определяет его местоположение под размером. Можно
присоединять несколько gtols (стеком) к одному размеру, и они ведут себя как один
допуск при управлении символом размера.

•  Datum � присоединяет допуск на размер к опорной величине. Если допуск на размер
уже присоединен непосредственно к опорному элементу, система сама выберет этот
элемент.

•  Leaders � присоединяет допуск на размер к нескольким кромкам (включая кромки
опорной лоскутной поверхности) с линиями выноски или к выносным линиям размера.

•  Free Note � размещает допуск на размер в любом месте рисунка. В режиме Детали,
нельзя отображать свободные gtols, которые были созданы в режиме Рисунка.
Размещение Free Note можно использовать только при выборе The Drawing из списка
Model как верхнюю модель.

•  Normal Leader � присоединяет допуск на размер к кромке вдоль линии выноски,
которая является перпендикулярной выбранной кромке.

•  Tangent Leader � присоединяет допуск на размер к кромке вдоль линии выноски,
которая является касательной к выбранной кромке, ориентируя текстовое поле допуска
на размер под тем же углом, что и выноска.

•  Other Gtol � присоединяет новый допуск на размер к существующему (нельзя
присоединять существующий допуск к размеру).

•  Dim Related � связывает допуск на размер с указанным размерным текстом. Выберите
этот элемент в списке Type; затем выберите размерный текст и местоположение
относительно текста. Для связывания существующего свободного допуска на размер с
размерным текстом, выберите TOOLS > Relate Dim.

•  Make Dim - создает управляемый размер и присоединяет к нему размер. Этот размер
принадлежит рисунку. Допуск на размер отображается в стандартном формате
размера, но с допуском на размер вместо значения размера. Его можно редактировать,
выбирая Value в меню MODIFY DRAW.
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Ссылочные Типы Объектов

Не все типы ссылочных объектов доступны для всех типов допуска на размер. Необходимо
выбирать новый объект всякий раз, при изменении типа объекта. Система не позволяет
завершать создание допуска на размер, пока не будет выбран ссылочный объект.
Ссылочный объект - геометрия или элемент, которыми управляет допуск на размер; его
нельзя использовать вместо установленного опорного элемента или как тип
присоединения для gtol.

Определение Ссылочного Опорного Элемента

Используя кнопки на странице Datum Refs диалогового окна Geometric Tolerance, можно
определить ссылочный опорный элемент и условия минимума/максимума материала для
gtol, а также значения и ссылочный опорный элемент составного допуска.

Опции Datum Refs

· Datum References � определяет первичные, вторичные и третичные ссылочные опорные
элементы для любого допуска на размер, который разрешает ссылочный опорный
элемент. Нажмите Primary, Secondary или Tertiary и выберите элемент из списков Basic и
Compound.

Списки содержат текущий выбранный опорный элемент и все другие опорные элементы в
текущей модели допуска на размер. Если требуется выбрать другой установленный
опорный элемент или ось, нажмите Select.... Для основных и составных ссылочных
опорных элементов можно также определить условие минимума/максимума материала,
выбирая элемент из списков Basic и Compound.

· Composite Tolerance - создает составной gtol. Введите значение в поле Value и выберите
ссылочный опорный элемент в списке Datum Reference.

· Unordered - выберите этот переключатель для перечисления двух ссылочных опорных
элементов в одном поле символа предельных отклонений.

Пример: Ссылочный Опорный Элемент для Составного Допуска
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Пример: Неупорядоченные Составные Ссылочные Опорные
Элементы

Определение Значения Допуска и Условия Минимума/Максимума
Материала

Используя кнопки на странице Tol Value диалогового окна Geometric Tolerance, можно
указать значение допуска и условие минимума/максимума материала.

Опции Tol Value

· Tolerance Value - определяет значение допуска. Введите значение в поле Overall
Tolerance или выберите флажок Per Unit Tolerance и укажите значение в полях Value/Unit
и Unit Length (или Unit Area для некоторых типов допусков на размер).

· Material Condition - определяет условие минимума/максимума материала.

Определение Символов и Модификаторов

Используя кнопки на странице Symbols диалогового окна Geometric Tolerace, можно
определить символы gtol's, модификаторы и спроецированное поле допуска.

Опции Symbols

· Symbols and Modifiers � определяет символы допуска на размер и модификаторы.
Выберите флажок Statistical Tolerance, Diameter Symbol, Free State, All Around Symbol
или Tangent Plane.

· Projected Tolerance Zone � определяет местоположение спроецированного поля допуска.
Выберите None, Below Gtol или Inside Gtol. Можно также указать высоту
спроецированного поля допуска, введите значение в поле Zone Height.
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· Profile Boundary (доступный только для допусков на профиль) � определяет
одностороннее направление, двустороннее направление или оба. Поле Flip позволяет
изменять направление профиля.

Концепция Ссылочных Опорных
Элементов

Использование Ссылочных Опорных Элементов

Перед ссылкой на опорную плоскость или ось в допуске на размер, их необходимо
установить. Система обводит название опорного элемента используя символ
установленного опорного элемента. Его можно изменять, выбирая Name в меню PART
SETUP в режиме Детали или диалоговом окне Datum в режиме Рисунка. После установки
опорного элемента, его можно продолжать использовать для создания элементов и сборки
деталей.

При отображении установленных плоскостей опорного элемента, учитывайте следующее:

· установленная опорная плоскость, присоединенная к размеру, отображается в рисунке
только при отображении размера, с которым она была связана.

· Система не отображает ссылочную опорную плоскость в рисунке, если она не
перпендикулярна экрану.

Создание Ссылочного Опорного Элемента, Используя Команду
Set Datum

1. Выберите GEOM TOL > Set Datum; затем выберите опорную плоскость или ось для
установки.

2. В меню DATUM LOC, выберите команду:

•  Dimension � присоединяет название опорного элемента к размеру.

•  Geom Tol � присоединяет название опорного элемента к выбранному допуску на
размер (эта команда доступна если опция "gtol_datums� файла установки рисунков
установлена в значение ISO или ASME).

•  Default � отображает название опорного элемента в его местоположении по
умолчанию, на конце плоскости.

3. Система включает опорный элемент в символ установленного опорного элемента. В
случае необходимости, для управления установленным опорным элементом выберите
следующие команды в меню DETAIL:

· выберите Move для корректировки концов установленного опорного элемента.

· Выберите Move Text для перемещения текстового поля вдоль линии текста.

· Выберите Mod Attach для перемещения текстового поля в двух направлениях
одновременно: по линии опорного элемента и линии текста.
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Создание Ссылочного Опорного Элемента, Используя
Диалоговое Окно Datum

1. Выберите DETAIL > Modify > Datum/Axis; затем выберите опорный элемент на экране.

2. В диалоговом окне Datum, нажмите -A- (установить). Система включает опорный
элемент в символ предельного отклонения.

3. Нажмите OK, чтобы закрыть диалоговое окно и сохранить изменения.

Определение Размещения Установленного Ссылочного Опорного
Элемента

1. Выберите In Dim и Pick Dim в диалоговом окне Datum.

2. Выберите размер в модели. Система размещает этот установленный опорный элемент
под размером на экране.

3. Нажмите OK, чтобы закрыть диалоговое окно и сохранить изменения.

Создание Ссылочного Опорного Элемента, Присоединенного к
Цилиндрической Поверхности

1. Щелкните по Modify > Datum/Axis, затем выберите ось. Открывается диалоговое окно
Axis.

Обратите внимание: ось должна существовать на виде цилиндра.

2. Щелкните по в диалоговом окне Axis для перехода к стандарту ISO, затем

выберите On Geometry в области Placement.
3. Выберите цилиндрическую поверхность, к которой требуется присоединить ссылочный
опорный элемент. Ссылочный опорный элемент присоединяется к цилиндрической
поверхности.

Обратите внимание: ссылочный опорный элемент присоединяется в точке, где была
выбрана на поверхность.

4. Щелкните по ОК.

Опция GTOL_DATUMS Файла Установок Рисунка

При установке опции "gtol_datums� файла установок рисунка в "STD_ASME" или "STD_ISO",
установленный опорный элемент можно также размещать на допуске на размер. Нажмите
In geometric tolerance и Pick Gtol... в диалоговом окне Datum; затем выберите допуск на
размер в модели.
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Пример: Символ Допуска на Размер с Составным Опорным
Элементом

Присоединение Установленных Опорных Элементов к
Диаметральным Размерам

Установленные опорные элементы можно перемещать отдельно от диаметральных
размеров, используя либо команду Move Text в меню DETAIL либо управляющие маркеры,
которые отображаются вокруг опорного элемента при использовании выпадающего меню.
Можно также присоединить установленный опорный элемент к диаметральному размеру,
устанавливая опцию "asme_dtm_on_dia_dim_gtol� файла установок рисунка в "on_gtol" или
"on_dim".

Концепция Базовых Размеров

Базовые размеры

Используя команды в меню GEOM TOL, можно преобразовать существующие размеры в
базовые размеры, и установить размеры для контроля согласно стандарту DIN. Базовые
размеры - теоретически точные размеры, которые отображаются со значением размера и
любым сопутствующим текстом, заключенным в символ предельного отклонения. Если
первоначальный размер имеет допуски, система автоматически удаляет их; нельзя
добавлять допуски к базовым размерам.

Преобразование Существующего Размера в Базовый, Используя
Меню GEOM TOL

1. Выберите GEOM TOL > Basic Dim
2. Выберите размеры. По мере выбора, система заключает его в символ предельного
отклонения. Для выбора нескольких размеров, выберите PICK MANY > Pick Box.

3. Обратите внимание: для возврата размеров в их первоначальное состояние, выберите
GEOM TOL > Clear перед выходом в меню.

4. Выберите EXIT > Done.
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Преобразование, Существующих Размеров в Базовые

1. Выберите MODIFY > Dimension.

2. Выберите размеры; затем выберите GET SELECT > Done Sel.
3. В диалоговом окне Modify Dimension, выберите флажок Basic Dim. Система включает
каждый размер в символ предельного отклонения.

Обратите внимание: для возврата размеров в их первоначальное состояние, выберите
флажок Basic Dim перед выходом из диалогового окна.

Использование Меню GEOM TOL для Установки Размеров для
Контроля

1. Выберите GEOM TOL > Inspect Dim
2. Выберите размеры. Система включает значение каждого выбранного размера и весь
связанный текст в овальное поле.

Обратите внимание: для возврата размеров в их первоначальное состояние, выберите
GEOM TOL > Clear перед выходом в меню.

3. Выберите EXIT > Done.

Использование Диалогового Окна Modify Dimension для
Установки Размеров для Контроля

1. Выберите MODIFY > Dimension.

2. Выберите размеры; затем выберите GET SELECT > Done Sel.
3. В диалоговом окне Modify Dimension, выберите флажок Inspection Dim. включает
значение каждого выбранного размера и весь связанный текст в овальное поле.

Обратите внимание: для возврата размеров в их первоначальное состояние, выберите
флажок Inspection Dim перед выходом из диалогового окна.

Пример: Размер для Контроля

Управление Размером Рамки Базового Размера

1. Щелкните по Modify > Dimension.

2. Выберите размер, затем нажмите Done Sel или нажмите среднюю кнопку мыши.
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Открывается диалоговое окно Modify Dimension.

3. Нажмите ярлычок Dim Text. В поле Dimension Text, используйте специальные символы
@[ - начало рамки размера и @] - конец рамки размера. Все, что находится между этими
символами заключается в рамку размера.

Концепция Обозначения Базы

Создание Обозначения Базы

Используя команду Make Target в меню GEOM TOL, можно создавать обозначение базы
(datum target)с использованием любой точки опорного элемента, кроме той, которая была
создана с использованием Offset Csys.

Создание Обозначения Базы

1. Выберите DETAIL > Create > Geom Tol > Make Target.
2. В рисунке, выберите ссылочный установленный опорный элемент, определяемый
обозначением базы. Можно выбирать эскизные опорные плоскости и оси.

3. Используя меню TARGET, сделайте следующее:

•  Выберите Simple, чтобы поместить название ссылочного опорного элемента в нижней
части символа обозначения базы.

•  Выберите Diameter для выбора точки размера для каждой точки опорного элемента
(отображается в верхней половине символа обозначения базы).

4. Используя меню GET DTM PNT, сделайте следующее:

•  Выберите Select Point для выбора опорной точки в рисунке.

•  Выберите Create Point для создания новый опорной точки.

5. Выберите местоположение для обозначения.
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Пример: Обозначение Базы

Отображение Обозначения Базы в Нескольких Видах

Используя диалоговое окно Show/Erase, можно отображать обозначения базы в
нескольких видах. Последовательность обозначений базы трехмерных моделей
изменяется при удалении промежуточного обозначения, в отличии от эскизных
(двумерных) обозначений. Например, если имеются три обозначения базы (B1, B2, и B3),
то удаление B2 даст B1 и B3, а не B1 и B2.

Изменение Геометрических Допусков

Изменение Значения Отдельного Условия Минимума/Максимума
Материала

1. Выберите DETAIL > Modify > Geom Tol.
2. Выберите допуск на размер.

3. В диалоговом окне Geometric Tolerance, нажмите Datum Refs.

4. Нажмите Primary, Secondary или Tertiary (что требуется) в поле Datum References.

5. Для базового ссылочного опорного элемента, выберите условие минимума/максимума
материала в списке Basic. Для составного ссылочного опорного элемента, выберите
условие минимума/максимума материала в списке Compound.
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6. Система обновляет допуск на размер на экране. Для закрытия диалогового окна и
сохранения изменений нажмите OK.

Изменение Ссылочного Опорного Элемента на Допуск на Размер

1. В верхней части диалогового окна Geometric Tolerance, выберите Datum Refs.

2. Сделайте следующее:

•  Для добавления нового ссылочного опорного элемента путем преобразования
существующего простого ссылочного опорного элемента в составной ссылочный
элемент. Добавьте второй или третий ссылочный опорный элемент, щелкая по
Secondary или Tertiary. Выберите ссылочный опорный элемент в списке Compound.
При необходимости, определите условие минимума/максимума материала.

•  Для замены ссылочного опорного элемента другим опорным элементом нажмите
Primary, Secondary или Tertiary (что требуется) в поле Datum References; затем
выберите другое название опорного элемента в списке Basic или Compound. Если
используемый опорный элемент отсутствует в списке, нажмите Select... для выбора его
в рисунке.

Для удаления ссылочного опорного элемента нажмите Primary, Secondary или Tertiary в
поле Datum References Tertiary (что требуется) в поле Datum References; затем None в
списке Basic или Compound.

Изменение Значения Допуска на Размер на Экране

1. Выберите DETAIL > Modify > Value.

2. Выберите изменяемое значение в рисунке.

3. Введите значение. Система перерисовывает изображение для отображения изменений.

Изменение Значения Допуска на Размер, Используя Диалоговое
Окно Geometric Tolerance

1. Выберите DETAIL > Modify > Geom Tol.
2. Выберите изменяемый допуск на размер. В диалоговом окне Geometric Tolerance,
нажмите Symbols.

3. Выберите флажок Zone Height и введите значение. Система обновляет изображение
для отображения изменений.

Изменение Допуска На размер После Добавления Его в Качестве
Примечания

После добавления допуска на размер в качестве примечания, его можно изменять,
используя любой из следующих методов:

· измените значение допуска на размер, выбирая Value в меню MODIFY DRAW; затем
введите новое значение допуска на размер.

· Замените один допуск на размер другим посредством редактирования текста. Если
ввести новый символ "#" при редактировании примечания, система заменит старый допуск
на размер новым, соответствующим новому символу "#". Для изменения допуска на размер
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как текста, выберите Text Line или Full Note в меню MODIFY DRAW.

Пример: Добавление Допусков на Размер к Примечаниям

Каждый символ допуска на размер в рисунке имеет условное обозначение. Можно
включать допуск на размер в примечание как параметр, вводя его символическое значение
в формате [&g#], где "#" - номер, указывающий порядок в котором был создан допуск на
размер.

Пример: Условное Обозначение

Пример: Создание Примечания

Удаление Допуска на Размер

В режиме Рисунка, можно удалять допуск на размер используя Delete в меню DETAIL.
Однако, в примечании допуск на размер остается нетронутым, даже при удалении его из
рисунка. При удалении в режиме Детали, система заменяет его в примечании на "***".

Отображение Допусков на Размер

Отображение Допусков на размер в Различных Режимах

Можно создавать допуски на размер сборки, детали или эскиза (не связанный с моделью) в
режиме Рисунка. Однако, допуски на размер, созданные в режиме Детали или Сборки
автоматически не отображаются в режиме Рисунка.

При размещении допуска для размера в режиме детали, учитывайте следующие правила:

· при размещении допуска для размера в детали и, затем, создании рисунка для этой
детали, вначале необходимо отобразить в рисунке размеры; иначе, допуск на размер не
отображается.
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· если допуск на размер присоединен к размеру детали, которую система не может
отобразить в сборочном чертеже, - допуск на размер не отображается.

Для отображения допусков на размер, которые были созданы в режимах Сборки и Детали
можно использовать диалоговое окно Show/Erase.

Концепция Символов Обработки
Поверхности

Символы Обработки поверхности

Символы обработки поверхности можно добавлять к модели, используя стандартные
символы обработки поверхности, доступные в Pro/DETAIL или можно создавать
собственные символы обработки поверхности. Однако, нельзя присоединять символы
обработки поверхности к деталям, пересеченным элементами сборки.

При наличии лицензии для Pro/DETAIL, можно вызывать набор стандартных символов
обработки поверхности в каталоге loaddirectory/symbols/surffins Pro/ENGINEER, как
показано в следующей таблице.

Обработка Поверхности в Рисунках
Pro/ENGINEER отражает символы обработки поверхности только в рисунке. Основной
символ обработки поверхности состоит из стандартных блоков или групп. Для создания
требуемого вхождения, необходимо выбрать любые группы для включения в символ и
указать требуемую информацию. Основной символ обработки поверхности расположен в
области символов системы.

Обработка поверхности связана с поверхностями в детали, но не объектами или видами в
рисунке. Каждое обозначение шероховатости поверхности относится ко всей поверхности.
При определении качества обработки поверхности, которая уже имеет символ обработки,
Pro/ENGINEER переопределяет информацию обработки поверхности в детали и заменяет
старый символ новым. Также как нельзя отобразить один размер в двух различных видах
Pro/ENGINEER, также нельзя отображать одну и ту же обработку поверхности на двух
видах.

Добавление Символа Обработки Поверхности

1. Выберите DETAIL > Create > Surf Finish.

2. Используя меню GET SYMBOL, сделайте следующее:

•  Используйте Name для выбора символа из списка меню. Это меню содержит все
символы, которые находятся в рисунке. Если символы отображаются с одинаковыми
именами, (фактически, они находятся в различных каталогах символов) система
идентифицирует их в меню SYMBOL NAMES с номером в круглых скобках (#). Короткая
справка для каждого названия содержит имя и путь для каждого символа.

•  Используйте Pick Inst для выбора символа, путем выбора любого вхождения символа
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в рисунке.

•  Используйте Retrieve для выбора символа, путем выбора из списка символов на диске.
Выбор UP переходит на один каталог. Выбор каталога переходит в этот каталог. Имя в
меню является названием текущего каталога. В отличие от сохранения символа, его
можно вызывать из любого места, где имеются соответственные разрешения, как
вверх так и вниз по дереву каталогов.

3. Выберите одну из команд в меню INST ATTACH.

4. Ответьте на запросы системы и команды меню для выбранных команд.

5. Введите значение шероховатости поверхности. Система размещает символ в рисунке с
размером относительно высоты текста по умолчанию.

Создание Символа Обработки Поверхности

1. Выберите DETAIL > Create > Symbol > Instance > Retrieve > System Syms.

2. В меню SYMBOLS, выберите каталог обработки поверхности и выберите символ
обработки поверхности. Расположите символ в рисунке.

3. Введите высоту символа.

4. Определите группы, включаемые в символы.

5. Ответьте на запросы системы, вводя требуемые данные. Символ отображается на
экране. Скорректируйте местоположение символа, используя меню ADJUST INST.
Выберите Done.

Добавление Собственных Символов Обработки Поверхности

При создании и добавлении собственных символов обработки поверхности, определите их
местоположение, устанавливая опцию "pro_surface_finish_dir� файла конфигурации.

Пример: Символ Обработки Поверхности

Меню INST ATTACH

· Leader - создает символ с выноской. Выберите команды в меню ATTACH TYPE.

· Entity - присоединяет символ к объекту (кромке модели или геометрии рисунка).

· Normal - присоединяет символ к кромке, объекту или размеру. Позиционируйте символ по
вертикали. В случае присоединения под углом к кромке, желтая стрелка указывает
нормаль к выбранному объекту.

· No Leader - создает одиночный символ.
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Группы, Используемые для Создания Символа Поверхности

Следующая таблица описывает группы, которые используются для создания символа
обработки поверхности. Первый столбец указывает на используемый символ ANSI, ISO
или оба.
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Таблицы Рисунка

Концепция Таблиц Рисунка
Таблица рисунка - сетка линий и столбцов, в которые вводится текст. При этом текст,
вводимый в ячейки выравнивается по указанному количеству символов и строк в ячейке.
Текст в таблице рисунка имеет все функциональные возможности текста рисунка; его
можно изменять, используя команды меню MODIFY TEXT. Можно вводить символы
размеров и меток рисунка; система будет их модифицировать при изменении модели или
рисунка. Таблицы рисунка можно включать в форматы, рисунки и компоновки. Ниже
приведен пример.

Использование Выпадающего Меню
Используя выпадающее меню Pro/ENGINEER можно изменять и управлять таблицами
рисунка следующими способами:

· перемещать их в другое место на листе рисунка.

· Редактировать текст и текстовый стиль в ячейке, как если бы это было примечание, за
одним исключением. При выборе ячейки, принадлежащей повторяющейся области, можно
вводить символ Pro/REPORT.

· Удалять содержание ячейки или всей таблицы.

· Изменять размер линии или столбца выбранной ячейки в единицах рисунка или единицах
высоты / длины текста.

· Поворачивать таблицу на 90 градусов относительно ее нулевой точки.

· Указывать новую нулевую точку таблицы (можно выбирать только угол сегмента таблицы
активной ячейки).

Создание Таблица Рисунка

1. Выберите DRAWING > Table > Create.

2. В меню TABLE CREATE выберите команду.

3. Разместите таблицу, щелкая в на рисунке. При выборе Descending и Rightward,
система использует положение для обозначения левого верхнего угла таблицы.

4. Отображается ряд чисел. Система отображает эти числа согласно текущей высоте
текста в файл установок рисунка. Обозначьте ширину каждого столбца числом (число
символов, которое строка может содержать при текущей высоте текста). Выберите Done по
завершении.

5. Обозначьте высоту каждой строки числом (число строк текста, которые линия может
содержать при текущей высоте текста). Выберите Done по завершении.
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Пример: Таблица рисунка

Меню TABLE CREATE

· Descending - назначает первую строку в качестве верхней строки таблицы.

· Ascending - назначает первую строку в качестве нижней строки таблицы.

· Rightward - расширяет таблицу вправо.

· Leftward - расширяется таблицу влево.

· By Num Chars - определяет ячейки таблицы по количеству символов и строк,
отображаемых в ячейке.

· By Length - определяет ячейки таблицы по ширине и высоте в единицах рисунка.

Пример: Создание Таблицы

Создание Столбцов

Создание Строк

В зависимости от того, была ли таблица определена как Leftward или Rightward, она
расширяется влево или вправо

Таблицы с Расширением Влево и Вправо
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Ввод Текста в Таблицу

При добавлении текста в таблицу, система устанавливает его высоту согласно опции
"drawing_text_height� файла установок рисунка. Для отмены текущей установки или
изменения параметров существующего текста таблицы, используйте команды в меню
MODIFY TEXT. Для добавления или редактирования текста в таблице рисунка, выберите
Enter Text в меню TABLE. Выберите ячейку и введите текст. Можно ввести несколько
строк. При установке опции "symbol_palette_input� файла конфигурации в «yes»
отображается окно палетты со специальными символами, доступными в Pro/ENGINEER.
Для использования палетты, сначала выберите ячейку, затем выберите символы из
палетты. По завершении дважды нажмите ENTER.

Добавление Текста

При изменении текста в ячейке или добавлении нового текста, система перезаписывает
содержимое всей ячейки. В текст таблицы, можно включать специальные символы,
названия параметров и значения размеров. Как и для примечаний, при включении размера,
система удаляет его из своего первоначального местоположения.

Совет: Ввод Текста

Таблицы рисунка можно размещать на слоях, выбирая Dwg Table в меню LAYER OBJ.
Текст в таблице имеет то же состояние отображения, что и таблица.

Копирование Ячейки

1. Выберите TABLE > Copy > Copy Cell.
2. Выберите копируемую ячейку.

Обратите внимание: если ячейка назначения содержит какой либо текст, сотрите ее
содержимое перед копированием в нее текста, выбирая DETAIL > Delete.

3. Выберите ячейки назначения. Система копирует содержание подсвеченной ячейки.
Нажмите среднюю кнопку для завершения.
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Копирование Таблицы

1. Выберите TABLE > Copy > Copy Table.

2. Щелкните внутри таблицы для ее подсвечивания.

3. Используя команды в меню GET POINT, выберите точку на экране, обозначающую
нулевую точку новой таблицы.

Содержимое Ячейки

Содержимое ячейки можно копировать в другую (пустую) ячейку или создавать копию всей
таблицы в рисунке.

Объединение Ячеек Таблицы

1. Выберите TABLE > Modify TABLE > Merge.

2. В меню TABLE MERGE, выберите Rows и Columns или Rows & Cols.

3. Выберите противоположные углы диапазона ячеек.

Ограничения, Накладываемые на Объединение Ячеек

При объединении ячеек, учитывайте следующие ограничения:

· объединяемые столбцы или строки должны быть подобны.

· Ячейка, содержащая текст, должна быть соответственно размещена относительно
нулевой точки таблицы. Например, для таблицы расширяющейся вправо и вниз, ячейка с
текстом должна являться левой (верхней) в диапазоне ячеек, которые объединяются с
пустой ячейкой в правом (нижнем) углу диапазона.

· Только одна ячейка в диапазоне может содержать текст.

Пример: Объединение Ячеек и Ограничения при Объединении

Объединение Ячеек
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Ограничения при Объединении
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Ограничения на Ячейки с Текстом

Изменение Сетки Строк и Столбцов Таблицы

1. Выберите TABLE > Modify TABLE > Remesh.

2. Для изменения сетки выберите противоположные углы диапазона ячеек. Только первая
ячейка в диапазоне может содержать какой либо текст.
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Пример: Изменение Сетки Ячеек

Изменение Нулевой Точки Таблицы

1. Выберите TABLE > Modify TABLE > > Origin.

2. Разместите неподвижный угол таблицы, выбирая в пределах угла ячейки. Система
изменяет нулевую точку таблицы. Нулевая точка таблицы по умолчанию - левый верхний
угол. Указанный угол теперь остается неподвижным при добавлении строк или столбцов к
таблице.

Поворот Таблицы на 90 Градусов

1. Выберите TABLE > Modify TABLE > Rotate.

2. Щелкните внутри таблицы. Она поворачивается на 90 градусов в направлении против
часовой стрелки относительно своей нулевой точки.

3. Продолжайте щелкать внутри таблицы; при каждом выборе таблица поворачивается на
90 градусов.

Скрытие или Отображение Строк Таблицы

1. Выберите TABLE > Modify TABLE > Line Display.

2. В меню TABLE LINE, выберите одну из следующих команд:

•  Blank � скрывает выбранную строку.

•  Unblank � перерисовывает изображение выбранной строки таблицы.

•  Unblank All � перерисовывает изображение всех строк, скрытых в таблице.

Изменение Шрифта Строки, Цвета и Ширины

Шрифт строки, цвет и ширину сетки таблицы можно изменять тем же способом, что и при
изменении геометрии. Изменения относятся ко всей сетке таблицы.

Работа Со Строками и Столбцами

Используя меню ROW/COLS OPTS, можно управлять строками и столбцами в таблице
следующими способами:

· вставлять строку или столбец;

· удалять строку или столбец;
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· изменять высоту строки или столбца;

· изменять выравнивание текста ячейки.

Можно также управлять несколькими строками или столбцами за раз, продолжая выбирать
границы ячейки после первого выбора.

Вставка Строки или Столбца

1. Выберите TABLE > Mod Rows/Cols > Insert.
2. Сделайте следующее:

•  Выберите Row и выберите горизонтальную линию таблицы. Система отображает
новую строку между двумя строками, граничащими с выбранной линией.

•  Выберите Column; затем выберите вертикальную линию таблицы. Система вставляет
новый столбец между двумя столбцами, граничащими с выбранной линией.

Удаление Строки или Столбца

1. Выберите TABLE > Mod Rows/Cols > Remove.

2. В меню ROW/COL OPTS, выберите Row или Column.

3. Щелкните внутри удаляемой строки или столбца.

Изменение Размера Строк и Столбцов

1. Выберите TABLE > Mod Rows/Cols > Change Size.

2. В меню ROW/COL OPTS, выберите Row или Column.

3. Щелкните строки или столбца.

4. Введите новую высоту строки или ширину столбца.

Выравнивание Текста в Столбце

1. Выберите TABLE > Mod Rows/Cols > Justify.

2. В меню HOR JUST TXT, установите горизонтальное выравнивание.

3. Установите вертикальное выравнивание.

4. Выберите столбцы для выравнивания. Система выравнивает весь текст, который будет
затем добавлен.

Совет: Отмена Выравнивания Ячейки Таблицы

Для отмены выравнивания ячейки таблицы после ввода текста, выберите, DETAIL >
Remove и выберите текст.
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Изменение Выравнивание Отдельного Текста Таблицы

1. Выберите MODIFY DRAW > Text > Text Style.

2. Используя меню GET SELECT, выберите текст. Выберите Done Sel. Отображается
диалоговое окно Text Style.

3. Сделайте следующее:

•  Укажите горизонтальное выравнивание, выбирая значение в списке Justify Horiz.

•  Укажите вертикальное выравнивание, выбирая значение в списке Justify Vert.
4. Щелкните по Apply. Система изменяет выравнивание текста на указанное. Для возврата
текста к старому стилю, нажмите Reset Settings.

Опции Горизонтального и Вертикального Выравнивания

· Left � выравнивает текст по левому краю.

· Center � центрирует текст.

· Right � выравнивает текст по правому краю.

· Hor Default - выравнивает текст по горизонтали, используя значение по умолчанию (по
левому краю).

· Top - выравнивает текст по верху ячейки.

· Middle - выравнивает текст по центру ячейки.

· Bottom - выравнивает текст по низу ячейки.

· Ver Default - выравнивает текст по вертикали, используя значение по умолчанию (по
верху).

Перемещение Таблицы в Пределах Листа Рисунка

1. Выберите TABLE > Move.

2. Выберите один из углов перемещаемой таблицы.

3. Выберите новое положение для этого угла.

4. Для перемещения таблицы на другой лист, выберите Switch Sheet в меню SHEETS.

Удаление Таблицы

1. Выберите TABLE > Delete.

Обратите внимание: эта команда удаляет всю таблицу, а не только строку или столбец.

2. Выберите удаляемую таблицу.

3. Введите [Y] для подтверждения.
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Сохранение Таблицы Рисунка

1. Выберите TABLESTORE > Store.

2. Щелкните внутри таблицы рисунка.

3. Введите название таблицы. Система сохраняет ее в файл в текущем каталоге и
присваивает имя "tablename.tbl". Имя файла получает уникальный номер версии,
предотвращающий таблицу под тем же именем от перезаписи.

Сохранение и Восстановление Таблицы

Используя команду Save/Retrieve в меню TABLE, можно сохранять таблицу и, затем,
вызвать ее в любой рисунок. Можно сохранять или вызывать таблицу в режимах Рисунка,
Компоновки, Формата, Отчета и Диаграммы. При вызове таблицы в рисунок она уже не
будет иметь размер рисунка, с которым была сохранена; таблицы сохраняют свой
абсолютный размер, то есть размер на момент своего создания.

Сохранение Текста Таблицы

1. Выберите TABLE > Save/Retrieve > Store Text.
2. Выберите таблицу.

3. Введите название файла (без расширения), в котором требуется сохранить текст
таблицы. Система создает файл с названием "имя файла 1". К расширению файла
прибавляется 1 всякий раз, когда указывается имя существующего текстового файла.

Вызов Сохраненной Таблицы Рисунка в Текущий Рисунок

1. Выберите TABLE STORE > Retrieve.

2. Введите название таблицы или введите [?] для выбора таблицы из списка меню
сохраненных таблиц.

3. Отображается контур таблицы с левым верхним углом, совмещенным с указателем.
Разместите таблицу, выбирая положение для левого верхнего угла.

Совет: Листинг Таблиц

Используя команду List в меню TABLE STORE, можно отображать информационное окно,
перечисляющее все таблицы, сохраненные в текущем рабочем каталоге, pro_format_dir и
sys_format_dir.
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Символы

Концепция Использования Символов

Символы

Символы - совокупность эскизной геометрии и текста. При использовании их в рисунке, они
становятся отдельными объектами или вхождениями. Можно добавлять любое количество
символов.

Установка Области Пользовательских Символов

Для определения области, в которой требуется сохранять пользовательские символы,
установите опцию "pro_symbol_dir файла конфигурации. Эта опция автоматически создает
путь поиска файлов к указанному каталогу. Pro/ENGINEER сохраняет и вызывает все
символы из их каталога по умолчанию, при добавлении этой опции к файлу конфигурации.
При изменении значения, система не удаляет символы, используемые в рисунке; при
добавлении, их определения сохраняются локально в рисунке.

Следует установить отдельный каталог в качестве библиотеки пользователей для всех
стандартных символов. Если каталог не определен, система ищет в текущем рабочем
каталоге. Можно изменять заданную по умолчанию область для определяемых
пользователем символов, вводя новое значение для опции "pro_symbol_dir" файла
конфигурации. При изменении этого каталога, файл конфигурации можно не изменять;
однако, это изменение имеет силу только для текущей сессии Pro/ENGINEER. Используйте
эту опцию для определения новых символов, сохраняемых в локальном или временном
каталоге; символы удобно вызывать из стандартной области символов.

Использование Системной Области Символов

Область системных символов содержит библиотеки символов Pro/ENGINEER, которые
доступны для модуля Pro/DETAIL.

Эта область только для чтения. Для вызова символа в режиме Рисунка, выберите,
DETAIL > Create > Symbol > Instance; в диалоговом окне Symbol Instance нажмите
Retrieve. Открывается диалоговое окно Open, в котором можно вызвать системный символ
с диска.

Библиотека Сварочных Символов, например, содержит набор основных системных
символов согласно стандарту ANSI и коллекцию символов согласно стандарту ISO.
Используя эту библиотеку, можно создавать разнообразные символы сварки, пайки и
контроля в рисунке. Перед созданием вхождения, изучите процедуру добавления
вхождений.
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Создание Пользовательской Библиотеки

Можно самостоятельно создавать собственную библиотеку символов. Для информации
относительно того, как создавать и размещать библиотеку символов, см. Руководство по
Инсталляции и Администрированию Pro/ENGINEER.

Вызов Символов

Символы Pro/ENGINEER существуют в двух различных областях: области
пользовательских символов и области системных символов.

Область пользовательских символов - область хранения пользовательских символов по
умолчанию. Область системных символов только для чтения и содержит системные
символы, поставляемые с модулем Pro/DETAIL Pro/ENGINEER (типа Библиотеки
Сварочных Символов).

Изменение "pro_symbol_dir" для Текущей Сессии

1. Выберите DETAIL ITEM > Symbol > Definition > Symbol Dir.
2. Введите имя пути каталога для нового "pro_symbol_dir".

3. Для регенерации имени пути по умолчанию для текущей сессии, сделайте следующее:

•  повторите процедуру и заменить первоначальный путь.

•  Выберите Utilities > Preferences > Load Config в меню Pro/ENGINEER и перезагрузите
файл конфигурации в котором находится эта опция.

Определение Символов

Pro/ENGINEER поддерживает два вида символов - простые и универсальные. Простой
символ � вхождение символа, который идентичен символу. Универсальный символ
определяет семейство подобных символов; он содержит все объекты, имеющие
отношение к этому семейству. В универсальном символе можно упорядочивать геометрию
и текст в группах и подгруппах, создавая древовидную структуру определения символа.

Для Удаления Символа

1. Выберите DWG SYMBOL > Delete.

2. Определить символ, выбирая Name или Pick Inst в меню GET SYMBOL.

3. Введите [Y] для удаления определения символа и его вхождений.

Удаление Символа

Используя команду Delete в меню DWG SYMBOL, можно удалять определение символа и
все его вхождения в рисунке.

Для Сохранение Символа

1. Выберите DWG SYMBOL > Write.
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2. Определите символ, выбирая Name или Pick Inst в меню GET SYMBOL.

3. Введите путь из каталога, указанного в "pro_symbol_dir".

Сохранение Символа

Символы можно сохранять в указанной области, устанавливая опцию "pro_symbol_dir�
файла конфигурации. Если путь не определен, Pro/ENGINEER сохраняет символы в
рабочем каталоге. При сохранении символа, можно вводить путь от каталога, указанного в
"pro_symbol_dir". Например, для UNIX-систем, если в "pro_symbol_dir" указан каталог
/usr/proe/symbols:

· при нажатии ENTER, система размещает символ в /usr/proe/symbols;

· при вводе [down_one_dir], символ сохраняется в /usr/proe/symbols/down_one_dir;

· подниматься в дереве каталогов, вводя [..];

· если требуется сохранить символ в каталоге, к которому нельзя обратиться через путь в
"pro_symbol_dir", измените опцию "pro_symbol_dir" перед началом работы;

· символ не обязательно сохранять, чтобы продолжать пользоваться им в рисунке. Однако,
если он не сохраняется на диск, система сохраняет его только локально в рисунке и он не
будет доступен для использования в других рисунках или другими пользователями.

Переопределение Универсального Символа

1. Выберите DETAIL > Create > Symbol > Definition > Redefine; затем выберите вхождение
символа.

2. Окно редактирования символа отображает универсальный символ. Создайте, удалите,
или измените любой из объектов символа, выбирая соответствующую команду
редактирования в меню SYMBOL EDIT:

•  Detail � создает, удаляет, перемещает, переносит и выполняет другие процедуры с
элементами, составляющими символ, подобно управлению эскизными объектами в
рисунках.

•  Mod Text � изменяет текст.

•  Mod Xhatch � изменяет штриховку сразу после ее создания в окне редактирования
символа. После выхода из окна, штриховка становится набором из отдельных
объектов.

•  Import - импортирует элементы в окне редактирования символа Pro/ENGINEER.

•  Attributes � повторно определяет тип выноски (если они имеются) и характеристики
размера символа.

При создании новых объектов, они автоматически становятся принадлежащими верхнему
уровню и отображаются во всех вхождениях. Если объект был удален, система
автоматически удаляет его из всех групп и подгрупп, которым он принадлежал.

3. Для добавления объекта (только что созданного) к группе, используйте команды
редактирования группы.

4. Выберите SYMBOL EDIT > Groups.

5. Выберите SYM ГРУППЫ > Edit. Меню TOP LEVEL отобразит группы верхнего уровня.
Выберите группу для указания требуемой ветви. Система подсвечивает синим цветом все
объекты, связанные с этой группой.

6. Для добавления объекта, выберите EDIT GROUP > Add Ref и выберите объект.
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Подтвердите выбор, выбирая Done Sel.
7. Для передачи этого объекта на уровень нижних групп, выберите Change Level.
Выберите группу верхнего слоя, с которой связан объект. В окне редактирования символа
появятся только объекты, принадлежащие выбранной группе, а в списке меню - подгруппы
выбранной группы. Это обозначает переход на один уровень вниз.

8. Выберите Edit. Выберите требуемую подгруппу из списка. Выберите Add и укажите
объект. Объект будет связан с указанной подгруппой.

9. Для дальнейшего перехода вниз, повторите Шаги 7 и 8.

10. После окончания процесса редактирования, можно повторно определить атрибуты.
После переопределения символа, можно сохранить новое определение символа, выбирая
DWG SYMBOL > Write. Система создает новый файл символа с номером версии,
позволяющей сохранить старый файл определения символа.

Обратите внимание: при переопределении символа, любая штриховка, которая
существует в символе, больше не является группой; поэтому необходимо управлять ею
соответственно.

Для переопределения простого символа, выполните Шаги с 1 по 6 предшествующей
процедуры для универсальных символов; затем выберите Attributes в меню SYMBOL
EDIT, для повторного определения атрибутов. Сохраните символ, выбирая Write в меню
DWG SYMBOL.

Переопределение Символов

Используя команду Redefine в меню DWG SYMBOL, можно добавлять, перемещать,
удалять или изменять элементы, составляющие символ.

Символ можно изменять следующим образом:

· создавать новые объекты, составляющие универсальный символ.

· Изменять существующие объекты, составляющие универсальный символ.

· Изменять стиль присоединения.

· Изменять определение группы, добавляя или удаляя объекты из групп или удаляя одну
или все группы.

Воздействие Переопределения Символа на Вхождения
При переопределении символа, он воздействует на отображение всех последующих
вхождений и всех вхождений символа, которые добавлены к рисунку, используя команду
By Reference.

Изменение Символов, Используемых в Рисунках
При размещении переопределенного символа, можно (но не необходимо) обновлять
символ в рисунке для отображения последнего определения. Система запросит обновить
символ, если версия вызванного символа более поздняя по отношению к версии символа с
тем же самым именем в рисунке.

Обновление символа рисунка изменяет каждый символ в рисунке с таким названием. Если
символы в текущем рисунке не обновляются, все создаваемые дополнительные вхождения
символа, получают ту же устаревшую версию. Для модифицирования существующего
символа, выберите Retrieve в меню GET SYMBOL, и выберите его имя в существующем
рисунке. Введите [Y] для обновления всех вхождений символа в текущем рисунке на самую
последнюю версию.
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Определение Простых Символов

Простые Символы

Для определения простого символа, необходимо определить объекты символа
(геометрию), атрибуты, нулевую точку или точку присоединения и любой переменный
текст. Используя меню SYMBOL EDIT, можно определять простой символ, используя
примитивы в формате или файле.

Определение Простого Символа

1. Создайте эскизную геометрию и добавьте примечания, включаемые в качестве
постоянного или переменного текста в символе. Размер текста и размещение должны быть
пропорциональны геометрии. Текст символа и геометрия остаются пропорциональными,
при изменении высоты символ.

2. Выберите DETAIL > Create > Symbol > Definition > Define.

3. Если не требуется перезаписать существующий символ, введите название, которое еще
не использовалось существующими символами (в каталоге, где Вы собираетесь сохранять
символ). Отображается окно редактирования символа.

4. Выберите Copy Drawing для копирования примитивов из формата или рисунка в окно
редактирования символа. Выберите GET SELECT > Pick Many > Pick Box и выделите все
объекты.

5. Выберите GET SELECT > Done Sel для подтверждения выбора. Все выбранные объекты
отображаются в окне редактирования символа.

6. Выберите SYMBOL EDIT > Attributes.

7. Выберите требуемые атрибуты в диалоговом окне Symbol Definition Attributes; затем
нажмите OK.

8. Выберите SYMBOL EDIT > Done. Система подтверждает, что символ был успешно
определен.

Пример: Выбор Нулевой Точки для Размещения Символа
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Определение Объектов Простого Символа

Для определения объектов, которые будут включены в определение символа можно
выбирать эскизную геометрию, узлы, одиночные примечания (определенные как
переменный или постоянный текст) и заполненные области, составляющие символ.
Используя команды в меню SYMBOL EDIT, можно создавать объекты символа любым из
следующих способов:

· в окне редактирования символа, создайте геометрию и текст, используя команду Detail.
· В рисунке, создайте геометрию и текст; затем скопируйте их в окно редактирования
символа, используя команду Copy Drawing.

· Используя команду Copy Symbol, вызовите выбранный символ в окно редактирования
символа (для универсального символа при добавлении символа, необходимо выбрать
группы для включения) и используйте его примитивы для определения собственного
символа. Как только символ появится в окне редактирования символа, система
разгруппировывает его объекты, и ими можно управлять по отдельности.

· Импортируйте объекты в окно редактирования символа, используя команду Import в
меню File Pro/ENGINEER. Можно импортировать рисунки IGES, DXF, SET и CGM.

Примечания:

•  Нельзя изменять штриховку во вхождении символа, потому что символ -
сгруппированный объект. При его разгруппировке, штриховка распадается на
отдельные объекты. Это происходит также при переопределении символа в меню
SYMBOL EDIT.

•  В символы нельзя включать размеры и системы координат.

Пример: Объекты, Разрешаемые к Использованию в Символе

Определение Типа Размещения Простого Символа

При выборе одного из допускаемых типов размещения символа, необходимо выбрать
начало координат. Можно присоединять символы к системе координат, используя
присоединение выноски или используя флажок On Entity при размещении вхождения
символа.

Указание Атрибутов

Используя диалоговое окно Symbol Definition Attributes, можно определить следующие
атрибуты символа:
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· тип размещения:

•  свободно на примитиве или перпендикулярно к объекту;

•  с левой, правой или радиальной выноской;

· высота вхождения символа:

•  постоянная;

•  переменная в единицах рисунка, единицах модели или зависимая от текста;

· положение и другие характеристики:

•  под установленным углом текста;

•  с изгибом;

•  зеркальное изображение исходной геометрии или текста;

· переменный текст

Связывание Высоты Символа с Видом Модели

1. Выберите Variable - Model Units на странице General диалогового окна Symbol
Definition Attributes.

2. Свяжите вхождение символа с моделью. Нажмите среднюю кнопку мыши, чтобы связать
символ со всем рисунком, который определяет его высоту в единицах рисунка, или
выберите определенный вид.

Обратите внимание: Символы, помещенные на элемент или перпендикулярно к элементу
отображаются на кромке модели и привязываются к этой модели или отображаются на
эскизном объекте и связываются со всем рисунком. Если свободный символ полностью
расположен в пределах границы отдельного вида, система автоматически выбирает
модель в этом виде. Иначе, необходимо выбрать вид для размещения символа.

3. Определите значение высоты вхождения символа в единицах модели.

Высота Вхождения Символа

Для связывания высоты символа с видом модели, который был определен с
использованием с атрибутами размещения On Item или Free Note, выберите Variable -
Model Units на странице General диалогового окна Symbol Definition Attributes. Система
запоминает высоту вхождений символа в единицах модели. При изменении масштаба вида
в единицах модели, видимый размер символа корректируется автоматически для
сохранения постоянных пропорциональных зависимостей с моделью.

Можно соотносить символы, типа символов диаметра, с последующим текстом. В этом
случае, определите атрибуты символа, выбирая Variable - Text Related в диалоговом окне
Symbol Instance. Однако, если символ (например, символ диаметра) не содержит текста, с
которым его можно соразмерять, можно создать текст символа с пустой строкой, делая
следующее:

· создать однострочное примечание в символе. В меню DRAWING, выберите Mod Text и
Full Note, и измените весь текст в примечании на одну пустую строку (убедитесь, чтобы
были сохранены фигурные скобки и другие специальные символы). Для включения этого
текста при определении символа, выберите Pick Box и выберите Variable - Text Related в
диалоговом окне Symbol Instance для определения символа.

· Включите примечание с переменным текстом при определении символа. Выберите
Variable - Text Related в диалоговом окне Symbol Instance для определения символа. При
создании вхождения этого символа, удалите весь текст в поле Var Text, чтобы текст в
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символе не отображался.

Создание Выноски с Изгибом

Для создания выноски с изгибом, выберите Allow Elbow в поле Attributes диалогового
окна Symbol Definition Attributes. Эта команда недоступна, пока не будет определен тип
размещения с использованием выноски. При создании вхождения, изгиб на выноске может
быть невидим. Чтобы сделать его видимым в рисунке, переместите символ, выбирая Move
Text в меню DETAIL.

Пример: Присоединение Символа к Выноске с Изгибом

Управление Свойствами Зеркального Отображения Простого
Символа

Можно управлять тем, как символ и его примечания будут отображаться и
переориентироваться при зеркальном отображении и повороте, используя один из
следующих трех методов:

· установите опцию "sym_rotate_note_center� файла установок рисунка в «yes» (значение по
умолчанию). Система поворачивает примечание символа относительно середины высоты
текста. При установке опции в «no», система поворачивает текст относительно
существующей нулевой точки . Изменение значения этой опции установки изменяет
положение существующего поворачиваемого текста при перерисовке.

· Определите атрибуты в диалоговом окне Symbol Definition Attributes. Можно делать
зеркальную копию исходной геометрии символа, выбирая Mirror в меню TOOLS и выбирая
эскизную линию. Если в диалоговом окне Symbol Definition Attributes не будет выбрано
Geom. Will Mirror, система зеркально отобразит только нулевую точку, и геометрия
символа появится в той же ориентации, что и копируемый символ. При выборе Text Will
Mirror, отображаемый текст будет зеркальной копией исходного текста, с началом
координат, перенесенным относительно линии зеркального отображения. Таким образом,
текст отображается наоборот по отношению к исходному тексту, его угол и нулевая точка
также отображаются.

· Используйте команду Toggle Rotate в меню NOTE ROTATE. Для вращения отдельных
примечаний с символом, выберите Redefine в меню DWG SYMBOL, Note Rotate в меню
SYMBOL EDIT и Toggle Rotate в меню NOTE ROTATE. Затем можно выбирать примечание
в окне редактирования символа, чтобы оно поворачивалось вместе с символом. Команда
Show Fixed подсвечивает примечания в окне редактирования символа, которые остаются
неподвижными в процессе поворота их символа. Эта подсветка исчезает после
перерисовки.
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Управление Переменным Текстом Простого Символа

Используя страницу Var Text в диалоговом окне Symbol Definition Attributes, можно
определить значения по умолчанию и дополнительные значения переменного текста для
символа:

· спецификация состоит из списка составляющих элементов и области ввода текста (поле).

· Каждый составляющий элемент в списке представляет переменный текст.

· Ярлычок слева от составляющего элемента обозначает название переменного текста.

Система использует значение по умолчанию (слева от названия переменного текста) при
создании первого вхождения символа. При вводе [&dim] в качестве текста по умолчанию
для определения символа, необходимо выбрать размер для конкретного вхождения.
Значение размера исчезает из его предыдущего места и отображается как текст символа.
При изменении переменного текста, если значение по умолчанию - " &dim, " необходимо
выбрать размер при размещении символа. Дополнительно к значению по умолчанию,
можно определить другие предварительно установленные значения для каждого
переменного текста.

Переменный текст можно использовать для создания уникальных вхождений символа,
заменяя заданный по умолчанию текст в символе на числовое значение, текст или размер
при создании вхождения. Pro/ENGINEER добавляет переменный текст как не
присоединенное примечание с текстом, заключенным между наклонными чертами влево
(\).

Обратите внимание: переменный текст может состоять только из текста. Так как
Pro/ENGINEER воспринимает специальные символы как отдельный текст, нельзя
использовать наклонную черту влево для определения значения переменного текста.

Определение Универсальных Символов
Универсальный символ определяет семейство подобных символов; он содержит все
примитивы, относящиеся к этому семейству. Геометрию и текст в универсальном символе
можно упорядочивать в группы и подгруппы, создавая древовидную структуру определения
символа. Каждый уровень в определении символа, содержащий более одной группы,
характеризуется атрибутом группы, ограничивающим выбор группы на указанном уровне.
То есть можно выбирать Exclusive в меню GROUP ATTR для определения группы, чтобы
включать только один из них во вхождение символа, или можно использовать команду
Independent, чтобы определить их таким образом, чтобы можно было выбирать любое
число групп (или ни одну). Следующий рисунок показывает, как использовать группы для
сборки вхождений символов.

Древовидная структура определения помогает создавать вхождения символа. При
определении группы для включения, система собирает вхождение из ранее определенных
блоков или групп. Группа может состоять из других подгрупп и независимых объектов.
Система всегда выбирает эти независимые объекты на каждом уровне, при выборе группы,
к который они принадлежат. Подгруппы различных подгрупп могут использовать одно и то
же имя.

Перемещение По Дереву Определений Символов

При определении и переопределении символов, можно перемещаться между группами и
подгруппами, используя команду Change Level в меню SYM GROUPS. При этом
отображается меню GROUP со списком существующих групп текущего уровня. Выбор
группы из списка перемещает вниз по уровню, чтобы можно было работать на нижнем
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уровне. Выбор This Level сообщает системе, что требуемый уровень достигнут и
необходимо продолжить операцию. При выборе UP, происходит перемещение на один
уровень в дереве определений символов.

Пример: Создание Универсального Определения Символа

Создание Древовидной Структуры Определения

1. Выберите DETAIL > Create > Symbol > Definition > Define.

2. Введите название символа [FILLET].

3. Выберите SYMBOL EDIT > Copy Drawing для копирования объектов в окно
редактирования символа. Выберите GET SELECT > Pick Many > Pick Box для быстрого
выделения всех объектов.

4. Выберите Done Sel для подтверждения выбора. Все выбранные объекты отображаются
в окне редактирования символа.

5. Выберите SYMBOL EDIT > Groups > Create.

6. Введите название группы, типа [ARROW_SIDE]. Выделите все объекты, которые
находятся по одну сторону стрелки, за исключением ссылочной линии. Система не
включает ссылочную линию ни в какую группу, так как она должна появляться во всех
вхождениях символа.

7. После выделения всех объектов, выберите Done Sel.
8. Для создания другой группы верхнего уровня, выберите SYM GROUPS > Create, введите
название группы [OTHER_SIDE], и выберите объекты, расположенные по другую стороны
ссылочной линии. Завершите выбором Done Sel.
9. В этом примере, группы верхнего уровня единственные. Выберите SYM GROUPS >
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Group Attr > Exclusive.

10. Для создания подгруппы для группы верхнего уровня, выберите SYM GROUPS >
Change Level.
11. Появляется меню TOP LEVEL со списком групп текущего уровня и командой This Level.
Выберите ARROW_SIDE; все объекты, относящиеся к этой группе отображаются в окне
редактирования символа.

12. Выберите ARROW_SIDE > This Level.
13. Для определения подгруппы на текущем уровне, выберите Create, введите название
группы, и выберите соответствующую геометрию или строку текста. При создании
подгрупп, используйте следующую таблицу:

Обратите внимание: система не включает скругление ни в какую подгруппу, потому что
оно должно всегда находиться в каждом вхождении по любую сторону стрелки.

По умолчанию, система устанавливает атрибут группы в Independent; поэтому, не следует
использовать меню GROUP ATTR. Группы являются независимыми, потому что можно
включать все группы в единственное вхождение.

Для определения подгруппы в группе CONTOUR, выберите Change Level > CONTOUR.
Окно редактирования символа отображает объекты текущей группы.

15. Выберите SYM GROUPS > Create. Создайте следующие три группы:

16. Выберите SYM GROUPS > Group Attr > Exclusive (Можно выбирать только одну из
предшествующих подгрупп под группой CONTOUR за раз).

17. Выберите Change Level > UP > FINISH. Для выбора требуемого символ на экране,
используйте Query Sel. Создайте группы следующим образом:
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18. Выберите SYM GROUPS > Group Attr > Exclusive. Теперь символ arrow-side в одной
ветке стрелки полностью описан.

19. Для определения подгруппы по ветке other-side, выберите Change Level > UP для
возвращения в меню TOP LEVEL.

20. Выберите OTHER_SIDE и продолжайте создавать группы, следуя процедуре,
описанной в Шагах с 8 по 19.

21. По завершении определения символа, выберите SYM GROUPS > Done.

22. Выберите SYMBOL EDIT > Attributes.

23. В диалоговом окне Symbol Definition Attributes, выберите элементы,
характеризующие точку присоединения, тип выноски и размер символа. Для этого
примера, нажмите Left Leader и Variable.

24. Выберите начало координат выноски на левой стороне символа; затем нажмите OK.

25. Нажмите ярлычок Var Text, чтобы ввести значения для примечаний, созданных между
слэшами (/) в качестве переменных текстовые вхождений.

26. Система сообщает, что символ определен. Для сохранения универсального символа на
диск, выберите SYMBOL EDIT > Write. Введите путь к каталогу или примите значение по
умолчанию.

Пример: Определение Универсального Символа

Следующий пример представляет универсальный символ, созданный с использованием
показанных объектов.

Объекты Универсального Символа

Следующий рисунок отображает древовидную структуру определения символа.

Древовидная Структура Определения Символа
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Обратите внимание: В этой структуре группа Exclusive обведена двойной рамкой.

Добавление Узлов к Символам

Добавление Узлов

В момент определении или после определения символов, можно добавлять узлы (также,
называются как контакты) в качестве точки присоединения провода компонентов и
соединителей. Также можно генерировать, изменять, сохранять и просматривать
установленные параметры.

Для Создания Узла

1. Выберите SYMBOL EDIT > Detail > Create > Node > Make Node.

2. Введите название узла в числовой или буквенно-цифровой форме.

3. Выберите местоположение узла на символе. На символе отображается зеленая точка с
именем узла, обозначающая узел.

Создание Узлов

При включении узла в символ, система идентифицирует его, помещая его название в
примечании. При создании узлов в процессе определения символа, к файлу параметра
символа автоматически добавляется команда PIN и значение названия узла. Опция
"node_radius� файла установок рисунка управляет отображением узлов в символах.

Изменение Параметров в Примечаниях Узла

Можно изменять значение параметров, на которые ссылаются примечания узла при работе
с определениями или вхождениями символов. Выберите Value в меню MODIFY DRAW,
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выберите значение изменяемого параметра, и введите новое значение.

Обратите внимание: "node_name" можно изменять в узле только при повторном создании
узла в символе, используя команды Definition и Redefine.

В определениях символа, параметр, на который ссылается примечание узла является
именем параметра, отображаемым в примечании, в то время как фактическое значение
параметра отображается в области сообщения. Поэтому, изменение значения параметра
не отображается в примечании; новое значение параметра отображается только в области
сообщения. При создании вхождения символа, система заменяет параметры, включенные
в примечание узла их значениями. Изменение значения параметра обновляет примечание
узла, чтобы показать значение текущего параметра. При изменении значений символа или
параметра узла в примечании узла с использованием команды Value в меню MODIFY
DRAW, система обновляет значения соответствующих параметров, перечисленных в
таблице параметра символа.

Скрытие Параметров в Примечаниях Узла

По умолчанию, система отображает примечания узла при их создании. Можно скрыть все
примечания узла, выбирая Erase Notes в меню SYMBOL NODE. Для регенерации их
изображения, выберите Show Notes.

Ссылки Параметров в Примечаниях Узла

Можно редактировать примечания узла как текст для включения следующих ссылок на
другие параметры:

· название узла, например, "&node_name";

· параметры узла, например, "&signal_name";

· параметры символа верхнего уровня, например, "&ref_des";

· любые действительные параметры рисунка, включенные как ярлычки, например "&scale".

Обратите внимание: можно ссылаться только на те символы, которым назначены
значения в установленных параметрах символов. При удалении параметра, на который
ссылается примечание, в примечании вместо отсутствующего значения параметра
отображаются звездочки "***".

Включение Параметров Символа
В Pro/DETAIL, в символ можно включать два типа параметров:

· параметры узла (node parameters), идентифицирующие узлы (только, если в конкретном
символе присутствуют узлы).

· Параметры определения символа, или установленные параметры верхнего уровня,
идентифицирующие символ. Система заменяет их соответствующей информацией, при
добавлении символа к рисунку. Постоянный текст отображается таким же для любого
вхождения символа. Можно использовать следующие параметры в определении символа:

•  любой из системных параметров для рисунков;

•  любые пользовательские параметры;

•  &dwg_name;

•  &model_name;
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•  &scale.

Обратите внимание: нельзя использовать параметр примечания для значения
переменного текста.

В зависимости от присоединения, символ может включать следующие категории
параметров:

· требуемый;

· необязательный, системный;

· необязательный, пользовательский.

Если присоединение использует символ с обязательными параметрами, но они
отсутствуют, система выдает сообщение об ошибках и можно редактировать файл
параметра символа. Следующий рисунок отображает формат файла параметра.

Установленный Формат Параметра

Pro/ENGINEER использует символы, содержащие индивидуальные установленные
параметры для создания электрических диаграмм. Символы Pro/DIAGRAM можно
определять в режиме Рисунка и режиме Диаграммы. Однако, если потребуется
использовать их в Pro/DIAGRAM, следует определять их как компоненты или соединители,
вводя набор параметров, соответствующий типу объекта представляемого символа
(компонента или соединителя). Следующие таблицы перечисляют параметры компонентов
и соединителей (требуемые параметры отображаются жирным шрифтом).

Параметры Компонента

ПАРАМЕТР ОПИСАНИЕ
DESCRIPTION Описание компонента (типа FUEL GAUGE)

TYPE Тип объекта (COMPONENT)

REF_DES Имя ссылки. Необходимо сохранять заданное по умолчанию имя с
определением символа. При размещении символа компонента
необходимо указать уникальное имя REF_DES, которое будет
сохранено со вхождением символа и использовано в списке проводов.

MODEL_NAME Имя ссылочной твердотельной модели (физической модели),
представленной символом компонента.

NUM_OF_PINS Количество логических контактов. Система определяет количество
видимых контактов по количеству узлов в определении символа.

PIN ... � � Имена контактов и информация по сигналам. Для каждого узла,
включенного в определение символа, система генерирует строку в
следующем формате:
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PIN PIN_NAME SIGNAL_NAME SIGNAL_VALUE ENTRY_PORT

PIN_NAME � заполняется автоматически.

SIGNAL_NAME и SIGNAL_VALUE � необязательные параметры; их
можно ввести вручную.

ПАРАМЕТРЫ
СОЕДИНИТЕЛЯ

ОПИСАНИЕ

DESCRIPTION Описание соединителя (типа 12 PIN FEMALE)

TYPE Тип объекта (CONNECTOR)

REF_DES Имя ссылки.

MODEL_NAME Имя ссылочной твердотельной модели (физической модели),
представленной символом соединителя.

GENDER MALE или FEMALE.

PIN ... � � Имена контактов и информация по сигналам. Для каждого узла,
включенного в определение символа, система генерирует строку в
следующем формате:

PIN PIN_NAME SIGNAL_NAME SIGNAL_VALUE ENTRY_PORT

PIN_NAME � заполняется автоматически.

SIGNAL_NAME и SIGNAL_VALUE � необязательные параметры; их
можно ввести вручную.

NUM_OF_PINS Количество логических контактов. Количество видимых контактов для
фиксированного соединителя, определенного количеством узлов в
определении символа для параметрического соединителя значением
атрибута Num Vis Pins

Для параметров можно выполнять следующие процедуры:

· генерировать, редактировать или просматривать набор параметров определений
символов.

Генерация Набора Параметров

Для создания набора параметров, можно сделать следующее:

· сгенерировать набор заданных по умолчанию параметров, считывая данные (системные
или пользовательские).

· Указать имена параметров и их значения в таблице с использованием среды Pro/TABLE.

Генерация Набора Параметров по Умолчанию

1. Выберите SYMBOL EDIT > Parameters > Read.

2. Используя меню READ SYM PRM, сделайте следующее:

•  выберите Comp Default и вызовите системный набор параметров по умолчанию для
компонентов.

•  Выберите Conn Default и вызовите системный набор параметров по умолчанию для
соединителей.
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•  Выберите Other и вызовите пользовательский файл (с расширением ".spm")
содержащий соответствующие параметры.

Создание Параметров в Pro/TABLE

1. Выберите SYM PARAMS > Modify. Отображается пустое окно Pro/TABLE пока не будет
считан файл параметров.

2. Используя редактор Pro/TABLE, введите параметры и их значения в требуемом
формате. Используйте команду Help или Edit в Pro/TABLE. При необходимости выберите
Keywords (клавиша - F4). Установленный параметр можно редактировать позже.

Редактирование Параметров Символа

После создания набора параметров, можно изменять символ и параметры узла,
редактируя файла параметра с использованием редактора Pro/TABLE. Можно изменять
значение параметра, добавлять пользовательские параметры или удалять параметры.
Если система находит ошибки после редактирования файла параметра, она отображает
Информационное Окно, обозначающее тип ошибки. Можно использовать команды в меню
REEDIT для разрешения несоответствий.

Просмотр Параметров Символа

Используя команду Show в меню SYM PARAMS, можно просматривать набор параметров
определений символов.

Сохранение Файла Параметра

1. Выберите SYMBOL EDIT > Parameters > Write.

2. Введите имя файла без расширения. Система сохраняет файл с именем "filename.spm"
на диск.

3. Если введенное имя файла параметра уже существует в рабочем каталоге, ведите [Y]
для замены существующего файла или [N] для отмены; затем введите новое имя файла.

Сохранение Параметров Символа

При работе с определением символа, можно сохранять набор параметров в файл в
рабочем каталоге и считывать его позже для создания подобного набора параметров для
других определений символа.

Системные Параметры для Рисунков

Следующая таблица перечисляет все системные параметры, доступные для
использования в рисунках, классифицируя их согласно функциональным возможностям.

Имя Параметра Определение
&d# Отображает размер в примечании рисунка, где # -

Идентификатор размера
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&ad# Отображает ассоциативный размер в примечании
рисунка, где # - Идентификатор размера

&rd# Отображает ссылочный размер в примечании рисунка,
где # - Идентификатор размера

&p# Отображает номер вхождения массива в примечании
рисунка, где # - Идентификатор размера

&g# Отображает gtol в примечании рисунка, где # -
Идентификатор размера

&<param_name> Отображает значение пользовательского параметра
размер в примечании рисунка.

&<param_name>:att_cmp Параметр объекта, который обозначает параметры
компонента, к которым присоединено примечание

&<param_name>:att_edge Параметр объекта, который обозначает параметры
кромки, к которой присоединено примечание

&<param_name>:att_feat Параметр объекта, который обозначает параметры
элемента, к которым присоединено примечание

&<param_name>:att_mdl Параметр объекта, который обозначает параметры
модели, к которым присоединено примечание

&<param_name>:att_pipe_b
end

Параметр объекта, который обозначает параметры
колена трубы, к которому присоединено примечание

&<param_name>:att_spool Параметр объекта, который обозначает параметры
катушки (spool), к которой присоединено примечание

&<param_name>:EID_<edg
e_name>

Параметр объекта на который ссылаются кромки

&<param_name>:FID_<feat
_ID>

Параметр объекта который включает параметр
элемента в примечание по Идентификатору (ID)

&<param_name>:FID_<FE
AT_NAME>

Параметр объекта который включает параметр
элемента в примечание по имени

&<param_name>:SID_<surf
ace_name>

Параметр объекта который ссылается на поверхности

&angular_tol_0_0 Указывает формат значения углового допуска в
примечании от одного до шести десятичных знаков

&current_sheet Отображает ярлычок рисунка, обозначающий номер
текущего листа

&det_scale Отображает ярлычок рисунка, обозначающий масштаб
выносного вида. Этот параметр нельзя использовать в
примечании рисунка.

Pro/ENGINEER создает этот параметр с видом и
размещает его в примечании автоматически. Это
значение можно изменять, но нельзя вызывать его в
другое примечание.

&dtm_name Отображает имена опорных элементов в
примечании рисунка. Name � имя опорного
элемента. Имя опорного элемента в примечании �
только для чтения, поэтому его нельзя изменять. В
отличии от размеров имена опорных элементов не
исчезают из вида модели при включении их в
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примечание. Система заключает их имена в
прямоугольник, как если бы они были
установленными базами.

&dwg_name Отображает ярлычок рисунка, обозначающий имя
рисунка.

&format Отображает ярлычок рисунка, обозначающий
формат рисунка (например, А1, А0, А, В и т.д.)

&linear_tol_0_0 Указывает формат значений допуска на размер в
примечании от одного до шести десятичных мест.

&model_name Отображает ярлычок рисунка, обозначающий имя
модели, используемой в рисунке.

&parameter:d Добавляет параметр рисунка к примечанию
рисунка, где parameter � имя параметра, а :d относится
к рисунку. Значение можно изменять с использованием
команды Value в меню MODIFY DRAW.

&pdmdb Отображает нулевую точку базы данных рисунка.

&pdmrev Отображает редакцию модели.
&pdmrev:d Отображает номер редакции модели (где :d

относится к рисунку)

&pdmrl Отображает уровень версии модели.

&scale Отображает ярлычок рисунка, обозначающий
масштаб рисунка.

&scale_of_view_detailed
_bar

&sym(<symbolname>) Включает символ рисунка в примечание, где
symbolname � имя символа.

&todays_date Отображает ярлычок рисунка, обозначающий дату
создания примечания в формате дд-мм-гг (например,
2-Jan-92). Его можно редактировать, как любое
непараметрическое примечание с использованием Text
Line или Full Note.

При включении этого символа в формат таблицы
система перерассчитывает его при копировании
формата в рисунок.

Для указания первоначального отображения даты в
рисунке используйте опцию �todays_date_note_format�
файла конфигурации.

&total_sheets Отображает ярлычок рисунка, отображающий общее
количество листов в рисунке.

&type Отображает ярлычок рисунка, обозначающий тип
модели в рисунке (например, сборка, модель и т.д.)
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&view_name Отображает ярлычок рисунка, обозначающий имя
вида. Этот параметр нельзя использовать в
примечании рисунка.
Pro/ENGINEER создает этот параметр с видом и
размещает его в примечании автоматически. Это
значение можно изменять, но нельзя вызывать его в
другое примечание.

&view_scale Отображает ярлычок рисунка, обозначающий имя
основного масштабированного вида Этот параметр
нельзя использовать в примечании рисунка.
Pro/ENGINEER создает этот параметр с видом и
размещает его в примечании автоматически. Это
значение можно изменять, но нельзя вызывать его в
другое примечание.

Системные Параметры Pro/REPORT
&asm.mbr.comp Вызывает информацию о компоненте из данных модели и

отображает ее в таблице отчета.

&asm.mbr.cparam Вызывает параметр данного компонента

&asm.mbr.cparams Перечисляет информацию, относящуюся ко всем
параметрам компонента для текущей модели.

&asm.mbr.name Отображает имя компонента сборки. Для отображения
связок (tie wraps) и маркеров атрибуты области должны
быть установлены в Cable Info.

&asm.mbr.param Отображает информацию по параметрам в компоненте
сборки.

&asm.mbr.type Отображает тип (деталь или сборка) компонента сборки.

&asm.mbr.User Defined Перечисляет указанные пользовательские параметры
соответствующих компонентов сборки. Обратите
внимание, что �&asm.mbr.� может быть использован в
качестве префикса для любого пользовательского
параметра компонента сборки.

&dgm

&fam Вызывает информацию таблицы семейства по модели.

&harn Отображает параметры жгутов для трехмерных деталей
жгутов и сборок плоских жгутов.

&lay Вызывает компоновочную информацию по модели

&mbr Вызывает параметры по отдельному компоненту.

&mdl Вызывает параметры по отдельной модели.

&prs Вызывает параметры отчета по обработке, используемые
по созданию отчета для всей последовательности
обработки.

&rpt Отображает информацию по каждой записи в
повторяемых областях.

&weldasm Вызывает информацию по сварке в модели.
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&asm.mbr.cblprm Перечисляет значения по параметрам данных кабелей.

&asm.mbr.cblprms Перечисляет значения по параметрам кабелей и
проводов.

&asm.mbr.connprm Перечисляет параметры по контактам соединителей в
плоской кабельной сборке.

&asm.mbr.pipe Отображает параметры трубопроводов, сегментов труб и
колен Pro/REPORT.

&asm.mbr.generic.name�. Перечисляет основные имена по вхождениям семейства
таблицы.

&asm.mbr.topgeneric.name�
.

Перечисляет основные имена верхнего уровня по
вхождениям таблицы семейства при работе с входящими
таблицами семейства.

Добавление Символов к Рисунку
При добавлении символа к рисунку, создается вхождение. Для поиска имени и каталога
символа, соответствующего вхождению, используйте команду Show Name в меню DWG
SYMBOL. Используя диалоговое окно Symbol Instance, можно создавать новые вхождения
символа и просматривать их в процессе создания. Конкретно, можно делать следующее:

· определять характеристики размещения:

•  содержимое;

•  высоту;

•  угол;

•  положение;

· определять группы, включаемые в символ;

· изменять переменный текст;

· изменять местоположение вхождения.

Вхождения символа существуют только в формате рисунка. В режиме Рисунка нельзя
редактировать символы, которые были созданы и добавлены к формату в режиме
Формата, если формат добавлен к рисунку. Для редактирования символа, вызовите
формат в режиме Формата и проведите все необходимые изменения. Для вызова
символов формата в режиме Рисунка, сохраните символ на диск, и вызовите его в рисунок
из соответствующего каталога, в котором файл сохранен.

Создание Вхождения Символа

1. Выберите DETAIL > Create > Symbol > Instance.

2. В диалоговом окне Symbol Instance, нажмите Pick Inst для выбора символа в рисунке,
или нажмите Retrieve для вызова системного символ с диска.

3. Определите высоту вхождения, введите значение в поле Height.
4. Определите тип размещения, выбирая элемент в списке Type.

5. Нажмите Place Inst... для размещения символа в рисунке.
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•  При выборе других условий в диалоговом окне Symbol Definition Attributes (типа On
Entity и Free) перед добавлением вхождения к рисунку, укажите, как разместить
вхождение, используя команды в меню INST ATTACH.

•  Если символ определяется с выноской, определите тип присоединения выноски,
выбирая команду в меню ATTACH TYPE.

6. Система отображает символ как было определено.

Размещение Вхождения Символа

Используя страницу Placement диалогового окна Symbol Instance, можно определить
содержание вхождения, назначить высоту, угол и размещение в рисунке.

Пример: Символ с Выноской

Для Повторения Вхождения Символа

1. В диалоговом окне Symbol Instance, нажмите Pick Inst для выбора символа в рисунке
или нажмите Retrieve для вызова системного символа с диска.

2. Нажмите Place Inst и выберите местоположение для размещения вхождения символа.

3. В диалоговом окне Symbol Instance, нажмите Repeat Inst. Эта команда создает копию
последнего выбранного вхождения символа.

4. Выберите местоположение для размещения вхождения символа.

Повторение Вхождения Символа

Вхождение символа можно повторить, щелкая по кнопке Repeat Inst в диалоговом окне
Symbol Instance.

Эта команда помогает создавать несколько копий выбранного символа.

Связывание Вхождения Символа с Размерным Текстом

Перед или после создания символа, его можно связывать непосредственно с размерным
текстом таким образом, чтобы он перемещался с размером. При определении размещения
нового вхождения символа, выберите Offset в списке Placement Type в диалоговом окне
Symbol Instance. Затем выберите размерный текст и местоположение относительно
текста. Для связывания существующего символа с размерным текстом, выберите Relate
Dim в меню TOOLS.
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Для Создания Смещенного Присоединения к Символу или
Примечанию

Можно присоединять символ или примечание, которые смещены от конечной точки стрелки
размерной выноски.

1. В меню DETAIL, нажмите Create > Note > Offset > Make Note.

2. Выберите следующее:

•  размер;

•  стрелку размера;

•  примечание;

•  позицию;

•  GTOL;

•  вхождение символа;

•  ссылочный размер.

3. Выберите местоположение для символа или примечания; затем выберите символ в
диалоговом окне Symbol Palette или введите примечание в текстовом поле.

Создание Смещенного Присоединения к Символу или
Примечанию

Символы и примечания могут быть присоединены со смещением к другим символам и
примечаниям. При перемещении родительского символа или примечания, дочерний
символ или примечание перемещаются вместе с ним и сохраняют расстояние смещения.
Также можно присоединять символ или примечание, которые смещены от конечной точки
стрелки выноски.

Указание Группировки Вхождения Символа

Используя страницу Grouping диалогового окна Symbol Instance, можно отображать
древовидное представление группировки символа.

Для разворачивания и сворачивания элементов дерева, выберите квадратик слева от
названия подгруппы следующим образом:

· один раз выберите подгруппу для включения ее во вхождение.

· Выберите ее еще раз для удаления ее (и всех подгрупп) из символа.

Включение или исключение группы не разворачивает и не сворачивает ее подгруппы;
однако, можно выбирать квадратик слева от названия подгруппы для изменения вида
дерева. При включении подгруппы, включаются все родители (если они еще не включены).
При отключении родителя, отключаются все дочерние записи. Если родительские записи
вновь включаются, система восстанавливает состояние подгрупп.

Создание Вхождения Универсального Символа

1. Выберите DETAIL > Create > Symbol > Instance.

2. В диалоговом окне Symbol Instance, нажмите Pick Inst для выбора символа в рисунке
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или нажмите Retrieve для вызова системного символа с диска.

3. Определите высоту вхождения, введите значение в поле Height.
4. Определите тип размещения, выбирая элемент в списке Type.

5. Нажмите Grouping для указания групп и подгрупп, включаемых в конкретное вхождение.
Во вхождении отображаются только группы, которые были выбраны в списке групп,
отображаемом во вхождении.

6. Диалоговое окно отображает древовидное представление иерархии групп символа.
Выберите группы следующим образом:

•  Если группы независимы, выберите любое число групп.

•  Если группы единственны, выберите только одну группу для включения в символ.

7. Разверните древовидную структуру для отображения подгрупп и выберите требуемые.
Нажмите OK.

Изменение Значения Переменного Текста

1. Выберите DETAIL > Modify > Symbol.
2. Выберите вхождение изменяемого символа.

3. В диалоговом окне Symbol Instance, нажмите Var Text. Диалоговое окно отображает
набор предопределенных значений для вхождения символа, в котором можно выбрать
только одно. Предопределенные значения, подобно значениям по умолчанию переменных
текстов, являются частью определения символа.

4. Определите значения по умолчанию и дополнительные предопределенные значения
переменного текста, или выберите переменный текст вхождения в рисунке в окне
предварительного просмотра и затем измените его.

Изменение Переменного Текста во Вхождении

Используя страницу Var Text диалогового окна Symbol Instance, можно изменять
содержание примечания, включенного во вхождение символа, если текст был создан как
переменный текст.

Можно изменять параметры текста при переопределении символа. Однако, при попытке
изменить параметры текста во вхождении, необходимо рассмотреть следующее:

· для символов с переменной высотой, нельзя изменять высоту текста независимо от
размеров символа.

· Для символов с фиксированной высотой, можно изменять текст только при
переопределении символа. Выберите Mod Text из меню SYMBOL EDIT для вызова команд
редактирования текста.

Изменение Местоположения Вхождения

Положение вхождения символа можно изменять в любое время после добавления его к
рисунку. При использовании кнопок Move, Move Text или Mod Attach в диалоговом окне
Symbol Instance, можно изменять местоположение вхождения путем его перемещения.
Как и при размещении символа, он перемещается динамически, вместе с курсором. При
его размещении, отображается постоянный текст символа.

· если символ имеет переменный текст, введите значение текста.
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· при перемещении символа, если он не будет размещаться динамически, нажмите
среднюю кнопку мыши для выхода (эта функция не доступна для символов Variable -
Model Units).

Управление Вхождениями Символа

Управление Вхождениями

Используя меню DETAIL, можно изменять, отображать, стирать и удалять вхождения;
включать вхождения в примечания; и связывать вхождения с размерным текстом. Можно
также отображать символы сварки, которые были созданы в Pro/WELDING.

Изменение Вхождения Символа

1. Выберите DETAIL > Modify > Symbol.
2. Выберите вхождение.

3. Используя диалоговое окно Symbol Instance, измените вхождение, делая следующее:

•  расчлените вхождение, выбирая Explode в списке Symbol Definition Usage.
Pro/ENGINEER копирует объекты из выбранного вхождения в рисунок и удаляет
вхождение. Узел отображается залитой точкой, а примечание, создаваемое системой
при расчленении примечания узла, присоединяется к точке. При этом копируются
только видимые объекты символа, и удаляется выноска символа (если она
существует).

•  Для изменения высоты символа, введите значение в поле Height.

•  Для изменения угла поворота, введите значение в поле Angle.

Обратите внимание: перед поворотом вхождения символа, можно сбрасывать параметр,
который управляет позиционированием текста, путем изменения определения символа с
использованием команды Attributes в меню SYMBOL EDIT; однако, изменение атрибутов
символа воздействует на все вхождения этого определения символа.

•  Для перемещения начальной точки, щелкните по Move Origin и выберите вид.

4. По завершении, нажмите OK для обновления отображения вхождения.

Изменение Вхождений

После создания символа, можно использовать диалоговое окно Symbol Instance для
изменения его следующими способами:

· расчленить вхождение символа;

· изменить высоту символа;

· изменить угол поворота;

· переместить начальную точку символа;

· изменить сгруппированные атрибуты;

· изменить переменный текст.

Можно также переподчинить вхождения и добавить новые линии выноски.
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Поворот Символов с Текстом

При вращении символа, любой текст, включенный в символ ведет себя согласно тому, как
определено в атрибутах символа (выбран ли флажок Fixed Text Angle в поле Attributes
диалогового окна Symbol Definition Attributes).

Используя опцию "sym_flip_rotated_text� файла установок рисунка, можно зеркально
отображать текст повернутого символа. При установке опции в «yes» (значение по
умолчанию - «no») и ориентации символа на + /- 90 градусов, весь текст, который был
определен в поле Attributes диалогового окна Symbol Definition Attributes зеркально
отображается, поворачиваясь вместе с символом.

Пример: Поворот Символов с Текстом

Поворот Символа с Текстом
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Зеркальное Отображение Текста с Использованием Опции "sym_flip_rotated_text"

Переподчинение Вхождения Символа

Используя команду Mod Attach в меню DETAIL, можно повторно присоединить вхождение
символа с выноской в любой момент после добавления его к рисунку, делая следующее:

· переподчинить выноску символа к новой точке геометрии в рисунке.

· переподчинить выноску символа к новой точке на объекте, который включает символ.

Добавление Дополнительной Строки Выноски к Символу

1. Выберите DETAIL > Mod Attach > Add Ref.
2. Выберите ссылочную точку на виде для выноски.

3. Выберите GET SELECT > Done Sel и ATTACH TYPE > Done. Система добавляет
дополнительную выноску.

•  Для добавления более одной выноски, повторите Шаги 2 и 3.

•  Для удаления выноски, выберите Delete Ref.
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Добавление Новых Линий Выноски

Можно добавлять выноски к символам (и удалять их) после процедуры, используемой для
добавления выносок к примечаниям рисунка. Однако, применяются следующие
ограничения:

· нельзя добавлять новые выноски к BOM символам или к символам обозначения базы.

· Для добавления выноски к пользовательскому символу, необходимо определить атрибут
в определении символа для размещения символа с выноской. Точно так же, чтобы удалить
выноску из определяемого пользователем символа, необходимо определить атрибут в
определении символе для размещения символа без выноски.

Стирание и Отображение Вхождения Символа

Используя диалоговое окно Show/Erase, можно стирать вхождения символа в рисунке
путем скрытия выбранных символов. Для восстановления их изображения, нажмите Show.

Удаление Вхождения Символа

Можно удалять вхождения символа из рисунка с использованием Delete в меню DETAIL.
При удалении вхождения из рисунка, система не удаляет определение символа из рисунка.
Для его удаления, выберите Delete из меню DWG SYMBOL.

Концепция Параметрических Символов
Сварки
Символы сварки можно отображать в рисунках для швов, которые были созданы в
Pro/WELDING, а также переопределять системные параметрические символы сварки для
повышения гибкости и производительности.

Отображение Символов для Швов, Созданных в Pro/WELDING
Используя меню DETAIL, можно отображать и стирать символы сварки в рисунках, которые
соответствуют швам, созданным в сборке с использованием Pro/WELDING. Можно также
делать следующее:

· Отображать элементы шва в рисунке.

· Стирать элементы шва в рисунке.

· Изменять число десятичных знаков, отображаемых в размерах, содержащихся в элементе
шва.

· Добавлять и удалять новые линии выноски для символов сварки.

Для отображения символов сварки Pro/WELDING в рисунках согласно по стандартам ANSI
или ISO, установите значение опции "weld_symbol_standard� файла установок рисунка в
"STD_ANSI" или "STD_ISO", соответственно.
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Ограничения на Использование Символов Сварки в Рисунках

При работе с символами сварки, применяются следующие ограничения:

· отображение элемента шва не воздействует отображение символа сварки и не обновляет
его точку присоединения при скрытии, восстановлении, стирании или отображении
элемента шва. Однако, система первый раз отображает символ сварки, его заданное по
умолчанию присоединение соответствует состоянию отображения элементов.

· система отображает символ сварки в рисунке только один раз, подобно допускам на
размер для сборки и символу обработки поверхности.

· Версия 15.0 и выше поддерживает следующий набор символов сварки:

•  Швы с усилением (Reinforced Welds): square groove, bevel groove, flared bevel groove,
and J-groove (все швы с усилением могут также являться двухсторонними).

•  Двусторонние швы (Two-sided Welds): fillet, square groove, V-groove, bevel groove, U-
groove, J-groove, flared V-groove, flared bevel groove.

Отображение Символов Сварки в Рисунке

1. Выберите DETAIL > Show/Erase.

2. В диалоговом окне Show/Erase, нажмите Show и выберите Symbol в поле Type.

3. Выберите элемент в поле Show By для определения элемента, вида или детали для
отображения символов сварки.

Стирание Символов Сварки

1. Выберите DETAIL > Show/Erase.

2. В диалоговом окне Show/Erase, нажмите Erase и выберите Symbol в поле Type.

3. Выберите соответствующие кнопки для выбора элементов шва и укажите
соответствующие символы сварки. Система стирает указанные символы.

Отображение или Стирание Элементов Шва в Рисунке

1. Выберите DETAIL > Show/Erase.

2. В диалоговом окне Show/Erase, нажмите Show или Erase; затем выберите Cosmetic
Feature в поле Type.

3. Выберите соответствующую группу переключателей и команды для отображения или
стирания элементов шва в рисунке.

Изменение Отображения Десятичных Разрядов Размеров в
Элементе Шва

1. Выберите DETAIL > Modify > Num Digits.

2. Введите число для изменения десятичного разряда выбранного значения размера.

3. Выберите изменяемый размер. Размер отображается с указанным числом десятичных
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знаков.

Изменение Числа Десятичных Знаков Углового Сварного Шва

При использовании Num Digits для изменения значения элемента углового сварного шва
(простой, двусторонний или шов с усилением), который имеет различные значения длины
катетов, отображаемых в символе, типа �L1 x L2�, число десятичных знаков обоих
отображаемых значений - связаны. То есть при выборе этой части символа для изменения,
система подсвечивает полный �L1 x L2� и оба значения для изменения указанного числа
десятичных знаков.

Перегруппировка Вхождения Символа Сварки

Для перегруппировки вхождения символа сварки, установите опцию
"sym_leader_orient_move_text� файла конфигурации в "yes" (значение по умолчанию - no).
Система перегруппировывает вхождение после перемещения текста.

Создание Пользовательского Символа Сварки

1. Для переопределения существующей системы символов сварки, сделайте следующее:

· добавьте требуемое число копий переменного текста.

· Измените значения по умолчанию переменных текстов.

· Добавьте и удалите требуемое число примечаний и примитивов и поместите новые в
любую группу (или без включения их в группу).

· Переопределите косметические элементы существующих примечаний и объектов.

2. Сохраните символ, назначая новое временное имя.

3. Переместите исходный (системный) символ сварки из системной библиотеки в другой
каталог или переименуйте его. Системная библиотека символов сварки расположена в
каталоге инсталляции <install_dir>/symbols/library_syms/weldsymlib>.

4.Переместите новый пользовательский символ в системную библиотеку символов сварки
и назначьте ему то же имя, что и для оригинала.

Пользовательские Параметрические Символы Сварки

Можно заменять поставляемую с Pro/ENGINEER системную библиотеку символов сварки
на пользовательские. После определения символа, система использует его для
автоматического аннотирования сварки. При последующей настройке символа сварки,
можно увеличить гибкость и производительность в процессе создания и изменения
рисунков.

Обратите внимание: перед выполнением этой процедуры, необходимо скопировать
системную библиотеку сварочных символов в резервный каталог.

Однако, при создании пользовательских символов сварки, применяются следующие
ограничения:

· все группы, которые существовали в исходном определении, должны остаться в новом
определении и нельзя добавлять новые или изменять имена существующих.

· При добавлении нового переменного текста или изменении имени существующей части
переменного текста, новое название должно соответствовать таковой для существующего
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переменного текста в оригинале.

· Тип высоты вхождения символа должен быть таким же в новом пользовательском
символе, как он был в оригинале.

· Типы размещения Left Leader и Right Leader должны оба существовать в новом
пользовательском символе сварки.

Символы Сварки по ISO
Этот раздел содержит примеры символов, позволяющие создать в рисунке символы
сварки, пайки и контроля согласно стандарту ISO. Для помощи в создании вхождения
символа, предусмотрена следующая информация для каждого символа:

· название символа;

· пример вхождения, созданного из этого символа и связанных подсказок;

· листинги групп и подгрупп в формате меню, отражающем древовидную структуру
определения символа;

Можно также обращаться к Glossary of Menu Picks, приведенному ниже для пояснения
выбора в меню для сварочных символов.

Библиотека Сварочных Символов
Библиотека Сварочных Символов, поставляемая с Pro/DETAIL, содержит набор символов
в соответствии со стандартом ISO-2553-1984. Используя эту библиотеку, можно создавать
в рисунке разнообразные символы сварки, пайки и контроля.

Для вызова символа из Библиотеки Сварочных Символов, выберите System Syms в меню
Select File для вызова области символов Pro/ENGINEER.

Глоссарий Пунктов Меню
Настоящий глоссарий описывает термины, которые являются уникальными в Библиотеке
Сварочных Символов ISO, и идентифицирует запрашиваемую для ввода информацию.
Названия пунктов Меню соответствует Библиотеке Сварочных Символов ISO в
максимально возможной степени. (Касательно терминов, которые также используются в
Библиотеке Сварочных Символов ANSI, и, поэтому, не соответствуют Библиотеке
Символов Сварки ISO, см. Глоссарий Пунктов Меню в Приложении B, Основные Символы
Сварки ANSI).

В Библиотеке Символов Сварки ISO, две линии формируют ссылочную линию, одна
непрерывная и одна штриховая линия. Символы сварки, присоединенные к сплошной
линии � называются "со стороны стрелки (arrow-side)". Символы сварки, присоединенные к
пунктирной линии, называются "с другой стороны (other side)". Пунктирная линия
используется только для симметрии символов. При создании сварочного символа, сначала
выбирается, будет ли символ "со стороны стрелки", "с другой стороны" или симметричным.
При выборе ARROW_SIDE или OTHER_SIDE, система запросит создать символ сварки
выше или ниже ссылочной линии. Затем, штриховая линия размещается соответственно
символу в зависимости от того, где он расположен - "со стороны стрелки" или "с другой
стороны".

Таблица 1: Пункты Меню Сварки ISO

Пункт Меню Опция Описание
ABOVE_REF Создает символ сварки над непрерывной ссылочной

линией.

AS_ABOVE_
REF

Обозначает (только совместно с символом сварки) будет
ли символ сварки "со стороны стрелки" размещен над или
под ссылочной линией.

BENEATH_REF Создает символ сварки под непрерывной ссылочной
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линией.

BUTT_SIZE Относится к окончательному размеру шва в зависимости
от типа символа - "со стороны стрелки", "с другой
стороны", симметричный или зигзагообразный. Символ
должен иметь суффикс "AS� (со стороны стрелки) �OS� (с
другой стороны) для обозначения стороны шва.

CONTOUR SMOOTH_BLEND Описывает окончательную форму шва. Этот вариант
выбора обозначает, что нижняя часть шва гладко
зачищена

FINISH По стандарту ANSI обозначает метод обработки

По стандарту ISO система добавляет символ
механической обработки поверхности над контуром
символа

FILLET_SIZE Относится к окончательному размеру шва в зависимости
от типа символа - "со стороны стрелки", "с другой
стороны", симметричный или зигзагообразный. Символ
должен иметь суффикс "AS� (со стороны стрелки) �OS� (с
другой стороны) для обозначения стороны шва.

FIL_SIZE Относится к окончательному размеру шва в зависимости
от типа символа - "со стороны стрелки", "с другой
стороны", симметричный или зигзагообразный. Символ
должен иметь суффикс "AS� (со стороны стрелки) �OS� (с
другой стороны) для обозначения стороны шва.

HOLE_DIA Относится к пробочному сварному шву.

OS_ABOVE_
REF

Обозначает (только совместно с символом сварки) будет
ли символ сварки "со стороны стрелки" размещен над или
под ссылочной линией.

PROJECT_DIA Относится к диаметру рельефного шва.

SEAM_WIDTH Относится к ширине роликового сварного шва.

SPOT_DIA Относится к диаметру точечного шва или шва сварки
расплавлением (fusion weld)

STYLE Относится к продольному размеру шва. Существуют
следующие два варианта:

CONTINOUS Сварной шов непрерывен на указанной длине.

INTERMITTENT Создаются цепочки швов указанной длины, расстояние
между смежными элементами шва и указанное
количество цепочек.

SYMMETRICAL Относится к символу сварки для создания подобных швов
"со стороны стрелки" и "с другой стороны".

TAIL Создает «хвостик» на противоположном конце символа
сварки от присоединения выноски. Предусмотрены два
варианта:

REFERENCE вводит ссылочный текст или примечание

WELD_PROCESS указывает процесс сварки

WELD_SIZE Относится к окончательному размеру шва в зависимости
от типа символа - "со стороны стрелки", "с другой
стороны", симметричный или зигзагообразный. Символ
должен иметь суффикс "AS� (со стороны стрелки) �OS� (с
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другой стороны) для обозначения стороны шва.

WELD_TYPE Для комбинированных сварочных символов обозначает
тип создаваемого сварочного шва и сторону "со стороны
стрелки" или "с другой стороны" (т.е. FILLET_AS).

Символ Стыкового Шва со Скосом Кромок: Bevel_Butt.sym
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Структура Определения Символа
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Символ Соединения под Углом: Inclined_Joint.sym
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Структура Определения Символа

Стыковой Шов с Разделкой Кромок с Увеличенной Площадью
Корня: Br_Root_Bevel.sym



Pro/ENGINEER 2000 i2 Pro/DETAIL Выпуск Документации

 - 301 -



Pro/DETAIL Выпуск Документации Pro/ENGINEER 2000 i2

302

Структура Определения Символа
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Символ Прорезного Шва: Iso_Slot.sym
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Структура Определения Символа

Символ Точечного Шва: Iso_Spot.sym
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Структура Определения Символа

Символ Роликового Шва: Iso_Seam.sym
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Структура Определения Символа

Символ Пробочного Шва: Iso_Plug.sym
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Структура Определения Символа
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Символ Углового Шва: Iso_Fillet.sym
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Структура Определения Символа

Символ J-образного Стыкового Шва: J_Butt.sym
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Структура Определения Символа
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Символ Стыкового Шва без Скоса Кромок: Iso_Square.sym
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Структура Определения Символа
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Символ V-образного Стыкового Шва: V_Butt.sym
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Структура Определения Символа
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Символ U-образного Стыкового Шва: U_Butt.sym
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Структура Определения Символа
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Символ Соединения Поверхностей: Surface_Joint.sym
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Структура Определения Символа

Символ Наплавки: Iso_Surfacing.sym
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Структура Определения Символа
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Символ V-образного Стыкового Шва Типа Steep-flanked:
Steep_V.sym
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Структура Определения Символа
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Символ Стыкового Шва Со Скосом Кромок Типа Steep-flanked:
Steep_Bevel.sym
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Структура Определения Символа
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Символ V-образного Стыкового Шва с Увеличенной Площадью
Корня: Broad_Root_V.sym
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Структура Определения Символа
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Символ Фальцовочного Шва: Fold_Joint.sym
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Структура Определения Символа

Символ Комбинированного Шва: Combine.sym
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Структура Определения Символа
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Символ Шва с Отбортовкой Кромок: Iso_Edge_Flange.sym
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Структура Определения Символа

Символ Торцевого Стыкового Шва: Edge_Weld.sym



Pro/ENGINEER 2000 i2 Pro/DETAIL Выпуск Документации

 - 335 -

Структура Определения Символа
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Режим Пометок

Концепция Пометок

Пометки

Пометка - объект, который подобно набору прозрачных листов поверх листа рисунка,
позволяет накладывать текст и эскизные объекты различными цветами для обозначения
проведения необходимых исправлений.

Пометка - неформализованный эскиз, который можно создавать в Pro/ENGINEER с
наложенным на любой объект текстом.

Основой для пометки является объект, выбранный для исправлений. Для создания
пометок, объект используется в том режиме, в котором он был создан:

· Деталь (включая все объекты с расширение .prt).

· Сборка (включает все объекты с расширением .asm).

· Рисунок

· Обработка

· Компоновка

· Отчет

· Диаграмма

Объект сохраняется в файле пометок, который использует расширение .mrk.

Каждая пометка - подобна отдельному прозрачному листу, наложенному на объект и
содержащая эскизные объекты и-или примечания одного цвета.

В процессе создания пометок, система никоим образом не изменяет объект и сохраняет
все эскизные объекты и примечания, созданные в режиме Пометки, с файлом пометки, а
не с объектом. Так как управляемый объект не изменяется, система не сохраняет его при
сохранении пометки.

Можно также создавать пометки для рисунка с несколькими листами, отображаемыми на
всех листах.

Создание Пометки

1. Выберите File > New.

2. В диалоговом окне New, нажмите Markup и OK.

3. В диалоговом окне Markup, выберите или вызовите объект.

4. Введите имя создаваемого объекта. Заданное по умолчанию имя - идентификатор
пользователя (user ID).

5. Выберите любую из следующих команд в меню MARKUP для помечания и
аннотирования объекта:
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•  Setup - изменяет цвет пометки, создает ее чертеж, переключает отображение или
переносит ее на другой лист пометки и рисунка. Меню MRKP SETUP отображает
следующие команды:

Color - изменяет цвет пометки. Заданный по умолчанию цвет пометки - красный.

Show - перечисляет пометки в текущей рабочей области и их цвета. Рядом с именем и
цветом текущей пометки отображается галочка, если она отображена в настоящий момент.
Выбор имени пометки снимает галочку и выключает отображение.

Switch Sht - отображает сокращенное меню SHEETS, позволяющее просматривать и
отмечать другие листы рисунка.

Text Height - устанавливает высоту текста перед созданием примечаний.

Line Width - устанавливает ширину эскизных объектов перед их созданием.

•  Note � размещает примечание без выноски.

•  Arrow � создает стрелку. Используйте левую кнопку мыши для выбора точки, на
которую указывает стрелка; затем выберите точку для другого конца стрелки. Нажмите
среднюю кнопку, чтобы прервать создание стрелки.

•  Curve - выберите точки кривой, по которой должен пройти сплайн. Используйте левую
кнопку мыши для выбора точки, среднюю кнопку, чтобы приостановить кривую и
правую кнопку, чтобы прервать создание кривой.

•  Sketch � создает кривую без выбора точки для нее. Удерживая левую кнопку мыши -
создайте свободную кривую. Отпустите левую кнопку по завершении.

•  Line - создает линию, используя левую кнопку мыши.

•  Move - перемещает примечание, кривую или линию.

•  Modify - изменяет текст примечания или ширину линии элемента пометки.

•  Delete - удаляет элемент пометки (примечание, стрелку, кривую, эскиз или линию).

Обратите внимание: команды Note, Arrow, Curve, Sketch и Line "липкие"; при выборе
одной из этих команд, этот тип объекта будет создаваться, пока не будет выбрана другая
команда.

Правила Использования Режима Пометки

Обратите внимание на следующие правила работы в режиме Пометки:

· при работе со сборками учитывайте следующее:

•  при создании покомпонентного изображения для элемента пометки, она не влияет на
состояние разнесения видов в других элементах.

•  Одновременно можно видеть только те элементы пометки, которые имеют одинаковый
статус разнесения, размеры разнесения и ориентацию вида.

•  Разнесенные размеры можно изменять с использованием Mod Explode в меню ENTER
MARKUP.

· Система отображает трехмерные объекты с их цветами и цветами рисунка.

· Файл пометки должен находиться в каталоге объекта, на который ссылается пометка.

· Размеры компоновок отображаются в символическом виде.

· При выполнении сравнения с трехмерными элементами пометки с использованием
команд Markup, Setup и Show, можно переключаться между Seen и Unseen только для тех
элементов, которые имеют точно тот же вид, что и текущего элемента пометки.
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Совет: Ориентированием Объектов Перед Созданием Пометки

Команды Orientation, Model Display и Advanced не доступны в меню Pro/ENGINEER View
после создания нового объекта пометки. Необходимо сориентировать трехмерный объект
перед созданием пометки. Система сохраняет ориентацию вместе с пометкой.

Пример: Рисунок с Пометками

Изменение Пометок

Для изменения пометок, выберите Modify в меню MARKUP, затем Note или Line Width..
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Углубленные Методики

Рисунки с Несколькими Моделями

Работа в Рисунках с Несколькими Моделями

Можно управлять видами различных моделей, которые отображаются в одном рисунке,
несколькими способами:

· отображать сборку и все ее компоненты.

· Понятно отображать размеры всех деталей и сборки в одном рисунке.

· Отображать несколько компонентов одного семейства с различными наборами
элементов.

· Работать с выносными элементами, таблицами, повторяющимися областями и так далее,
принадлежащими любой из моделей.

При работе в рисунках с несколькими моделями, учитывайте следующее:

· необходимо добавить все модели к рисунку прежде, чем можно будет отображать их в
видах.

· Система устанавливает масштаб каждой модели независимо (значение масштаба можно
увидеть в левом нижнем углу детали). Измените этот масштаб для каждой модели, когда
модель будет активна.

· Для добавления видов конкретной модели, необходимо установить эту модель активной.

· При добавлении уравнений, система добавляет их к текущей модели. Поэтому, выберите
модель перед добавлением уравнения.

· При замене основной сборки вхождением сборки, которая использует PART_B вместо
PART_A, необходимо выбрать Show/Erase в меню DETAIL и нажать Dimension в
диалоговом окне Show/Erase для отображения размеров PART_B.

Добавление Модели к Рисунку

Прежде, чем можно будет использовать и образмеривать модель в виде, необходимо
добавить ее к рисунку. Добавление модели к рисунку не размещает вид модели на листе,
но дает возможность рисунку ссылаться на модель, чтобы можно было размещать вид.
Добавьте первую модель, выбирая Views в меню DRAWING и вводя имя модели. Для всех
последующих моделей, выберите Add Model в меню DWG MODELS.

· модель можно удалять, выбирая Del Model в меню DWG MODELS; однако, сначала
необходимо удалить все виды модели.

·Можно заменять одну деталь другой, выбирая Replace в меню DWG MODELS, если
детали являются компонентами одной таблицы семейства.
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Пример: Несколько Моделей в Одном Рисунке

Установка Модели в Качестве Текущей

1. Выберите VIEWS > Dwg Models > Set Model.
2. Сделайте следующее:

•  выберите модель, с которой требуется работать в списке меню. Оно содержит только
те названия моделей, которые были добавлены к рисунку.

•  Выберите вид модели, которую необходимо сделать активной.

3. Для подсветки активной модели, выберите DWG MODELS > Model Disp > Hilite Cur.
4. Для возврата отображения модели, выберите МОДЕЛЬ DISP > Normal.

Установка Модели по Умолчанию

Pro/ENGINEER рассматривает только одну модель в рисунке моделью по умолчанию или
текущей моделью. Последняя добавленная к рисунку модель становится текущей
моделью, но текущей можно устанавливать любую модель, выбирая Set Model в меню
DWG MODELS.

Система ссылается на активную модель при добавлении видов или при любых функциях,
требующих заданной по умолчанию модели. Например, при добавлении области
повторения к таблице рисунка, ввода параметров отчета в области повторения и
обновлении таблицы, информация берется из модели, которая являлась текущей моделью
рисунка, в момент добавления области повторения к таблице. Кроме того, меню Info
Pro/ENGINEER и команда Regenerate в меню DRAWING работают с активной моделью.

Совет: Использование Панели Пиктограмм Set Model

Панель пиктограмм Set Model доступна в качестве ярлыка при использовании VIEWS >
Dwg Models > Set Model для установки текущей модели рисунка. Кнопка Set Model
отображает список доступных моделей рисунка, в которых можно выбирать имя
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активизируемой модели.

Кнопка Set Model включена в диалоговое окно Toolbar Customization, вызываемого из
меню Utilities Pro/ENGINEER.

Слияние Рисунков

Используя команду Merge в меню ADV DWG OPTS, можно объединять два рисунка.
Объединение позволяет увеличивать эффективность работы и управлять большими
рисунками. Отдельные пользователи Pro/ENGINEER могут работать параллельно и, затем,
объединять свои отдельные рисунки в один файл рисунка. Исходный файл добавляется к
конечному файлу в виде дополнительных листов; Например, при объединении исходного
рисунка с двумя листами с рисунком с четырьмя листами, конечный рисунок будет
содержать шесть листов. Позже можно использовать SHEETS > Reorder для
переупорядочивания порядка листов.

Обратите внимание: Слияние удаляет исходный файл из памяти. Если исходный файл
был сохранен на диск, он будет удален из сессии но останется на диске.

1. Нажмите File > Open и выберите и вызовите конечный рисунок или файл отчета.
Конечный рисунок � тот, в который вставляется другой рисунок.

2. Выберите DRAWING > Advanced > Merge.

3. Используйте диалоговое окно Open для выбора исходного файла и объединения с
текущим рисунком. При выборе файла, исходный файл объединяется с текущим файлом.

Выберите дополнительные исходные файлы для объединения и добавьте
дополнительные листы к текущему рисунку.

Правила при Слиянии Рисунков

Следующие правила и ограничения накладываются на объединяемые рисунки или отчеты:

· конечный файл рисунка должен находиться в сессии.

· Рисунок или отчет не могут быть объединены с собой.

· Исходный рисунок удаляется из памяти после объединения.

· Основной файл рисунка может содержать один или более форматов. Каждый лист может
использовать различный формат. Когда исходный рисунок объединяется с конечным,
который имеет другой формат, исходный формат автоматически не заменен. Исходный
формат можно заменить после слияния.

· Если объединяемый исходный рисунок содержит размеры аналогичные конечному
рисунку, Pro/ENGINEER автоматически удаляет такие двойные размеры из исходного
рисунка.

· Если объединяемые файлы ссылаются на различные версии одной модели, в рисунке
будет использована самая последняя версия, находящаяся в памяти.

· Исходный и конечный рисунок должны использовать одни единицы измерения.

· Если исходный и конечный рисунок содержат модель с одинаковым названием, даже если
эти модели различны, в конечном рисунке используются текущая в сессии модель.

· После слияния файлов, опции файла установок конечного рисунка получают приоритет
над опциями, используемыми в исходном рисунке.

· Если исходный рисунок содержит программу рисунка, она удаляется при слиянии. Для
сохранения программы рисунка, используйте рисунок с программой в качестве конечного
рисунка.
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· Параметры рисунка источника удаляются в процессе слияния.

Презентации Рисунка
Функциональные возможности презентации рисунка доступны только с лицензией
Advanced Assembly.

Можно определять и выполнять конфигурации рисунков, называемых презентацией
рисунков. Презентация рисунка - набор команд, которые определяют конфигурацию
отображения для текущего рисунка. Можно использовать презентации рисунка для
управления тем, какие модели и которые виды рисунка будут вызваны и показаны
системой. Например, можно временно удалить все модели и виды, которые не нужны для
текущей операции. Используя презентации рисунка, можно увеличить эффективность
выполнения работы, особенно при работе с большими сборочными чертежами и рисунками
сложных моделей.

С функциональными возможностями презентаций рисунков можно выполнять следующие
операции:

· уменьшить время поиска рисунка и увеличить эффективность обработки рисунка,
минимизируя расчеты по отображению вида, типа регенерации и перерисовки.

· Сконфигурировать отображение рисунка таким образом, чтобы можно было работать
только с той информацией рисунка, которая необходима на данном этапе работ и
выгрузить ненужные данные из памяти

· Выключить отображение видов, над которыми не работают, чтобы система не
рассчитывала ненужную информацию и, в частности, не вызывала модели в сессию при
регенерации рисунка.

· Загружать рисунок в отдельный лист рисунка, изменять масштаб изображения или
центрировать вид - например, вызывать только указанные листы рисунка без загрузки всех
листов и отображения каждого вида на каждом листе.

Создание Презентации Рисунка

Презентации рисунка можно создавать, используя один из двух методов:

· Создать презентацию рисунка в процессе регенерации рисунка.

При вызове рисунка, можно продолжать следующим образом:

•  вызвать существующую презентацию рисунка.

После вызова рисунка, можно запустить презентацию рисунка. Отображаются рисунок и
презентация рисунка, и рисунок конфигурируется согласно презентации рисунка.

•  Вызвать диалоговое окно Drawing Rep Tool
После указания вызываемого рисунка, нажмите Open Rep, затем нажмите Create New
Drawing Rep. Открывается диалоговое окно Drawing Rep Tool. Теперь можно создавать
новые презентации рисунка. Этот метод позволяет вызывать рисунок без вызова в сессию
ненужных видов и моделей.

· Создать презентацию рисунка после регенерации рисунка

Если в сессии уже имеется рисунок, можно использовать команду Create в меню DRAWING
REP для вызова диалогового окна Drawing Rep Tool и создания презентации текущего
рисунка.

Каждой презентации рисунка присваивается имя и она запускается. При сохранении
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рисунка, система также автоматически сохраняет презентацию этого рисунка.

Меню DRAWING REP можно также использовать для копирования или переопределения
ранее созданных презентаций рисунка.

Конфигурирование Презентации Рисунка

Презентацию рисунка можно конфигурировать для управления отображением вида и
отображением рисунка следующими способами:

· отображать или стирать все виды.

· Отображать или стирать указанный вид.

· Отображать или стирать виды указанного типа, например, все поперечные сечения.

· Отображать или стирать все виды, связанные с указанной моделью.

· Отображать или стирать виды на указанном листе.

· Загружать рисунок на указанный лист.

· Загружать рисунок в состоянии панорамирования/зумирования.

· Загружать рисунок в центр указанного вида.

· Устанавливать таблицы в состояние замораживания или обновления.

Презентация рисунка не может быть активной, она всегда запущена. Рисунок всегда
находится на этапе конфигурации и может быть изменен в любой момент. Создание
презентации рисунка означает определение одной или более команд для конфигурации
текущего рисунка. При определении команд, можно применять каждую команду к рисунку
немедленно или можно определять несколько команд и затем выполнять их все сразу.
Предусмотрена опция задержки для конфигурирования рисунка без вызова данные, пока
конфигурация не будет закончена.

Важен порядок, в котором определяются команды. Система компилирует список команд и
выполняет их в том порядке, в котором они были определены. Команды взаимодействуют
друг с другом кумулятивно. Например, можно выключать все виды (команда #1) и, затем,
включать все основные виды (команда #2).

Презентация рисунка ведет себя иначе, чем упрощенные представления в режиме Детали
или Сборки. Если одно представление выполняется после другого представления, рисунок
отображает результаты обоих представлений. Например, можно стереть все виды на листе
#1; затем стереть виды на листе #2 и, затем, отобразить все виды.

Меню DRAWING REP

Используйте команды меню DRAWING REP вместе с диалоговым окном Drawing Rep Tool
для создания и работы с представлением рисунка.

При первом вызове меню доступны только команды Create, Execute и Done-Return.

После создания презентации рисунка становятся доступными другие команды.

Меню DRAWING REP содержит следующие команды:

Create � открывает диалоговое окно Drawing Rep Tool и позволяет конфигурировать
презентацию рисунка для текущего рисунка. Диалоговое окно автоматически выбирает
соответствующие команды и обновляет пункты для выбора в соответствии с текущим
состоянием рисунка.

Execute � открывает диалоговое окно Select Rep и позволяет выбирать выполняемую
презентацию из списка существующих презентаций. Выберите выполняемую презентацию
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и нажмите OK. Система выполняет выбранную презентацию для текущего рисунка. Таким
образом, для конфигурирования рисунка требуются выполняемые команды, как
определено презентацией рисунка. Для сохранения текущей презентации, необходимо
сохранить рисунок.

Copy � копирует выбранную пользовательскую презентацию рисунка в новую презентацию
рисунка с новым именем.

Redefine � отображает выбранную пользовательскую презентацию рисунка в диалоговом
окне Drawing Rep Tool, чтобы ее можно было изменять.

Delete � удаляет выбранную пользовательскую презентацию рисунка.

Info � отображает окно, содержащее информацию по выбранной презентации.

Done-Return � выходит из меню DRAWING REP и возвращается в меню ADV DWG OPTS.

Диалоговое Окно Drawing Rep Tool

Диалоговое окно Drawing Rep Tool разделено на две страницы и открывается на странице
View Display. Страница View Display позволяет управлять конфигурациями отображения
вида, а страница Drawing Display позволяете управлять листом,
панорамированием/зумированием и конфигурированием таблиц. Следующие опции
доступны для обеих страниц:

Name - отображает заданное название презентации рисунка по умолчанию, которое можно
изменять.

Navigate Sheets - позволяет переключать листы рисунка для отображения текущего листа.

OK - принимает все параметры настройки конфигурации рисунка, закрывает диалоговое
окно DRAWING REP TOOL и возвращается в меню DRAWING REP.

Execute - выполняет активную команду или применяет все перечисленные команды в
рисунке. Если не существует никакой активной команды � команда Execute становится не
доступной, что означает, что все перечисленные команды были выполнены.

Презентации Рисунка по Умолчанию

Система автоматически создает две презентации рисунка по умолчанию с именами All
Views и No Views для всех последних созданных рисунков.

Для создания презентации рисунка по умолчанию для предварительно сохраненного
рисунка, вызовите и сохраните рисунок. Будут созданы презентации рисунка по умолчанию
All Views и No Views.

· All Views � включает отображение всех видов во всем рисунке, сохраняет обновленные
таблицы и сбрасывает установки панорамирования/зумирования.

Все модели вызываются.

· No Views - выключает отображение всех видов во всем рисунке, сохраняет таблицы
замороженными и сбрасывает установки панорамирования/зумирования.

В сессии отсутствуют модели.

Нельзя использовать No Views для создания выносных элементов типа примечаний и
символов, которые не имеют присоединения к модели. Можно вызвать рисунок,
отображающий только примечания и работать с ним без загрузки каких либо моделей.
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Копирование Презентации Рисунка

После сохранения презентации рисунка, ее можно копировать с использованием команды
Copy в меню DRAWING REP.

1. Выберите DRAWING > Advanced > Drawing Rep > Copy. Открывается диалоговое окно
Select Rep, отображающее сохраненные презентации.

2. В диалоговом окне Select Rep, выберите Rep для копирования из списка существующих
презентаций и нажмите OK. Можно копировать только пользовательские представления.

Система копирует выбранную презентацию рисунка и открывает диалоговое окно Drawing
Rep Tool. Название презентации рисунка автоматически изменяется, в диалоговом окне
выбираются те же команды, что и в оригинальной презентации, и в области списка команд
отображаются текущие команды.

3. Переименуйте и измените новую презентацию рисунка.

Переопределение Презентации Рисунка

После сохранения презентации рисунка ее можно переопределять с использованием
команды Redefine в меню DRAWING REP.

1. Выберите DRAWING > Advanced > Drawing Rep > Redefine. Открывается диалоговое
окно Select Rep с сохраненными презентациями.

2. В диалоговом окне Select Rep, выберите переопределяемую презентацию из списка
существующих и нажмите OK. Переопределять можно только пользовательские
презентации.

Система открывает выбранную презентацию в диалоговом окне Drawing Rep Tool.
3. Переопределите выбранную презентацию.

Удаление Презентации Рисунка

После сохранения презентации рисунка ее можно удалять с использованием команды
Delete в меню DRAWING REP.

1. Выберите DRAWING > Advanced > Drawing Rep > Delete. Открывается диалоговое окно
Select Rep с сохраненными презентациями.

2. Выберите удаляемую презентацию и нажмите OK. Можно удалять только
пользовательские презентации.

Система удаляет выбранную презентацию.

Получение Информации по Презентации Рисунка

После сохранения презентации рисунка, можно получить информацию относительно
презентации, используя команду Info в меню DRAWING REP.

1. Выберите DRAWING > Advanced > Drawing Rep > Info. Открывается диалоговое окно
Select Rep с сохраненными презентациями.

2. В диалоговом окне Select Rep, выберите в списке существующих презентаций и
нажмите OK.

Информационное окно отображает информацию типа названия презентации рисунка,
команд, управляющих отображением вида, команд, управляющих загрузкой рисунка.
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Выберите File > Save для записи информацию в файл с именем drawingrep.inf или
выберите File > Save As для записи информации в указанный файл.

Создание Новой Презентации в Процессе Вызова Рисунка

Новую презентацию рисунка можно создавать в процессе вызова рисунка. Эта процедура
позволяет перейти непосредственно к диалоговому окну Drawing Rep Tool в состояние
презентации рисунка No Views. Никакие модели рисунка не вызываются и опция Delay
View Command(s) Until Execute выбирается по умолчанию.

Обратите внимание: опция Delay View Command(s) Until Execute выбирается по
умолчанию для создания презентации рисунка в процессе вызова. Это гарантирует от
случайного вызова моделей в сессию при определении презентации рисунка.

С опцией Delay View Command(s) Until Execute можно определять несколько команд для
конфигурирования представления до выполнения любого из них. Каждая команда
добавляется к списку команд. Команды не выполняются и система не вызывает данные,
пока не будет выбрана команда Execute.

Если флажок Delay View Command Until Execute снят, каждая команда выполняется
немедленно.

1. Выберите File > Open.

2. Выберите рисунок в диалоговом окне File Open (щелкните только один раз для выбора
рисунка, не открывая его) и нажмите Open Rep. Диалоговое окно Open Rep открывается с
двумя презентациями рисунка по умолчанию All Views и No Views.

3. Не выбирая презентацию рисунка, выберите флажок Create New Drawing Rep и
нажмите OK.

Открывается диалоговое окно Drawing Rep Tool.
Обратите внимание: выбор опции Create New Drawing Rep - удобный способ вызвать
диалоговое окно Drawing Rep Tool без вызова какой либо модели. Система вызывает
выбранный рисунок без отображения его видов и с таблицами установленными в
замороженное состояние. Модели в сессию не вызываются.

Выполнение Презентации в Процессе Вызова Рисунка

Презентацию рисунка можно запускать непосредственно в сессии, при вызове рисунка,
используя опцию Open Rep в диалоговом окне File Open.

1. Выберите File > Open.

2. Выберите рисунок в диалоговом окне File Open (щелкните только один раз для выбора
рисунка не открывая его) и нажмите Open Rep. Открывается диалоговое окно Open Rep,
содержащее ранее сохраненные презентации и две презентации рисунка по умолчанию,
All Views и No Views..
3. Выберите название выполняемой презентации рисунка и нажмите OK.

Система вызывает рисунок и конфигурирует его в соответствии со статусом презентации
рисунка.

Создание Презентации Текущего Рисунка

После вызова рисунка, можно создать новую презентацию рисунка, используя ADV DWG
OPTS > Drawing Rep > Create.
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1. Вызовите рисунок.

2. Выберите DRAWING > Advanced > Drawing Rep > Create. Открывается диалоговое окно
Drawing Rep Tool на странице View Display. Диалоговое окно автоматически выбирает
соответствующие команды и обновляет варианты выбора в соответствии с текущим
состоянием рисунка. Текущие команды отображаются в области списка команд.

Страница View Display может быть использована для настройки отображения вида.

4. В диалоговом окне Drawing Rep Tool, введите название презентации рисунка в поле
Name или используйте значение по умолчанию.

5. В диалоговом окне Drawing Rep Tool, выберите Display или Erase для изменения
отображения вида:

•  Display � включает отображение указанных видов рисунка.

•  Erase - выключает отображение видов рисунка.

Стертый вид заменяется зеленой рамкой, содержащей название вида. Для
предотвращения подсвечивания стертых видов, снимите флажок Highlight Erased Views в
диалоговом окне Environment.
Можно переключаться между Display и Erase при определении общих команд.

6. Измените выбор видов:

•  Выберите All для выделения всех видов в текущем рисунке.

•  Выберите Individual для определения конкретного вида в текущем рисунке.
Автоматически активизируется инструмент выбора и отображается меню GET SELECT,
позволяя выбирать на экране. Можно использовать Navigate Sheets для переключения
между листами. При выборе вида, его имя отображается в поле.

•  Выберите Sheet для указания листа (ов), где будут применены команды. Введите
номер или номера листов в поле листа, разделяя их запятыми (1,3) или указывая
диапазон (5-12).

•  Определите виды конкретного типа, выбирая Type и, затем, выберите имя вида в
списке Type.

Список Type включает наиболее часто используемые типы видов:

· Общий (General);

· Проекционный (Projection);

· Выносной (Detailed);

· Вспомогательный (Auxiliary);

· X-сечение (X-section);

· С разрывом (Broken);

· Частичный (Partial);

· Покомпонентный (Exploded).

Можно выбирать более одного типа в любой комбинации для уточнения выбора.
Например, выберите Projection для выделения всех проекционных видов; затем выберите
X-section, чтобы определить только проекционные виды с поперечным сечением.

Выберите Individual для выбора не перечисленных типов видов, типа Диаграммы,
Повернутых или видов типа Of Flat Ply.

•  Выберите Model для выделения всех видов, связанных с указанной моделью рисунка.
Щелкните по инструменту выбора и выберите модель рисунка из списка доступных
моделей (модели, принадлежащие текущему рисунку).
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7. Каждая определяемая команда, находится в области списка команд. При выполнении
презентации, все команды выполняются в указанном порядке, как они были введены.
Управляйте списком команд следующим образом:

•  После выбора опции для настройки рисунка, нажмите Add для добавления команды к
списку команд. Опция Add имеет тот же эффект, что и Execute до тех пор, пока не
выбран флажок Delay View Command Until Execute.

•  Для вставки команды в список команд, выберите команду в списке, затем выберите
опцию, затем нажмите Insert. Новая команда вставляется в список команд над
выбранной командой. Если выбран флажок Delay View Command(s) Until Execute,
опция Insert не выполняется, пока не будет выбрана Execute.

•  Для удаления команды из списка команд, выберите команду и нажмите Delete.
Команда будет удалена из списка команд. Если флажок Delay View Command Until
Execute выбран, опция Delete не выполняется, пока не будет выбрана Execute.

8. В любой момент или когда все команды для конфигурирования презентации рисунка
будут перечислены, нажмите Execute. Система выполнит все перечисленные команды, в
том порядке, в котором они были перечислены. Когда все перечисленные команды будут
выполнены, опция Execute становится не доступной, пока не будет выбрана опция Delay
View Command(s) Until Execute.

9. Нажмите ярлычок Drawing Display.

Страница Drawing Display может быть использована для автоматического вызова
указанного листа, перехода к именованному виду или центрирования указанного вида. Эта
страница диалогового окна также управляет поведением таблиц с областями повторения.

Используйте опции Drawing Display для управления косметическими компонентами
рисунка. В области Drawing Location диалогового окна, сделайте следующее:

•  Выберите из списка Go to Sheet доступные листы в текущем рисунке, чтобы
определить лист, где будет загружена презентация рисунка (например, загрузиться на
6-й лист в рисунке с 10 листами). При вызове презентации рисунка, отображается
указанный лист рисунка. При вызове презентации рисунка загружаются только
указанные листы.

•  Для определения именованного местоположения панорамирования/зумирования
рисунка, выберите название вида из списка Go to Named Pan/Zoom State. Этот список
содержит те же имена вида, которые находятся в списке View > Saved Views
(предварительно определенные виды).

При последующем вызове презентации рисунка, рисунок изменяет масштаб изображения в
соответствии с выбранным видом. Это позволяет проводить незначительные изменения в
небольшой части рисунка без отображения всего рисунка.

•  Выберите Go to Center of View для определения местоположения презентации
рисунка. Центрирование вида сохраняет рисунок от перерисовки других видов. Выбор
Go to Center of View автоматически снимает флажки Go to Sheet и Go to Named
Pan/Zoom State.

Выберите вид для перехода из списка видов и моделей, или используйте меню GET
SELECT для выбора вида и укажите середину вида. При последующем вызове
презентации рисунка, рисунок выравнивается по центру указанного вида.

10. В области Table Preferences определите способ управления таблицей:

•  As Is � оставляет таблицы BOM в их текущем состоянии

•  Frozen - замораживает таблицы BOM; вычисления повторяемых областей
замораживаются таким образом, что любые изменения в сборках BOM не будут
отражены в таблице

•  Updating - обновляет таблицы BOM; вычисления повторяемых областей
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автоматически изменяют информацию сборки BOM

11. По завершении конфигурирования презентации рисунка, нажмите OK, чтобы принять
команды. Отображается меню DRAWING REP.

После создания пользовательской презентации рисунка, отображается полное меню
DRAWING REP и можно запускать, копировать, переопределять или удалять презентацию
рисунка или отображать информацию по ней в окне.

12. Сохраните рисунок.

Обратите внимание: сохранение рисунка также сохраняет презентацию рисунка.

Совет: Стирание Видов из Меню или в Диалоговом Окне Drawing
Rep Tool

Опции Drawing Rep Tool Erase и Display, функционально отличаются от команд меню
Erase View и Resume View, чтобы можно было предотвращать появление ранее стертых
видов при вызове рисунка.

При стирании вида с использованием опции Erase в Drawing Rep Tool, необходимо
использовать опцию Display в Drawing Rep Tool для повторного отображения вида; любые
виды, стертые с использованием команды меню Erase View, остаются стертыми.

При стирании вида с использованием команды меню Erase View, необходимо
использовать команду меню Resume View для отображения вида снова.

Выполнение Презентации Рисунка

Можно выполнять новую, All Views или No Views презентации рисунка . Презентация All
Views конфигурирует рисунок на включение всех видов для отображения всего рисунка,
сохраняет обновленные таблицы и сбрасывает установку панорамирования/зумирования.

Презентация No Views конфигурирует рисунок на выключение всех видов на всех листах
рисунка, сохранение таблиц замороженными и сбрасывает установку
панорамирования/зумирования. При загрузке рисунка модели не загружаются.

1. Выберите DRAWING > Advanced > Drawing Rep > Execute. Открывается диалоговое
окно Select Rep.

2. Выберите имя презентации рисунка и нажмите OK. Система выполняет выбранную
презентацию рисунка.

Различия Между Рисунками

Проверка Различий Между Рисунками

Используя команду Picture в меню Utilities Pro/ENGINEER, можно проверять различия
между двумя версиями рисунка. После сохранения изображения рисунка, можно позже
вызвать его в рисунок. Все одинаковые элементы исчезают; на экране остаются только
различия между ними.

Для создания сообщения, перечисляющего различия между двумя объектами, выберите
Advanced в меню DRAWING и Integrate в меню ADV DWG OPTS.

После вызова файла проекта интеграции и отчета различий, отображаются исходный и
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конечный объект, появляется меню INTEGRATE, содержащее команды для выполнения
интеграции:

· Next - перемещает к следующему элементу (различий) в отчете.

· Previous - перемещает к предыдущему элементу (различий) в отчете.

· Show � в активном окне подсвечивает объект (элемент, компонент, и т.д)
соответствующий текущему элементу в отчете различий. (Эта команда доступна только,
если текущий элемент принадлежит объекту в текущем окне Pro/ENGINEER).

· Info - открывает окно Information, содержащее информацию относительно текущего
элемента в отчете различия (имя модели, номер компонента, внутренний номер ID,
наименование детали и родительские и/или дочерние записи).

· Action - открывает меню ACTION. При определении действия для одного вхождения
элемента (элемент, компонент и т.д.) в отчете, указанное действие для этого элемент
устанавливается автоматически каждый раз, когда он отображается в сообщении.

Меню ACTION содержит следующие команды:

•  To Merge � помечает исходный элемент для автоматического слияния с конечным
объектом.

•  To Delete - помечает этот элемент для автоматического стирания из конечного
объекта.

•  To Ignore - игнорирует этот элемент (то есть не выполнять ни слияния, ни удаления его
даже при обнаружении различий).

•  Clear � стирает все ожидающие своей очереди действия или команды и игнорирует
элемент.

•  Do Manual - интегрирует элемент вручную. Это включает копирование элемента
вручную из исходного в конечный объект.

•  Merged - помечает элемент как "Merged (Объединенный)" после объединения его
вручную.

•  Deleted � помечает элемент как "Deleted (Удаленный)" после удаления его вручную.

•  All Changes � принимает и интегрирует все изменения в исходном и конечном рисунке.

•  Source Changes - принимает и интегрирует все изменения в исходном рисунке.

•  Target Changes - принимает и интегрирует все изменения в конечном рисунке.

•  Unspecified � включает применение обозначающих действий ко всем элементам,
которые не имеют назначенных действий.

•  Overwrite - позволяет назначать действие на все элементы, даже если на эти
элементы уже были назначены действия. Новое действие перезаписывает
существующее действие.

•  Current Item - позволяет применять действие к текущему элементу.

•  All Items - позволяет применять действие ко всем элементам, на которые можно
воздействовать.

•  By Type - позволяет применять действие к элементам по типу: DIM COSMETICS или
PARAMETERS (Косметические Размеры или Параметры).

· Execute - автоматически выполняет действия, указанные в столбце ACTION отчета
различий для устранения разногласий между исходным и конечным объектами. Каждый
элемент помечается как Merged, Deleted или Ignored в соответствии с определенным для
него действием.

· Save Report - сохраняет отчет различий в локальной рабочей области как текстовый
файл ASCII.
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· Merge View � отображает отчет различий с элементами, отсортированными в том
порядке, в котором они должны быть интегрированы для правильной загрузки всех
внешних ссылок (например, родители должны быть объединены раньше потомков, а
дочерние записи должны быть удалены перед родителями).

· Diff View - (значение по умолчанию) отображает отчет различий, отсортированный по
объектам и, в пределах объекта, по типу элемента. Этот отображение дает быстрое
сообщение о том, где и какие находятся различия.

Таблицы Отверстий
Используя меню ADV DWG OPTS в режиме Рисунка, можно создавать таблицы отверстий
для рисунков. При создании таблицы отверстий, система автоматически создает таблицу
элементов отверстий в указанном виде. В таблице отверстий указывается следующая
информация:

· местоположение в координатах X и Y;

· диаметр отверстия.

Можно также создавать таблицы для опорных точек и осей. При создании таблицы с
опорными точками, их местоположения даются в координатах X, Y и Z. При создании
таблицы с опорными осями, их местоположения даются в координатах X и Y.

Меню HOLE TABLE представляет опции, позволяющие создавать, настраивать, обновлять
или удалять таблицы отверстий:

•  Set Up - позволяет устанавливать формат для таблицы отверстий:

− Num Decimals - устанавливает число десятичных мест в значениях в таблице
отверстий.

− Param Column - определяет параметрический столбец для диаграммы отверстия
или таблицы. При добавлении параметрического столбца, типом параметра должен
быть параметр элемента.

− Label Size - определяет размер текста, используемого для помечания отверстий.

− Max Rows � определяет максимальное число строк в таблице отверстий.

− Hole Naming - определяет метод обозначения отверстий (алфавитно-цифровой или
числовой).

− Sort Setup - изменяет протокол сортировки вхождений в таблице отверстий.

•  Create - позволяет создавать следующее:

− Holes - создает таблицу отверстий.

− Datum Points - создает таблицу опорных точек.

− Datum Axes - создает таблицу опорных осей.

•  Update - обновляет таблицу отверстий в текущем рисунке.

•  Delete - удаляет всю таблицу отверстий.

После создания диаграммы отверстий, отверстия помечаются в рисунке в цифровой
форме в соответствии со стандартом ISO или алфавитно-цифровым способом в
соответствии со стандартом ASME.

Обратите внимание: нельзя обновлять таблицу любой другим способом, иначе чем через
меню HOLE TABLE.
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Создание Таблицы Отверстий, Опорных Точек или Опорных Осей

1. Нажмите Advanced > Hole Table > Create.

2. В меню List Type, выберите следующее:

•  Holes - создает таблицу отверстий, которая перечисляет местоположение отверстий в
координатах X и Y и их диаметр.

•  Datum Points - создает таблицу, которая перечисляет местоположения опорных точек
в координатах X, Y и Z.

•  Datum Axes - создает таблицу, которая перечисляет местоположения опорных осей в
координатах X и Y.

3. Выберите систему координат для перечисления.

4. Выберите местоположение верхнего левого угла таблицы отверстий. Эта операция
создает таблицу отверстий.

Обратите внимание: только элементы просверливаемых отверстий могут быть
перечислены в таблице отверстий.

Примечания ВОМ в Рисунке

Включение Спецификации Материалов в Рисунке

В случае отсутствия модуля Pro/REPORT и необходимости добавить Спецификацию
Материалов (BOM) к рисунку, можно создать BOM файл в режиме Сборки, выбирая BOM в
меню Info Pro/ENGINEER. Добавьте BOM файл к рисунку как примечание, взятое из файла.
Для форматирования или упорядочивания информации в BOM, необходимо использовать
системный редактор. Можно полностью редактировать BOM, отображаемый в рисунке как
примечание без изменения оригинального файла BOM.

Обратите внимание: BOM, добавляемый к рисунку, не связан с BOM файлом,
используемым для создания примечания. Если состав сборки изменится, необходимо
создать новый BOM и добавить его к рисунку как новое примечание.

Добавление BOM к Рисунку

1. Выберите DETAIL ITEM > Note >, File > Make Note.

Обратите внимание: при добавлении BOM к рисунку в качестве примечания, выровняйте
примечание, используя Default или Left. При использовании Center или Right, система
может некорректно форматировать BOM в рисунке.

2. Выберите местоположение для отображения примечания (BOM).

3. Введите название файла BOM, включая расширение ".bom". BOM отображается в
рисунке.
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Снимки Видов

Создание Снимка Вида Рисунка

Команда Snapshot в меню VIEW MODIFY преобразовывает виды рисунка в набор
примитивов, которые больше не связаны с соответствующей моделью. При создании
снимка из вида, происходит следующее:

· вся видимая геометрия, оси, опорные элементы и другие объекты в виде становятся
эскизными объектами.

· Все примитивы, которые были раньше связаны с видом, становятся свободными.

· Все присоединенные элементы рисунка (типа примечаний, допусков на размер, символов
и эскизных размеров) становятся одиночными.

· Все видимые размеры модели преобразуются в эскизные размеры.

· Размеры вида становятся не ассоциативными эскизными размерами.

Обратите внимание: после создания снимка, примечания и символы, присоединенные к
этому виду остаются параметрическими, пока модель не будет удалена с использованием
команды Del Model. Однако, опорные модели в снимке вида станут эскизными объектами с
примечаниями.

Последствия Создания Снимка
После преобразования вида в снимок, система удаляет вид, а также дочерние виды,
дочерние записи на других листах и стертые дочерние записи.

Создание Снимка Вида

1. Выберите VIEWS > Modify View > Snapshot.
2. Определите вид (ы), делая следующее:

•  Выберите All Views, чтобы сделать снимки со всех видов всех моделей в рисунке. Так
как примитивы связаны только с первой моделью рисунка, первая модель должна быть
активной, чтобы можно было управлять образующимися примитивами.

•  Выберите Pick View. В рисунке с несколькими моделями, эта команда делает снимки
видов только текущей модели.

3. По мере выбора каждого вида, подтвердите, что требуется конвертировать его в
эскизные объекты.

Обратите внимание: после создания снимка, отображение стрелок вида может
измениться.
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Аппликации Рисунка

Использование Аппликаций Рисунка

Используя аппликации рисунка, можно накладывать выбранные виды или весь лист одного
рисунка на лист текущего рисунка. Эта функциональная возможность доступна для
рисунков, компоновок, отчетов, диаграмм и форматов; каждый из них может ссылаться на
объекты этих четырех типов.

При работе с аппликациями, учитывайте следующее:

· аппликации в текущем рисунке только для чтения.

· Система обновляет аппликации в соответствии с изменениям в исходном рисунке.

· Виды с аппликациями отображаются со всеми выносными элементами.

· Нельзя выбирать аппликации ни для какой процедуры рисунка.

· Если размер текущего рисунка отличается от размеров исходного рисунка, аппликации,
внесенные в текущий рисунок, сохраняю свой экранный размер (то есть, занимают ту же
самую часть графического окна), который они имели в исходном рисунке.

Создание Аппликаций

1. Выберите DRAWING > Advanced > Overlay > Add Overlay > Place Views.

2. Разместите аппликацию должным образом, делая следующее:

•  если объект исходного рисунка имеет только один отображенный вид на каждом из
листов, укажите начало координат, используя меню GET POINT для выбора нового
местоположения. Нажмите среднюю кнопку мыши или выберите Done.

•  Если объект исходного рисунка имеет более одного вида на любом из листов,
выберите PLACE VIEWS > Select Views и укажите требуемые виды. (Если вид, который
требуется использовать в качестве аппликации, находится на другом листе, выберите
Change Sheet и укажите требуемый лист). Расположите начало координат основного
вида, выбирая точку на экране. Для принятия текущего положения за нулевую точку
вида нажмите среднюю кнопку мыши или выберите GET POINT > Done. Система
соответственно разместит все зависимые виды.

Наложение Рисунка на Текущий Рисунок

1. Выберите DRAWING > Advanced > Overlay > Add Overlay > Place Sheet.
2. Если исходный рисунок имеет только один лист, система подтверждает это и
накладывает исходный рисунок на текущий лист.

Иначе, если рисунок имеет более одного листа, укажите соответствующий номер листа.
Если номер требуемого листа забыт, введите [?] для отображения исходного рисунка в
подокне. Найдите лист, используя команды в меню PLACE SHEET; затем выберите Done.
Указанные листы рисунка наложатся на лист текущего рисунка.
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Удаление Аппликации

1. Выберите OVERLAY DWG > Del Overlay.

2. Сделайте следующее:

•  Выберите Sel Overlay для указания удаляемой аппликации, путем выбора объекта
исходного рисунка в меню SEL OVERLAY.

•  Выберите All Overlays для удаления всех аппликаций.

Перемещение Аппликации

1. Выберите OVERLAY DWG > Move Overlay.

2. В меню SEL OVERLAY, выберите имя аппликации или выберите ее на экране.

3. В меню SEL OVLY ITM выберите вид. Определите вектор перемещения, используя
команды в меню GET VECTOR.

Обратите внимание: аппликацию можно перемещать, выбирая OVERLAY DWG > Move
Overlay; однако, нельзя перемещать листы с аппликациями.

Представления по Виду

Выполнение Представлений по Виду

Используя команду Represent в меню VIEWS, можно упростить сборку в рисунке, выполняя
представления по виду. При выполнении представлений по виду, учитывайте следующее:

· команду Simplify можно использовать на данном виде рисунка только один раз. При
использовании ее во второй раз на этом виде, система восстанавливает предыдущие
упрощения при завершении второго упрощения.

· Замена модели в рисунке удаляет все представления из рисунка.

· Нельзя удалять из отображения какие либо компоненты подсборки, если на них
использованы сборочные зависимости.

· Можно подавлять элемент, используемый для ориентации вида.

· Упрощенная модель в режиме Рисунка - тот же объект базы данных, что и оригинал, и
не содержит никакой определенной информации, за исключением того, что относится к
подавленным элементам или компонентам.

Обратите внимание: для упрощения модели, можно также использовать более гибкие
методы типа таблиц семейства (с упрощенными вхождениями, которые имеют
подавленные элементы), отображения компонентов (скрытие компонентов) и упрощенных
представлений (за исключением моделей или элементов).

Упрощение Сборки в Рисунке

1. Выберите INSTANCES > Simplify; затем выберите All Views или Pick View. Сборка
отображается в маленьком окне.

2. Выберите упрощаемый компонент сборки.
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3. Выберите COMP TYPE > Rep Part для упрощения модели на уровне деталей, подавляя
элементы; или, выберите COMP TYPE > Rep Subasm для упрощения модели на уровне
подсборок, подавляя деталь.

4. Отображается подокно, содержащее выбранную деталь или подсборку. Выберите
INSTANCES > New или введите название ранее созданного представления.

•  Для нового представления выберите подавляемые элементы или детали.

•  При выборе выносного вида или родителя выносного вида для представления, система
отображает рамку вокруг родительского и выносного вида, указывая, что процедура
будет выполнена в обоих видах.

Система упрощает сборку верхнего уровня соответственно.

Пример: Упрощение Сборки в Режиме рисунка
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Упрощенные Представления

Использование Упрощенных Представлений

Используя команды в меню DWG MODELS, можно вызывать, изменять и удалять
упрощенное представление модели сборки, а также создавать сборочные виды с
использованием упрощенных представлений. Pro/ENGINEER ограничивает упрощенные
представления видом сборки, и их необходимо определить перед добавлением вида.
Можно добавлять к рисунку несколько видов сборки, каждое из различных представлений.
После добавления вида, можно изменять представление вида только путем удаления вида
и добавления нового вида с новым представлением.

Вызов Упрощенного Представления Модели Сборки

1. Выберите DWG MODELS > Add Model.
2. Введите название сборки. Отображается меню SELECT REP (в режиме Сборки) при
вызове исходной сборки и для всех моделей сборки, добавляемых впоследствии. Меню
перечисляет Мастер-Представления и все упрощенные представления, существующие для
текущей сборки. Если для модели сборки ничего не было создано, меню не отображается и
система автоматически вызывает Master Representation.

3. Выберите представление. Система применяет это представление для последующих
видов. Можно принять Мастер-Представление как значение по умолчанию или выбрать
другое представление для вызова.

Изменение Представления Модели Сборки

После добавления модели сборки к рисунку, его представление изменять выбирая
Set/Add Rep в меню DWG MODELS. Однако, текущая модель должна являться моделью
сборки. Выбор вида устанавливает текущее представление в представление,
отображаемое в этом виде - можно выбирать только виды текущего представления. Можно
использовать Sel By Menu для вызова списка всех представлений, существующих для
текущей сборки. Система делает указанное представление активным представлением и
применяет его к последующим видам. Если упрощенные представления были сделаны для
модели сборки, автоматически вызывается Мастер-Представление.

При создании упрощенных представлений в режиме Рисунка и проведении в них
изменений, необходимо иметь в виду следующее:

· в режиме Сборки упрощенные представления могут содержать подстановочные детали. В
режиме Рисунка, на эти детали нельзя накладывать размеры.

· При проведении изменений в упрощенном представлении в режиме Сборки, можно
потерять информацию в рисунке. Например, при изменении состояния компонента путем
подстановки ранее включенного компонента, все ссылки на замененный компонент будут
потеряны.

· При ссылке на сборку или ее компоненты в упрощенном представлении, система может
находить и использовать только те компоненты, которые фактически существуют в
упрощенном представлении. В частности, при ориентировании вида, нельзя использовать
опорные элементы, принадлежащие или помещенные в соответствии с компонентами,
которые не находятся в текущем упрощенном представлении.



Pro/DETAIL Выпуск Документации Pro/ENGINEER 2000 i2

360

· Можно создавать проецируемые, выносные, повернутые и выносные виды по основному
виду того же упрощенного представления.

Для Удаления Упрощенных Представлений из Сессии

1. Выберите меню DWG MODELS > Delete Rep. (Текущей моделью должна являться
модель сборки, имеющая более одного представления в сессии.) Отображается меню RMV
REP с представлениями, на которые ссылается рисунок.

2. Выберите представление, которое не использует вид. Можно выбирать один вид за раз.
Система запросит подтвердить его удаление.

Удаление Упрощенных Представлений из Сессии

При добавлении представления модели сборки к рисунку, оно остается в сессии до его
удаления. Если вид рисунка относится к конкретному упрощенному представлению,
которое было выбрано для удаления, система не позволит удалить его, пока рисунок
находится в сессии; и попытается вызвать Мастер-Представление. Удалении его из сессии
вызывает ошибку при вызове рисунка. Система запросит выбрать существующее
представление в меню RMV REP, и назначит это представление всем видам, которые
ссылались на удаленное представление. Если Мастер-Представления сборки больше не
существует, рисунок вызвать нельзя.

Замена Вида Упрощенного Представления

Можно заменять вид упрощенного представления (включая Мастер-Представление) на
другое упрощенное представление.

1. Выберите VIEWS > Modify Views > View State.

2. Выберите изменяемый вид рисунка.

3. Выберите упрощенное представление из списка доступных представлений для
использования в качестве замены.

Геометрические Презентации
При работе с упрощенными представлениями в режиме Рисунка, можно использовать
геометрические презентации � тип углубленного упрощенного представления.
Геометрические презентации требуют меньшего количества времени для вызова по
сравнению с фактической деталью, потому что система не вызывает никакую
параметрическую информацию, только геометрию. Презентации можно использовать для
удаления невидимых линий, получения информации по размерам и точного вычисления
масс-инерционных характеристик.

При работе с геометрическими презентациями, учитывайте следующее:

· По умолчанию, нельзя создавать ссылки рисунка на геометрические презентации (они
включают размеры, примечания и выноски), но при установке опции
"allow_reps_to_geom_reps_in_drws� файла конфигурации в «yes» можно создавать ссылки.
Однако, эти ссылки могут стать некорректными при изменении ссылочной геометрии. Эта
опция - для опытных пользователей, которые знают, что некоторые ссылки на
геометрические презентации не могут быть изменены в рисунках.

· Графические презентации не доступны. При включении графических презентаций в вид
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рисунка упрощенного представления, система изменяет такие представления на
геометрические презентации. Для получения дополнительной информации см.
Руководство Пользователя по Моделированию Сборки.

Программы Рисунка

Создание Программы Рисунка

Используя команду Program в меню ADV DWG OPTS, можно создавать программу рисунка
для определения того, как рисунок будет адаптироваться к изменению состояния своей
модели. Изменения могут происходить при повторном выполнении модели с новыми
данными Pro/PROGRAM, или при замене ее другим вхождением семейства моделей. Как
правило, можно отличать одну последовательность или состояние, от другого значениями
некоторых из параметров в модели.

Программа рисунка предназначена для адаптирования рисунка к программе детали или
сборки. Она содержит логические инструкции, которые управляют компоновкой рисунка и
выполняет различные вспомогательные функции. Например, рисунок детали может
включать выносной вид конкретного элемента, типа шпоночного паза. При подавлении
этого элемента, система должна стереть этот выносной вид и переместить другие виды
для заполнения пространства. При создании состояния типа "no_detail_view", при котором
стираются выносной вид, а другие виды соответственно упорядочиваются
(перемещаются), программа запрашивает систему, подавлен ли шпоночный паз. Если да,
рисунок отображает состояние "no_detail_view". Если нет, рисунок отображает выносные
виды модели.

Программа рисунка имеет две части: состояния и текст программы. Состояние �
именованная последовательность знакомых процедур, типа отображения размеров или
перемещения вида, которая выполняется в рисунке, чтобы определить конечное состояние
рисунка. Это запись изменений, которые требуется провести в рисунке. Для создания
состояния, введите название и сделайте запись различных команд. Можно проигрывать
эти команды, чтобы определить, что состояние рисунка фактически делает и, затем,
редактировать их при необходимости. При создании рисунка, можно создавать
дополнительные состояния и удалять старые.

Можно размещать размеры, разрывы размеров и обрезать размеры по линиям привязки в
процессе создания программы состояния рисунка.

Как только состояние рисунка будет определено, можно создавать программу рисунка, как
показано в следующем рисунке. Программа рисунка - текстовый файл, внедренный внутрь
рисунка, который содержит строки текста, устанавливающие некоторые состояния для
рисунка, в зависимости от значений используемых условных выражений. Можно
использовать условный оператор IF, параметры рисунка и операторы назначения для
установления определенных состояний рисунка. Программа сначала ищет рисунок для
параметра рисунка; если параметр не найден, она ищет заданную по умолчанию модель
для параметра модели. Если программа рисунка распознает параметр рисунка, она
определяет его с постфиксом ":d" (то есть drawing_attribute:d). Если это параметр модели,
он обозначается номером модели.

· Команды для выполнения состояния рисунка принимают следующую форму: SET STATE
name_of_state.

· Можно создавать условные операторы IF в следующей форме:

IF <expression>

ELSE IF <expression>
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ELSE

ENDIF

Expression - логическое выражение, которое может быть использовано в уравнении детали.
Оно может содержать атрибуты рисунка (находящиеся в меню SET UP) или функцию
подавления элемента (то есть FEAT_SUPPRESSED (model_name, feat_id), для
определения, подавлен ли элемент; и FEAT_SUPPRESSED (assembly_name, comp_id), для
определения, подавлен ли компонент). Например:

IF FEAT_SUPPRESSED (bolt,15)

SET STATE no_detail_view

В этом случае, система проверяет, подавлен ли элемент с ID 15 в модели с именем "bolt".
Если да, она устанавливает состояние в "no_detail_view"; иначе, система не делает ничего.

· инструкции Assignment принимают следующую форму: var_name = expression,, где
var_name - имя переменной

· строки комментария принимают следующую форму: /* This is a comment line.

Обратите внимание: слова IF, ELSE, ENDIF, SET, STATE, FEAT_SUPPRESSED
зарезервированы. Их нельзя использовать в качестве переменных имен в программах
рисунка. Также, при использовании знака равно (=) в условном операторе IF, используйте
"==". При использовании инструкции для установления значения параметра, используйте
"=".

Пример: Текст Программы Рисунка

Создание Записи Изменений Рисунка (Состояний)

1. Выберите DRAWING > Advanced > Program > Define States > Create State.

2. Введите название состояния.

3. Выберите Record Cmds.

4. В меню DWG COMMANDS, выберите команды перемещения, стирания и отображения
элементов в рисунке; затем сохраните их изменения (позже, можно редактировать
состояние и подсвечивать эти элементы).

5. Для отмены любого проведенного изменения, выберите EDIT STATE > Undo Cmds. Как
показано в иллюстрации текстового окна Undo State Commands, система размещает
курсор над последней выполненной командой и подсвечивает в окне рисунка элемент,
который был задействован. Если строка команды подсвечивается красным цветом, это
означает что система отменила ее (поле name не всегда заполняется, потому что не все
элементы имеют названия).

6. После создания состояния, система сбрасывает рисунок в его заданное по умолчанию
отображение. Выберите Done для активизации состояние и проведения изменений.
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Меню EDIT STATE Отображает Следующие Команды:

· Record Cmds - отображает меню DWG COMMANDS, составное меню возможных команд
и типы обрабатываемых объектов. После выбора действия и типа элемента, можно
изменять элементы в рисунке. Следующая таблица представляет команды, которые можно
записывать (отмеченные знаком "X"). В дополнение к командам, включенным в таблицу,
нельзя записывать следующее: перемещение зигзага выноски или размера; изменение
сетки модели; стирание, отображение и перемещение стрелок поперечного сечения и
примечания вида; стирание или перемещение ординатных размеров; и изменение залитых
эскизных поперечных сечений.

· Play Cmds - сбрасывает отображение рисунка в его первоначальное отображение (перед
запуском состояния) и проигрывает каждую сохраненную команду в состоянии, делая паузу
между ними. Воспроизведение можно остановить, выбирая пиктограмму остановки в
области сообщения. Система пропускает команды, которые не относятся ни к какому
отображенному листу.

· Undo Cmds - удаляет команды. Отображает текстовое окно Undo State Commands с
командами состояния.

· Layer States - отображает меню DPM LAYER. Можно скрывать, отображать или
устанавливать в нормальное состояние отображение любого слоя рисунка. Также можно
оставлять состояние неизменным. Программы рисунка могут управлять только
состоянием слоев рисунка и не могут воздействовать на слои модели.

· Set Cur Sheet - переключает на другой лист рисунка для проведения в нем изменений.
Можно также отображать другой лист рисунка, выбирая Windows > New в меню
Pro/ENGINEER. Эта команда никоим образом не воздействует на текущее состояние.

Команды, Которые Можно Записывать (помечены "X")

DETAIL ITEMS Move Mod
Attach

Erase Show Show
View

Switch
Sheet

Create

Dimensions X X X X X X

Reference X X X X X X

Dimensions
Notes X X X X X X X

Balloon Notes X X X X X X X

BOM X X X X X

Balloons
Symbols X X X X X X

Gtols X X X X X X

Surf Finish X X X X X X

Symbols
Datum X X X

Targets
Set Datums X X X

Axes X X X

Draft Entities X X

Draft Datums X X
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Draft Axes X X

Draft Groups X X

Tables X X

Views X X X X

Меню UNDO COMMANDS отображает следующие команды:

· Next - выполняет команду в следующей строке и перемещает курсор на эту строку.

· Prev � отменяет выполнение команды в предыдущей строке и перемещает курсор к ней.

· Run - выберите строку в текстовом окне. Система выполняет или отменяет команды до
этой строки.

· Toggle Cur � отменяет команду в текущей строке. Система обновляет окно рисунка и
подсвечивает строку команды. Если текущая команда уже отменена, эта команда
регенерирует ее.

· Pick/Toggle - выбирает строку команды в текстовом окне. При выборе не отмененной
команды, она отменяется. При выборе отмененной команды, она регенерируется.

Пример: Текстовое Окно Команд Отмены Состояния

Создание Выносных Элементов в Состоянии Рисунка

Для создания выносных элементов типа размеров, примечаний и примечаний позиций в
состоянии рисунка, выберите Create из меню DWG COMMANDS. Элементы, которые были
созданы в одном состоянии, не видны в любом другом состоянии или вне программы
рисунка.

Переопределение Состояния Рисунка

Для переопределения состояния, выберите Edit State в меню DRAW STATES. В меню
PRGM STATES, выберите редактируемое состояние. Если программа рисунка не
использует состояние, система проигрывает ее быстро; иначе, она прокручивает
программу до места запуска состояния и отображает меню EDIT STATE.
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Удаление Состояния Рисунка

Для удаления состояния, выберите Delete State в меню DRAW STATES. Можно удалять
любое состояние, не используемое в настоящий момент программой рисунка.

Вызывают(называют) Пользовательскую Функцию

Для вызова пользовательской функции, которая уже зарегистрирована в приложении
Pro/TOOLKIT, выберите User Func из меню DWG COMMANDS.

Запуск Программы Рисунка (Выполнение Состояния)

Вместе с меню EDIT PROGRAM, открывается текстовое окно DRAW PROGRAM со
строками программы. Используя команды в меню EDIT PROGRAM, можно в интерактивном
режиме добавлять, удалять и изменять строки в программе, переходить вперед и назад.
По мере выполнения каждого изменения, система обновляет отображение рисунка.

Примечания:

•  Нельзя изменять значение, которым управляет программа (типа значения атрибута
пользователя рисунка, лист на котором должен находиться эскизный объект). Однако,
можно изменять значение, которым программа не управляет, если программа
перемещает вид.

•  При удалении элемента, которым управляет программа рисунка, система
автоматически удаляет этот элемент из состояния команды в программе, которая им
управляет.

•  При конвертировании вида к снимку, система удаляет из их состояний все команды в
программе рисунка, которая управляет видом и его зависимыми элементами.

•  Программа рисунка может изменять только рисунок, но не модели рисунка.

Когда программа отображается, система размещает курсор в текстовом окне после
последней выполненной строки. При прохождении по программе, можно изменять
отображение, выбирая команды в меню SET STATE. После выхода из меню DRAW
PROGRAM, система полностью выполняет программу и регенерирует изображение
рисунка. При этом программа рисунка автоматически обновляется для отображения
изменений, сделанных в деталях при вызове рисунка, переключении в режим Рисунка или
при регенерации с командой Draft в меню REGENERATE (Model можно использовать
только, если модель была изменена).

После использования одной из команд редактирования, система повторно интерпретирует
весь текст программы и повторно выполняет программу до курсора.

· при успешной интерпретации, программа преобразует все имена параметров, моделей и
ключевые слова в верхний регистр. Кроме того, при необходимости, автоматически
отображается постфикс параметра модели (например, если рисунок имеет более одной
модели).

· при ошибке в интерпретации, система сообщает об ошибке и подсвечивает ошибочную
строку. Не интерпретируемая строка не может выполняться; при перемещении курсора в
текстовом окне в не интерпретируемую область программы, никакие состояния не
выполняются и рисунок не выполняется. Пока ошибка не будет исправлена, система не
выполняет программу и не проводит никаких изменений, которые программа должна
делать в рисунке.
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Меню Edit Program

Для создания программы рисунка, выберите Edit Program в меню DRAW PROGRAM. В
меню содержатся следующие команды:

· Insert Line � запрашивает ввести текст в программу. По завершении, нажмите Enter.

· Delete Line � удаляет диапазон строк в программе.

· Edit Line - изменяет текущую строку в области сообщения.

· Screen Edit - редактирует программу непосредственно в текстовом окне.

· File Edit - редактирует программу рисунка, используя системный редактор.

· Set State - отображает меню во время выполнения всех состояний рисунка. Можно
выбирать состояние из меню или создать новое состояние в интерактивном режиме.

· Next � переходит к следующей выполняемой строке программы.

· Prev � отменяет одну строку, отменяя изменения, произведенные этой строкой в рисунке.
Если переход к этой строке был осуществлен при помощи команды Jump, отмена будет
выполнена до строки, с которой был начат переход.

· Run - выполняет программу вперед или назад до достижения некоторой строки.

· Jump - устанавливает текущую строку как указанный номер строки без выполнения какой
либо строки. Можно переходить только к выполняемой строке программы.

· Switch Dim - изменяет отображение информации на символьные или числовые значения.
Эта команда не изменяет программу или рисунок.

· Set Cur Sheet - устанавливает текущий лист рисунка с целью отображения. Можно
отображать другой лист рисунка, выбирая Windows в меню Pro/ENGINEER, затем New.
Эта команда не изменяет программу или рисунок.

Размер Вида рисунка

Концепция Установки Размера Вида Рисунка

Размер вида рисунка можно устанавливать таким образом, чтобы при изменении размеров
модели, размер вида рисунка оставался постоянным относительно размеров данной
модели. Для этого, определите параметр модели "drawing_scale_factor�, используемый в
режиме Рисунка как масштабный коэффициент вида. Этот параметр является масштабным
коэффициентом, на который умножается масштаб рисунка для определения фактического
размера полного вида рисунка.

Обратите внимание: при этом значение "d#" в рисунке или общий масштабный
коэффициент не изменяется; изменяются только пространственные размеры
отображаемых объектов.
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Следующая таблица показывает, как система вычисляет размер вида рисунка, используя
масштаб рисунка и параметр модели "drawing_scale_factor".

Расчет Размера Вида Рисунка

Величина
d#

Параметр
длины

drawing_sc
ale_factor

Масштаб
рисунка

Длина в
Виде

Пояснение

5 5 1 2 10 Изменение масштаба рисунка.
Масштаб рисунка изменяется на 2,
длина кромки в виде становится 10.

5 5 1 1 5 Исходные условия

Кромка модели имеет соответствующий
размер d#=5. Если масштаб рисунка 1,
а длина кромки 5, то
"drawing_scale_factor" устанавливается
в 1.

10 5 .5 1 5 Изменение значения размера

Значение d# изменяется в режиме
Детали или Сборки на 10.
"drawing_scale_factor" становится
равным 5. Расчетная длина в виде
становится равной половине значения
размера (остается неизменной, 5).

5 10 2 1 10 Изменение значения параметра
"length"

Значение параметра "length" в
уравнении изменяется на 10 и
"drawing_scale_factor" становится
равным 2. Длина кромки в виде
умножается на 2.

5 10 2 2 20 Изменение значения параметра
"length" на указанный масштаб

Кромка со значением размера 5
отображается в виде с масштабом 2.
Изменение параметра "length" до 10
изменяет "drawing_scale_factor" до 2 и
новая длина кромки в виде становится
20.

Установка Размера Вида Рисунка

1. Укажите кромку, которая будет использоваться в качестве базовой для установки
"drawing_scale_factor". Система использует значение размера и длину этого кромки в
рисунке для вычислений. Всякий раз, при изменении любой один из этих переменных
("length" или d#), длина кромок модели рассчитывается согласно следующему уравнению:

длина в виде = (значение размера) x (drawing_scale_factor) x (drawing_scale)

2. Добавьте следующее уравнение к детали или сборке:

drawing_scale_factor = длина / размер

Где длина - параметр, соответствующий вышеупомянутому размеру d# в текущем рисунке,
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а размер � размер модели d#.

3. Регенерируйте модель.

Масштаб Эскиза

Установка Масштаба Эскиза

При установке масштаба эскиза с использованием опции "draft_scale� файла установок
рисунка, можно создавать примитивы с масштабируемым размером. Если опция
установлена в 0.5, все последующие объекты создаются с половинным от указанного
размером. Например, создавая горизонтальную линию в 4 дюйма (выбирая одну конечную
точку и помещая вторую конечную точку с использованием Rel Coords x=4, y=0), линия на
листе получается длиной 2 дюйма, но с размером 4 дюйма. При изменении масштаба
эскиза после создания и ассоциативного образмеривания примитивов, размеры
изменяются.

Масштаб эскиза, подобно другим значениям параметра в файле установок рисунка,
является полностью независимым от масштаба рисунка. При изменении размеров рисунка,
значение масштаба эскиза не изменяется. Система пропорционально масштабирует
эскизную геометрию для сохранения ее относительного местоположения на листе и для
отображения размеров такими же, что и прежде. Фактически, геометрия имеет различные
размеры (потому что листы имеют различный размер), и это отражается любыми новыми
размерами, создаваемыми для нее; отношение нового размера к предыдущему равно
отношению размера нового листа к старому. При установке опции
"associative_dimensioning� файла установок рисунка в «yes» (значение по умолчанию), если
размер образмеренного примитива изменяется, система обновляет размеры в
соответствии с последним значением.

Пример: Использование Эскизного Масштаба

h_dr_det_dftsca_over_ex.doc
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Пример: Влияние Изменения Формата Рисунка на Примитивы
В следующем рисунке, формат изменяется с размера "E" на "C". Примитивы на экране
одинаковы, но фактически равны половине от их предыдущего размеры, так как система
уменьшила размер рисунка в два раза и масштаб эскиза не изменился. Размеры модели
остались те же, потому что масштаб вида изменился; система уменьшила его в два раза
вместе с размером рисунка.

Схема Образмеривания

Изменение Схемы Образмеривания

h_dr_det_dimsch_over_ov.doc

Можно изменять схему образмеривания элемента в режиме Рисунка, используя Scheme в
меню DIM PARAMS. При выборе элемента, модель отображается в подокне. Затем можно
изменять сечение элемента, используя команды в меню SKETCHER.

Изменение Схемы Образмеривания Элемента или Детали

h_dr_det_dimsch_modify_pr.doc

1. Выберите DETAIL > Modify > Dim Params > Scheme.

2. Выберите элемент для повторного образмеривания. При выборе базового элемента,
отображается только сечение базового элемента и значения размеров. При выборе более
позднего элемента на модели, система откатывается назад и отображает модель в
ориентации по умолчанию. Сечения и размеры элемента (если используются)
отображаются на модели.

3. Добавьте или удалите размеры, или измените размещение зависимостей, при
необходимости. Нельзя изменять существующие значения размеров или добавлять или
удалять элементы.

4. Выберите Done по завершении.

5. Система регенерирует модель для отображения изменений. При установке опции
"auto_regen_views� файла конфигурации в "no", необходимо выбрать Regen View в меню
View Pro/ENGINEER для просмотра изменений в видах рисунка.

Можно также изменять схему образмеривания в режиме детали.
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Линии Привязки в Видах Рисунка

Использование Линий Привязки в Видах Рисунка

h_dr_det_snplns_over_ov.doc

Можно определять линии привязки на отдельных рисунках для размещения размеров,
примечаний, допусков на размер, символов и символов обработки поверхности. Система
позиционирует линии привязки относительно контура вида или выбранной кромки модели
или опорной плоскости. После размещения элемента на линии привязки, элемент
перемещается по ней при смещении линий координатной сетки (например, при
расширении границ вида).

Создание Линий Привязки

h_dr_det_snplns_create_pr.doc

1. Выберите DETAIL > Create > Snap Line.

2. Сделайте следующее:

•  Выберите CR SN LINE > Att View. Выберите границу вида, определите смещение от
границы и количество создаваемых линий. При создании более одной линии,
определите промежуток между двумя линиями. Линия привязки присоединяется к
указанной границе вида.

•  Выберите CR SN LINE > Att Geom/Snap.. Выберите геометрию вида (типа кромки),
опорные плоскости или другую линию привязки; определите значение смещения,
количество создаваемых линий и промежуток между двумя линиями (при создании
более одной линии). Линии привязки присоединяются к указанной геометрии вида,
опорным плоскостям или линиям привязки.

Ограничения при Использовании Линий Привязки

h_dr_det_snplns_create_rf.doc

При работе с линиями привязки, учитывайте следующее:

· линии привязки размещают и располагают выносные элементы. Они не являются
графическими элементами рисунка, поэтому система не их не печатает.

·Можно размещать линии привязки на слоях рисунка и скрывать их, но к скрытым линиям
нельзя добавлять новые элементы. Существующие элементы остаются привязанными.

· Нельзя добавлять объекты одного вида к линиям привязки другого вида. Для видов с
разрывом, нельзя привязывать элемент одного сегмента вида к линии привязки другого
сегмента. Вид элемента определяется как вид, к которому присоединен элемент выноски.
В случае нескольких выносок, элемент может быть привязан к любому из видов.

· При удалении вида, система также удаляет все его линии привязки.

· При размещении размера в месте пересечения двух линий привязки, он не ведет себя
так, как если бы был привязан только к одной линии привязки. Свободные элементы могут
быть привязаны к любым линиям привязки.



Pro/ENGINEER 2000 i2 Pro/DETAIL Выпуск Документации

 - 371 -

Размещение Элементов на Линии Привязки

h_dr_det_snplns_place_pr.doc

Можно размещать и располагать следующие элементы на линиях привязки, выбирая Move
в меню DETAIL (для выбора нескольких элементов сразу, используйте кнопку MOVE MANY
в инструментальной панели Pro/ENGINEER или команду MOVE MANY в меню DETAIL):

· размеры;

· обрезанные размерные стрелки;

· примечания;

· символы;

· названия установленного опорного элемента;

· конечные точки установленных опорных линий;

· допуски на размер;

· символы обработки поверхности;

· стрелки вида.

Условия Размещения Элементов На Линиях Привязки

h_dr_det_snplns_place_rf.doc

При размещении элементов на линиях привязки, учитывайте следующее:

· при перемещении элемента на одной линии привязки, он отображается сиреневым
цветом. При установке местоположения нажатием на левую кнопку мыши, элемент
привязывается к линии привязки. Линия привязки определяет местоположение элемента,
пока элемент не будет снова перемещен.

· при перемещении элемента на место пересечения двух линий привязки, система
подсвечивает одну из линий красным цветом. Если элемент привязан более, чем к одной
установленной линии привязки в этом месте, можно управлять всеми возможными
установками, используя меню SEL SNAP LINE. При выборе Accept, система размещает
элемент в месте пересечения двух линий привязки. При перемещении линии привязки,
элемент перемещается вместе с ней.

Совет: Привязка Элемента к Линии

h_dr_det_snplns_place_tt.doc

Можно привязать элемент к одной линии привязки или к пересечению двух линий привязки.
Можно также присоединять обрезанные выносные объекты (типа размеров, установленных
конечных точек выносных линий, установленных опорных конечные точек и конечных точек
осей). При размещении элемента на линии привязки, он перемещается при перемещении
линии привязки.

Изменение Присоединения Линии Привязки

h_dr_det_snplns_modify_pr.doc

1. Выберите DETAIL > Mod Attach.

2. Выберите линию привязки.
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3. В меню MOD SNAP ATT, выберите одну из следующих команд:

•  Keep Position � сохраняет положение линии привязки.

•  Change Orient � изменяет ориентацию линию привязки с переназначением смещения
новой ссылки.

•  Att View � изменяет присоединение линии привязки к границе вида.

•  Att Geom/Snap - изменяет присоединение линии привязки к другой геометрии или
другой линии привязки.

4. Определите новую ссылку. Присоединение линии привязки изменяется.

Линиями привязки можно управлять несколькими способами:

•  Выберите Delete в меню DETAIL для удаления линии привязки; однако, как только она
будет удалена, все элементы, расположенные на ней, освобождаются. Для удаления
более одной линии привязки, можно использовать команду Pick Box в меню PICK
MANY или кнопку Delete Many в инструментальной панели Pro/ENGINEER.

•  Выберите Move в меню DETAIL для изменения положения линии привязки. Система
обновляет все элементы, расположенные на перемещенной линии привязки после
выбора нового местоположения.

•  Выберите Clip в меню DETAIL для управления положением конечных точек линий
привязки. Любые проведенные изменения являются косметическими и влияют только
на линии привязки.

•  Выберите Modify в меню DETAIL, затем Snap Space для изменения интервала линий
привязки.

Управление Отображением Линий Привязки

h_dr_det_snplns_contrl_pr.doc

Для управления отображением линий привязки, выберите Display Snap Line в диалоговом
окне Environment. Для включения привязки выберите Snap to snap line в диалоговом окне
Environment. По умолчанию, система выбирает обе команды. Если линии привязки не
отображаются или флажок Snap to snap line снят, элементы, которые уже привязаны к
линии привязки продолжают перемещаться вместе со своими линиями привязки.

Параметры Рисунка

Концепция Параметров Рисунка

h_dr_det_dwgprm_over_ov.doc

Используя команду Parameters в меню ADV DWG OPTS, можно обращаться к
функциональным возможностям параметров рисунка для рисунков и форматов. Параметры
рисунка функционируют таким же образом, что и параметры модели. Параметр рисунка -
неграфическая информация, которую можно добавлять к рисунку. Параметры полезны для
хранения в рисунке некоторой дополнительной информации, которую нельзя включать в
примечания. Их можно отображать в примечании, вводя [&parameter:d]

При работе с параметрам рисунка, учитывайте следующее:

· система связывает параметры только с объектом, который является текущим в момент
добавления параметра.
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· Атрибуты рисунка, определенные в версиях Pro/ENGINEER до Версии 15.0,
преобразуются в параметры рисунка автоматически.

· Система преобразует названия атрибутов, которые начинаются с цифры, но их нельзя
использовать в примечаниях.

· Нельзя использовать параметры рисунка в уравнениях.

· Можно определять параметры для Pro/PDM.

Создание Параметра Рисунка

h_dr_det_dwgprm_create_pr.doc

1. Выберите ADV DWG OPTS > Parameters > Drawing > Create.

2. В меню ADD PARAM, выберите команду для определения типа параметра:

•  IntNumber - добавляет параметр в форме целого числа.

•  RealNumber - добавляет двойной параметр.

•  String - добавляет параметр в форме строки.

•  Yes No - добавляет параметр со значением «yes» или «no».

3. Введите название и значение параметра.

Изменение или Удаление Существующих Параметров Рисунка

h_dr_det_dwgprm_modify_pr.doc

1. В меню MODEL PARAMS, выберите Modify или Delete.

2. В меню PARAMETER, выберите параметр рисунка.

•  Для изменения параметра, введите новое значение.

•  Для удаления параметра, выберите Done.

3. Для отображения окна Information, содержащего все существующие параметры и их
значения, выберите MODEL PARAMS > Info.

Вы также имеете доступ к параметрам режима Детали и Сборки во время работы в режиме
Рисунка.

Типы Линий

Создание и Изменение Типов Линий

h_dr_det_lnsty_over_ov.doc

Тип линии состоит из следующих элементов: шрифт линии (массивы черточек, пробелов и-
или точек), цвета и ширины линии. Изменение типа линии включает изменение всех или
любого из элементов типа линии. Можно создавать, изменять и удалять типы линии и
шрифты линии сеток таблиц, символов, осей, эскизных объектов и косметических
элементов.
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Вызов Типов Линий в Режиме Рисунка

h_dr_det_lnsty_access_pr.doc

В режиме детали пользовательские шрифты линии отображаются сплошным шрифтом
(solid font). Для обращения к функциональным возможностям типа линии в режиме
Рисунка, выберите Modify в меню DETAIL и Line Style в меню DETAIL ITEM.

Определение Заданной по Умолчанию Установки Типа Линии

h_dr_det_lnsty_set_pr.doc

Используя команду Set Current в меню LINE STYLE, можно определить тип линии
текущим. Система создает все новые объекты с текущим типом линии.

1. Выберите LINE STYLES > Set Current.
2. В меню SEL STYLE, выберите одну из следующих команд:

•  Hidden - отображает геометрию на экране невидимыми линиями (полутона); на печать
выводит пунктирными линиями (dashed lines).

•  Geometry - отображает видимую геометрию на экране стандартным образом (белым
цветом); на печать выводит непрерывными линиями (solid lines).

•  Leader - отображает на экране в виде размеров (желтым цветом); на печать выводит
желтыми линиями.

•  Cut Plane - отображает на экране белыми линиями phantom; на печать выводит
линиями phantom Пером 1.

•  Phantom - отображать экране серыми линиями phantom; на печать выводит линиями
phantom Пером 3.

•  Centerline - отображает на экране желтыми осевыми линиями; на печать выводит
осевыми линиями.

Назначение Типа Линии Объектам

h_dr_det_lnsty_assign_pr.doc

Используя Modify Line в меню LINE STYLE, можно вызвать диалоговое окно LINE STYLE
для назначения атрибутов выбранным линиям.

Обратите внимание: для открытия диалогового окна, необходимо выбрать Done Sel в
меню GET SELECT после выбора линий.

· Для назначения типа линии объектам, выберите тип линии из списка Style; затем
нажмите Apply.

· Для установки шрифта линии, выберите шрифт линии из Списка Line Font; затем
нажмите Apply.

· Для установки ширины, введите значение в поле Width; затем нажмите Apply (это
текстовое поле доступно только в режиме Рисунка и не используется при изменении типа
линии объектов детали в любом другом режиме).
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Установка Цвета с Использованием Системного Цвета

h_dr_det_lnsty_setcol_pr.doc

1. Выберите DETAIL > Modify > Line Style > Modify Lines.

2. Выберите изменяемый элемент; затем выберите GET SELECT > Done Sel.
3. В диалоговом окне Modify Line Style, нажмите Color.
4. В диалоговом окне Color, выберите системный цвет в поле System Colors; затем
нажмите OK. Система отображает выбранный элемент с указанным цветом и закрывает
диалоговое окно Color.
5. Для возврата элемента к старому стилю, нажмите Reset и Apply.

Создание Собственного Цвета Линии

h_dr_det_lnsty_owncol_pr.doc

1. В диалоговом окне Color, нажмите New.

2. В инструменте Color Editor Pro/ENGINEER, используя левую кнопку мыши, определите
новый цвет. Переместите ползунки RGB влево; затем нажмите на цветовую область (или
нажмите OK) при желательной установке. Новый цвет отображается в поле User-Defined
Colors.

3. Щелкните по Apply в диалоговом окне Modify Line Style. Система отображает
выбранный элемент с указанным цветом и сохраняет цвет в модели.

4. Для возврата элемента к старому стилю, нажмите Reset и Apply.

Создание (или Добавление) Нового Типа Линии

h_dr_det_lnsty_creadd_pr.doc

1. Выберите LINE STYLES > Edit Styles.

2. В диалоговом окне Line Style Library, нажмите New.

3. В диалоговом окне New Line Style, введите название в поле New Name, выберите
существующий стиль для копирования из списка Style или нажмите Select Line.

4. Установите шрифт линии, ширину и цвет.

5. Примите новый тип линии и нажмите OK.

Система добавляет тип линии к Библиотеке Типов линии.

Удаление Пользовательского Типа Линии

h_dr_det_lnsty_delete_pr.doc

1. В диалоговом окне Line Style Library, выберите существующий тип линии в поле Style.

2. Щелкните по Delete.

3. В меню Confirm Deletion, нажмите Yes. Система удаляет тип линии.
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Изменение Пользовательского Типа Линии

h_dr_det_lnsty_modify_pr.doc

1. Выберите LINE STYLES > Edit Styles.

2. В диалоговом окне Line Style Library, выберите существующий тип линии в поле Style.

3. Щелкните по Modify.

4. В диалоговом окне Modify Line Style, измените выбранный тип линии:

•  Для изменения шрифта, выберите шрифт из списка Line Font.

•  Для изменения ширины, введите значение в поле Width.

•  Для изменения цвета, нажмите Color и выберите цвет в диалоговом окне Color.
Обратите внимание: система не обновляет автоматически элемент, который был
предварительно назначен данному типу линии (перед проведением изменений).
Изменения, выполненные с использованием этого диалогового окна, влияют только на
элементы, которым был назначен пользовательский тип линии после их изменения.

Вызов Типа Линии в Режиме Детали

h_dr_det_lnsty_assign_rf.doc

В режиме детали, можно вызывать диалоговое окно Line Style, выбирая Line Style в меню
MODIFY. Оно содержит средства управления, используемые в режиме Рисунка.

Шрифты Линии

Создание и Изменение Шрифтов Линии

h_dr_det_lfonts_over_ov.doc

Используя команды Edit Fonts в меню Line Style, можно создавать собственные шрифты
линии, определяя длину и массив шрифта; также можно изменять существующие шрифты.
Шрифт линии � массив черточек и пробелов, которые являются пропорциональными в
пределах указанной длины. Например, 5 черточек и 5 пробелов с длиной массива 1 дюйм
дают две черточки и два пробела для 2-дюймовой линии в рисунке. То же самое
определение массива для 1/4-дюймовой длины массива дает 8 черточек и пробелов для 2-
дюймовой линии в рисунке. Можно иметь максимум 16 комбинаций пробел-черточка в
файле шрифта линии.

Создание Нового Шрифта Линии

h_dr_det_lfonts_create_pr.doc

1. Выберите LINE STYLES > Edit Font
2. В диалоговом окне Line Font Library, нажмите New.

3. В диалоговом окне New Line Font, введите название в поле New Name, выберите
существующий шрифт для копирования из списка Font или нажмите Select Line.

4. Введите длину одного элемента в поле Unit Length.
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5. Определите массив шрифта, вводя ряд черточек (-) и пробелов ( ) в поле Font Pattern.

6. Нажмите OK для принятия определенного шрифта. Система добавляет шрифт к
Библиотеке Шрифтов Линий.

Установка Заданной по Умолчанию Длины Шрифта

h_dr_det_lfonts_setdef_pr.doc

Чтобы установить заданную по умолчанию длину шрифта, используйте опцию
"line_style_length� файла установок рисунка. Однако, после добавления этой опции к файлу
установок рисунка, ее нельзя удалить, удаляя линию из файла или вызывая в рисунок
другой файл ".dtl". Необходимо изменить значение этой опции на �default� для исключения
опции из файла установок рисунка.

Используйте следующий формат:

line_style_length font_name value/default

Где "font_name" - название шрифта, который требуется изменить, �value� � требуемое
значение длины шрифта в единицах системы, а �default� указывает системе использовать
заданное по умолчанию значение длины. Необходимо определять эту опцию в файле
установок рисунка всякий раз, когда требуется изменить длину. Для установки длины
эскизных линий с использованием "line_style_length", необходимо установить опцию
"axis_interior_clipping� файла установок рисунка в «no». Опция файла установок рисунка
"line_style_length� воздействует только на эскизные объекты.

Обратите внимание: любые изменения длины шрифта в рисунке с использованием
диалогового окна Modify Line Font, отменяют настройку по умолчанию, определенную в
файле установок рисунка.

Изменение Шрифта Линии

h_dr_det_lfonts_modify_pr.doc

1. Выберите LINE STYLES > Edit Font.
2. В диалоговом окне Line Font Library, выберите существующий шрифт из поля Fonts.

3. Щелкните по Modify.

4. В диалоговом окне Modify Line Font, выполните необходимые изменения выбранного
шрифта:

•  Измените длину, вводя новое значение в поле Unit Length.

•  Измените массив шрифта, вводя ряд черточек (-) и пробелов ( ) в поле Font Pattern.

5. Нажмите OK для принятия определенного шрифта. Диалоговое окно Modify Line Font
закрывается.

Удаление Шрифта Линии

h_dr_det_lfonts_delete_pr.doc

Для удаления шрифта линии из рисунка, измените значение опции "aux_line_font� файла
установок рисунка на <number> solidfont.
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Импорт и Экспорт Пользовательских Шрифтов

h_dr_det_lfonts_impexp_pr.doc Шрифты

В режиме Рисунка, опция "iges_out_dwg_line_font� файла конфигурации управляет
экспортом пользовательских шрифтов линии в формате IGES, в то время как
"iges_in_dwg_line_font" управляет импортом. Pro/ENGINEER обрабатывает определение
примитива шрифта линии IGES (тип 304, форма 2) при установке этих опций в «yes».

Вызов Файла Шрифта Линии

h_dr_det_lfonts_create_rf.doc

Пользовательские файлы шрифта линии, "fontname.lsl" должны постоянно находиться в
локальном каталоге, чтобы его можно было использовать. При вызове рисунка, если
система не может найти файл шрифта линии, она отображает любую линию, которая
установлена со стилем непрерывной линии и предупреждает, что файл шрифта не
загружен. Если в файле установок рисунка указаны файлы вспомогательных шрифтов
(auxiliary font) (это происходит автоматически при создании шрифта, когда рисунок
активен), система идентифицирует файлы шрифта, которые не может найти.

Для использования шрифтов линии в рисунках, отличных от тех, в которых они были
созданы, установите опцию файла установок рисунка "aux_line_font" для определения
шрифта линии по имени и идентификатору:

aux_line_font # font filename

, где "#" - целое число между 1 и 10,000, представляющее идентификатор шрифта в
рисунке. Он служит в качестве перекрестной ссылки между геометрией и шрифтом линии,
позволяя проводить общие изменения в геометрии шрифтов путем изменения файла
установок рисунка и определения нового имени шрифта для этого же номера. Например,
изменяя значение "aux_line_font" со �100 dash 1� до "100 solidfont", изменяется вся
геометрия с "dash 1� на "solidfont".

Пример: Определение Шрифта Линии

h_dr_det_lfonts_over_ex.doc
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Сетки Модели

Использование Сеток Модели и Эскиза

h_dr_det_mgrids_over_ov.doc

При работе с рисунком, можно использовать трехмерную сетку (модели), которая была
определена в режиме Детали или Сборки или двумерную сетку. Для использования сетки
модели, нажмите Modify > Grid > Model Grid; затем используйте диалоговое окно Model
Grids. Для использования эскизной сетки, нажмите Modify > Grid > Draft Grid; затем
используйте меню GRID MODIFY.

Создание Сетки Модели

h_dr_det_mgrids_create_pr.doc

Сетку модели можно создавать в режиме Детали или Сборки, выбирая Grid в меню Set Up
и, затем, выбирая систему координат для определения начала координат сетки в
диалоговом окне Model Grids. В сборке, эта система координат должна принадлежать
сборке верхнего уровня.

Отображение Сетки Модели в Рисунке

При работе с рисунком, можно использовать команды в диалоговом окне Model Grids для
отображения и стирания сетки модели. Для отображения сетки модели, необходимо
сориентировать виды таким образом, чтобы одна ось системы координат была
перпендикулярна экрану, а вторая ось параллельна границе листа рисунка.

1. В меню DETAIL, нажмите Modify > Grid > Model Grid. Отображается диалоговое окно
Model Grids.

2. Определите отображение. Выберите View для отображения сетки в выбранных видах,
Line для отображения сетки по линии или Sheet для отображения сетки на всем листе.

3. Щелкните по Show. Сетка отображается в соответствии с опциями, указанными в Шаге
2.

Обратите внимание: при добавлении вида на лист, который имеет сетку листа, модель
вида имеет заданное начало координат сетки, а вид находится планарно по отношению к
этой сетке, система перемещает начало координат вида в начало координат сетки и
привязывает эти точки к точкам сетки листа.

Стирание Сетки Модели в Рисунке

h_dr_det_mgrids_erase_pr.doc

1. В меню DETAIL, нажмите Modify > Grid > Model Grid. Отображается диалоговое окно
Model Grids.

2. Нажмите Erase; затем сделайте следующее:

•  если необходимо стереть сетку по виду, нажмите View, затем выберите вид. Система
стирает сетку, но не удаляет ее на постоянной основе из модели.

•  Если требуется стереть линию сетки, нажмите Line, затем выберите отдельные линии
сетки.
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•  Если требуется стереть сетку на всем листе, нажмите Sheet. Система запросит
подтверждения на стирание сетки текущей страницы. Введите yes.

3. Для вызова изображения отдельных стертых линий, нажмите Show > View.

Изменение Сетки Модели

1. В меню DETAIL, нажмите Modify > Grid > Model Grid. Отображается диалоговое окно
Model Grids.

2. В диалоговом окне Model Grids, используйте различные опции на страницах Grids и
Settings для изменения сетки модели.

Удаление Сетки Модели из Детали или Сборки

1. Нажмите Set Up > Grid. Отображается диалоговое окно Model Grids.

2. Щелкните по Delete Grid. Сетка исчезает.

Обратите внимание: можно удалять сетку только в режиме Детали или Сборки.

Правила Использования Сетки Трехмерной Модели

h_dr_det_mgrids_create_rf.doc

При использовании сетки трехмерной модели, учитывайте следующее:

· при изменении ориентации вида с сеткой, система может скрыть сетку. Поэтому, перед
завершением процедуры, необходимо подтвердить изменение ориентации вида.

· При изменении масштаба вида, сетка модели распространяется на весь вид.

· Система распространяет линии сетки за рамку вида на расстояние двух промежутков
сетки по умолчанию. При первом отображении модели используется заданная по
умолчанию сетка. Ее можно изменять позже, но расстояние расширения не изменяется.

Пример: Сетка Модели

h_dr_det_mgrids_display_ex.doc
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Диалоговое Окно Model Grids

Создавайте и изменяйте сетку модели, используя диалоговое окно Model Grids.

Страница Grids, содержит следующие опции:

· Origin - позволяет выбирать систему координат для начала координат сетки.

· Display - управляет отображением сетки.

•  Show � отображает сетку и ярлычки по виду, линии или листу.

•  Erase - стирает сетку и ярлычки сетки по виду, линии или листу.

Show/Erase by:

•  View � отображает или стирает сетку в выбранных видах.

•  Line � отображает или стирает отдельные линии сетки.

•  Sheet � отображает или стирает сетку на всем листе. Все соответствующие виды
привязываются к сетке.

· Spacing - позволяет назначать один интервал для сетки всей модели или по отдельной
оси.

•  All � разносит все линии сетки на указанное в текстовом поле расстояние.

•  By Axis - разносит все линии сетки по любой указанной оси, на расстояния, указанные
в текстовом поле.

•  View � применяет изменения к сетки модели после отображения сетки модели.

· Delete Grid - удаляет сетку в текущем виде.

Страница Settings содержит следующие опции:

· Setup Options - позволяет назначать различные значения следующим опциям:

•  Balloon Radius � введите радиус позиции.

•  Offset Distance � введите расстояние смещения линий сетки.

•  Decimal Places � введите число десятичных знаков.

•  Negative Prefix

•  Text Orientation � размещает текст горизонтально или параллельно линиям
координатной сетки.

•  Text Position - центрирует текст над или под линиями координатной сетки.

•  Display Balloon - отображает позицию.

· Label Text

•  Show Additional Text � выберите этот флажок, если требуется ввести дополнительный
текст в качестве префикса или суффикса по любой из осей.
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Эскизные Сетки

Создание Эскизной Сетки

h_dr_det_dgrids_over_ov.doc

Используя команды в меню GRID MODIFY, можно создавать два типа эскизных сеток в
рисунке: Декартовы и Полярные. Система создает Декартову сетку, размещая точки на
плоскости и откладывая их расстояние от любых пересекающихся прямолинейных осей,
параллельных другой оси. Полярная сетка создается, размещая точки на плоскости и
откладывая их расстояние от неподвижной точки на линии и под углом к неподвижной
линии. Для переключения с одного типа на другой, выберите Type в меню GRID MODIFY.

При использовании двумерной эскизной сетки в рисунке, учитывайте следующее.

· начало координат сетки и угол влияют на значения координат, указанные для точек
геометрии. Ось X - всегда направлена вдоль одного направления сетки, в то время как ось
Y - по другой.

· Начало координат сетки влияет на значения координат, отображающиеся в области
сообщения при эскизировании.

· При использовании меню GET SELECT для выбора объекта, он не привязывается к сетке.

Изменение Отображения Сетки

h_dr_det_dgrids_display_pr.doc

Для переключения отображения эскизной сетки, используйте команды Grid On и Grid Off в
меню GRID MODIFY. Включение отображения сетки не влияет на привязку эскизных
объектов к пересечениям сетки. Для изменения привязки к сетке, выберите Grid Snap в
диалоговом окне Environment.

Перемещение Начала Координат Сетки

h_dr_det_dgrids_mvorg_pr.doc

1. Выберите GRID MODIFY > Origin.

2. В меню GRID ORIGIN выберите тип объекта для установки начала координат:

•  Get Point - выберите точку в качестве начала координат.

•  Edge/Entity - выберите точку на кромке или объекте.

•  Default - использует заданное по умолчанию начало координат сетки.

3. При выборе Get Point или Edge/Entity, выберите объект для размещения начала
координат сетки.

Места Размещения Начала Координат Сетки

h_dr_det_dgrids_mvorg_rf.doc

Можно располагать начало координат сетки в следующих местах:
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· конечная точка или центр эскизного объекта;

· эскизная точка;

· опорная точка;

· кромка или вершина кривой.

Изменение Интервала Сетки

h_dr_det_dgrids_modify_pr.doc

Используя команду Grid Params в меню GRID MODIFY, можно изменять интервал и угол
наклона линий сетки. Типы доступных команд зависят от типа сетки. Система сохраняет
значения интервала сетки и вызывает их вместе с рисунком.

Меню CART PARAMS и POLAR PARAMS

h_dr_det_dgrids_modify_rf.doc

Для Декартовой сетки, меню CART PARAMS отображает следующие команды:

· X&Y Spacing - устанавливает одинаковый интервал линий сетки в направлении X и
направлении Y.

· X Spacing - устанавливает интервал линий сетки только в направлении Х.

· Y Spacing - устанавливает интервал линий сетки только в направлении Y.

· Angle - изменяет угол между горизонталью на экране и направлением X сетки.

Для Полярной сетки, меню POLAR PARAMS отображает следующие команды:

· Ang Spacing - устанавливает угол между радиальными линиями. Введенное значение,
должно равномерно укладываться в 360.

· Num Lines - устанавливает число используемых радиальных линий. Угловой интервал -
360 на число линий.

· Rad Spacing - изменяет интервал круговой сетки.

· Angle - изменяет угол между горизонтальной и радиальной (0 градусов) линией.

Использование Окна Дерева Модели в
Режиме Рисунка
h_dr_det_tree_over_ov.doc

Окно Model Tree можно использовать в режиме Рисунка для вызова моделей рисунка и их
выбора (например, при отображении и стирании размеров). Дерево Моделей работает в
режиме Рисунка аналогично работе в режиме Детали и Сборки. Можно настраивать
столбцы; отображать различные объекты типа элементов, номера и типа; распахивать и
сворачивать дерево требуемым образом. Для выключения отображения окна Model Tree,
снимите флажок Model Tree в диалоговом окне Environment.
Следующий раздел справки представляет полный список опций файла установок рисунка,
их значений и определений, отображая для каждой опции:

· название файла установок;
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· связанные значения (значения по умолчанию отображаются курсивом);

· определение.

Пример: Файл Установок Рисунка

h_dr_det_setup_create_ex.doc

!
! These options control text not subject to other options

!

drawing_text_height 0.156250

text_thickness 0.000000

text_width_factor 0.800000

!

! These options control views and their annotations

!

broken_view_offset 1.000000

create_area_unfold_segmented YES

def_view_text_height 0.000000

def_view_text_thickness 0.000000

detail_circle_line_style SOLIDFONT

detail_view_circle ON

half_view_line SOLID

projection_type THIRD_ANGLE

show_total_unfold_seam YES

view_note STD_ANSI

view_scale_denominator 0

view_scale_format DECIMAL

!

! These options control cross sections and their arrows

!

crossec_arrow_length 0.187500

crossec_arrow_style TAIL_ONLINE

crossec_arrow_width 0.062500

crossec_text_place AFTER_HEAD

cutting_line STD_ANSI

cutting_line_adapt NO

cutting_line_segment 0.000000

draw_cosms_in_area_xsec NO

remove_cosms_from_xsecs TOTAL

!

! These options control solids shown in views
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!

datum_point_size 0.312500

datum_point_shape CROSS

hlr_for_pipe_solid_cl NO

hlr_for_threads YES

location_radius DEFAULT(2.)

mesh_surface_lines ON

thread_standard STD_ANSI

hidden_tangent_edges DEFAULT

ref_des_display NO

!

! These options control dimensions

!

allow_3d_dimensions NO

angdim_text_orientation HORIZONTAL

associative_dimensioning YES

blank_zero_tolerance NO

chamfer_45deg_leader_style STD_ASME_ANSI

clip_dimensions YES

clip_dim_arrow_style DOUBLE_ARROW

default_dim_elbows YES

dim_fraction_format DEFAULT

dim_leader_length 0.500000

dim_text_gap 0.500000

draft_scale 1.000000

draw_ang_units ANG_DEG

draw_ang_unit_trail_zeros YES

dual_digits_diff -1

dual_dimension_brackets YES

dual_dimensioning NO

dual_secondary_units MM

iso_ordinate_delta NO

lead_trail_zeros STD_DEFAULT

lead_trail_zeros_scope DIMS

ord_dim_standard STD_ANSI

orddim_text_orientation PARALLEL

parallel_dim_placement ABOVE

shrinkage_value_display PERCENT_SHRINK

text_orientation HORIZONTAL

tol_display NO

tol_text_height_factor STANDARD
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tol_text_width_factor STANDARD

use_major_units NO

witness_line_delta 0.125000

witness_line_offset 0.062500

!

! These options control text and line fonts

!

default_font font

aux_font 1 filled

!

! These options control leaders

!

draw_arrow_length 0.187500

draw_arrow_style CLOSED

dim_dot_box_style DEFAULT

draw_arrow_width 0.062500

draw_attach_sym_height DEFAULT

draw_attach_sym_width DEFAULT

draw_dot_diameter DEFAULT

leader_elbow_length 0.250000

!

! These options control axes

!

axis_interior_clipping NO

axis_line_offset 0.100000

circle_axis_offset 0.100000

radial_pattern_axis_circle NO

!

! These options control geometric tolerancing information

!

gtol_datums STD_ANSI

gtol_dim_placement ON_BOTTOM

new_iso_set_datums YES

asme_dtm_on_dia_dim_gtol ON_GTOL

!

! These options control tables, repeat regions, and BOM balloons

!

dash_supp_dims_in_region YES

def_bom_balloon_leader_sym ARROWHEAD

model_digits_in_region YES
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show_cbl_term_in_region YES

2d_region_columns_fit_text NO

!

! These options control layers

!

draw_layer_overrides_model NO

ignore_model_layer_status YES

!

! These options control model grids

!

model_grid_balloon_size 0.200000

model_grid_neg_prefix -

model_grid_num_dig_display 0

model_grid_offset DEFAULT

!

! These options control theoretical piping bend intersection

!

show_pipe_theor_cl_pts BEND_CL

pipe_pt_shape CROSS

pipe_pt_size DEFAULT

!

! Miscellaneous options

!

decimal_marker COMMA_FOR_METRIC_DUAL

drawing_units INCH

line_style_standard STD_ANSI

max_balloon_radius 0.000000

min_balloon_radius 0.000000

node_radius DEFAULT

sym_flip_rotated_text NO

weld_symbol_standard STD_ANSI

yes_no_parameter_display TRUE_FALSE

default_pipe_bend_note NO





Pro/ENGINEER 2000 i2 Pro/DETAIL Выпуск Документации

 - 389 -

Опции Файла Установок Рисунка
h_dr_det_setup_create_rf.doc

Этот раздел справки представляет полный список опций файла установок рисунка, их
значений и определений, отображая для каждой опции:

· название файла установок;

· связанные значения (значения по умолчанию отображаются курсивом);

· определение.

2d_region_columns_fit_text
no, yes
Определяет, будет ли каждый столбец в двумерной области повторения изменять свой
размер для соответствия самой длинной части текста в каждом столбце.

Если установлено в «yes», каждый столбец в двумерной области повторения изменяет
свой размер для соответствия самому длинному тексту в столбце и не накладывается на
смежные столбцы или увеличивает интервалы в таблице. Столбцы без текста используют
для области ширину столбца по умолчанию (ширина ячейки прототипа).

Столбцы таблиц с автоматически измененными двумерными областями повторения не
могут быть изменены вручную.

allow_3D_dimensions
no, yes
Определяет отображение размеров в изометрических изображениях.

angdim_text_orientation
horizontal, parallel_outside, horizontal_outside, parallel_above, parallel_fully_outside
Управляет размещением угловых размеров в рисунках. Если установлено в "horizontal",
текст угловых размеров отображается всегда горизонтально, по центру между выносками
(эквивалентно значению "horizontal" для опции "text_orientation� файла установок рисунка).
Если установлено в "parallel_outside", текст отображается параллельно линиям выноски,
независимо от их ориентации (эквивалентно значению "parallel" для опции "text_orientation�
файла установок рисунка). Если установлено в "horizontal_outside", текст отображается
горизонтально вне размеров. Если установлено в "parallel_above", текст отображается
параллельно дуге размера над ней. Если установлено в "parallel_fully_outside", текст
угловых размеров отображается (с плюсовым/ минусовым допуском) параллельно линиям
выноски.

asme_dtm_on_dia_dim_gtol
on_dim, on_gtol
Управляет размещением установленного опорного элемента, присоединенного к
диаметральному размеру. Если установлено в "on_dim", установленный опорный элемент
присоединяется к диаметральному размеру в соответствии со стандартом ASME. Если
установлено в "on_gtol", элемент размещается в gtol.
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associative_dimensioning
yes, no
Связывает эскизные размеры с примитивами. Система связывает только размеры, которые
были созданы при опции, установленной в «yes».

aux_font
1 filled, # индексное имя шрифта (# = от 1 до 8)
Устанавливает вспомогательный текстовый шрифт '#' в качестве шрифта,
идентифицированного в указанном индексе шрифта. Система помнит номер
вспомогательного шрифта, соответствующего имени шрифта, которое отображается в
меню TEXT FONTS с доступными шрифтами. Не включайте суффикс ".ndx"; например, "1
gothicfont".

Доступны шрифты PTC и TrueType. См. раздел справки шрифта по умолчанию для
подробной информации.

aux_line_font
# имя шрифта (# = от 1 до 10,000)

Устанавливает вспомогательные шрифты линии как указанные шрифты. Использует целое
число для связи шрифта линии для эскизной геометрии. Таким образом можно
производить общие изменения, изменяя имя шрифта, связанное с номером. Эту опцию
необходимо добавить к файлу установок рисунка вне зависимости от установки
вспомогательного шрифта.

axis_interior_clipping
no, yes
Если установлено в «no», отображает оси в рисунке согласно стандарту ANSI Y14.2M.
Можно корректировать оси как показано ниже.

Если установлено в «yes», можно корректировать каждую ось индивидуально, отсекая и
перемещая ее как показано ниже.
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axis_line_offset
0.100000, значение
Устанавливает заданное по умолчанию расстояние, на которое линейная ось выходит за
связанный с ней элемент.

blank_zero_tolerance
no, yes
Управляет отображением плюсовым или минусовым значением допуска. Если установлено
в «yes», не отображает плюсовое или минусовое значение допуска если значение допуска
нулевое.

broken_view_offset
0.100000, значение
Устанавливает расстояние смещения между двумя половинами вида с разрывом.

chamfer_45deg_leader_style
std_asme_ansi, std_din, std_iso, std_jis
Управляет типом выноски размера фаски без изменения текста.

circle_axis_offset
0.100000, значение
Устанавливает заданное по умолчанию расстояние, на которое оси окружности выходят за
кромки.

clip_diam_dimensions
yes, no
Автоматически отсекает диаметральные размеры по границе вида. Конечные точки
размера, лежащие за границами вида отсекаются по границе вида. Отсечение не
происходит, если обе конечных точки находятся внутри границы вида.

Значение по умолчанию � no, для рисунков, созданных в более ранних версиях.
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clip_dim_arrow_style
double_arrow, arrowhead, dot, filled_dot, arrow, slash, integral, box, filled_box, none
Управляет стилем стрелки обрезанных размеров.

clip_dimensions
yes, no
Управляет отображением размеров в выносном виде. Если установлено в «yes», не
отображает размеры полностью за границей выносного вида. Размеры, пересекающие
границу вида, отображаются со специальной двойной стрелкой (как показано ниже). Если
установлено в «no», отображаются все размеры.

create_area_unfold_segmented
yes, no
Отображает размеры в области развернутых поперечных сечений, подобно таковым в
развернутых видах поперечных сечений. Если установлено в «yes», отображает вид в
сегментах, при создание нового вида (один сегмент за раз), соответствующих
прямолинейным сегментам эскиза поперечного сечения. [Для создания границ вида между
сегментами вида, установите "show_total_unfold_seam" в «yes».] Эта опция воздействует
только на новые виды. Pro/ENGINEER не поддерживает выносные виды сегментированной
области развернутых поперечных сечений или полные развернутые поперечные сечения.
Однако, он поддерживает выносные виды несегментированных областей развернутых
поперечных сечений.

crossec_arrow_length
0.187500, значение
Устанавливает длину стрелок секущей плоскости поперечного сечения.

crossec_arrow_style
tail_online, head_online
Устанавливает стиль отображения стрелок поперечного сечения.
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crossec_arrow_width
0.062500, значение
Устанавливает ширину стрелок секущей плоскости поперечного сечения

crossec_text_place
after_head, before_tail, above_tail, above_line, no_text
Устанавливает местоположение текста поперечного сечения. Если установлено в "no_text",
текст поперечного сечения не отображается.

crossec_type
old_style, new_style
Увеличивает возможности создания сложных видов поперечных сечений в рисунках,
снижая возможность возникновения ошибок при создании вида поперечного сечения.

Если установлено в old_style, система использует разрез для удаления геометрии при
создании вида поперечного сечения. Если установлено в new_style, система использует
плоскость Z-отсечения для создания вида поперечного сечения.

cutting_line
std_ansi, std_din, std_iso, std_jis, std_ansi_dashed, std_jis_alternate
Управляет отображением линии сечения. Если установлено в "std_ansi", для линии
сечения используется стандарт ANSI. Если установлено в "std_ansi_dashed", используются
пунктирные линии. Иначе, используется линия сечения по стандарту DIN. Ее утолщенная
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часть отображается белым цветом, а тонкая часть - серым. Если установлено в
"std_jis_alternate", а опция файла установок рисунка �cutting_line_segment" - установлена,
стрелки вида отображаются следующим образом:

· утолщенная часть линии сечения формирует угол и система отображает ее синим цветом.

· Соединяющая часть сегмента линии сечения между утолщенными сегментами
отображается желтым цветом.

· Части стрелки отображаются белым цветом.

При установке опции "cutting_line_segment� файла установок рисунка в "0", вся линия
сечения отображается как штриховая линия желтого цвета. Если длина сегмента линии
сечения слишком большая, вся линия сечения отображается синим цветом.

cutting_line_adapt
no, yes
Управляет отображением шрифтов линии используемых для отображения стрелок
поперечного сечения. Если опция установлена в «yes», все шрифты линии отображаются
соответственно, начинаясь и заканчиваясь в середине полного сегмента линии.

cutting_line_segment
0.000000, значение
Определяет длину утолщенной части линии сечения (не по стандарту ANSI) в единицах
рисунка. Если установлено в "0", длина сегмента линии сечения - 0.

dash_supp_dims_in_region
no, yes
Управляет отображением значений размеров в областях повторения таблицы
Pro/REPORT. Если установлено в «no», значения в областях повторения таблицы
Pro/REPORT отображаются. Если установлено в «yes», подавляет размер и отображает
вместо него черточку.

datum_point_shape
cross, dot, circle, triangle, square
Управляет отображением опорных точек.

datum_point_size
Значение по умолчанию, значение
Управляет размером модели опорных точек и эскизных двумерных точек. Система не
использует единицы рисунка или модели; она всегда отображает размер точки в дюймах.

decimal_marker
comma_for_metric_dual, period, comma
Определяет, символ десятичной точки во вторичных размерах.

def_bom_balloon_leader_sym
arrowhead, dot, filled_dot, no_arrow, slash, integral, box, filled_box
Устанавливает стиль стрелки по умолчанию (точку присоединения) для позиций BOM в
сообщениях.
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def_view_text_height
0.000000, значение
Устанавливает высоту текста в именах видов, используемых в примечаниях видов, и в
стрелках на поперечных сечениях и проекционных выносных видах.

def_view_text_thickness
0.000000, значение
Устанавливает высоту нового текста в именах видов, используемых в примечаниях видов,
и в стрелках на новых созданных поперечных сечениях и проекционных выносных видах.

default_dim_elbows
yes, no
Управляет отображением изгибов размеров. Если установлено в «yes», размеры
отображаются с изгибами.

default_font опция файла конфигурации
font, font index name
Устанавливает заданные по умолчанию текстовые шрифты в качестве шрифтов,
перечисляемых в указанном индексе шрифта. Не включайте расширение ".ndx". Шрифты
�font� и �filled� находятся в файле установок.

default_pipe_bend_note
no, значение
Управляет отображением примечаний колен трубопровода в рисунках. Если установлено
как текст в кавычках, при создании примечания изгиба используется это значение. Текст
может включать параметры типа "&bend_name:att_pipe_bend" и "&bend_tol: att_pipe_bend".
Если установлено как путь к каталогу, ссылается на предварительно созданное
примечание, сохраненное как файл.

detail_circle_line_style
SOLID FONT, любой доступный системный или пользовательский шрифт линии
Устанавливает шрифт линии для кругов, обозначающих выносной вид в рисунке.

detail_view_circle
on, off
Устанавливает отображение окружности, нарисованной вокруг части модели, которая
отображается в выносном виде.

dim_dot_box_style
default, filled, hollow
Управляет отображением стиля стрелки для точек и квадратиков только для выносок
линейных размеров. Если установлено в �default� (установка по умолчанию), использует
установку "draw_arrow_style".

Если установлено в �filled�, заливает точки и квадратики стрелок линейных размеров.
Используйте �filled� для того, чтобы новые рисунки отображались с заполненные точками и
квадратиками размерных стрелок.

Если установлено в �hollow�, точки и квадратики стрелок линейных размеров не
заливаются.
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Если установлено в �default� для стрелок позиций BOM, опция
"def_bom_balloon_leader_sym� файла установок рисунка определяет стиль стрелки по
умолчанию (точки присоединения) для позиций BOM в отчетах.

опция dim_fraction_format файла конфигурации
Значение по умолчанию, std, aisc
Управляет отображением дробных размеров в рисунках. Пока не будет установлено в
�default�, эта опция заменяет опцию "dim_fraction_format� файла конфигурации.

Если установлено в "std", отображает дробные размеры в рисунках в стандартном
формате Pro/ENGINEER.

Если установлено в "aisc", отображает дробные размеры в рисунках в формате AISC.

Если установлено в �default� (настройка по умолчанию), отображает дробные размеры в
рисунках согласно установке опции "dim_fraction_format� файла конфигурации.

Установите опцию в "AISC" для отображения дробных размеров в формате AISC.
Установка "AISC" также отображает архитектурные единицы согласно формату AISC для
размеров футы-дюймы.

Установите опцию в �default� для отображения дробных размеров в соответствии с
установкой опции config.pro "dim_fraction_format".

Опция "use_major_units� файла установок рисунка используется для контроля, отображать
ли дробные размеры в футах-дюймах. Используйте опцию следующим образом:

установите опцию в «no» и дробные размеры не будут отображаться в основных единицах.

Установите опцию в �default� для отображения дробных размеров согласно установке
опции config.pro "use_major_units".

Опции "dim_fraction_format� и "use_major_units" файла установок рисунка управляют
отображением размеров при вызове рисунков, созданных до Версии 2000i. Опция файла
конфигурации управляет форматированием дробных размеров.

Опция "dim_fraction_format� файла установок рисунка управляет отображением дробных
размеров в рисунках. Опция файла установки рисунка заменяет опцию "dim_fraction_format�
файла конфигурации, если опция установки рисунка не установлена в �default�.

Опция "use_major_units� файла установки рисунка управляет отображением дробных
размеров в рисунках так же, как и опция "use_major_units� файла конфигурации управляет
отображением дробных размеров в режимах Детали и Сборки. Опция "use_major_units�
установки рисунка заменяет опцию "use_major_units� файла конфигурации в рисунках, если
опция рисунка не установлена в �default�.

dim_leader_length
0.500000, значение
Устанавливает длину линии выноски размера, когда стрелки выноски находятся за
выносными линиями.
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dim_text_gap
0.500000, коэффициент
Управляет расстоянием между размерным текстом и линией размерной выноски, и
представляет отношение размера промежутка и высоты текста.

Для диаметрального размера, если "text_orientation" установлен в "parallel_diam_horiz", то
"dim_text_gap", управляет удлинением изгиба за текст.

draft_scale
1.000000, значение
Определяет значение эскизных размеров относительно фактической длины нарисованного
объекта в рисунке.

draw_ang_unit_trail_zeros
yes, no
Управляет отображением угловых размеров. Если установлено в «yes», удаляет конечные
нули (в соответствии со стандартом ANSI) при отображении угловых размеров в формате
градусы/минуты/секунды. Если установлено в «no», не отображает конечные нули в
угловых размерах или допусках.

draw_ang_units
ang_deg, ang_min, ang_sec
Устанавливает отображение угловых размеров в рисунке. Если установлено в "ang_deg",
создает десятичные градусы; если установлено в "ang_min", создает градусы и десятичные
минуты; если установлено в "ang_sec", создает градусы, минуты и десятичные секунды.

draw_arrow_length
0.187500, значение
Устанавливает длину стрелок линии выноски.
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draw_arrow_style
closed, open, filled
Управляет стилем стрелки для всех выносных элементов, включая стрелки выноски
размеров, примечаний, трехмерных примечаний, допусков на размер, символов и позиций.

draw_arrow_width
0.062500, значение
Устанавливает ширину стрелок линии выноски. Управляет следующими опциями файла
установок рисунка:

draw_attach_sym_height

draw_attach_sym_width

draw_dot_diameter

draw_attach_sym_height
default, значение
Устанавливает высоту косых черточек линии выноски, знаков интеграла и квадратиков.
Если установлено в "default", используется значений для "draw_arrow_width".

draw_attach_sym_width
default, значение
Устанавливает ширину косых черточек линии выноски, знаков интеграла и квадратиков.
Если установлено в "default", используется значений для "draw_arrow_width".

draw_cosms_in_area_xsec
no, yes
Управляет отображением косметических эскизов и элементов опорных кривых, которые
лежат в секущей плоскости плоского поперечного сечения. Если установлено в «yes»,
отображаются все косметические эскизы и элементы опорной кривой, лежащие в секущей
плоскости. Если установлено в «no», они не отображаются.

draw_dot_diameter
default, значение
Устанавливает диаметр точек линии выноски. Если установлено в "default", используется
значений для "draw_arrow_width".

draw_layer_overrides_model
no, yes
Управляет установкой отображения слоя рисунка для определения установки слоев
рисунка модели с таким же названием. Если установлено в «yes», неявно включает слои
модели рисунка в слои рисунка с тем же именем с целью установки отображения. Если
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установлено в "no", игнорирует слои, не принадлежащие рисунку, когда состояние
отображения слоев установлено в модели рисунка.

drawing_text_height
0.156250, значение
Устанавливает заданную по умолчанию высоту текста для всего текста в рисунке,
используя установленное значений для "drawing_units".

drawing_units
inch, foot, mm, cm, m
Устанавливает единицы для всех параметров рисунка.

dual_digits_diff
-1, значение
Управляет количеством знаков справа от десятичного разделителя для вторичных
размеров, отличающихся от первичных. Например, значение по умолчанию -1 приводит к
следующему результату, когда первичные единицы - дюймы, а вторичные единицы -
миллиметры: 10.235 [259.96].

dual_dimension_brackets
yes, no
Управляет отображением скобок с размерными единицами. Эта опция работает только при
использовании "dual_dimensioning". При установке в «yes», отображает размерные
единицы с секундами в скобках; если установлено в «no», не отображает скобки.

dual_dimensioning
no, primary [secondary], secondary [primary], secondary
Управляет форматом отображения размеров. Если установлено в «no», отображает
единственное значение для размеров. Если установлено в "primary [secondary]",
отображает размеры с первичными единицами (установленными в модели) и вторичными
единицами; если установлено в "secondary", отображает только вторичные размеры
рисунка так, как если бы они были первичными.

dual_secondary_units
mm, inch, foot, cm, m
Устанавливает единицы отображения вторичных размеров.

gtol_datums
std_ansi, std_ansi_mm, std_iso, std_jis, std_din, std_iso_jis, std_ansi_dashed, std_asme
Устанавливает чертежный стандарт для отображения ссылочных опорных элементов в
рисунках. Отображение воздействует на оси и опорные плоскости, и отображение опорных
элементов ссылочных деталей.

Опция gtol_dim_placement файла конфигурации
on_bottom, under_value
Определяет местоположение символа предельных отклонений допуска на размер при
присоединении к символу размера, содержащему дополнительный текст. Если
установлено в "on_bottom", размещает допуск на размер под символом размера, ниже
любых дополнительных строк текста. Если установлено в "under_value", размещает допуск
на размер сразу под значением размера и над любыми дополнительными строками текста.
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half_view_line
solid, symmetry, symmetry_iso, symmetry_asme, none
Если установлено в "solid", рисует сплошные линии в месте присутствия материала. Если
установлено в "symmetry", рисует осевую линию, выходящую за деталь и представляющую
линию разрыва. Если установлено в "symmetry_iso", отображает линию симметрии
половины вида согласно стандарту ISO 128:1982 5.5. Линия симметрии половины вида
отображается желтым цветом с тонким стилем линии и тонкими "засечками" на концах
желтого цвета. Если установлено в "symmetry_asme", отображает линию симметрии
половины вида согласно стандарту ASME Y14.2M-1992. Линия симметрии половины вида
отображается желтым цветом тонким стилем линии и толстыми "засечками" белого цвета.

Если установлено в "none", рисует объект на маленьком расстоянии от линии симметрии.
Необходимо выбрать опорный элемент смещения для создания половины вида;
удостоверьтесь, что имеется осевая линия, обозначающая фактическую половину.

hidden_tangent_edges
default, dimmed, erased
Управляет отображением скрытых касательных кромок в видах рисунка. Если установлено
в "dimmed", чертит скрытые касательные кромки вида, используя Перо 7. Линии
отображаются штриховой линией тем же цветом, что и скрытые видимые касательные
кромки. Однако, необходимо выбрать Hidden Line или No Hidden Line в списке Display
Style диалогового окна Environment Pro/ENGINEER. Если установлено в "erased",
автоматически удаляет все скрытые касательные кромки на экране и при печати.

hlr_for_pipe_solid_cl
no, yes
Управляет отображением осевых линий трубопровода. Если установлено в «yes»,
удаление невидимой линии воздействует на осевые линии трубопровода. Если
установлено в «no» - не влияет. Эта опция работает только с трубопроводами, созданными
в Pro/PIPING, но не с элементами трубопровода детали.

hlr_for_threads
no, yes
Управляет отображением резьб в рисунке в зависимости от стандарта ISO или ANSI
(устанавливается опцией "thread_standard"). Если установлено в «yes» кромки резьбы
соответствуют стандарту ANSI или ISO для отображения Hidden Line.

ignore_model_layer_status
yes, no
Управляет тем, будет ли система учитывать состояние слоев в моделях. Если установлено
в «yes», игнорирует изменения состояния слоев в модели рисунка, сделанные в другом
режиме.

iso_ordinate_delta
no, yes
Улучшает отображение смещения между ординатными размерными линиями по стандарту
ISO и выносной линией, называемой еще "выносная линия дельта". Если установлено в
«yes», смещение отображается правильно, согласно значению, указанному для опции
файла установок рисунка "witness_line_delta". Если установлено в «no», смещение не
отображается точно в соответствии с указанным значением (смещается приблизительно на
2 миллиметра).
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lead_trail_zeros
std_default, std_metric, std_english, both
Управляет отображением ведущих и последних нулей в размерах. Может также управлять
отображением ведущих и последних нулей в параметрах, в зависимости от установки
опции "lead_trail_zeros_scope� файла установок рисунка. Если "lead_trail_zeros_scope"
установлена в "all" управляет отображением ведущих и последних нулей для размеров, а
также для всех параметров с плавающей запятой в рисунке, включая параметрические
примечания, примечания масштаба вида, таблицы, символы и примечания косметической
резьбы.

Если используется двойное образмеривание, эта опция независимо управляет
использованием ведущих и последних нулей в обоих стандартах.

Если единицы в опции "dual_dimensioning" файла установок рисунка установлены в
�primary[secondary]�, опция "std_english [std_metric]" отображает значения первичных
единиц с конечными нулями, в то время как вторичные единицы отображают значения с
ведущими нулями.

Если единицы в опции"dual_dimensioning" файла установок рисунка установлены в
�secondary [primary]�, опция "std_english [std_metric]" отображает значения вторичных
единиц с конечными нулями, в то время как первичные единицы отображают значения с
ведущими нулями.

Если установлено в "std_default", размер или параметр отображается согласно его
единицам. Если установлено в "both", ведущие и конечные нули в размерах или
параметрах отображаются, независимо от используемых метрических или британских
единиц.

lead_trail_zeros_scope
dims, all
Управляет, воздействует ли опция "lead_trail_zeros� установки рисунка только на размеры.
Если установлено в "dims", опция "lead_trail_zeros� установки рисунка управляет только
размерами. Если установлено в "all", опция "lead_trail_zeros" установки рисунка управляет
размерами и также всеми параметрами, включая параметрические примечания,
примечания масштаба вида, таблицы, символы и примечания косметической резьбы.

leader_elbow_length
0.250000, значение
Определяет длину изгиба выноски (горизонтальный участок, присоединенный к тексту).

line_style_length
font_name default, font_name value
Устанавливает длину элементов, составляющих шрифт. Эту опцию необходимо добавлять
к файлу установок рисунка всякий раз, когда требуется изменить длину. Введите имя
шрифта и, затем, требуемое значение длины шрифта в единицах системы. Установка
"default" указывает значения длины по умолчанию.

line_style_standard
std_ansi, std_iso, std_jis, std_din
Управляет цветом текста в рисунках. Пока не будет установлено в "std_ansi", весь текст
рисунка отображается синим цветом, а границы выносных видов отображаются желтым
цветом.
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location_radius
default (2.), 0.0, любое значение
Изменяет радиус узлов, обозначающих местоположение, улучшая их видимость, особенно
при выводе рисунков на печать. Если установлено в �default�, устанавливает радиус как 2
единицы рисунка. Если установлено в " 0.0", отображает узлы местоположения, но не
печатает их. Максимального значения для этой установки не существует.

max_balloon_radius
0.000000, non-zero, значение
Устанавливает максимальный допустимый радиус позиции. Если установлено в "0", радиус
позиции зависит только от размера текста.

mesh_surface_lines
on, off
Управляет отображением синих линий сетки поверхности.

min_balloon_radius
0.000000, ненулевое значение
Устанавливает минимально допустимый радиус позиции. Если установлено в "0", радиус
позиции зависит только от размера текста.

model_digits_in_region
yes, no
Управляет отображением цифр в двумерных областях повторения. Если установлено в
«yes», двумерные области повторения отображают количество цифр размеров модели
детали и сборки.

model_display_for_new_views
default

Определяет отображение невидимых линий в виде.

model_grid_balloon_size
0.200000, значение
Определяет радиус позиций по умолчанию, отображаемых с сеткой модели в рисунке.

Опция model_grid_neg_prefix файла конфигурации
-, любая строка
Управляет префиксом отрицательных значений, отображаемых в позициях сетки модели.

model_grid_num_dig_display
0, значение (целое число)
Управляет числом цифр, отображаемых в координатной сетке, которые отображаются в
сетке позиций. Введите целое число, определяющее число десятичных знаков, или
используйте системное значение по умолчанию (0) для отображения координаты в виде
целого числа.
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model_grid_offset
значение по умолчанию, значение
Управляет смещением новых позиций сетки модели от вида рисунка. Если установлено в
"default", новые позиции сетки модели смещаются от вида рисунка на удвоенное
расстояние текущего интервала сетки модели. Если установлено в значение, позиции
смещаются от вида на указанное число дюймов (не единиц рисунка).

new_iso_set_datums
yes, no
Управляет отображением установленных опорных элементов. Если установлено в «yes»,
установленные эскизные опорные элементы отображаются в соответствии со стандартом
ISO.

node_radius
default, значение
Управляет отображением узлов в символах. Если установлено в "default", система
определяет радиус узлов. Если установка настолько мала, что узлы не отображаются,
система использует настройку по умолчанию. Не имеется никакого максимального
значения для этой установки.

ord_dim_standard
std_ansi, std_iso, std_jis, std_din
Устанавливает стандарт для отображения ординатных размеров. Если установлено в
"std_ansi", размеры отображаются без соединительной линии (Рис. a). Иначе, размещает
связанные ординатные размеры по соединительной линии, перпендикулярной к базовой
ссылочной линии и начинает с окружности (Рис. b). Каждый сегмент соединительной линии
заканчивается стрелкой. Стрелки и окружность отображаются залитыми или открытыми,
согласно текущей установки опции "draw_arrow_style� файла установок рисунка. Примите
во внимание, что связанные выносные линии перемещаются вместе при перемещении
любого из связанных размеров.
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orddim_text_orientation
parallel, horizontal
Управляет ориентацией текста ординатных размеров. Если установлено в "parallel",
размерный текст отображается параллельно линиям выноски. При установке в "horizontal",
он отображается горизонтально, параллельно основанию листа рисунка.

parallel_dim_placement
above, below
Определяет отображение размера над или под линией выноски, при установке
опции"text_orientation" в "parallel". Эта опция не воздействует на двойные размеры.

pipe_pt_shape
cross, dot, circle, triangle, square
Управляет формой точек пересечения теоретических изгибов в рисунках трубопроводов.

pipe_pt_size
default, значение
Управляет размером точек пересечения теоретических изгибов в рисунках трубопроводов.

projection_type
third_angle, first_angle
Определяет метод создания проекционных видов.

radial_pattern_axis_circle
no, yes
Устанавливает режим отображения осей вращения, перпендикулярных экрану в элементах
радиальных массивах. Если установлено в «no», осевые линии отображаются (Рис. a).
Если установлено в «yes», отображаются общие оси и линии осей проходят через центр
круговых массивов (Рис. b).

ref_des_display
no, yes. DEFAULT
Управляет отображением ссылочных указателей в рисунке сборки кабелей. Если
установлено в "DEFAULT", выберите переключатель Reference Designators в диалоговом
окне Environment.

remove_cosms_from_xsecs
total, all, none
Управляет отображением опорных кривых, резьб, косметических объектов и косметической
штриховкой на полных поперечных сечениях. Если установлено в "all", удаляет опорные
элементы и косметические элементы со всех типов поперечных сечений. Если установлено
в "total", удаляет элементы, расположенные полностью перед плоскостью рассечения от
поперечного сечения. Эти элементы отображаются полностью только, если они
пересекают секущую плоскость. Если установлено в "none", не отображает опорные
лоскутные поверхности и косметические элементы.
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select_hidden_edges_in_dwg
yes, no
Отключает выбор кромок No Hidden в рисунках при использовании Query Select, отклоняя
кромки, лежащие за первой поверхностью в точке выбора.

show_cbl_term_in_region
no, yes
Позволяет использовать символы отчета "&asm.mbr.name" и "&asm.mbr.type" для
отображения окончаний в таблицах Pro/REPORT для сборок кабелей, имеющих
соединители с параметрами окончаний. Если установлено в «yes» (следует установить
атрибут Cable Info для область повторения), окончания отображаются. При создании
новых рисунков, значение по умолчанию - «yes». Для существующих рисунков, значение по
умолчанию - «no».

show_pipe_theor_cl_pts
bend_cl, theor_cl, both
Управляет отображением осевых линий и теоретических точек пересечения в рисунках
трубопроводов. Если установлено в "bend_cl", осевые линии отображаются только с
коленами. Если установлено в "theor_cl", осевые линии отображаются только с
теоретическими точками пересечения колена. Если установлено в "both", отображаются и
колена, и теоретические точки пересечения.

show_preview_default
remove, keep
Определяет заданное по умолчанию поведение предварительного просмотра в
диалоговом окне Show/Erase. Remove устанавливает по умолчанию Sel to Remove. Keep
устанавливает Sel to Keep.

show_quilts_in_total_xsecs
no, yes
Определяет включение геометрии поверхности в поперечное сечение рисунка и
разрезание поверхности плоскостью поперечного сечения. Установка в "no" (значение по
умолчанию) исключает поверхностную геометрию. Установка в «yes» включает
поверхностную геометрию.

show_total_unfold_seam
yes, no
Управляет отображением стыков (кромок секущей плоскости) полного развернутого
поперечного сечения. При установке в «yes» стыки отображаются; при установке в «no»,
стыки скрываются.
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shrinkage_value_display
percent_shrink, final_value
Отображает усадочные размеры в процентах или как окончательные значения.

sym_flip_rotated_text
no, yes
Зеркально отображает любой текст в перевернутом символе Rotate Text, устанавливая его
написание справа налево. Если установлено в «yes» и символ ориентирован на + /- 90
градусов, зеркально отражает текст, вращая его вместе с символом.

sym_rotate_note_center
yes, no
Управляет отображением символа, его примечаний и ориентацией при зеркальном
отображении и повороте. Если установлено в «yes», примечания символа поворачиваются
вокруг середины высоты текста. Если установлено в "no", текст поворачивается вокруг его
начальной точки.

tan_edge_display_for_new_views
default

Определяет отображение касательных кромок.

text_orientation
horizontal, parallel, parallel_diam_horiz, ISO_parallel, ISO_parallel_diam_horiz
Управляет ориентацией размерного текста в рисунке. Если установлено в �horizontal�, весь
размерный текст отображается горизонтально. Если установлено в �parallel�, текст
отображается параллельно линии выноски размера. Если установлено в
"parallel_diam_horiz", все размеры, кроме диаметральных, отображаются параллельно
своим выноскам; только диаметральные размеры отображаются горизонтально. Изгиб
диаметрального размера всегда достигает конца текста. Чтобы управлять вытягиванием
изгиба до текста, используйте опцию "dim_text_gap� файла установок рисунка. Если
установлено в "ISO_parallel", текст отображается параллельно выносной линии размера. В
отличии от значения �parallel�, допуска размеров также могут отображаться в формате ISO
406:1987 (E) или British Standard Tolerance. Если установлено в
"ISO_PARALLEL_DIAM_HORIZ", все размеры, за исключением диаметральных,
отображаются параллельно их выноскам. Предельные допуски выстраиваются в
соответствии со стандартом ISO.

Опция "angdim_text_orientation� файла установок рисунка (а не "text_orientation") управляет
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отображением угловых размеров.

text_thickness
0.000000, 0 < значение < .5
Устанавливает толщину текста по умолчанию для нового текста после регенерации и
существующего текста, чья толщина не изменялась. Введите значение в единицах рисунка.

text_width_factor
0.800000,. 25<#>8
Устанавливает заданное по умолчанию отношение между шириной текста и высотой
текста. Система сохраняет это отношение, пока ширина не будет изменена с
использованием команды Text Width.

thread_standard
std_ansi, std_ansi_imp, std_iso_imp, std_iso_imp_assy, std_ansi_imp_assy, std_iso
Управляет отображением резьбового отверстия с осью (перпендикулярно к экрану в виде
дуги (стандарт ISO) или в виде окружности (ANSI)).

Если установлено в "std_ansi_imp" или "std_iso_imp", скрытые линии резьбы не
отображаются, при выборе No Hidden Line в списке Display Style в диалоговом окне
Environment Pro/ENGINEER. При выборе Hidden Line, линии резьбы в сборочных
чертежах отображаются как линии выноски (желтым). Если установлено в
"std_iso_imp_assy", резьбы в поперечных сечениях сборочных чертежей отображаются в
соответствии со стандартом ISO 6410. Если установлено в "std_ansi_imp_assy", они
отображаются в соответствии со стандартом ANSI. Значения "std_iso" и "std_ansi" работают
с рисунками, созданными до Версии 15.0.

tol_display опция файла конфигурации
no, yes
Управляет отображением допусков размеров. Диалоговое окно Environment
Pro/ENGINEER нельзя вызывать, если эта опция установлена.

tol_text_height_factor
standard, число > 0
Устанавливает отношение по умолчанию между высотой текста допуска и высотой
размерного текста, при отображении допуска в формате "плюс минус". Если установлено в
"standard", система использует 1 для стандарта ANSI и .6 для стандарта ISO.

tol_text_width_factor
standard, число > 0
Устанавливает коэффициент по умолчанию, сохраняющий пропорцию между шириной
текста допуска и шириной размерного текста, при отображении допуска в формате "плюс
минус". Если установлено в "standard", система использует .8 для стандарта ANSI и .6 для
стандарта ISO.
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use_major_units опция файла конфигурации
default, yes, no
Управляет отображением дробных размеров в футах и дюймах. Управляет отображением
дробных размеров в рисунке аналогично опции "use_major_units� файла конфигурации,
управляющей отображением дробных размеров в режиме Детали или Сборки.

Если установлено в «no», дробные размеры не отображаются в основных единицах.

Если установлено в «yes», дробные размеры отображаются в основных единицах.

Если установлено в �default� (настройка по умолчанию), отображает дробные размеры
согласно установке опции "use_major_units" файла конфигурации.

view_note
std_ansi, std_din, std_iso, std_jis
Если установлено в "std_din", создает примечание, связанное с видом, с пропущенными
словами �SECTION,� �DETAIL,� и �SEE DETAIL�.

view_scale_denominator
0, целое число
Определяет знаменатель в масштабе вида перед упрощением дроби. Если установлено
положительное целое число и view_scale_format - десятичное число, масштаб вида,
выбранный для первого вида модели в рисунке, округляется до ближайшего значения с
указанным знаменателем. Если масштаб вида будет настолько мал, что округление
приведет к масштабу 0.0, значение view_scale_denominator автоматически изменяется,
умножая масштаб на 10, и дает положительное значение при округлении масштаба. При
вводе значения масштаба вида, можно округлять его до допустимой дроби. Система не
округляет существующие значения масштаба после редактирования файла установок.
Приблизительные масштабы отображаются с предшествующей тильдой (~), при установке
опции mark_approx_dims файла конфигурации в «yes». При установке опции в 0, значение
масштаба выражается в десятичном формате.

view_scale_format
decimal, fractional, ratio_colon
Выражает масштаб в виде десятичного или дробного значения. Если установлено в
"ratio_colon", отображает значения масштаба вида в виде отношения. Например, вместо
масштаба 0.5, отображает масштаб вида как 1:2. Так как отношение � всего лишь вариант
отображения дроби, убедитесь, что опция "view_scale_denominator" установлена
соответственно.

weld_solid_xsec

weld_symbol_standard
std_ansi, std_iso
Отображает символы сварки в рисунке согласно стандарту ISO или ANSI.

witness_line_delta
0.125000, значение
Устанавливает удлинение выносных линий за стрелки размерных выносок.
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witness_line_offset
0.062500, значение
Устанавливает смещение между размерной линией и образмериваемым объектом. Этот
промежуток может отображаться только при выводе рисунка на печать. Чтобы увидеть его
� используйте вывод печати на экран.

Также управляет размером разрыва в месте пересечения выносных линий, при
использовании разрыва типа �Dimension�.

yes_no_parameter_display
true_false, yes_no
Управляет отображением параметров �yes/no� в примечаниях и таблицах рисунка. Если
установлено в "yes_no", параметры могут иметь значение «yes» или «no» в примечаниях
рисунка. Если установлено в "true_false", они могут иметь значения �true� или �false�.
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